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Spine Toolbox is an application, which provides means to define, manage, and execute complex data processing and
computation tasks, such as energy system models.

If you are new to Spine Toolbox, Getting Started section is a good place to start. If you want to run SpineOpt.jl using
Spine Toolbox, How fo set up SpineOpt.jl provides the step-by-step instructions on how to get started. For information
on how to set up Python, Julia, and Gams for Spine Toolbox, see Setting up External Tools. Please see Settings chapter
for information on user customizable Spine Toolbox settings. If you need help in understanding the terms we use
throughout the app and this User Guide, please check the Terminology section. If you want to contribute to this project,
please see the Contribution Guide for Spine Toolbox. The last section contains the complete code reference of Spine
Toolbox.
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CHAPTER
ONE

GETTING STARTED

Welcome to the Spine Toolbox’s getting started guide. In this guide you will learn two ways of running a “Hello,
World!” program on Spine Toolbox. If you need help on how to run SpineOpt.jl using Spine Toolbox, see chapter
How to set up SpineOpt jl.

This chapter introduces the following topics:

Spine Toolbox Interface

Creating a Project

Creating a Tool specification

Adding a Tool item to the project

Executing a Tool

Editing a Tool specification

Adding a Data Connection item to the project

Adding data files to a Data Connection

Connecting project items

1.1 Spine Toolbox Interface

The central element in Spine Toolbox’s interface is the Design View, which allows you to visualize and manipulate your
project workflow. In addition to the Design View there are a few ‘dock widgets’ that provide additional functionality:

* Project provides a more concise view of your project, including the Ifems that are currently in the project, grouped
by category: Data Stores, Data Connections, Tools, Views, Importers, Exporters and Manipulators.

* Properties provides an interface to interact with the currently selected project item.
» Event Log shows relevant messages about user performed actions and the status of executions.
e Item Execution Log shows the output of executed project items.

* Python console provides an interface to interact with the Python programming language, and also allows Spine
Toolbox to execute Python Tools.

* Julia console provides an interface to interact with the Julia programming language, and also allows Spine Tool-
box to execute Julia Tools.

» Executions shows a list of parallel executions available in the project.
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In addition to the Design view and the dock widgets, the main window contains a foolbar split into two sections. The
Main section contains the project items that you can drag-and-drop onto the Design View and the Execute section has
buttons related to executing the project.

Tip: You can drag-and-drop the dock widgets around the screen, customizing the interface at your will. Also, you can
select which ones are shown/hidden using either the View/Dock Widgets menu, or the main menu toolbar’s context
menu. Spine Toolbox remembers your configuration between sessions. Selecting Restore Dock Widgets from the
View/Dock Widgets menu restores the widgets back to their default location.

Tip: Most elements in the Spine Toolbox’s interface are equipped with tool tips. Leave your mouse cursor over an
element (button, checkbox, list, etc.) for a moment to make the tool tip appear.

1.2 Creating a Project

To create a new project, please do one of the following:
* From the application main menu, select File -> New project...
* Press Ctri+N.

The Select project directory (New project...) dialog will show up. Browse to a folder of your choice and create a
new directory called ‘hello world’ there. Then select the ‘hello world’ directory and press Enter. Spine Toolbox will
populate the selected directory with some files and directories it needs to store the project’s data.

Congratulations, you have created your first Spine Toolbox project.

1.3 Creating a Tool specification

Note: Spine Toolbox is designed to run and connect multiple tools, which are specified using Tool specifications. You
may think of a Tool specification as a self-contained program specification including a list of source files, required and
optional input files, and expected output files. Once a Tool specification is added to a project, it can then be associated
to a Tool item for its execution as part of the project workflow.

Note: Justlike the main window, the Tool specification editor consists of dock widgets that you can reorganize however
you like.

In the toolbar, click on the icon next to the Tool icon , to reveal the Tool specification list. Since there are none in the
project yet, click on the button to open the Tool specification editor. Follow the instructions below to create a minimal
Tool specification:

* Type ‘hello_world’ into the Name: field.
 Select ‘Python’ from the Tool type dropdown list,

* Click on the button next to the Main program file text in the Program files dock widget. A Create new main
program file file browser dialog opens. Name the file hello_world.py and save it e.g. directly to the ‘hello world’
project directory or to a folder of your choice.
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We have just created a ‘hello_world.py’ Python script file, but at the moment the file is empty. Spine Toolbox provides
an mini IDE where you can view and edit the contents of Tool specification files. Let’s try it out.

Select ‘hello_world.py’ below the Main Program File. Click on the (black) editor dock widget with the title
‘hello_world.py’.

Type in the following:

print("Hello, world!")

Now, whenever hello_world.py is executed, the sentence ‘Hello, World!” will be printed to the standard output.

The Tool specification editor should be looking similar to this now:

A Tool specification editor — O x
hello world* £ | <=

Name: |he||n world Description: |E-' ter spedification description here. .. E
Tool type |Python ~ | Command line arguments: |‘-.'_1§ arguments here... | Execute in work directory
Program files & % | hello_world.py g X

¥ Main program file ORK print ("Hello

B hello_world.py*
Additional program files OEWmD

]

Input _output files

Input files

Opticnal input files

23 B3 )
B 8 8,

Qutput files

| Main program dir: C:fdata/SpineToolboxProjects/ hello world ‘

Note that the program file (hello_world.py) and the Tool specification (hello world) now have unsaved changes. This is
indicated by the star (*) character next to hello_world.py* and the Tool specification name in the tabbar (hello world*).

¢ Save changes to both by either pressing Ctrl-s or by mouse clicking on Save in the hamburger menu in the upper
right hand corner.

¢ Close Tool specification editor by pressing Alt-F4 or by clicking on ‘X’ in the top right hand corner of the
window.

Your main window should look similar to this now.

1.3. Creating a Tool specification 5
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& hello woerld [C:\data\SpineToolboxProjects\helle world] - Spine Toolbox - m] x

File Edit View Plugins Consoles Help

N

n =

Main = .’» » A’ » M« + s d Execute

‘R 2 VL DI Ve 1c10

Project & X | Design View £ X Properties g X
Data Stores
Data Connections
Tools
Views
Importers
Exporters
Manipulators

Select a project item to view its properties

Event Log B x
Item Execution Log =

Select and execute & project item to view its execution lo

f you need help, please read the Getting Started guide.

Item Execution Log Julia Console Python Console

Tool specifications are saved in JSON format by default into a dedicated directory under the project directory. If you
want you can open the newly created hello_world.json file by clicking on the file path in the Event log message. The
file will open in an external editor provided that you have selected a default program for files with the .json extension
(e.g in Windows 10 you can do this in Windows Settings->Apps->Default apps). In general, you don’t need to worry
about the contents of the JSON Tool specification files. Editing these is done under the hood by the app.

If you want to save the ‘hello_world.json’ file somewhere else, you can do this by clicking the white [Change] link after
the path in the Event Log.

Tip: Saving the Tool specification into a file allows you to add and use the same Tool specification in another project.
To do this, you just need to click add tool specification from file. .. button () in the toolbar and select the tool specification
file (.json) from your system.

Congratulations, you have just created your first Tool specification.

1.4 Adding a Tool item to the project

Note: The Tool project item is used to run Tool specifications.

Let’s add a Tool item to our project, so that we’re able to run the Tool specification we created above. To add a Tool
item drag-and-drop the Tool icon from the toolbar onto the Design View.

The Add Tool form will popup. Change name of the Tool to ‘say hello world’, and select ‘hello_world’ from the
dropdown list just below, and click Ok. Now you should see the newly added Tool item as an icon in the Design View,
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and also as an entry in the Project dock widget, Items list, under the “Tools’ category. It should look similar to this:

Project & X | Design View
Data Stores
Data Connections

¥ Tools

/" say hello world

Views
Importers | -
Exporters

Manipulators !: /\ :!

Another way to do the same thing is to drag the with the ‘hello world’ text from the toolbar onto the Design View.
Similarly, the Add Tool form will popup but the ‘hello world’ tool specification is already selected from the dropdown
list.

Note: The Tool specification is now saved to disk but the project itself is not. Remember to save the project every
once in a while when you are working. You can do this from the main window File->Save project button or by pressing
Ctrl-s when the main window is active.

1.5 Executing a Tool

Select the ‘say hello world’ Tool on Design View, and you will see its Properties in the dedicated dock widget. It looks
similar to this:

1.5. Executing a Tool 7
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& X Tool Properties g X

say hello world |

Specification  #* hello world v ™

Command line arguments

say hello world Specification arguments

i ¥ Tool arguments

[
l:,\j Type new arg here...

e
—

Available resources

Results. ..

Execute in (® Work directory () Source directory =

Press execute project button on the toolbar. This will execute the ‘say hello world” Tool project item which now has
the ‘hello world” Tool specification associated to it. In actuality, this will run the main program file hello_world.py in
a dedicated process.

Once the execution is finished, you can see the item execution details in the Item Execution Log and the details about
the whole execution in Event Log.

8 Chapter 1. Getting Started
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« hello world [C\data\SpineToclboxProjectsihello world]™ - Spine Toolbox - m] X

File Edit View Plugins Consoles Help

- B AN TN W LY L WA » JORO)

Project & X  DesignView & X Tool Properties g x
Data Stores say hello world
Data Connections
~ Tools Specification | A hello world ~ ||
) say hello world
Views Command line arguments
Importers Specification arguments
Exporters ~ Tool arguments
Manipulators Type new arg here...
ﬁ -

say hello world
L Available resources

Execute in (® Work directory () Source directory =y
say hello world Execution Log g X

llo world===

Event Log g x

say hello world Execution Log ~ Julia Consale  Python Console

Note: For more information about execution modes in Spine Toolbox, please see Setting up External Tools for help.

Congratulations, you just executed your first Spine Toolbox project.

1.6 Editing a Tool specification

To make things more interesting, we will now specify an input file for our ‘hello_world” Tool specification.

Note: Input files specified in the Tool specification can be used by the program source files, to obtain input data for the
Tool’s execution. When executed, a Tool item looks for input files in Data Connection, Data Store, Gdx Exporter,
Exporter, and Data Transformer project items connected to its input.

Open the Tool specification editor for the ‘hello world” Tool spec. You can do this for example, by double-clicking the
‘say hello world’ Tool, or by selecting Edit specification from the ‘hello world’ Tool specification context menu in the
toolbar, or from the ‘say hello world’ Tool context-menu (Specification...->Edit specification).

In Input & Output files dock widget, click the button next to the Input Files text. A dialog appears, that lets you enter
a name for an input file. Type ‘input.txt’ and press Enter.

1.6. Editing a Tool specification 9
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So far so good. Now let’s use this input file in our program. Still in the Tool specification editor, replace the text in the
main program file (hello_world.py), with the following:

with open("input.txt") as input_file:
print(input_file.read())

Now, whenever hello_world.py is executed, it will look for a file called ‘input.txt’ in the current directory, and print its
content to the standard output.

The editor should now look like this:

[‘ Tool specification editor
hello world= £ | ==

—
fi —
—

Mame: |he||0 world Description: |Enter specification description here. ..
Tool type |Python ~ | | Command line arguments: |Type arguments here. .. | Execute in work directory
Program files & X | hello_world.py g X

input file:
)

v Main program file DR
HE hello_world.py*
Additional program file] |§ B @

Input _eutput files g X
v Input files E] Eﬁ
g input.txt
Optional input files Ej Eﬁ
Output files Ej Eﬁ

Main program dir: C:\data\SpineToolboxProjects\hello world

Save the specification and close the editor by pressing Ctrl-s and then Alt-F4.

Note: See Tool specification editor for more information on editing Tool specifications.

Back in the main window, note the exclamation mark on the Tool icon in Design View, if you hover the mouse over this
mark, you will see a tooltip telling you in detail what is wrong. If you want you can try and execute the Tool anyway
by pressing in the toolbar. The execution will fail. because the file ‘input.txt’ is not made available for the Tool:
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+ hello world [C\data\SpineToolbexProjects\hello world]* - Spine Toolbox - m] *
File Edit View Plugins Consoles Help
Y » -
- 1]
Sl - R AN IR W EVLsy | W ALY » JOXO)
Project & X | Design View & X | Tool Properties a8 %
Data Stores say hello world
Data Connections
~ Tools Specification ™ hello world |
) say hello world
Views Command line arguments
Importers Specification arguments
Exporters ¥ Tool arguments
Manipulators Type new arg here...
Available resources
say hello world
o
H
A
I i
Ll w )
Executein (@) Work directory (0 Source directory =1
say hello world Execution Log
say hello world==*
n hello world prog

Event Log

say hello world Execution Log Juliz Consale Python Consale

1.7 Adding a Data Connection item to the project

Note: The Data Connection item is used to hold generic data files, so that other items, notably Importer and Tool
items, can make use of that data.

Let’s add a Data Connection item to our project, so that we’re able to pass the file ‘input.txt’ to ‘say hello world’. To
add a Data Connection item, drag-and-drop the Data Connection icon () from the toolbar onto the Design View.

The Add Data Connection form will show up. Type ‘pass input txt’ in the name field and click Ok. The newly added
Data Connection item is now in the Design View, and also as an entry in the Project dock widgets items list, under the
‘Data Connections’ category. It should look similar to this:

1.7. Adding a Data Connection item to the project 11
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1.8 Adding data files to a Data Connection

Select the ‘pass input txt’ Data Connection item to view its properties in the Properties dock widget.

& ¥  Data Connection Properties g X
pass input b
References
pass input txt say helle world
A T €
| b J'
— + =/ 18
Data
=

Right click anywhere within the Data box and select New file... from the context menu. When prompted to enter a
name for the new file, type ‘input.txt’ and click Ok.

There’s now a new file in the Data list:
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Data Connection Properties [

pass input ot

References

+ = B
Data
Qf' ~ojectsihello world'spinetoolboxhitems\pass_input_tet\input.txt

Double click this file to open it in your default text editor. Then enter the following into the file’s content:

Hello again, World!

Save the file.

1.9 Connecting project items

As mentioned above, a Tool item looks for input files in Data Connections connected to its input. Thus you now need
to create a connection from ‘pass input txt’ to ‘say hello world’. To do this, click on one of the connector slots at the
edges of ‘pass input txt’ in the Design view, and then on a similar slot in ‘say hello world’. This will create an arrow
pointing from one to another, as seen below:

1.9. Connecting project items 13
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Design View

say hello world

Press once again. The project will be executed successfully this time:

& hello world [C:\data\SpineTaolboxProjects\hello world] - Spine Toolbox - m] X

File Edit View Plugins Consoles Help

Mai”EE.’” E’”GE;(O" -E”’ /"". # El(ecute°®@

Project & X | Design View & % Tool Properties 8 x
Data Stores say hello world
v Data Connections ey
B pass inputixt Specification | /* hello world v ||
v Tools -
A say hello werld pass input txt Command line arguments ‘ ~
Views Specification arguments
Importers “ Tool arguments o
Exporters
Manipulators [+] -
Available resources
Q' inputtxt
.
=}

say hello world Execution Log

Event Log

say hello world Execution Log ~~ Julia Console  Python Conscle

That’s all for now. I hope you’ve enjoyed following this guide as much as I enjoyed writing it. See you next time.
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Where to next: If you need help on how to set up and run SpineOpt.jl using Spine Toolbox, see chapter How fo set up
SpineOpt.jl.

1.9. Connecting project items 15
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CHAPTER
TWO

A

HOW TO SET UP SPINEOPT.JL

Install Julia (v1.2 or later) from https://julialang.org/downloads/ if you don’t have one. See latest SpineOpt.jl
Julia compatibility information here.

Start Spine Toolbox
Create a new project (File->New project...)
Select File->Settings from the main menu and open the Tools page.

Set a path to a Julia executable to the appropriate line edit (e.g. C:\Julia-1.5.4\bin\julia.exe). Your selections
should look similar to this now.

—— GAMS
— General
GAMS executable
%" Project -
Julia
/ Tools Select Julia kernel spec... w
|C:\lulia-1.5.4\bin\julia.exe Qs
= Db editor
|LI5in|;| Julia default project | |—3
}! Spec. editors (®) Run Julia tools in a subprocess () Run Juliz tools in embedded consale
AddUpdate SpineCpt
Python
Select Python kernel spec. .. Al Kernel spec editor
|t:'-.,F“,athnnB?'-._p*,athDn EHE |—3
(®) Run Python tools in a subprocess () Run Python toals in embedded console
0K Cancel
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6. [Optional] If you want to install and run SpineOpt in a specific Julia project environment (the place for
Project.toml and Manifest.toml), you can set the path to the environment folder to the line edit just below the
Julia executable (the one that says Using Julia default project).

7. Next, you need to install SpineOpt.jl package for the Julia you just selected for Spine Toolbox. You can do
this manually by following the instructions or you can install SpineOpt.jl by clicking the Add/Update SpineOpt
button. After clicking the button, an install/upgrade Spineopt wizard appears. Click Next twice and finally Install
SpineOpt. Wait until the process has finished and you are greeted with this screen.

? >

Spine0pt Installer

Installing SpineOpt

Close the wizard.
8. Click Ok to close the Settings window
9. Back in the main window, select Plugins->Install plugin... from the menu
10. Select SpineOpt and click Ok. After a short while, a red SpineOpt Plugin Toolbar appears on the main window.

Spine Toolbox and Julia are now correctly set up for running SpineOpt.jl. Next step is to Create a project workflow
using SpineOpt.jl (takes you to SpineOpt documentation). See also Tutorials for more advanced use cases. For more
information on how to select a specific Python or Julia version, see Setting up External Tools).

Note: The SpineOpt Plugin Toolbar contains two predefined Tools that make use of SpineOpt.jl. The SpineOpt
Plugin is not a requirement to run SpineOpt.jl, they are provided just for convenience and as examples to get you
started quickly.

18 Chapter 2. How to set up SpineOpt.jl
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CHAPTER
THREE

TUTORIALS

Welcome to the Spine Toolbox’s tutorials page. The following tutorials are available:

3.1 Simple System tutorial

Welcome to Spine Toolbox’s Symple System tutorial.

This tutorial provides a step-by-step guide to setup a simple energy system on Spine Toolbox and is organized as follows:

* Introduction
— Model assumptions

e Guide

Installing requirements

Installing the SpineOpt plugin

Setting up project

Entering input data
* Importing the SpineOpt database template
* Creating objects
% Establishing relationships
% Specifying object parameter values
* Specifying relationship parameter values

— Executing the workflow

— Examining the results

19
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3.1.1 Introduction

Model assumptions

Two power plants take fuel from a source node and release electricity to another node in order to supply a demand.

Power plant ‘a’ has a capacity of 100 MWh, a variable operating cost of 25 euro/fuel unit, and generates 0.7
MWh of electricity per unit of fuel.

Power plant ‘b’ has a capacity of 200 MWh, a variable operating cost of 50 euro/fuel unit, and generates 0.8
MWh of electricity per unit of fuel.

The demand at the electricity node is 150 MWh.

The fuel node is able to provide infinite energy.

Entity graph =

fuel_node

power_plant_a

power_plant_b
electricity_node

20
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3.1.2 Guide

Installing requirements

Note: This tutorial is written for latest Spine Toolbox and SpineOpt development versions.

* If you haven’t, follow the instructions here to install Spine Toolbox and SpineOpt in your system.

* If you already have Spine Toolbox and SpineOpt installed, please follow the instructions here and here to upgrade
to the latest versions.

Installing the SpineOpt plugin

1. Launch Spine Toolbox and select Plugins -> Install plugin... from the main menu. The Install plugin dialog
will pop up. Select SpineOpt from the list and press Ok.

Install plugin

Search registry...

SpineOpt

A new toolbar will appear, looking similar to this:

P P

SpineOpt ,
Run SpineOpt  Load template

3.1. Simple System tutorial 21
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Setting up project

1.

9.

Select File -> New project... from Spine Toolbox main menu. Browse to a location where you want to create
the project and create a new folder for it, called e.g. *SimpleSystem’, and then click Open.

Drag the Data Store icon from the tool bar and drop it into the Design View. This will open the Add Data Store
dialog. Type ‘input’ as the Data Store name and click OKk.

Repeat the above procedure to create a Data Store called ‘output’.
Create a database for the ‘input® Data Store:

1. Select the input Data Store item in the Design View to show the Data Store Properties (on the right side of
the window, usually).

2. In Data Store Properties, select the sqlite dialect at the top, and hit New Spine db. A dialog will pop up to
let you select a name for the database file; just accept the default name.

Repeat the above procedure to create a database for the ‘output’ Data Store.

Drag the Run SpineOpt icon from the SpineOpt tool bar into the Design View. This will open the Add Tool
dialog. Accept the default name (‘Run SpineOpt 1) and click Ok.

Note: Each item in the Design view is equipped with three connectors (the small squares at the item boundaries).

Click on one of ‘input’ connectors to start a connection, and then on one of ‘Run SpineOpt 1’ connectors to close
it.

. Repeat the procedure to create a connection from ‘Run SpineOpt 1’ to ‘output’. It should look something like
this:
Design View =
Nt output
1] Run SpineOpt 1 E'————---__:
- 2 -
__j/ :H'_ e ! — :
' | I

Setup the arguments for the Run SpineOpt Tool:

1. Select the Run SpineOpt Tool to show the Tool Properties (on the right side of the window, usually). You
should see two elements listed under Available resources, {db_url@input} and {db_url@output}.

2. Drag the first resource, {db_url@input}, and drop it in Command line arguments; then drag the second
resource, {db_url@output}, and drop it right below the previous one. The panel should be now looking
like this:

22
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Tool Properties
| Run Spine0pt 1 |

specification | / Run SpineOpt
Sysimage

Command line argurnents
Specification arguments
~ Tool arguments
0: db_url@input
1: db_url@output
Type new arg here...

+]

Available resources

0 db_url@input
& db_url@output

Woark directory ‘® Source directory

Execute in
[

3. Double-check that the order of the arguments is correct: first, {db_url@input}, and second,

{db_url@output}. (You can drag and drop to reorganize them if needed.)

10. From the main menu, select File -> Save project.

Entering input data
Importing the SpineOpt database template

1. Download the basic SpineOpt database template (right click on the link, then select Save link as...)

2. Select the ‘input’ Data Store item in the Design View.
3. Go to Data Store Properties and hit Open editor. This will open the newly created database in the Spine DB

editor, looking similar to this:

23
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Spine DB Editor (X

input & | +

S s |sq lite://{/home/manuelma/Codes/spine/toolbox/projects/case_study_a5/.spinetoolbox/items/input/in put.sqlite| |

Object tree B Object parameter value E® Tool/Feature tree @&
name database object_class_name object_name parameter_name alternative_name value  database name
& root input No... input - & input
- % feature
Enter new feature he|
- A tool

Type new tool name |

4 »
Parameter value list @
~ o input

B Type new list name K

Object parameter value | Object parameter definition

Relationship tree @ Relationship parameter value @&
name database relationship_class_name object_name_list parameter_name alternative_name value (| L4
< root input No... inpu| Alternative/Scenario tree B
name =
T & input
- -'F alternative
Base

Type new alternatiy
- B scenario

] b

Parameter tag B@®
tag =
! v & input
Relationship parameter value ~ Relationship parameter definition y B Toimn et b b

Note: The Spine DB editor is a dedicated interface within Spine Toolbox for visualizing and managing Spine
databases.

4. Press Alt + F to display the main menu, select File -> Import..., and then select the template file you previously
downloaded. The contents of that file will be imported into the current database, and you should then see classes
like ‘commodity’, ‘connection’ and ‘model’ under the root node in the Object tree (on the left).

5. From the main menu, select Session -> Commit. Enter ‘Import SpineOpt template’ as message in the popup
dialog, and click Commit.

Note: The SpineOpt basic template contains (i) the fundamental entity classes and parameter definitions that SpineOpt
recognizes and expects; and (ii) some predefined entities for a common deterministic model with a ‘flat” temporal
structure.
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Creating objects

1. Always in the Spine DB editor, locate the Object tree (typically at the top-left). Expand the root element if not
expanded.

2. Right click on the node class, and select Add objects from the context menu. The Add objects dialog will pop
up.

3. Enter the names for the system nodes as seen in the image below, then press Ok. This will create two objects of
class node, called fuel_node and electricity_node.

Add objects X

object_class name  object name description databases
1 node fuel_node input
2 node input
3/ node input

& Remove selected rows

=0 B

4. Right click on the unit class, and select Add objects from the context menu. The Add objects dialog will pop up.

5. Enter the names for the system units as seen in the image below, then press Ok. This will create two objects of
class unit, called power_plant_a and power_plant_b.
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Add objects X

object_class name  object name description databases
1 unit power_plant_a input
2/ unit input
3 unit input

& Remove selected rows

Crganee | ok

Note: In SpineOpt, nodes are points where an energy balance takes place, whereas units are energy conversion devices
that can take energy from nodes, and release energy to nodes.

1. Right click on the output class, and select Add objects from the context menu. The Add objects dialog will pop
up.

2. Enter unit_flow under object name as in the image below, then press Ok. This will create one object of class unit,
called unit_flow.

Add objects x

object_class name  object name description databases
1 output unit_flow input
2| output input

& Remove selected rows

Crganee | ok

Note: In SpineOpt, outputs represent optimization variables that can be written to the output database as part of a
report.

Note: To modify an object after you enter it, right click on it and select Edit... from the context menu.
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Establishing relationships

1. Always in the Spine DB editor, locate the Relationship tree (typically at the bottom-left). Expand the root element
if not expanded.

2. Right click on the unit__from_node class, and select Add relationships from the context menu. The Add rela-
tionships dialog will pop up.

3. Select the names of the two units and their sending nodes, as seen in the image below; then press Ok. This will
establish that both power_plant_a and power_plant_b take energy from the fuel_node.

Add relationships X

Relationship class | unit__from_node (unit,node) >

unit node relationship name databases
1 power_plant_a fuel_node unit__from_node_power_plant_a__fuel_node input
2 power_plant_b unit__from_node_power_plant_b__fuel_nade input
3 input

& Remove selected rows

g | or

4. Right click on the unit__to_node class, and select Add relationships from the context menu. The Add relation-
ships dialog will pop up.

5. Select the names of the two units and their receiving nodes, as seen in the image below; then press Ok. This will
establish that both power_plant_a and power_plant_b release energy into the electricity_node.

Add relationships X

Relationship class | unit__to_node (unit,node) >

unit node relationship name databases
1 power_plant_a electricity_node unit__to_node_power_plant_a__electricity_node input

2 power_plant_b unit__to_node_power_plant_b__electricity_node input
3 input

& Remove selected rows

Cocment | or

6. Right click on the report__output class, and select Add relationships from the context menu. The Add relation-
ships dialog will pop up.

7. Enter reportl under report, and unit_flow under output, as seen in the image below; then press Ok. This will tell
SpineOpt to write the value of the unit_flow optimization variable to the output database, as part of reportl.
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Add relationships X

Relationship class | report__output (report,output)

report output relationship name databases
1|reportl report__outp-ut_reportl__unit_fLow input
2 input

& Remove selected rows

Cocmen | or

Specifying object parameter values

1. Back to Object tree, expand the node class and select electricity_node.

2. Locate the Object parameter table (typically at the top-center).

3. Inthe Object parameter table (typically at the top-center), select the demand parameter and the Base alternative,
and enter the value /00 as seen in the image below. This will establish that there’s a demand of ‘100 at the

electricity node.

B

Object parameter value

object_class_name object_name parameter_name alternative_name value database
&5 node electricity_node demand Base m input

node electricity_node input

4. Select fuel_node in the Object tree.

5. In the Object parameter table, select the balance_type parameter and the Base alternative, and enter the value
balance_type_none as seen in the image below. This will establish that the fuel node is not balanced, and thus

provide as much fuel as needed.

@&

Object parameter value
object_class_name object_name parameter_name alternative_name value database

&5 node fuel_node  balance_type Base balance_type_none [l

node fuel_node input
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Specifying relationship parameter values

1. In Relationship tree, expand the unit__from_node class and select power_plant_a | fuel_node.

2. In the Relationship parameter table (typically at the bottom-center), select the vom_cost parameter and the Base
alternative, and enter the value 25 as seen in the image below. This will set the operating cost for power_plant_a.

Relationship parameter value B
relationship_class_name object_name_list parameter_name alternative_name value database

* unit__from_node power_plant_a | fuel_node vom_cost Base 25.0 i
unit__from_node power_plant_a,fuel_node input

3. Select power_plant_b | fuel_node in the Relationship tree.

4. In the Relationship parameter table, select the vom_cost parameter and the Base alternative, and enter the value
50 as seen in the image below. This will set the operating cost for power_plant_b.

Relationship parameter value (]ES]
relationship_class_name object_name_list parameter_name alternative_name value database
&* unit__from_node power_plant_b | fuel_node vom_cost Base m input
unit__from_node power_plant_b,fuel_node input

5. In Relationship tree, expand the unit__to_node class and select power_plant_a | electricity_node.

6. In the Relationship parameter table, select the unit_capacity parameter and the Base alternative, and enter the
value /00 as seen in the image below. This will set the capacity for power_plant_a.

Relationship parameter value [=]E3]
relationship_class_name object_name_list parameter_name alternative_name value database
¥* unit__to_node power_plant_a | electricity_node unit_capacity Base minput
unit__to_node power_plant_a,electricity_node input

7. Select power_plant_b | electricity_node in the Relationship tree.

8. In the Relationship parameter table, select the unit_capacity parameter and the Base alternative, and enter the
value 200 as seen in the image below. This will set the capacity for power_plant_b.

Relationship parameter value =]ES)
relationship_class_name object_name_list parameter_name alternative_name value database
* unit__to_node power_plant_b | electricity_node unit_capacity Base m input
unit__to_node power_plant_b,electricity_node input

9. In Relationship tree, select the unit__node__node class, and come back to the Relationship parameter table.

10. In the Relationship parameter table, select power_plant_a | electricity_node | fuel_node under object name
list, fix_ratio_out_in_unit_flow under parameter name, Base under alternative name, and enter 0.7 under value.
Repeat the operation for power_plant_b, but this time enter 0.8 under value. This will set the conversion ratio
from fuel to electricity for power_plant_a and power_plant_b to 0.7 and 0.8, respectively. It should like the
image below.
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Relationship parameter value @&
relationship_class_name object_name_list parameter_name alternative_name value database
&% unit__node__node  power_plant_a | electricity_node | fuel_node fix_ratio_out_in_unit_flow Base 0.7 input

¥% unit__node__node  power_plant_b | electricity_node | fuel_node fix_ratio_out_in_unit_flow Base 0.8 input
unit__node__node input

When you’re ready, commit all changes to the database.

Executing the workflow

1. Go back to Spine Toolbox’s main window, and hit the Execute project button from the tool bar.
You should see ‘Executing All Directed Acyclic Graphs’ printed in the Event log (at the bottom left by default).

2. Select the ‘Run SpineOpt 1’ Tool. You should see the output from SpineOpt in the Julia Console.

Examining the results

1. Select the output data store and open the Spine DB editor.
2. Press Alt + F to display the main menu, and select Pivot -> Index.

3. Select report__unit__node__direction__stochastic_scenario under Relationship tree, and the first cell under
alternative in the Frozen table.

4. The Pivot table will be populated with results from the SpineOpt run. It will look something like the image

below.
Pivot table @

(%)
parameter * |unit_flow

report * | unit * | node * | direction * | stochastic_scenario * |index =

reportl power_plant_a electricity_node to_node realization 2000-01-01T00:00:00 100.0

reportl power_plant_a fuel_node from_node realization 2000-01-01T00:00:00 142.857142..

reportl power_plant_b electricity_node to_node realization 2000-01-01T00:00:00 50.0

reportl power_plant_b fuel_node from_node realization 2000-01-01T00:00:00 62.5

3.2 Spine Tutorial - Simple Hydro Power Planning

Welcome to this Spine Toolbox tutorial of a simple hydro power planning problem. The tutorial models one day of
operation of two hydrodologically-coupled hydro power power plants.

* Introduction
— Model assumptions
— Modelling choices

e Guide

— Installing requirements
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Creating a new project

% Configuring SpineOpt

Setting up a project

Importing the model

Executing the workflow

% Importing raw data with the importer
* Importing the SpineOpt database template

* Execute the model

Examining the results

3.2.1 Introduction

Model assumptions

For each hydro power plant, the following information is known.

The capacity, or the maximal electricity output.
The maximal amount of water the reservoirs can store.
The content of the reservoir at the beginning of the simulation period.

The minimal amount of spilled water required. Spilled water does not produce any electricity as it it does not go
through the turbine; it helps the fish to pass the hydro power plant.

The minimal amount of total water flow, spilled + discharged required.
The water delay time between power plants is neglected.

The local inflow, or amount of water that naturally enters the reservoir at every hour. In this study, it is assumed
constant over the entire simulation period.

The system is operated so as to maximize total profit over the day. In this simple exercise, the value of stored water
(contained in the reservoirs at the end of the planning period) is not taken into account. Capacity constraints, maximal
reservoir level constrains, and so on are limits the system.

Modelling choices

Modelling the electric system is simple, a common electricity node receives the power produced by the power plants.
One electricity load unit then takes electricity from that node.

The river system is, however, more detailed. Each hydro power plant is modelled using the following elements:

An upper water node, located at the entrance of the plant.
A lower water node, located at the exit of the plant.
A flow node where discharged and spilled water is released into.

A power plant unit, that discharges water from the upper node into the lower node, and feeds electricity produced
in the process to the common electricity node.

A spillway unit, that takes spilled water from the upper node and releases it to the flow node.

A discharge unit, that takes water from the lower node and releases it to the flow node.

3.2. Spine Tutorial - Simple Hydro Power Planning 31



Spine Toolbox Documentation, Release 0.6.6.dev0-dev.0

Below is a schematic of the model. For clarity, the schematic only presents one power station:
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3.2.2 Guide

Installing requirements

Note: This tutorial is written for latest Spine Toolbox and SpineOpt master versions.

Follow the instructions here to install Spine Toolbox and SpineOpt in your system.
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Creating a new project

Each Spine Toolbox project resides in its own directory, where the user can store data, programming scripts and other
necessary material. The Toolbox application also creates its own special subdirectory .spinetoolbox, for project settings,
etc.

To create a new project, select File -> New project... from Spine Toolbox main menu. Browse to a location where
you want to create the project and create a new folder for it, e.g., “Two_hydro’, and then click Select Folder.

Configuring SpineOpt

1. To use SpineOpt in your project, you need to create a Tool specification for it. Click on the small arrow next to
the Tool icon (in the Main section of the tool bar), and press New... The Tool specification editor will popup:

Tool specification editor (]

<unnamed specification> & | 4+

Name: |Enter specification name here... | Description: |Enter specification description here. =

Tool type j Command line arguments: |Type arguments here... v| Execute in work directory

Program files @® @&
Main program file OK

Additional program files OEm@d

Input & output files @
Input files ]
Optional input files o
Output files 5]

Main program dir: |

2. Type ‘SpineOpt’ as the name of the specification and select ‘Julia’ as the tool type. Deselect Execute in work
directory.

3. Press next to Main program file to create a new Julia file. Enter a file name, e.g. ‘run_spineopt.jl’, and click
Save.

4. Back in the Tool specification editor, select the file you just created under Main program file. Then, enter the
following text in the text editor to the right:

using SpineOpt

run_spineopt (ARGS...)

At this point, the form should be looking like this:
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Tool specification editor (X

SpineOpt* ¥ | +

Name: |SpineOpt Description: |Enter specification description here... =
Tool type | Julia ~ || Command line arguments: | Type arguments here... Execute in work directory
Program files @& run_spineopt.jl @
= Main program file D& using SpineOpt

& run_spineopt.jl run_spineopt(ARGS. ..)

Additional program files OEm@d

Input & output files @®
Input files 5 ]
Optional input files S}
OQutput files % ]

| Main program dir: /home/manuelma/Codes/spine/toolbox/projects/spine-cs-a5

5. Press Ctrl+S to save everything, then close the Tool specification editor.

Setting up a project

. Drag the Data Store icon from the tool bar and drop it into the Design View. This will open the Add Data Store

dialogue. Type ‘input’ as the Data Store name and click Ok.

. Repeat the above procedure to create a Data Store called ‘output’.
. Create a database for the ‘input’ Data Store:

. Select the input Data Store item in the Design View to show the Data Store Properties (on the right side of the

window, usually).

. In Data Store Properties, select the sqlite dialect at the top, and click New Spine db.
. Repeat the above procedure to create a database for the ‘output’ Data Store.

. Click on the small arrow next to the Tool icon and drag the ‘SpineOpt’ item from the drop-down menu into the

Design View. This will open the Add Tool dialogue. Type ‘SpineOpt’ as the Tool name and click OKk.

Note: Eachitem in the Design view is equipped with three connectors (the small squares at the item boundaries).

. Drag the Data Connection icon from the tool bar and drop it into the Design View. This will open the Add Data

connection dialogue. Type in ‘Data Connection’ and click on Ok.

. To import the model of the planning problem into the Spine database, you need to create an Import specification.

Create an Import specification by clicking on the small arrow next to the Importer item (in the Main section of
the toolbar) and press New. The Importer specification editor will pop-up:
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5. Type ‘Import Model’ as the name of the specification. Save the specification by using Ctrl+S and close the
window.

6. Drag the newly created Import Model Importer item icon from the tool bar and drop it into the Design View.
This will open the Add Importer dialogue. Type in ‘Import Model’ and click on Ok.

7. Connect ‘Data Connection’ with ‘Import Model’ by first clicking on one of the Data Connection’s connectors
and then on one of the Importer’s connectors.

8. Repeat the procedure to create a path from ‘Data Connection’ to ‘output’. Now the project should look similar
to this as shown below:

Data Connection
E Import Model
-{’:l T~ lﬂ h| SpineOpt

Y
2

9. Setup the arguments for the SpineOpt Tool:

1. Select the SpineOpt Tool to show the Tool Properties (on the right side of the window, usually). You should see
two elements listed below Available resources, {db_url@input} and {db_url@output}.

2. Drag the first resource, {db_url@input}, and drop it in Command line arguments, just as shown in the image
below.
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Tool Properties & 3
SpineOpt

Specification | / SpineOpt - ||

Command line arguments

Specification arguments

|
—

Available resources

Execute in ' Work directory '® Source directory =

3. Drag the second resource, {db_url@output}, and drop it right below the previous one. The panel should be
now looking like this:
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Tool Properties (&
| SpineCpt |

Specification | /* SpineOpt * | #

Command line argurments

Specification arguments
= Tool arguments
0: {db_url@input}
1: {db_url@output}
Type new arg here...

4]
—
Available resources

{7 {db_url@input}

& {db_url@output}

Executein ' ' Work directory '® Source directory &=

4. Double-check that the order of the arguments is correct: first, {db_url@input}, and second,
{db_url@output}. (You can drag and drop to reorganize them if needed.)

1. From the main menu, select File -> Save project.

Importing the model

1. Download the SpineOpt database template , the data and the accompanying mapping (right click on the links,
then select Save link as...).

2. Add a reference to the file containing the model.

1. Select the Data Connection item in the Design View to show the Data Connection properties window (on the
right side of the window usually).

2. In Data Connection Properties, click on the plus icon and select the previously downloaded Excel file.
3. Next, double click on the Import model in the Design view. A window called Select connector for Import Model

will pop-up, select Excel and klick OK. Next, still in the Importer specification editor, click the alternatives icon
in the top right and import the mappings previously downloaded. Finally, save by clicking Ctrl+S and exit the

Importer specification editor.
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Executing the workflow

Importing raw data with the importer

Once the workflow is defined and source file is in place, the project is ready to import the data to the input database.
While holding Ctrl, select Data Connection, Import Model, and input. Directly click the Execute selection button on
the tool bar.

You should see ‘Executing Selected Directed Acyclic Graphs’ printed in the Event log (on the lower left by default).
SpineOpt output messages will appear in the Process Log panel in the middle. After some processing, ‘DAG 1/1
completed successfully’ appears and the execution is complete.

Importing the SpineOpt database template

Select the input Data Store item in the Design View. Go to Data Store Properties and click on Open editor.
This will open the newly created database in the Spine DB editor, looking similar to this:

& Spine DB Editor - X
input +
& 3> 2 S [sqreiicusersierik fobb it =
Object tree & X Object parameter value 8 X Tool/Feature tree 8 x
name database object_class_name object_name parameter_name alternative_name value database * | name description
v & root input & model instance duration_unit Base hour input v & input
© commodity input © model instance model_end Base 2021-01-02T00:0000 input v W feature
Enter new feature here.
© model input © model instance model start Base 2021-01-01T000000 input v
© node input v ™ tool
D node Fallet_upper demand Base -20 input N
© output input be new tool name here
© report input © node Fallet_upper fix node_state Base Time sefies input
© stochastic_scenario input ® node Fallet_upper has_state Base True input
@ stochastic_structure input @ node Fallet_upper node_state_cap Base 39000 input
@ temporal block  input ® node Fallet_upper state_coeff Base 1.0 input < >
© unit input & node Spranget_upper demand Base 1120 input Parameter value list 8 x
& node Spranget_upper fix_node_state Base Time series input v & input
B Type new list name here.
& node Spranget_upper has_state Base True input
& node Spranget_upper node_state_cap Base 36000 input
& node Spranget_upper state_coeff Base 1.0 input
& temporal_block some_day resolution Base 1h input
82 unit Fallet spill fix_units on Rase True input. h
Relationship tree 5 x| Oblect parameter value  Object parameter defintion
name Relationship parameter value 8 x
v & root it | relationship_class_name object_name_list parameter_name alternative_name  value database ~
" Alternative/Scenario tree & x
& model_default_stochastic_structure it | unit_from_node Fallet_pwr_plant | Fallet_upper unit_capacity Base 1156 input
name descriptior
& model_default temporal block i\ ® unit_fromnode  Fallet_spill | Fallet_upper minimum_operating_point Base 0001 input
& model_report i » 10000 v & input
& node_commodity i unit_from_node Fallet_spill | Fallet_upper unit_capacity Base input v l= alternative
& report_output it | unit_from_node Fallet_to_downstream_flow | Fallet_flow  minimum_operating_point Base 007 input Base
& stochastic_structure_stochastic_scenario if | unit_from_node Fallet_to_downstream_flow | Fallet flow  unit_capacity Base 1000.0 jnput Type new alternative name here
& unit_from node & unit_from node  Spranget_pwr_plant | Spranget_upper unit_capacity Base 712 input v H scenario
& unit_node_node i " . R 0001 e new scenario name hel
& unit_to_node /@ unit_from node  Spranget_spill | Sprénget upper minimum_operating_point Base input
&® unit_from_node Spranget_spill | Sprénget_upper unit_capacity Base 10000 jnput
s L < >
& unit_from_node Spranget_to_Fallet_flow | Spranget flow  minimum_operating_point Base 001 input
., x
& unit_fromnode  Sprénget_to_Fallet_flow | Spranget_flow  unit_capacity Base 10000 input B )
& unit_from_node electricity_load | electricity_node vom_cost Base Time ser.. input tag description
v & input
&> unit_node_node Fallet_disch | Fallet_flow | Fallet_lower fix_ratio_out_in_unit_flow Base 10 input v ’ e new a0 here
< > | Relationship parameter value Relationship parameter definition

Note: The Spine DB editor is a dedicated interface within Spine Toolbox for visualizing and managing Spine
databases.

. Press Alt + F to display the main menu, select File -> Import..., and then select the template file you previously

downloaded. (Tip: Make sure you search for a folder with .json ending.) The contents of that file will be imported
into the current database, and you should then see classes like ‘commodity’, ‘connection’ and ‘model’ under the
root node in the Object tree (on the left) with colourful icons.

. From the menu in the top right corner, select Session -> Commit. Enter ‘Import SpineOpt template’ as message

in the popup dialogue and click Commit. Exit the Spine DB editor.
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Note: The SpineOpt template contains the fundamental object and relationship classes, as well as parameter
definitions, that SpineOpt recognizes and expects. You can think of it as the generic structure of the model, as
opposed to the specific data for a particular instance.

Execute the model

Finally, the project is ready to be executed. Hold Ctrl, select SpineOpt and output. Directly, click on Execute selection

Examining the results

Select the output data store and open the Spine DB editor. To checkout the flow on the electricity load (i.e., the total
electricity production in the system), go to Object tree, expand the unit object class, and select electricity_load. Next,
go to Relationship parameter value and double-click the first cell under value. The Parameter value editor will pop up.
You should see something like this:

[ ] [ ] Edit value -- my_report | electricity_load | electricity_node | from_node | realization - unit_flow --

Parameter type | Time series variable resclution j

Ignore year Repeat ; , :
t Value ﬁé*‘*’QEu »

1 2021-01-01T.. 1868

2 2021-01-01T... 1868 195.0 A
3 2021-01-01T.. 186,8 192.5 1
4 2021-01-01T.. 1868 190.0 7
5 2021-01-01T.. 1868 187:5 1

185.0 4
6 2021-01-01T.. 1868

1825
7 2021-01-01T.. 1868

180.0
8 2021-01-01T.. 1868

177.5 4

-] A% 2
> 3,031 P
o

9 =-01- T T T T T T
2021-01-01 186,8 K R
o ¥ o D o ¥ o B o o o
1 1 Ty oY

10 2021-01-01T.. 1868 o [\t [\t oY oV

11 AR A1 AaT ELT-X-}
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3.3 Case Study A5 tutorial

Welcome to this Spine Toolbox Case Study tutorial. Case Study AS5 is one of the Spine Project case studies designed
to verify Toolbox and Model capabilities. To this end, it reproduces an already existing study about hydropower on the
Skellefte river, which models one week of operation of the fifteen power stations along the river.

This tutorial provides a step-by-step guide to run Case Study AS on Spine Toolbox and is organized as follows:

Introduction
— Model assumptions
— Modelling choices
Installing requirements
Creating a new project
— Configuring SpineOpt
— Setting up a project
— Importing the SpineOpt database template
Entering data
— Entering data manually
* Creating objects
% Specifying object parameter values
% Establishing relationships
* Specifying parameter values of the relationships
— Using the Importer
* Additional Steps for Project Setup
* Importing the model

Executing the workflow

* Examining the results

3.3.1 Introduction

Model assumptions

For each power station in the river, the following information is known:

The capacity, or maximal electricity output. This datum also provides the maximal water discharge as per the
efficiency curve (see next point).

The efficiency curve, or conversion rate from water to electricity. In this study, a piece-wise linear efficiency
with two segments is assumed. Moreover, this curve is monotonically decreasing, i.e., the efficiency in the first
segment is strictly greater than the efficiency in the second segment.

The maximal reservoir level (maximal amount of water that can be stored in the reservoir).

The reservoir level at the beginning of the simulation period and at the end.
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* The minimal amount of water that the plant must discharge at every hour. This is usually zero (except for one of

the plants).

* The minimal amount of water that needs to be spilled at every hour. Spilled water does not go through the turbine
and thus is not used for producing electricity; it just helps keeping the reservoir level at bay.

* The downstream plant, or next plant in the river course.

* The time that it takes for the water to reach the downstream plant. This time can be different depending on
whether the water is discharged (goes through the turbine) or spilled.

* The local inflow, or amount of water that naturally enters the reservoir at every hour. In this study, it is assumed

constant over the entire simulation period.

* The hourly average water discharge. It is assumed that before the beginning of the simulation, this amount of
water has constantly been discharged at every hour.

The system is operated so as to maximize the total profit over the planning week, while respecting capacity constraints,
maximal reservoir level constrains, etc. Hourly profit per plant is simply computed as the product of the electricity

price and the production.

Modelling choices

The model of the electric system is fairly simple, only two elements are needed:

* A common electricity node.

* A load unit that takes electricity from that node.

On the contrary, the model of the river system is more detailed. Each power station in the river is modelled using the

following elements:

* An upper water node, located at the entrance of the station.

¢ A lower water node, located at the exit of the station.

* A power plant unit, that discharges water from the upper node into the lower node, and feeds electricity produced

in the process to the common electricity node.

* A spillway connection, that takes spilled water from the upper node and releases it to the downstream upper node.

* A discharge connection, that takes water from the lower node and releases it to the downstream upper node.

Below is a schematic of the model. For clarity, only the Rebnis station is presented in full detail:

‘ g‘
Rehnis_upper'hagE

Rebnis_to_Bergnas_spill

S

Rebnis_pwr_plant

Bergnas_upper
L)HH
o

Rebnis_lower
Rebnis_to_Bergnas_disch

-1
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3.3.2 Installing requirements

Note: This tutorial is written for latest Spine Toolbox and SpineOpt master versions.

Follow the instructions here to install Spine Toolbox and SpineOpt in your system.

3.3.3 Creating a new project

Each Spine Toolbox project resides in its own directory, where the user can store data, programming scripts and other
necessary material. The Toolbox application also creates its own special subdirectory .spinetoolbox, for project settings,
etc.

To create a new project, select File -> New project... from Spine Toolbox main menu. Browse to a location where
you want to create the project and create a new folder for it, e.g. ‘cs_a5_importer’, and then click Select Folder.

Configuring SpineOpt

1. To use SpineOpt in your project, you need to create a Tool specification for it. Click on the small arrow next to
the Tool icon (in the Main section of the tool bar), and press New... The Tool specification editor will popup:

Tool specification editor (X

<unnamed specification> & | +

Name: |Enter specification name here... | Description: |Enter specification description here. =
Tool type j Command line arguments: | Type arguments here... v| Execute in work directory
Program files 23] B

Main program file O &
Additional program files ODEWm@

Input & output files @®
Input files 5 ]
Optional input files S}
OQutput files 5 ]

Main program dir: |

2. Type ‘SpineOpt’ as the name of the specification and select ‘Julia’ as the tool type. Deselect Execute in work
directory.

3. Press next to Main program file to create a new Julia file. Enter a file name, e.g. ‘run_spineopt.jI’, and click
Save.
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4.

Back in the Tool specification editor, select the file you just created under Main program file. Then, enter the
following text in the text editor to the right:

using SpineOpt

run_spineopt (ARGS...)

At this point, the form should be looking like this:

Tool specification editor (]

SpineOpt* ¥ | +

Name: |SpineOpt Description: |Enter specification description here.
Tool type | Julia = || Command line arguments: | Type arguments here... Execute in work directory
Program files @& run_spinecpt.jl B

~ Main program file Ok using SpineOpt

& run_spineopt.jl run_spineopt (ARGS. . )
Additional program files ODEWm@

Input & output files 23]
Input files 0o
Optional input files nm
OQutput files 5 ]

| Main program dir: /home/manuelma/Codes/spine/toolbox/projects/spine-cs-a5

5. Press Ctrl+S to save everything, then close the Tool specification editor.

Setting up a project

Drag the Data Store icon from the tool bar and drop it into the Design View. This will open the Add Data Store
dialogue. Type ‘input’ as the Data Store name and click Ok.

2. Repeat the above procedure to create a Data Store called ‘output’.
3. Create a database for the ‘input‘ Data Store:
1. Select the input Data Store item in the Design View to show the Data Store Properties (on the right side of
the window, usually).
2. In Data Store Properties, select the sqlite dialect at the top, and hit New Spine db.
4. Repeat the above procedure to create a database for the ‘output’ Data Store.
5. Drag the ‘SpineOpt’ item from the tool bar into the Design View. This will open the Add Tool dialogue. Type
‘SpineOpt’ as the Tool name and click Ok.
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Note: Each item in the Design view is equipped with three connectors (the small squares at the item boundaries).

6. Click on one of ‘input’ connectors and then on one of ‘SpineOpt’ connectors. This will create a connection from
the former to the latter.

7. Repeat the procedure to create a connection from SpineOpt to output. It should look something like this:

SpineQpt

' ¢
Input

- . output
1] - T | /‘ = | 3]

8. Setup the arguments for the SpineOpt Tool:

1. Select the SpineOpt Tool to show the Tool Properties (on the right side of the window, usually). You should
see two elements listed under Available resources, {db_url@input} and {db_url@output}.

2. Drag the first resource, {db_url@input}, and drop it in Command line arguments, just as shown in the
image below.
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Tool Properties (& )
SpineOpt

Specification | ™ SpineOpt - ||

Command line arguments

Specification arguments

3
—

Available resources

Execute in Work directory '® Source directory =

3. Drag the second resource, {db_url@output}, and drop it right below the previous one. The panel should
be now looking like this:
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Tool Properties
| SpineCpt |

Specification | / SpineOpt v ||

Comrmand line arguments
Specification arguments
= Tool arguments
0: {db_url@input}
1: {db_url@output}
Type new arg here...

E

Available resources

{7 {db_url@input}
& {db_url@output}

Execute in ' ' Work directory '® Source directory =

4. Double-check that the order of the arguments is correct: first, {db_url@input}, and second,

{db_url@output}. (You can drag and drop to reorganize them if needed.)

9. From the main menu, select File -> Save project.

Importing the SpineOpt database template

1. Download the SpineOpt database template (right click on the link, then select Save link as. ..)

2. Select the input Data Store item in the Design View.
3. Go to Data Store Properties and hit Open editor. This will open the newly created database in the Spine DB

Editor, looking similar to this:
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Spine DB Editor (X

input & | +
S s |sqHte:jm'homefmanuelma,fCUdesjspine,ltoolboxfproje(tsjcase_study_a5}.spinetoolbox{items}’input,finput.sqlite| | =
Object tree B Object parameter value E® Tool/Feature tree @&
name database object_class_name object_name parameter_name alternative_name value  database name
& root input No... input - & input
- W feature
Enter new feature he|
- A tool
Type new tool name |
4 »
Parameter value list @
~ o input
B Type new list name K
Object parameter value | Object parameter definition
Relationship tree @ Relationship parameter value @&
name database relationship_class_name object_name_list parameter_name alternative_name value (| L4
< root input No... inpu| Alternative/Scenario tree B
name =
T & input
- -'F alternative

Base
Type new alternatiy
~ B scenario

] b

Parameter tag B@®
tag =
! v & input
Relationship parameter value ~ Relationship parameter definition y B Toimn et b b

Note: The Spine DB editor is a dedicated interface within Spine Toolbox for visualizing and managing Spine
databases.

4. Press Alt + F to display the editor menu, select File -> Import..., and then select the template file you previously
downloaded (in case it is not displayed in the folder where you saved it, doublecheck that you selected . The
contents of that file will be imported into the current database, and you should then see classes like ‘commodity’,
‘connection’ and ‘model” under the root node in the Object tree (on the left).

5. From the editor menu (Alt + F), select Session -> Commit. Enter ‘Import SpineOpt template’ as message in the
popup dialog, and click Commit.

Note: The SpineOpt template contains the fundamental object and relationship classes, as well as parameter defini-
tions, that SpineOpt recognizes and expects. You can think of it as the generic structure of the model, as opposed to the
specific data for a particular instance. In the remainder of this section, we will add that specific data for the Skellefte
river.
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3.3.4 Entering data

There are two options in this tutorial to enter data in the Database. The first one is to enter data manually and the second
to use the importer functionality. These are described in the next two subsections respectively.

Entering data manually

Creating objects

1. To add power plants to the model, stay in the Spine DB Editor and create objects of class unit as follows:

a.

Select the list of plant names from the text-box below and copy it to the clipboard (Ctrl+C):

Rebnis_pwr_plant
Sadva_pwr_plant
Bergndas_pwr_plant
Slagnds_pwr_plant
Bastusel_pwr_plant
Grytfors_pwr_plant
Gallejaur_pwr_plant
Vargfors_pwr_plant
Rengard_pwr_plant
Batfors_pwr_plant
Finnfors_pwr_plant
Granfors_pwr_plant
Krangfors_pwr_plant
Selsfors_pwr_plant
Kvistforsen_pwr_plant

. Go to Object tree (on the top left of the window, usually), right-click on unit and select Add objects from

the context menu. This will open the Add objects dialog.

. Select the first cell under the object name column and press Ctrl+V. This will paste the list of plant names

from the clipboard into that column; the object class name column will be filled automatically with ‘unit°.
The form should now be looking similar to this:
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Add objects X

object_class name
unit
unit
unit
unit
unit
unit
unit
unit

Wioo |~ o || W k(=

unit

[y
o

unit

=
[

unit

[y
Pt

unit

[y
w

unit

,_,
-

unit

[y
un

unit

[y
[4]]

unit

object name
Sadva_pwr_plant
Bergnas_pwr_plant
Slagnds_pwr_plant
Bastusel_pwr_plant
Grytfors_pwr_plant
Gallejaur_pwr_plant
Vargfors_pwr_plant
Rengard_pwr_plant
Batfors_pwr_plant
Finnfors_pwr_plant
Granfors_pwr_plant
Krangfors_pwr_plant
Selsfors_pwr_plant

Kvistforsen_pwr_plant

& Remove selected rows

d. Click Ok.

description

input
input
input
input
input
input
input
input
input
input
input
input
input
input
input
input

databases

(v g | ok

e. Back in the Spine DB Editor, under Object tree, double click on unit to confirm that the objects are

effectively there.

f. Commit changes with the message ‘Add power plants’.

2. Add discharge and spillway connections by creating objects of class connection with the following names:

Rebnis_to_Bergnds_disch
Sadva_to_Bergnads_disch
Bergnds_to_Slagnds_disch
Slagnds_to_Bastusel_disch
Bastusel_to_Grytfors_disch
Grytfors_to_Gallejaur_disch
Gallejaur_to_Vargfors_disch
Vargfors_to_Rengard_disch
Rengard_to_Batfors_disch
Batfors_to_Finnfors_disch

(continues on next page)
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(continued from previous page)

Finnfors_to_Granfors_disch
Granfors_to_Krangfors_disch
Krangfors_to_Selsfors_disch
Selsfors_to_Kvistforsen_disch
Kvistforsen_to_downstream_ disch
Rebnis_to_Bergnds_spill
Sadva_to_Bergnds_spill
Bergnds_to_Slagnds_spill
Slagnds_to_Bastusel_spill
Bastusel_to_Grytfors_spill
Grytfors_to_Gallejaur_spill
Gallejaur_to_Vargfors_spill
Vargfors_to_Rengdrd_spill
Rengard_to_Batfors_spill
Batfors_to_Finnfors_spill
Finnfors_to_Granfors_spill
Granfors_to_Krangfors_spill
Krangfors_to_Selsfors_spill
Selsfors_to_Kvistforsen_spill
Kvistforsen_to_downstream_spill

. Add water nodes by creating objects of class node with the following names:

Rebnis_upper
Sadva_upper
Bergnds_upper
Slagnds_upper
Bastusel_upper
Grytfors_upper
Gallejaur_upper
Vargfors_upper
Rengard_upper
Batfors_upper
Finnfors_upper
Granfors_upper
Krangfors_upper
Selsfors_upper
Kvistforsen_upper
Rebnis_lower
Sadva_lower
Bergnds_lower
Slagnds_lower
Bastusel_lower
Grytfors_lower
Gallejaur_lower
Vargfors_lower
Rengard_lower
Batfors_lower
Finnfors_lower
Granfors_lower
Krangfors_lower
Selsfors_lower

(continues on next page)
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(continued from previous page)

Kvistforsen_lower

4. Next, create the following objects (all names in lower-case):
a. instance of class model.
b. water and electricity of class commodity.
c. electricity_node of class node.
d. electricity_load of class unit.
e. some_week of class temporal_block.
f. deterministic of class stochastic_structure.
g. realization of class stochastic_scenario.
5. Finally, create the following objects to get results back from Spine Opt (again, all names in lower-case):
a. my_report of class report.

b. unit_flow, connection_flow, and node_state of class output.

Note: To modify an object after you enter it, right click on it and select Edit... from the context menu.

Specifying object parameter values

1. To specify the general behaviour of our model, stay in the Spine DB Editor and enter model parameter values as
follows:

a. Select the model parameter value data from the text-box below and copy it to the clipboard (Ctrl+C):

model instance duration_unit Base "hour"

model instance model_end Base {"type": "date_time",
—"data": "2019-01-08T00:00:00"}

model instance model_start Base {"type": "date_time
<", "data": "2019-01-01T00:00:00"}

b. Select instance in the Object tree and inspect the table in Object parameter value (on the top-center of the
window, usually). Make sure that the columns in the table are ordered as follows (drag and drop columns
if you need to change their order):

object_class_name | object_name | parameter_name | alternative_name | value |.
-.database

c. Select the first cell under object_class_name and press Ctrl+V. This will paste the model parameter
value data from the clipboard into the table. The form should be looking like this:
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Object parameter value

object_class_name object_name parameter_name alternative_name

a model instance duration_unit Base hour
(<] model instance model_end Base

(<] model instance model_start Base

model instance

value databasze

input
2019-01-08 00:00:00 input
2019-01-01 00:00:00 input

Mone input

2. Specify the resolution of our temporal block some_week in the same way using the data below:

temporal_block some_week resolution Base
—"duration", "data": "1h"}

{utypeu:

3. Specify the behaviour of all system nodes with the data below, where:

a. demand represents the local inflow (negative in most cases).

b. fix_node_state represents fixed reservoir levels (at the beginning and the end).

c. has_state indicates whether or not the node is a reservoir (true for all the upper nodes).

d. state_coeff is the reservoir ‘efficienty’ (always 1, meaning that there aren’t any loses).

e. node_state_cap is the maximum level of the reservoirs.

To do this in one single step, simply select node in the Object tree and paste the following values in the first

empty cell:

node Bastusel_upper demand Base -0.2579768519
node Bergnds_upper demand Base -22.29

node Batfors_upper demand Base -2

node Finnfors_upper demand Base 0

node Gallejaur_upper demand Base 15.356962963
node Granfors_upper demand Base 0

node Grytfors_upper demand Base -3.78

node Krangfors_upper demand Base

node Kvistforsen_upper demand Base -1.3273809524
node Rebnis_upper demand Base -3.68

node Rengdrd_upper demand Base -10.37

node Sadva_upper demand Base -5.43

node Selsfors_upper demand Base 0

node Slagnds_upper demand Base 0

node Vargfors_upper demand Base -3.5584953704
node Bastusel_upper fix_node_state Base {"type": "time_

—"2019-01-07T23:00:00": 5417.28%}}
node Bergnds_upper fix_node_state Base

—"2019-01-07T23:00:00": 105898.8}}
node Batfors_upper fix_node_state Base

"2019-01-07T23:00:00": 891.1}}
node Finnfors_upper fix_node_state Base

—01-07T23:00:00": 234.0}}
node Gallejaur_upper fix_node_state Base

—series", "data": {"2019-01-01T00:00:00": 5581.44, "2019-01-01T01:00:00": NaN,

{"type": "time_

—series", "data": {"2019-01-01T00:00:00": 114543.6, "2019-01-01T01:00:00": NaN,

{"type": "time_

—series", "data": {"2019-01-01T00:00:00": 1117.2, "2019-01-01T01:00:00": NaN,

{"type": "time_

—series", "data": {"2019-01-01T00:00:00": 234.0, "2019-01-01T01:00:00": NaN, "2019-

{"type": "time_

—series™, "data": {"2019-01-01IT00:00:00™: 1224.0, "2019-0I1-01TOT1:00 : 0@SnfinNeNp next page)

—"2019-01-07T23:00:00": 2808.0}}
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node Granfors_upper fix_node_state
—series", "data": {"2019-01-01T00:00:00": 232.4,
~01-07T23:00:00": 212.8}}

node Grytfors_upper fix_node_state
—series"”, "data": {"2019-01-01T00:00:00": 1060.8,
~"2019-01-07T23:00:00": 1110.72}}

node Krangfors_upper fix_node_state
—series", "data": {"2019-01-01T00:00:00": 201.3,
~01-07T23:00:00": 207.9}}

Base {"type": "time_
"2019-01-01T01:00:00": NaN, "2019-

Base {"type": "time_
"2019-01-01T01:00:00": NaN,

Base {"type": "time_
"2019-01-01T01:00:00": NaN, "2019-

node Kvistforsen_upper fix_node_state Base {"type":
—"time_series", "data": {"2019-01-01T00:00:00": 769.066666704, "2019-01-01T01:00:00
—'": NaN, "2019-01-07T23:00:00": 560.0}}

node Rebnis_upper fix_node_state Base {"type": "time_

—series", "data": {"2019-01-01T00:00:00": 70243.509200184, "2019-01-01T01:00:00":_

—NaN, "2019-01-07T23:00:00": 59524.122689676}}
node Rengdrd_upper fix_node_state Base {"type": "time_
—series", "data": {"2019-01-01T00:00:00": 1022.0, "2019-01-01T01:00:00": NaN,

—"2019-01-07T23:00:00": 770.0}}

node Sadva_upper fix_node_state Base {"type": "time_
—series", "data": {"2019-01-01T00:00:00": 99057.7777728, "2019-01-01T01:00:00": ..
—NaN, "2019-01-07T23:00:00": 93831.111108}}

node Selsfors_upper fix_node_state Base {"type": "time_
—series", "data": {"2019-01-01T00:00:00": 40.0, "2019-01-01T01:00:00": NaN, "2019-
—01-07T23:00:00": 200.0}}

node Slagnds_upper fix_node_state Base {"type": "time_
—series", "data": {"2019-01-01T00:00:00": 384.0, "2019-01-01T01:00:00": NaN, "2019-
—01-07T23:00:00": 537.6}}

node Vargfors_upper fix_node_state Base {"type": "time_
—series", "data": {"2019-01-01T00:00:00": 3386.76, "2019-01-01T01:00:00": NaN,
—"2019-01-07T23:00:00": 3847.68%}}

node Bastusel_upper has_state Base true

node Bergnds_upper has_state Base true

node Batfors_upper has_state Base true

node Finnfors_upper has_state Base true

node Gallejaur_upper has_state Base true

node Granfors_upper has_state Base true

node Grytfors_upper has_state Base true

node Krangfors_upper has_state Base true

node Kvistforsen_upper has_state Base true

node Rebnis_upper has_state Base true

node Rengard_upper has_state Base true

node Sadva_upper has_state Base true

node Selsfors_upper has_state Base true

node Slagnds_upper has_state Base true

node Vargfors_upper has_state Base true

node Bastusel_upper state_coeff Base 1

node Bergnads_upper state_coeff Base 1

node Batfors_upper state_coeff Base 1

node Finnfors_upper state_coeff Base 1

node Gallejaur_upper state_coeff Base 1

node Granfors_upper state_coeff Base 1

node Grytfors_upper state_coeff Base 1

(continues on next page)
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node
node
node
node
node
node
node
node
node
node
node
node
node
node
node
node
node
node
node
node
node
node
node

Krangfors_upper
Kvistforsen_upper
Rebnis_upper
Rengard_upper
Sadva_upper
Selsfors_upper
Slagnds_upper
Vargfors_upper
Bastusel_upper
Bergnds_upper
Batfors_upper
Finnfors_upper
Gallejaur_upper
Granfors_upper
Grytfors_upper
Krangfors_upper
Kvistforsen_upper
Rebnis_upper
Rengdrd_upper
Sadva_upper
Selsfors_upper
Slagnds_upper
Vargfors_upper

state_coeff Base
state_coeff Base
state_coeff Base
state_coeff Base
state_coeff Base 1
state_coeff Base
state_coeff Base
state_coeff Base
node_state_cap Base
node_state_cap Base
node_state_cap Base
node_state_cap Base
node_state_cap Base
node_state_cap Base
node_state_cap Base
node_state_cap Base
node_state_cap Base
node_state_cap Base
node_state_cap Base
node_state_cap Base
node_state_cap Base
node_state_cap Base
node_state_cap Base

8208
216120
1330

300

3600

280

1248

330
1120
205560
1400
168000

500
768

4008

Establishing relationships

Tip: To enter the same text on several cells, copy the text into the clipboard, then select all target cells and press

Ctrl+V.

1. Create relationships of the class unit__from_node to represent that a power plant receives water from the
station’s upper water node, and that the electricity load takes electricity from the common electricity node. Both
the power plants and the electricity load belong to the class unit.

a.

Select the list of unit and node names from below and copy it to the clipboard (Ctrl+C).

Rebnis_pwr_plant
Sadva_pwr_plant
Bergnds_pwr_plant
Slagnds_pwr_plant
Bastusel_pwr_plant
Grytfors_pwr_plant
Gallejaur_pwr_plant
Vargfors_pwr_plant
Rengard_pwr_plant
Batfors_pwr_plant
Finnfors_pwr_plant
Granfors_pwr_plant
Krangfors_pwr_plant
Selsfors_pwr_plant

Rebnis_upper
Sadva_upper

Bergnds_upper
Slagnds_upper
Bastusel_upper
Grytfors_upper
Gallejaur_upper
Vargfors_upper
Rengard_upper
Batfors_upper
Finnfors_upper
Granfors_upper
Krangfors_upper
Selsfors_upper

(continues on next page)
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Kvistforsen_pwr_plant Kvistforsen_upper
electricity_load electricity_node

b. In the Spine DB Editor, go to Relationship tree (on the bottom left of the window, usually), right-click on
unit__from_node and select Add relationships from the context menu. This will open the Add relation-
ships dialog.

c. Select the first cell under the unit column and press Ctrl+V. This will paste the list of plant and node names
from the clipboard into the table. The form should be looking like this:

“ Add relationships

Relationship dass |unit__from_node {unit,node) o

unit node relationship name databases
1 Rebnis_pwr_plant Rebnis_upper unit__frem_node_Rebnis_pwr_plant__Rebnis_upper input
2 Sadva_pwr_plant Sadva_upper unit__frem_node_Sadva_pwr_plant_Sadva_upper input
3 Bergnis_pwr_plant Bergnids_upper unit_frem_node_Bergnds_pwr_plant__Bergnis_upper input
4 Slagnds_pwr_plant Slagnds_upper unit_frem_node_Slagnds_pwr_plant_ Slagnds_upper input
5 Bastusel_pwr_plant Bastusel_upper unit__frem_node_Bastusel_pwr_plant__Bastusel_upper input
6 Grytfors_pwr_plant Grytfors_upper unit_frem_node_Grytfors_pwr_plant_ Grytfors_upper input
7 Gallgjaur_pwr_plant Gallejaur_upper unit_frem_node_Gallejaur_pwr_plant_ Gallgjaur_upper input
g Vargfors_pwr_plant Vargfors_upper unit__frem_node_Vargfors_pwr_plant_ Vargfors_upper input
5 Rengdard_pwr_plant Rengard_upper unit_from_node_Rengdrd_pwr_plant_Rengérd_upper input
10 Batfors_pwr_plant Batfors_upper unit_from_node_Batfors_pwr_plant_ Batfors_upper input
11 Finnfors_pwr_plant Finnfors_upper unit_frem_node_Finnfors_pwr_plant__Finnfors_upper input
12 Granfors_pwr_plant Granfors_upper unit__frem_node_Granfors_pwr_plant__Granfors_upper input
13 Krangfors_pwr_plant Krangfors_upper unit_frem_node_Krangfors_pwr_plant_ Krangfors_upper input
14 Selsfors_pwr_plant Selsfors_upper unit__frem_node_Selsfors_pwr_plant__Selsfors_upper input
15 Kvistforsen_pwr_plant  Kvistforsen_upper  unit_from_node_Kvistforsen_pwr_plant_Kvistforsen_upper input
& Remove selected rows

d. Click Ok.

e. Back in the Spine DB Editor, under Relationship tree, double click on unit__from_node to confirm that
the relationships are effectively there.

f. From the main menu (Alt + F), select Session -> Commit to open the Commit changes dialog. Enter ‘Add
from nodes of power plants‘ as the commit message and click Commit.

2. Create relationships of the class unit__to_node to represent that a power plant releases water to the station’s
lower water node, and that the power plants supply electricity to the common electricity node. Use the following
data and do as before:

Rebnis_pwr_plant Rebnis_lower
Sadva_pwr_plant Sadva_lower
Bergnds_pwr_plant Bergnds_lower
Slagnds_pwr_plant Slagnds_lower
(continues on next page)
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Bastusel_pwr_plant
Grytfors_pwr_plant
Gallejaur_pwr_plant
Vargfors_pwr_plant
Rengard_pwr_plant
Batfors_pwr_plant
Finnfors_pwr_plant
Granfors_pwr_plant
Krangfors_pwr_plant
Selsfors_pwr_plant
Kvistforsen_pwr_plant
Rebnis_pwr_plant
Sadva_pwr_plant
Bergnds_pwr_plant
Slagnds_pwr_plant
Bastusel_pwr_plant
Grytfors_pwr_plant
Gallejaur_pwr_plant
Vargfors_pwr_plant
Rengard_pwr_plant
Batfors_pwr_plant
Finnfors_pwr_plant
Granfors_pwr_plant
Krangfors_pwr_plant
Selsfors_pwr_plant
Kvistforsen_pwr_plant

Bastusel_lower
Grytfors_lower
Gallejaur_lower
Vargfors_lower
Rengard_lower
Batfors_lower
Finnfors_lower
Granfors_lower
Krangfors_lower
Selsfors_lower
Kvistforsen_lower
electricity_node
electricity_node
electricity_node
electricity_node
electricity_node
electricity_node
electricity_node
electricity_node
electricity_node
electricity_node
electricity_node
electricity_node
electricity_node
electricity_node
electricity_node

Note: At this point, you might be wondering what’s the purpose of the unit__node__node relationship class.
Shouldn’t it be enough to have unit__from_node and unit__to_node to represent the topology of the system?
The answer is yes; but in addition to topology, we also need to represent the conversion process that happens in
the unit, where the water from one node is turned into electricty for another node. And for this purpose, we use
a relationship parameter value on the unit__node__node relationships (see Specifying relationship parameter

values).

. Create relationships of the class connection__from_node to represent that water can be either discharged or

spilled. If discharged, it is taken from the lower water node of the station, if spilled it is taken from the upper
water node of the station. Use the following data and do as before:

Bastusel_to_Grytfors_disch
Bergnads_to_Slagnds_disch
Batfors_to_Finnfors_disch
Finnfors_to_Granfors_disch
Gallejaur_to_Vargfors_disch
Granfors_to_Krangfors_disch
Grytfors_to_Gallejaur_disch
Krangfors_to_Selsfors_disch
Kvistforsen_to_downstream_disch
Rebnis_to_Bergnds_disch
Rengard_to_Batfors_disch
Sadva_to_Bergnads_disch
Selsfors_to_Kvistforsen_disch

Bastusel_lower
Bergnds_lower
Batfors_lower
Finnfors_lower
Gallejaur_lower
Granfors_lower
Grytfors_lower
Krangfors_lower
Kvistforsen_lower
Rebnis_lower
Rengard_lower
Sadva_lower
Selsfors_lower

(continues on next page)

56

Chapter 3. Tutorials




Spine Toolbox Documentation, Release 0.6.6.dev0-dev.0

(continued from previous page)

Slagnds_to_Bastusel_disch
Vargfors_to_Rengard_disch
Bastusel_to_Grytfors_spill
Bergnds_to_Slagnds_spill
Batfors_to_Finnfors_spill
Finnfors_to_Granfors_spill
Gallejaur_to_Vargfors_spill
Granfors_to_Krangfors_spill
Grytfors_to_Gallejaur_spill
Krangfors_to_Selsfors_spill

Kvistforsen_to_downstream_spill

Rebnis_to_Bergnds_spill
Rengdrd_to_Batfors_spill
Sadva_to_Bergnas_spill
Selsfors_to_Kvistforsen_spill
Slagnds_to_Bastusel_spill
Vargfors_to_Rengard_spill

Slagnds_lower
Vargfors_lower
Bastusel_upper
Bergnds_upper
Batfors_upper
Finnfors_upper
Gallejaur_upper
Granfors_upper
Grytfors_upper
Krangfors_upper
Kvistforsen_upper
Rebnis_upper
Rengdrd_upper
Sadva_upper
Selsfors_upper
Slagnds_upper
Vargfors_upper

4. Create relationships of the class connection__to_node to represent that both discharge and spill are released
into the upper node of the next downstream station. Use the following data and do as before:
Bastusel_to_Grytfors_disch Grytfors_upper
Bastusel_to_Grytfors_spill Grytfors_upper
Bergnas_to_Slagnds_disch Slagnds_upper
Bergnds_to_Slagnds_spill Slagnds_upper
Batfors_to_Finnfors_disch Finnfors_upper
Batfors_to_Finnfors_spill Finnfors_upper
Finnfors_to_Granfors_disch Granfors_upper
Finnfors_to_Granfors_spill Granfors_upper
Gallejaur_to_Vargfors_disch Vargfors_upper
Gallejaur_to_Vargfors_spill Vargfors_upper
Granfors_to_Krangfors_disch Krangfors_upper
Granfors_to_Krangfors_spill Krangfors_upper
Grytfors_to_Gallejaur_disch Gallejaur_upper
Grytfors_to_Gallejaur_spill Gallejaur_upper
Krangfors_to_Selsfors_disch Selsfors_upper
Krangfors_to_Selsfors_spill Selsfors_upper
Rebnis_to_Bergnds_disch Bergnds_upper
Rebnis_to_Bergnds_spill Bergnads_upper
Rengard_to_Batfors_disch Batfors_upper
Rengard_to_Batfors_spill Batfors_upper
Sadva_to_Bergnads_disch Bergnds_upper
Sadva_to_Bergnds_spill Bergnds_upper
Selsfors_to_Kvistforsen_disch Kvistforsen_upper
Selsfors_to_Kvistforsen_spill Kvistforsen_upper
Slagnds_to_Bastusel_disch Bastusel_upper
Slagnds_to_Bastusel_spill Bastusel_upper
Vargfors_to_Rengard_disch Rengard_upper
Vargfors_to_Rengard_spill Rengdrd_upper
Note: At this point, you might be wondering what’s the purpose of the connection__node__node relationship
class. Shouldn’t it be enough to have connection__from_node and connection__to_node to represent the
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topology of the system? The answer is yes; but in addition to topology, we also need to represent the delay in the
river branches. And for this purpose, we use a relationship parameter value on the connection__node__node
relationships (see Specifying relationship parameter values).

. Create relationships of the class node__commodity to represent that each node has to be in balance, for water

nodes with respect to water, for electricity nodes with respect to electricity. This way, you link all nodes to either
the commocity water or the commodity electricity. Use the following data and do as before:

Rebnis_upper water
Sadva_upper water
Bergnds_upper water
Slagnds_upper water
Bastusel_upper water
Grytfors_upper water
Gallejaur_upper water
Vargfors_upper water
Rengdrd_upper water
Batfors_upper water
Finnfors_upper water
Granfors_upper water
Krangfors_upper water
Selsfors_upper water
Kvistforsen_upper water
Rebnis_lower water
Sadva_lower water
Bergnds_lower water
Slagnds_lower water
Bastusel_lower water
Grytfors_lower water
Gallejaur_lower water
Vargfors_lower water
Rengard_lower water
Batfors_lower water
Finnfors_lower water
Granfors_lower water
Krangfors_lower water
Selsfors_lower water
Kvistforsen_lower water
electricity_node electricity

. Define that our model

. Define that all nodes in our model have to be balanced at each time step. To do this, you create a relationship of the

class model__default_temporal_block between the model instance and the temporal_block some_week
in the same way as before.

is deterministic. To do this, you create a relationship of the class
model__default_stochastic_structure between the model instance and the stochastic structure
deterministic, as well as a relationship of class stochastic_structure__stochastic_scenario
between the stochastid structure deterministic and the stochastic scenario realization in the same way as
before.

. In order to get the results from running Spine Opt written to the ouput database, create relationships of the

class report__output between the report my_report and each of the following output objects: unit_£flow,
connection_flow, and node_state. In addition, you also need to create a relationship of the class
model__report between the model instance and the report my_report.
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Specifying parameter values of the relationships

1. Finally, the values of all parameters have to be entered. Specify the capacity of all hydropower plants, and their
respective variable operating cost by entering unit__from_node parameter values as follows:

a.

Select the data from the text-box below and copy it to the clipboard (Ctrl+C):

unit__from_node Bastusel_pwr_plant,Bastusel_upper unit_

—.capacity Base 127.5

unit__from_node Bergnas_pwr_plant,Bergnds_upper unit_

<,capacity Base 120

unit__from_node Batfors_pwr_plant,Batfors_upper unit_

<,capacity Base 210

unit__from_node Finnfors_pwr_plant,Finnfors_upper unit_

<,capacity Base 176.25

unit__from_node Gallejaur_pwr_plant,Gallejaur_upper unit_
—,capacity Base 228.75

unit__from_node Granfors_pwr_plant,Granfors_upper unit_

<,capacity Base 180

unit__from_node Grytfors_pwr_plant,Grytfors_upper unit_

<,capacity Base 123.75

unit__from_node Krangfors_pwr_plant,Krangfors_upper unit_
-,capacity Base 180

unit__from_node Kvistforsen_pwr_plant,Kvistforsen_upper minimum_
—operating_point Base 0.0888888888889

unit__from_node Kvistforsen_pwr_plant,Kvistforsen_upper unit_
<,capacity Base 225

unit__from_node Rebnis_pwr_plant,Rebnis_upper unit_

<,capacity Base 60

unit__from_node Rengdrd_pwr_plant,Rengdrd_upper unit_

<,capacity Base 165

unit__from_node Sadva_pwr_plant,Sadva_upper unit_

<,capacity Base 52.5

unit__from_node Selsfors_pwr_plant,Selsfors_upper unit_

<,capacity Base 225

unit__from_node Slagnds_pwr_plant,Slagnds_upper unit_

<,capacity Base 120

unit__from_node Vargfors_pwr_plant,Vargfors_upper unit_

<,capacity Base 232.5

unit__from_node electricity_load,electricity_node vom_

—.cost Base {"type": "time_series", "index": {"start": "2019-01-
01 00:00:00", "resolution": "1h", "ignore_year": false, "repeat": false},
—"data": [-162.03, -156.36, -151.06, -153.52, -158.91, -164.02, -175.56, -283.
11, -278.76, -299.57, -285.28, -207.34, -194.95, -190.41, -185.4, -183.41, -
-191.54, -202.9, -197.69, -195.33, -186.72, -178.87, -174.71, -168.75, -172.89,
- -172.13, -171.66, -173.27, -176.97, -179.63, -226.41, -271.96, -399.3, -402.
53, -353.28, -330.79, -294.54, -271.29, -248.71, -226.79, -240.93, -374.44, -
—255.54, -210.47, -186.65, -178.21, -173.18, -166.44, -165.09, -162.91, -161.
-11, -162.53, -166.04, -169.16, -174.28, -185.37, -195.79, -189.92, -187.74, -
-181.96, -179.12, -178.36, -177.13, -177.03, -177.69, -184.8, -187.27, -179.49,
- -175.23, -172.67, -169.07, -165.37, -170.06, -171.48, -171.58, -174.14, -180.
-3, -185.89, -195.37, -328.65, -365.91, -315.0, -242.68, -230.73, -225.33, -
-225.8, -213.38, -207.32, -215.37, -243.81, -243.53, -215.56, -192.05, -187.88,
- -181.15, -172.15, -174.16, -171.05, -170.77, -174.82, -179.62, -178.87, -191.
49, -229.64, -336.07, -242.07, -228.5, -201.85, -196.67, —192.34?”mﬂgﬁ938?1W@®
-.187.44, -186.68, -190.26, -191.21, -187.53, -179.34, -171.9, -166.53, -160.59,
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b. In the Spine DB Editor, go to Relationship tree (on the bottom left of the window, usually), and click
on unit__from_node. Then, go to Relationship parameter value (on the bottom-center of the window,
usually). Make sure that the columns in the table are ordered as follows (drag and drop columns if you need
to change their order):

relationship_class_name | object_name_list | parameter_name | alternative_name.
— | value | database

c. Select the first cell under relationship_class_name and press Ctrl+V. This will paste the parameter
value data from the clipboard into the table.

. Specify the conversion ratio between discharged water and generated electricity for each hydropower station as

well as a similar conversion rate (set to 1) to represent that water cannot be lost between upper and lower water
nodes. Use the following data to enter the parameter values unit__from_node:

unit__node__node Bastusel_pwr_plant,electricity_node,Bastusel_

—upper fix_ratio_out_in_unit_flow Base 0.577810871184
unit__node__node Bergnds_pwr_plant,electricity_node,Bergnds_upper fix_
—ratio_out_in_unit_flow Base 0.0506329113924

unit__node__node Batfors_pwr_plant,electricity_node,Batfors_upper fix_
—ratio_out_in_unit_flow Base 0.148282097649

unit__node__node Finnfors_pwr_plant,electricity_node,Finnfors_

—.upper fix_ratio_out_in_unit_flow Base 0.180985725828
unit__node__node Gallejaur_pwr_plant,electricity_node,Gallejaur_

—upper fix_ratio_out_in_unit_flow Base 0.730442000415
unit__node__node Granfors_pwr_plant,electricity_node,Granfors_

—.upper fix_ratio_out_in_unit_flow Base 0.164556962025
unit__node__node Grytfors_pwr_plant,electricity_node,Grytfors_

—upper fix_ratio_out_in_unit_flow Base 0.190257000384
unit__node__node Krangfors_pwr_plant,electricity_node,Krangfors_

—upper fix_ratio_out_in_unit_flow Base 0.274261603376
unit__node__node Kvistforsen_pwr_plant,electricity_node,Kvistforsen_

—upper fix_ratio_out_in_unit_flow Base 0.472573839662
unit__node__node Rebnis_pwr_plant,electricity_node,Rebnis_upper fix_
—ratio_out_in_unit_flow Base 0.810126582278

unit__node__node Rengard_pwr_plant,electricity_node,Rengard_upper fix_
—ratio_out_in_unit_flow Base 0.165707710012

unit__node__node Sadva_pwr_plant,electricity_node,Sadva_upper fix_
—ratio_out_in_unit_flow Base 0.448462929476

unit__node__node Selsfors_pwr_plant,electricity_node,Selsfors_

—upper fix_ratio_out_in_unit_flow Base 0.209282700422
unit__node__node Slagnds_pwr_plant,electricity_node,Slagnds_upper fix_
—ratio_out_in_unit_flow Base 0.0443037974684

unit__node__node Vargfors_pwr_plant,electricity_node,Vargfors_

—upper fix_ratio_out_in_unit_flow Base 0.34299714169
unit__node__node Bastusel_pwr_plant,Bastusel_lower,Bastusel_upper fix_
—ratio_out_in_unit_flow Base 1

unit__node__node Bergnds_pwr_plant,Bergnds_lower,Bergnas_upper fix_
—ratio_out_in_unit_flow Base 1

unit__node__node Batfors_pwr_plant,Batfors_lower,Batfors_upper fix_
—ratio_out_in_unit_flow Base 1

(continues on next page)
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unit__node__node

—ratio_out_in_unit_flow

unit__node__node

unit__node__node

—ratio_out_in_unit_flow

unit__node__node

Finnfors_pwr_plant,Finnfors_lower,Finnfors_upper fix_

Base 1

Gallejaur_pwr_plant,Gallejaur_lower,Gallejaur_

—.upper fix_ratio_out_in_unit_flow Base 1
Granfors_pwr_plant,Granfors_lower,Granfors_upper fix_
Base 1
Grytfors_pwr_plant,Grytfors_lower,Grytfors_upper fix_
Base 1

—ratio_out_in_unit_flow

unit__node__node
unit__node__node
unit__node__node

—out_in_unit_flow
unit__node__node

—ratio_out_in_unit_flow

unit__node__node
—out_in_unit_flow
unit__node__node

—ratio_out_in_unit_flow

unit__node__node

—ratio_out_in_unit_flow

unit__node__node

Krangfors_pwr_plant,Krangfors_lower,Krangfors_

—.upper fix_ratio_out_in_unit_flow Base 1
Kvistforsen_pwr_plant,Kvistforsen_lower,Kvistforsen_
—upper fix_ratio_out_in_unit_flow Base 1
Rebnis_pwr_plant,Rebnis_lower,Rebnis_upper fix_ratio_
Base 1
Rengard_pwr_plant,Rengdrd_lower,Rengdrd_upper fix_
Base 1
Sadva_pwr_plant,Sadva_lower,Sadva_upper fix_ratio_
Base 1
Selsfors_pwr_plant,Selsfors_lower,Selsfors_upper fix_
Base 1
Slagnds_pwr_plant,Slagnds_lower,Slagnds_upper fix_
Base 1
Vargfors_pwr_plant,Vargfors_lower,Vargfors_upper fix_
Base 1

—ratio_out_in_unit_flow

3. Specify the average discharge and spillage in the first hours of the simulation. Use the following data to enter the
parameter values connection__from_node
connection__from_node Bastusel_to_Grytfors_disch,Bastusel_lower fix_
—.connection_flow Base {"type": "time_series", "index": {"start":
—"2018-12-30 00:00:00", "resolution": "2D"}, "data": [110.7, 110.7]}
connection__from_node Bergnds_to_Slagnds_disch,Bergnds_lower fix_
—,connection_flow Base {"type": "time_series", "index": {"start":
~"2018-12-30 00:00:00", "resolution": "2D"}, "data": [105.0, 105.0]}
connection__from_node Batfors_to_Finnfors_disch,Batfors_lower fix_
—.connection_flow Base {"type": "time_series", "index": {"start":
~"2018-12-30 00:00:00", "resolution": "2D"}, "data": [150.2, 150.2]%}
connection__from_node Finnfors_to_Granfors_disch,Finnfors_lower fix_
—,connection_flow Base {"type": "time_series", "index": {"start":
~"2018-12-30 00:00:00", "resolution": "2D"}, "data": [155.3, 155.3]}
connection__from_node Gallejaur_to_Vargfors_disch,Gallejaur_lower fix_
—.connection_flow Base {"type": "time_series", "index": {"start":
—"2018-12-30 00:00:00", "resolution": "2D"}, "data": [118.2, 118.2]}
connection__from_node Granfors_to_Krangfors_disch,Granfors_lower fix_
—connection_flow Base {"type": "time_series", "index": {"start":
~"2018-12-30 00:00:00", "resolution": "2D"}, "data": [155.6, 155.6]}
connection__from_node Grytfors_to_Gallejaur_disch,Grytfors_lower fix_
—.connection_flow Base {"type": "time_series", "index": {"start":
—"2018-12-30 00:00:00", "resolution": "2D"}, "data": [117.2, 117.2]}
connection__from_node Krangfors_to_Selsfors_disch,Krangfors_lower fix_
—.connection_flow Base {"type": "time_series", "index": {"start":
"2018-12-30 00:00:00", "resolution": "2D"}, "data": [156.0, 156.0]}
(continues on next page)
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connection__from_node
—lower

<"y {"start": "2018-12-30 00:00:00",

connection__from_node
—.connection_flow
"2018-12-30 00:00:00",
connection__from_node
—,connection_flow
~"2018-12-30 00:00:00",
connection__from_node
—.connection_flow
—"2018-12-30 00:00:00",
connection__from_node

. lower

<" {"start":
connection__from_node
—.connection_flow
—"2018-12-30 00:00:00",
connection__from_node
—.connection_flow
~"2018-12-30 00:00:00",
connection__from_node
—,connection_flow
—"2018-12-30 00:00:00",
connection__from_node
—.connection_flow
"2018-12-30 00:00:00",
connection__from_node
—,connection_flow
~"2018-12-30 00:00:00",
connection__from_node
—.connection_flow
—"2018-12-30 00:00:00",
connection__from_node
—connection_flow
~"2018-12-30 00:00:00",
connection__from_node
—.connection_flow
—"2018-12-30 00:00:00",
connection__from_node
—.connection_flow
~"2018-12-30 00:00:00",
connection__from_node
—,connection_flow
—"2018-12-30 00:00:00",
connection__from_node
—.upper

<" {"start":
connection__from_node
—,connection_flow
—"2018-12-30 00:00:00",
connection__from_node

—

—"2018-12-30 00:00:00",

fix_connection_flow

fix_connection_flow
"2018-12-30 00:00:00",

fix_connection_flow
"2018-12-30 00:00:00",

Kvistforsen_to_downstream_disch,Kvistforsen_

Base {"type": "time_series", "index
"resolution": "2D"}, "data": [158.5, 158.5]}
Rebnis_to_Bergnds_disch,Rebnis_lower fix_
Base {"type": "time_series", "index": {"start":
"resolution": "2D"}, "data": [21.5, 21.5]}
Rengard_to_Batfors_disch,Rengard_lower fix_
Base {"type": "time_series", "index": {"start":
"resolution": "2D"}, "data": [141.5, 141.5]}
Sadva_to_Bergnids_disch,Sadva_lower fix_
Base {"type": "time_series", "index": {"start":
"resolution": "2D"}, "data": [34.6, 34.6]}
Selsfors_to_Kvistforsen_disch,Selsfors_
Base {"type": "time_series", "index
"resolution": "2D"}, "data": [158.4, 158.4]}
Slagnds_to_Bastusel_disch,Slagnds_lower fix_
Base {"type": "time_series", "index": {"start":
"resolution": "2D"}, "data": [106.6, 106.6]}
Vargfors_to_Rengard_disch,Vargfors_lower fix_
Base {"type": "time_series", "index": {"start":
"resolution": "2D"}, "data": [119.6, 119.6]}
Bastusel_to_Grytfors_spill,Bastusel_upper fix_
Base {"type": "time_series", "index": {"start":
"resolution": "2D"}, "data": [0.0, 0.0]}
Bergnds_to_Slagnds_spill,Bergnds_upper fix_
Base {"type": "time_series", "index": {"start":
"resolution": "2D"}, "data": [0.0, 0.0]1}
Batfors_to_Finnfors_spill,Batfors_upper fix_
Base {"type": "time_series", "index": {"start":
"resolution": "2D"}, "data": [0.0, 0.0]}
Finnfors_to_Granfors_spill,Finnfors_upper fix_
Base {"type": "time_series", "index": {"start":
"resolution": "2D"}, "data": [0.0, 0.0]}
Gallejaur_to_Vargfors_spill,Gallejaur_upper fix_
Base {"type": "time_series", "index": {"start":
"resolution": "2D"}, "data": [0.0, 0.0]}
Granfors_to_Krangfors_spill,Granfors_upper fix_
Base {"type": "time_series", "index": {"start":
"resolution": "2D"}, "data": [0.0, 0.0]}
Grytfors_to_Gallejaur_spill,Grytfors_upper fix_
Base {"type": "time_series", "index": {"start":
"resolution": "2D"}, "data": [0.0, 0.0]1}
Krangfors_to_Selsfors_spill,Krangfors_upper fix_
Base {"type": "time_series", "index": {"start":
"resolution": "2D"}, "data": [0.0, 0.0]}
Kvistforsen_to_downstream_spill,Kvistforsen_
Base {"type": "time_series", "index
"resolution": "2D"}, "data": [0.0, 0.0]}
Rebnis_to_Bergnds_spill,Rebnis_upper fix_
Base {"type": "time_series", "index": {"start":
"resolution": "2D"}, "data": [0.0, 0.0]}
Rengard_to_Batfors_spill,Rengard_upper fix_
me_ i , i + (Cortl n next page

"resolution": "2D"}, "data": [0.0, 0.0]}
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(continued from previous page)

connection__from_node Sadva_to_Bergnads_spill,Sadva_upper fix_
—,connection_flow Base {"type": "time_series", "index": {"start":
~"2018-12-30 00:00:00", "resolution": "2D"}, "data": [0.0, 0.0]}
connection__from_node Selsfors_to_Kvistforsen_spill,Selsfors_

—upper fix_connection_flow Base {"type": "time_series", "index
<" {"start": "2018-12-30 00:00:00", "resolution": "2D"}, "data": [0.0, 0.0]}
connection__from_node Slagnds_to_Bastusel_spill,Slagnds_upper fix_
—,connection_flow Base {"type": "time_series", "index": {"start":
~"2018-12-30 00:00:00", "resolution": "2D"}, "data": [0.0, 0.0]}
connection__from_node Vargfors_to_Rengard_spill,Vargfors_upper fix_
—.connection_flow Base {"type": "time_series", "index": {"start":
—"2018-12-30 00:00:00", "resolution": "2D"}, "data": [0.0, 0.0]}

4. Finally, specify the delay (the time it takes for the water to run between water nodes) and the transfer ra-

tio (being equal to 1) of different water connections. Use the following data to enter the parameter values

connection__node_node

connection__node__node

—lower connection_
" "1h"}
connection__node__node
—.upper connection_
~": "150m"}
connection__node__node
—lower connection_
" "1h"}
connection__node__node
—.upper connection_
<" "1h"}
connection__node__node

. lower connection_
~": "3h"}
connection__node__node
—.upper connection_
<" "3h"}
connection__node__node

. lower connection_
<" "3h"}
connection__node__node
—.upper connection_
<" "3h"}
connection__node__node

- lower connection_
<" "30m"}
connection__node__node
—.upper connection_
S": "150m"}

connection__node__node

Bastusel_to_Grytfors_disch,Grytfors_upper,Bastusel_

flow_delay Base {"type": "duration", "data
Bastusel_to_Grytfors_spill,Grytfors_upper,Bastusel_
flow_delay Base {"type": "duration", "data

Bergnds_to_Slagnds_disch,Slagnds_upper,Bergnds_

flow_delay Base {"type": "duration", "data
Bergnds_to_Slagnds_spill, Slagnds_upper,Bergnds_
flow_delay Base {"type": "duration", "data

Batfors_to_Finnfors_disch,Finnfors_upper,Batfors_

flow_delay Base {"type": "duration", "data
Batfors_to_Finnfors_spill,Finnfors_upper,Batfors_
flow_delay Base {"type": "duration", "data

Finnfors_to_Granfors_disch,Granfors_upper,Finnfors_

flow_delay Base {"type": "duration", "data
Finnfors_to_Granfors_spill,Granfors_upper,Finnfors_
flow_delay Base {"type": "duration", "data

Gallejaur_to_Vargfors_disch,Vargfors_upper,Gallejaur_

flow_delay Base {"type": "duration", "data
Gallejaur_to_Vargfors_spill,Vargfors_upper,Gallejaur_
flow_delay Base {"type": "duration", "data

Granfors_to_Krangfors_disch,Krangfors_upper,Granfors_

—lower connection_flow_delay Base {"type": "duration", "data
_": "3h"}

connection__node__node Granfors_to_Krangfors_spill,Krangfors_upper,Granfors_

—upper connection_flow_delay Base {"type": "duration", "data
", nopmy
3R

(continues on next page)
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(continued from previous page)

connection__node__node

—lower
(4)”: "151’[’[”}

connection__node__node

—upper
" "1sm"}

connection__node__node

—lower
_": "3h"}

connection__node__node

—upper
(‘)ll: ll3hll}

connection__node__node

—lower
_": "2D"}

connection__node__node

—,upper
(ﬁ)ll: IIZDIl}

connection__node__node

—lower
_": "3h"}

connection__node__node

—.upper
:4)”: ll3hll}

connection__node__node

—lower
L": "2D"}

connection__node__node

—.upper
<4)”: HZDII}

connection__node__node
—.Selsfors_lower

"data":

connection__node__node
—Selsfors_upper

1]
—

<", "data":
connection__node__node

—lower
<4)”: ll4hll}

connection__node__node

—upper
L' "4h"}

connection__node__node

—lower
“}ll: ll3hll}

connection__node__node

—upper
_": "3h"}

connection__node__node

—lower

connection__

—upper

Grytfors_to_Gallejaur_disch,Gallejaur_upper,Grytfors_
connection_flow_delay Base {"type": "duration", "data

Grytfors_to_Gallejaur_spill,Gallejaur_upper,Grytfors_
connection_flow_delay Base {"type": "duration", "data

Krangfors_to_Selsfors_disch,Selsfors_upper,Krangfors_
connection_flow_delay Base {"type": "duration", "data

Krangfors_to_Selsfors_spill,Selsfors_upper,Krangfors_
connection_flow_delay Base {"type": "duration", "data

Rebnis_to_Bergnds_disch,Bergnds_upper,Rebnis_
connection_flow_delay Base {"type": "duration", "data

Rebnis_to_Bergnds_spill,Bergnds_upper,Rebnis_
connection_flow_delay Base {"type": "duration", "data
Rengard_to_Batfors_disch,Batfors_upper,Rengard_

connection_flow_delay Base {"type": "duration", "data

Rengard_to_Batfors_spill,Batfors_upper,Rengard_
connection_flow_delay Base {"type": "duration", "data

Sadva_to_Bergnds_disch,Bergnas_upper, Sadva_
connection_flow_delay Base {"type": "duration", "data

Sadva_to_Bergnds_spill,Bergnds_upper, Sadva_
connection_flow_delay Base {"type": "duration", "data

Selsfors_to_Kvistforsen_disch,Kvistforsen_upper,
connection_flow_delay Base {"type": "duration
"3h"}

Selsfors_to_Kvistforsen_spill,Kvistforsen_upper,
connection_flow_delay Base {"type": "duration
"3h"}

Slagnds_to_Bastusel_disch,Bastusel_upper,Slagnds_
connection_flow_delay Base {"type": "duration", "data

Slagnds_to_Bastusel_spill,Bastusel_upper,Slagnds_
connection_flow_delay Base {"type": "duration", "data

Vargfors_to_Rengard_disch,Rengard_upper,Vargfors_
connection_flow_delay Base {"type": "duration", "data

Vargfors_to_Rengard_spill,Rengdrd_upper,Vargfors_
connection_flow_delay Base {"type": "duration", "data

Bastusel_to_Grytfors_disch,Grytfors_upper,Bastusel_
fix_ratio_out_in_connection_flow Base 1

node__node Bastusel_to_Grytfors_spill,Grytfors_upper,Bastusel_
fix_ratio_out_in_connection_flow Base 1

(continues on next page)
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(continued from previous page)

connection__node__node

. lower
connection__node__node
—.upper
connection__node__node
—lower
connection__node__node
—,upper
connection__node__node
—lower
connection__node__node
—,.upper

connection__node__node
—lower
connection__node__node

—.upper
connection__node__node
. lower
connection__node__node
—.upper
connection__node__node
—lower
connection__node__node
—,upper
connection__node__node
—lower
connection__node__node
—.upper

connection__node__node
—lower
connection__node__node

fix_ratio_out_in_connection_flow

Bergnds_to_Slagnds_disch,Slagnds_upper,Bergnds_
Base 1
Bergnds_to_Slagnds_spill, Slagnds_upper,Bergnds_

fix_ratio_out_in_connection_flow Base 1

Batfors_to_Finnfors_disch,Finnfors_upper,Batfors_

fix_ratio_out_in_connection_flow Base 1

Batfors_to_Finnfors_spill,Finnfors_upper,Batfors_

fix_ratio_out_in_connection_flow Base 1

Finnfors_to_Granfors_disch,Granfors_upper,Finnfors_

fix_ratio_out_in_connection_flow Base 1

Finnfors_to_Granfors_spill,Granfors_upper,Finnfors_

fix_ratio_out_in_connection_flow Base 1

Gallejaur_to_Vargfors_disch,Vargfors_upper,Gallejaur_

fix_ratio_out_in_connection_flow Base 1

Gallejaur_to_Vargfors_spill,Vargfors_upper,Gallejaur_

fix_ratio_out_in_connection_flow Base 1

Granfors_to_Krangfors_disch,Krangfors_upper,Granfors_

fix_ratio_out_in_connection_flow Base 1

Granfors_to_Krangfors_spill,Krangfors_upper,Granfors_

fix_ratio_out_in_connection_flow Base 1

Grytfors_to_Gallejaur_disch,Gallejaur_upper,Grytfors_

fix_ratio_out_in_connection_flow Base 1

Grytfors_to_Gallejaur_spill,Gallejaur_upper,Grytfors_

fix_ratio_out_in_connection_flow Base 1

Krangfors_to_Selsfors_disch,Selsfors_upper,Krangfors_

fix_ratio_out_in_connection_flow Base 1

Krangfors_to_Selsfors_spill,Selsfors_upper,Krangfors_

fix_ratio_out_in_connection_flow Base 1

Rebnis_to_Bergnds_disch,Bergnds_upper,Rebnis_

fix_ratio_out_in_connection_flow Base 1

Rebnis_to_Bergnds_spill,Bergnds_upper,Rebnis_

—upper fix_ratio_out_in_connection_flow Base 1
connection__node__node Rengard_to_Batfors_disch,Batfors_upper,Rengard_
- lower fix_ratio_out_in_connection_flow Base 1
connection__node__node Rengdrd_to_Batfors_spill,Batfors_upper,Rengdrd_
—upper fix_ratio_out_in_connection_flow Base 1
connection__node__node Sadva_to_Bergnds_disch,Bergnds_upper, Sadva_
—lower fix_ratio_out_in_connection_flow Base 1
connection__node__node Sadva_to_Bergnds_spill,Bergnds_upper, Sadva_
—upper fix_ratio_out_in_connection_flow Base 1

connection__node__node
—.Selsfors_lower

connection__node__node
—.Selsfors_upper

connection__node__node
— lower
connection__node__node
—.upper
connection__node__node
. lower
connection__node__node
—.upper

Selsfors_to_Kvistforsen_disch,Kvistforsen_upper,

fix_ratio_out_in_connection_flow Base 1

Selsfors_to_Kvistforsen_spill,Kvistforsen_upper,

fix_ratio_out_in_connection_flow Base 1

Slagnds_to_Bastusel_disch,Bastusel_upper,Slagnds_

fix_ratio_out_in_connection_flow Base 1

Slagnds_to_Bastusel_spill,Bastusel_upper,Slagnds_

fix_ratio_out_in_connection_flow Base 1

Vargfors_to_Rengard_disch,Rengard_upper,Vargfors_

fix_ratio_out_in_connection_flow Base 1

Vargfors_to_Rengard_spill,Rengdrd_upper,Vargfors_

fix_ratio_out_in_connection_flow Base 1
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5. When you’re ready, commit all changes to the database via the main menu (Alt + F).

Using the Importer

Additional Steps for Project Setup

. Drag the Data Connection icon from the tool bar and drop it into the Design View. This will open the Add Data

connection dialogue. Type in ‘Data Connection’ and click on Ok.

. To import the model of the planning problem into the Spine database, you need to create an Import specification.

Create an Import specification by clicking on the small arrow next to the Importer item (in the Main section of
the toolbar) and press New. The Importer specification editor will pop-up.

. Type ‘Import Model’ as the name of the specification. Save the specification by using Ctrl+S and close the

window.

. Drag the newly created Import Model Importer item icon from the tool bar and drop it into the Design View.

This will open the Add Importer dialogue. Type in ‘Import Model” and click on Ok.

. Connect ‘Data Connection’ with ‘Import Model’ by first clicking on one of the Data Connection’s connectors

and then on one of the Importer’s connectors. Connect similarly the importer with the input database. Now the
project should look similar to this:

Data Connection

E Import Model

~X3 _% . L input

SpineOpt

¥

6. From the main menu, select File -> Save project.

Importing the model

. Download the data and the accompanying mapping (right click on the links, then select Save link as...).
. Add a reference to the file containing the model.

. Select the Data Connection item in the Design View to show the Data Connection properties window (on the

right side of the window usually).

. In Data Connection Properties, click on the plus icon and select the previously downloaded Excel file.

. Next, double click on the Import model in the Design view. A window called Select connector for Import Model

will pop-up, select Excel and klick OK. Next, still in the Importer specification editor, click the alternatives icon
in the top right and import the mappings previously downloaded. Finally, save by clicking Ctrl+S and exit the
Importer specification editor.
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3.3.5 Executing the workflow

Once the workflow is defined and input data is in place, the project is ready to be executed. Hit the Execute project

button on the tool bar.

You should see ‘Executing All Directed Acyclic Graphs’ printed in the Event log (on the lower left by default). SpineOpt
output messages will appear in the Process Log panel in the middle. After some processing, ‘DAG 1/1 completed
successfully’ appears and the execution is complete.

3.3.6 Examining the results

Select the output data store and open the Spine DB editor.

Spine DB Editor X

input.sqlite 3¢ output.sglite 3

~al

e~ sqglite:////home/manuelma/Codes/spineftoolbox/projects/case_study_a5/.spinetoolbox/items/output/output.sqlite

Object tree
name

+ &P report

4 e stochastic_scenario

v e unit
’ e Bastusel_pwr_plant
» e Bergnas_pwr_plant
» & Batfors_pwr_plant
4 e Finnfors_pwr_plant
’ a Gallejaur_pwr_plant
» & Granfors_pwr_plant
» e Grytfors_pwr_plant
» & Krangfors_pwr_plant
4 e Kvistforsen_pwr_plant
’ e Rebnis_pwr_plant
» &2 Rengard_pwr_plant
» e Sadva_pwr_plant
4 e Selsfors_pwr_plant
4 e Slagnds_pwr_plant
’ e Vargfors_pwr_plant

+

@@ Object parameter value

datat™ object_class_name object_name parameter_name alternative_name value

outpl
outpt
outpt
outpt
outpl
outpt
outpt
outpt
outpt
outpl
outp!
outpt
outpt
outpl
outpl
outpt
outpt
outpt

electricity_load outpl

1

Relationship tree
name

~ & root

» &% report__connection__node__dire
» & report__node__stochastic_scenal
» &% report__unit__node__direction__

@®

3

unit electricity_...

Object parametervalue = Object parameter definition

Relationship parameter value
object_name_list parameter_name alternative_name value
my_report | ele... unit_flow Base

@® Tool/Feature tree

dal name

No.. outpl ~ & output.sqlite

2]

database

3

output.sqglite

None putput.sglite

Relationship parameter value | Relationship parameter definition

b

- % feature

Enter new feature here,

- /A tool

Type new tool name he

Parameter value list
* & output.sqlite
B Type new list name her

Alternative/Scenario tree

name

~ 4 output.sqlite

- -? alternative
Base

Parameter tag

tag

~ & output.sqglite

B Tirms maane toe

(=]ES]

(=]

3

To checkout the flow on the electricity load (i.e., the total electricity production in the system), go to Object tree, expand
the unit object class, and select electricity_load, as illustrated in the picture above. Next, go to Relationship
parameter value and double-click the first cell under value. The Parameter value editor will pop up. You should see

something like this:
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Edit value -- my_report | electricity_load | electricity_node | from_node - unit_flow --

Parameter type | Time series - variable resolution j
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CHAPTER
FOUR

SETTING UP EXTERNAL TOOLS

This section describes the default Python used by Spine Toolbox and how to change that. Here you can also find the
instructions on how to set up Julia and Gams for executing Julia and Gams Tools. To get started with SpineOpt.jl,
see How to set up SpineOpt.jl. See also Executing Projects and Execution Modes.

* Python
— Default Python for Spine Toolbox installed using an installation bundle
— Default Python for Spine Toolbox installed using Git
— Changing the default Python

e Julia

* GAMS

4.1 Python

No set up required! Python Tools are executed using the default Python, which depends on how you installed Spine
Toolbox. The installation options are:

1. Using a single-file installation bundle (e.g. spine-foolbox-0.6.0-final.2-x64.exe or newer). You can find this
file and all releases from Spine Toolbox releases. The installation bundles are only available for Windows at the
moment.

2. Cloning Spine Toolbox Git repository from https://github.com/Spine-project/Spine-Toolbox. Checkout branch
release-0.6 or master and run pip install -r requirements.txt in the repo root.

Tip: You can always see the current Python configured for Spine Toolbox from the Tools page in File->Settings. ...
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4.1.1 Default Python for Spine Toolbox installed using an installation bundle

The default Python is the Python in your PATH environment variable. If Python is not in your PATH, the default
Python is an ‘embedded’ Python that is shipped with the installation bundle. The ‘embedded’ Python is located in
<install_dir>\tools\python.exe, where <install_dir> is C:\Program Files\Spine Toolbox if you installed Spine Toolbox
to the default directory for all users.

Important: If you want access to spinedb_api package from Tools and Consoles in Spine Toolbox, bear in mind that
the version of spinedb_api must be compatible with the version of Spine Toolbox you are using! Spine Toolbox v0.6.0
is shipped with spinedb_api v0.12.1. If you want to use the Python in your PATH, you must install the correct version
of spinedb_api for this Python manually. The correct version in this case is in the release-0. 12 branch of spinedb_api
git repo (https://github.com/Spine-project/Spine-Database- API/tree/release-0.12). To avoid this additional step, it
is recommended that you use the ‘embedded’ Python interpreter that is shipped with the application. You can set up
this Python for Spine Toolbox by opening the Tools page of File->Settings... and replacing the path of the Python
Interpreter with <install_dir>\tools\python.exe. The ‘embedded’ Python interpreter has access to “spinedb_api
that is shipped with the application.

Here are the recommended settings

—— GAMS
= General
GAMS executable
" Project C:\GAMS\win&s4\28.2\gams.exe =
Julia
A Tools Select Julia kernel spec. .. w
|C:".JLI|iE-1 .3.4\bin'julia.exe | =
= Db editor
|I_I5ing Juliz default project | |—]
ﬁ Spec. editors (®) Run Julia tools in & subprocess () Run Julia tools in embedded console
Add/Update SpineCpt
Python
Select Python kernel spec... Al Kernel spec editor
|C:jPrngrc|rn Filles/Spine Toolbox/tools/python.exe Q | |—)
(®) Run Python tools in a subprocess () Run Python tools in embedded console
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4.1.2 Default Python for Spine Toolbox installed using Git

The default Python is the Python that was used in launching the application (i.e. sys.executable). When you start
the app for the first time (or if you clear the path), the path to the default Python is shown as placeholder (gray) text in
the line edit like this:

—— GAMS
= General
GAMS executable
%' Project C:\GAMS\win64\28.2\gams.exe =
Julia
/ Tools Select Julia kernel spec... v
|C:'—.JL|Iia-1 .5.4\binjulia.exe | —
= Db editor
|Ll5in|;| Julia default project | |—]
ﬁ Spec. editors (®) Run Julia tools in a subprocess () Run Julia tools in embedded console
Install Julia AddfUpdate SpineQpt
Python
Select Python kernel spec... Sl kernel spec editor
“C:'-.F"-.-‘.hu:n|13?'-.D'-.-—_hc|n BXE |—]
(®) Run Python tools in a subprocess () Run Python tools in embedded console

The default Python has access to the spinedb_api version that was installed with the application (the one in in
<python_dir>\lib\site-packages\spinedb_api).

4.1.3 Changing the default Python

If you want to use another Python than the default, you can use existing Pythons in your system or you can download
additional Pythons from https://www.python.org/downloads/. You can change the default Python on the Tools page of
File->Settings... by clicking the button and selecting the Python interpreter (python.exe on Windows) you want. You
can use any Python in your system.

Note: Executing Python Tools using the Jupyter Console supports Python versions from 2.7 all the way to newest one.
Executing Python Tools without using the Jupyter Console supports even earlier Pythons than 2.7. You can start Spine
Toolbox only with Python 3.7 or with 3.8, but you can set up a Jupyter Console in Spine Toolbox that uses e.g. Python
2.7. This means, that if you still have some old Python 2.7 scripts lying around, you can incorporate those into a Spine
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Toolbox project workflow and execute them without modifications.

Important: If you want to have access to spinedb_api, you need to install it manually for the Python you select here.

4.2 Julia

Executing Julia Tools in Spine Toolbox requires that Julia is installed on your system. Julia downloads are available
from https://julialang.org/downloads/. You can see the current Julia on the Tools page in File->Settings. ... The default
Julia is the Julia in your PATH environment variable. Setting some other Julia to the line edit overrides the Julia in
PATH. If you want to use a specific Julia project environment (the place for Project.toml and Manifest.toml), you can
set the path to the environment folder to the line edit just below the Julia executable line edit (the one that says Using
Julia default project when empty).

If you are trying to execute Julia Tools and you see an error message in Event Log complaining about not finding Julia,
you either don’t have a Julia installation in your PATH, or the Julia path in Settings is invalid.

4.3 GAMS

Executing Gams Tools and the GDXExporter Project Item requires an installation of Gams on your system. You can
download Gams from https://www.gams.com/download/.

Note: You do not need to own a Gams license as the demo version works just as well.

As with Julia, the default Gams is the Gams in your PATH environment variable. You can see the one that is currently in
use from the Tools page in File->Settings. .. . The placeholder text shows the Gams in your PATH if found. You can also
override the default Gams by setting some other gams.exe path to the line edit (e.g. CAGAMS\win64\28.2\gams.exe).

Important: The bitness (32 or 64bit) of Gams has to match the bitness of the Python interpreter.
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CHAPTER
FIVE

MAIN WINDOW

This section describes the different components in the application main window.

The first time you start the application you will see the main window like this.

+ Spine Toolbox - O X
File Edit View Help

Ge'\e"cﬂ:a'ns‘f E g E.. / _a ) ili ‘ Speciﬁcitems Execution

Project B X | Design View Properties g X

Select a project item to view its properties

Event Log & X ProcessLog & % Julia Console & X Python Console g X

The application main window contains six dock widgets (Project, Properties, Event Log, Process Log, Julia Console,
and Python Console), a tool bar, a Design View, and a menu bar with File, Edit, View, and Help menus. The Project
dock widget contains a list of project items and Tool specifications that are available in your project. The Properties
dock widget shows the properties of the selected project item. Event Log shows messages depending on what you do
in Spine Toolbox. Process Log shows messages from processes that are spawned by the application, i.e. it shows the
stdout and stderr streams of GAMS, Julia, Python (if Tools are executed without embedded Julia and Python Consoles,
see Sertings section), and executable programs. Julia and Python Consoles provide full iJulia and a iPython consoles. If
you choose to execute Julia tools in the embedded Julia Console, the Julia code will be included into the Julia Console
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and executed there. You can interact with the iJulia in the Julia Console like you would with any iJulia you use.

Tip: You can configure the Julia and Python versions you want to use in File->Settings.

The menu bar in the top of the application contains File, Edit, View, and Help menus. In the File menu you can create
a new project, open an existing project, save the project, upgrade an old project to modern directory-based project,
and open the application Settings among other things. Spine Toolbox is project based, which means that you need to
create a new project or open an existing one before you can do anything. You can create a new project by selecting
File->New project... from the menu bar. Drag & Drop Icon tool bar contains the available project item types.
The button can be used to remove all items from your project. The Execute icons control the execution of the items in
the Design view where you build your project. The button executes all Directed-Acyclic Graphs (DAG) in the project
in arow. The button executes the selected project items only. The button terminates the execution (if running).

You can add a new project item to your project by pointing your mouse cursor on any of the draggable items in the Drag
& Drop Icon tool bar, then click-and-drag the item on to the Design view. After this you will be presented a dialog,
which asks you to fill in basic information about the new project item (name, description, etc.).

The main window is very customizable so you can e.g. close the dock widgets that you do not need and/or you can
resize the views to fit your needs and display size or resolution.

Note: If you want to restore all dock widgets to their default place use the menu item View->Dock
Widgets->Restore Dock Widgets. This will show all hidden dock widgets and restore them to the main window.

Below is an example on how you can customize the main window. In the picture, a user has created a project My
First Project, and created one project item from each of the seven categories. A Data Store called Database, a Data
Connection called Data files, A Tool called Julia model, a View called View, an Importer called Importer, an Exporter
called Exporter, and a Manipulator called Combiner. The project items are also listed in the Project dock widget.
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«» My First Project [C:/data/Spine Toolbox Projects/My First Project] - Spine Toolbox - O X

File Edit View Help

e EBE S o 8 A I oo [£]4] 0 O[®@

Project & X | Design View Properties F X
“ Data Stores . 2
E Data Store Data Store Data Connection Julia Tool
“ Data Connections 1 1 1
Bj Data Connecti ~—] - N
ata Connection = /
v Tools -
% Julia Tool
v Views
iR View View Importer Exporter
* |Importers 1 1
3 Imperter - - Select a project item to view its properties
v Exporters -{’ =+
= Exporter
v Manipulators .
I:E Combiner Combiner
1) '
v
Event Log & X Processlog & ¥ JuliaConsole @ ¥ | Python Console F X
t Gimlet add
Tool added
My First Project s
mbiner Combiner add
My First Project s w w
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CHAPTER
SIX

PROJECT ITEMS

* Project Item Properties
* Project Item Descriptions
— Data Store data_store
— Data Connection data_connection
— Tool tool
— Gimlet gimlet
— Data Transformer data_transformer
— View view
— Importer importer

— Exporter exporter

— GdxExporter gdx-exporter

Project items in the Design view and the connections between them make up the graph (Directed Acyclic Graph, DAG)
that is executed when the or buttons are pressed.

See Executing Projects for more information on how a DAG is processed by Spine Toolbox. Those interested in looking
under the hood can check the Project item development section.

6.1 Project Item Properties

Each project item has its own set of Properties. You can view and edit them by selecting a project item on the Design
View. The Properties are displayed in the Properties dock widget on the main window. Project item properties are
saved into the project save file (project. json), which can be found in <proj_dir>/.spinetoolbox/ directory,
where <proj_dir> is your current project directory.

In addition, each project item has it’s own directory in the <proj_dir>/.spinetoolbox/items/ directory. You can
quickly open the project item directory in a file explorer by clicking on the button located in the lower right corner of
each Properties form.
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6.2 Project Item Descriptions

The following items are currently available:

6.2.1 Data Store
A Data store item represents a connection to a (Spine) database. Currently, the item supports sqlite and mysql dialects.

The database can be accessed and modified in Spine db editor available by double-clicking a Data store on the Design
view, from the item’s properties, or from a right-click context menu.

6.2.2 Data Connection

A Data connection item provides access to data files. The item has two categories of files: references connect to files
anywhere on the file system while data files reside in the item’s own data directory.

6.2.3 Tool

Tool is the heart of a DAG. It is usually the actual model to be executed in Spine Toolbox but can be an arbitrary script
or executable as well. A tool is specified by its specification.

6.2.4 Gimlet

While being able to run most scripts and copyable executables, Tool cannot handle system commands or executables
meant to run from system’s path. This is a job for Gimlet. A Gimlet can execute an arbitrary system command with
given command line arguments, input files and work directory.

6.2.5 Data Transformer
Data transformers set up database manipulators for successor items in a DAG. They do not transform data themselves;

rather, Spine Database API does the transformations configured by Data transformers when the database is accessed.
Currently supported transformations include entity class and parameter renaming.

6.2.6 View

A View item is meant for inspecting data from multiple sources using the Spine db editor. Note that the data is opened
in read-only mode so modifications are not possible from the View item.

6.2.7 Importer

This item provides the user a chance to define a mapping from tabulated data such as comma separated values or Excel
to the Spine data model. See Importing and exporting data for more information.
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6.2.8 Exporter

Exporter outputs database data into tabulated file formats that can be consumed by Tool or used e.g. by external software
for analysis. See Importing and exporting data for more information.

6.2.9 GdxExporter

Note: GdxExporter is pending for removal and its use in new projects is discouraged. Use Exporter instead.

This item exports databases contained in a Data Store into . gdx format for GAMS Tools. See Importing and exporting
data for more information.
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CHAPTER
SEVEN

TOOL SPECIFICATION EDITOR

This section describes how to make a new Tool specification and how to edit existing Tool specifications.

To execute a Julia, Python, GAMS, or an executable script in Spine Toolbox, you must first create a Tool specification
for your project. You can open the Tool specification editor in several ways. One way is to press the arrow next to the
Tool icon in the toolbar to expand the Tool specifications, and then press the New... button.

Main E /\’“ - ‘

Mew...

When you press New... the following form pops up;

Tool specification editor (]

<unnamed specification> & | +

Name: |Enter specification name here... | Description: |Enter specification description here... =

Tool type j Command line arguments: | Type arguments here... v| Execute in work directary

Program files [E]ES) (=)
Main program file O

Additional program files OEWd

Input & output files @
Input files B m
Optional input files IS
Qutput files B m

| Main program dir: |

Start by giving the Tool specification a name. Then select the type of the Tool. You have four options (Julia, Python,
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GAMS or Executable). Then select, whether you want the Tool specification to be executed in the work directory or in
its source directory (See Terminology section). You can give the Tool specification a description, describing what the
Tool specification does. Main program file is the main file of your tool, i.e. a script that can be passed to Julia, Python,
GAMS, or the system shell. You can create a blank file by pressing the button, or you can browse to find an existing
main program file by pressing the button.

Command line arguments can be appended to the actual command that Spine Toolbox executes in the background. For
example, you may have a Windows batch file called do_things.bat, which accepts command line arguments a and b.
Writing a b on the command line arguments field in the tool specification editor is the equivalent of running the batch
file in command prompt with the command do_things.bat a b.

Additional source files is a list of files that the main program requires in order to run. You can add individual files or
whole directories at once to this list.

Tip: You can also drag&drop a directory from your operating systems File Explorer into the Additional source files
list.

Input files is a list of input data files that the program requires in order to execute. You can also add directories and
subdirectories. Wildcards are not supported (see Optional input files).

Examples:
* data.csv -> File is copied to the same work directory as the main program
* input/data.csv -> Creates directory input/ to the work directory and copies file data.csv there
¢ output/ -> Creates an empty directory output/ into the work directory

Optional input files are files that may be utilized by your program if they are found. Unix-style wildcards ? and * are
supported.

Examples:
* data.csv -> If found, file is copied to the same work directory as the main program
* *.csv -> All found .csv files are copied to the same work directory as the main program

* input/data_?.dat -> All found files matching the pattern data_?.dat are copied into input/ directory in the work
directory.

Output files are files that will be archived into a timestamped result directory of the Tool’s project directory after the
Tool specification has finished execution. Unix-style wildcards ? and * are supported.

Examples:
* results.csv -> File is copied from work directory into results directory
* *.csv -> All .csv files from work directory are copied into results directory

* output/*.gdx -> All GDX files from the work directory’s output/ subdirectory will be copied to into output/
subdirectory in the results directory.

When you are happy with your Tool specification, press Ctrl+S to save it. You will see a message in the Event log
(back in the main Spine Toolbox window), specifying the path of the saved specification file. The Tool specification
file is a text file in JSON format and has an extension .json You can change the location by pressing [change]. Also,
you need to save your project for the specification to stick.

Tip: Only name, type, and main program file fields are required to make a Tool specification. The other fields are
optional.
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Here is a minimal Tool specification for a Julia script script.jl

Tool specification editor (]

Example Tool specification* 3 | 4

Name: |Example Tool specification Description: |Enter specification description here...
Tool type | Julia ~ || Command line arguments: Type arguments here... v| Execute in work directary
Program files @& script.jl @®

~ Main program file OR println{"Hello from Spine Toolbox")|

Additional program files ODOEm@d

Input & output files @
Input files g m
Optional input files B m
Qutput files 5]

Main program dir: ftmp

Note: Under the hood, the contents of the Tool specification are saved to a Tool specification file in JISON format.
Users do not need to worry about the contents of these files since reading and writing them is managed by the app. For
the interested, here are the contents of the Tool specification file that we just created.:

{
"name": "Example Tool specification",
"description": "",

"tooltype": "julia",

"execute_in_work": true,

"includes": [
"script.jl"”

1,

"inputfiles": [],

"inputfiles_opt": [],

"outputfiles": [],

"cmdline_args": ""

After you have saved the specification, the new Tool specification has been added to the project.
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2 e
Main E /"“ + /

Mew... Example Teol specification

To edit this Tool specification, just right-click on the Tool specification name and select Edit specification from the
context-menu.

You are now ready to execute the Tool specification in Spine Toolbox. You just need to select a Tool item in the Design
view, set the specification Example Tool specification for it, and click or button.
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CHAPTER
EIGHT

EXECUTING PROJECTS

This section describes how executing a project works and what resources are passed between project items at execution
time. Execution happens by pressing the (Execute project) or the (Execute selection) buttons in the main window tool
bar. A project consists of project items and connections (yellow arrows) that are visualized on the Design View. You
use the project items and the connections to build a Directed Acyclic Graph (DAG), with the project items as nodes
and the connections as edges. A DAG is traversed using the breadth-first-search algorithm.

Rules of DAGs:
1. A single project item with no connections is a DAG.

2. All project items that are connected, are considered as a single DAG (no matter, which direction the arrows go).
If there is a path between two items, they are considered as belonging to the same DAG.

3. Loops are not allowed (this is what acyclic means).

You can connect the nodes in the Design View how ever you want but you cannot execute the resulting DAGs if they
break the rules above. Here is an example project with three DAGs.
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Design View g X

e DAG 1: items: a, b, ¢, d. connections: a-b, a-c, b-d, c-d
¢ DAG 2: items: e, f. connections: e-f
* DAG 3: items: g. connections: None

The numbers on the upper left corners of the icons show the item’s execution ranks which roughly tell the order of
execution within a DAG. Execution order of DAG 1 is a->b->c->d or a->c->b->d because b and c are siblings which
is also indicated by their equal execution rank. DAG 2 execution order is e->f and DAG 3 is just g. All three DAGs are
executed in a row though which DAG gets executed first is undefined. Therefore all DAGs have their execution ranks
starting from 1.

After you press the button, you can follow the progress and the current executed item in the Event Log. Design view
also animates the execution.

Items in a DAG that breaks the rules above are marked by X as their rank. Such DAGs are skipped during execution.
The image below shows such a DAG where the items form a loop.
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Design View g X

view 1

_I_".;.—-___'__'_-_-____-_-_:___--- - _o_i

We use the words predecessor and successor to refer to project items that are upstream or downstream from a project
item. Direct predecessor is a project item that is the immediate predecessor while Direct Successor is a project item
that is the immediate successor. For example, in DAG 1 above, the successors of a are project items b, ¢ and d. The
direct successor of b is d. The predecessor of b is a, which is also its direct predecessor.

You can also execute only the selected parts of a project by multi-selecting the items you want to execute and pressing
the button in the tool bar. For example, to execute only items b, d and f, select the items in Design View or in the
project item list in Project dock widget and then press the button.

Tip: You can select multiple project items by holding the Ctrl-key down and clicking on desired items or by drawing
a rectangle on the Design view.

8.1 Example DAG

When you have created at least one Tool specification, you can execute a Tool as part of the DAG. The Tool specification
defines the process that is executed by the Tool project item. As an example, below we have two project items; Data
File Data Connection and Julia Model Tool connected to each other.
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4% First project [C:\data\Spine Teelbox Projects\First project] - Spine Toolbox - m] *
File Edit View Plugins Consoles Help

: 3 , ==

= - I TN WA, TP | W ey, JOXO!
Project 2 X | Design View & X  Data Connection Properties g X

Data Stores Data File
~ Data Connections

~
Data File References
v Tools .
Cihdatat\Spine Toelbox Projects\First project'data.csv
A Julia Model al P ! prel

Views

Importers

Exporters

Manipulators Julia Model

+ =B
Data
=

Event Log & X ltem Execution Log & X | |Julia Console g X

Select and execute a Julia Tool to see its console
Select and execute a project item to view its execution log

ct First project
ct First project Julia Console Python Console

In ths example, Data File has a single file reference data.csv. Data Connections make their files visible to direct
successors and thus the connection between Data File and Julia Model provides data.csv to the latter.

Selecting the Julia Model shows its properties in the Properties dock widget.
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«5 First project [C\data\Spine Toolbox Projects\First project] - Spine Toolbox - m} X
File Edit View Plugins Consoles Help
h Y s
- [
= - AN TN WA, B Y L W e » XOXO)
Project & X Design View & X  Tool Properties g X
Data Stores Julia Model
~ Data Connections
B Data File Specification | A Julia Model Specification | |
~ Tools X .
A Julia Model Sysimage | =
Views Command line arguments
Importers
Exporters Specification arguments
i v Tool arguments
Manipulators Data File Julia Model rgaments
_________ Type new arg here...
1 | [2 ]
b g \ i
.
E 5 A
HI I - 5
Awailable resources
@ data.csv
Executein ®) Work directory () Source directory =)
Event Log & ¥ | ltem Execution Log 2 ¥ Julia Console g X
Select and execute a Julia Tool to see its console
Select and execute a project item to view its execution log
Julia Console Python Console

In the top of the Tool Properties, there is a specification drop-down menu. From this drop-down menu, you can select
the Tool specification for this particular Tool item. The Julia Model Specification tool specification has been selected
for Julia Model. Below the drop-down menu, you can choose a precompiled sysimage and edit Tool’s command line
arguments. Note that the command line argument editor already ‘sees’ the data.csv file provided by Data File.
Results... button opens the Tool’s result archive directory in system’s file browser (all Tools have their own result
directory). The Execute in radio buttons control, whether this Tool is first copied to a work directory and executed
there, or if the execution should happen in the source directory where the main program file is located.

When you click on the button, the execution starts from the Data File Data Connection as indicated by the execution
rank numbers. When executed, Data Connection items advertise their files and references to project items that are their
direct successors. In this particular example, data.csv contained in Data File is also a required input file in Julia
Model Specification. When it is the Julia Model tool’s turn to be executed, it checks if it finds the data.csv from its
direct predecessor items that have already been executed. Once the input file has been found the Tool starts processing
the main program file script.jl. Note that if the connection would be the other way around (from Julia Model to Data
File) execution would start from the Julia Model and it would fail because it cannot find the required data.csv. The
same thing happens if there is no connection between the two project items. In this case the project items would be in
separate DAGs.

Since the Tool specification type was set as Julia and the main program is a Julia script, Spine Toolbox starts the
execution in the Julia Console (if you have selected this in the application Settings, See Settings section).
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CHAPTER
NINE

EXECUTION MODES

You can execute Python or Julia Tools in the Jupyter Console or as in the shell. Gams Tools are only executed as in the
shell.

9.1 Python

9.1.1 Shell execution (default)

On Tools page in File->Settings. .., check the Run Python Tools in a subprocess radiobutton (release-0.6) or uncheck
the Jupyter Console check box (master). This is the default execution mode for Python Tools.

9.1.2 Jupyter Console / Python Console execution

If you want to use the embedded Python Console (Jupyter Console). Check the Run Python Tools in embedded console
radiobutton (release-0.6) or check the Jupyter Console check box (master). There is an extra step involved since the
Jupyter Console requires a couple of extra packages (ipykernel and its dependencies) to be installed on the selected
Python. In addition, kernel specifications for the selected Python need to be installed beforehand. Spine Toolbox can
install these for you, from the Kernel Spec Editor widget that you can open from the Tools page in File->Settings..
by clicking the Kernel Spec Editor button. In the Kernel Spec Editor, give the spec a name and click Make kernel
specification button.

Note: You can install Python kernel specifications manually and Spine Toolbox will find them. You can select the
kernel spec used in the Jupyter Console from the drop-down menu Select Python kernel spec... .

9.2 Julia

9.2.1 Shell execution (default)

On Tools page in File->Settings. . ., check the Run Julia Tools in a subprocess radiobutton (release-0.6) or uncheck the
Jupyter Console check box (master). This is the default execution mode for Julia Tools.
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9.2.2 Jupyter Console / Julia Console execution

Like the Python Console, Julia Console requires some extra setting up. The Julia Console requires a couple of additional
packages (IJulia, etc.) to be installed and built. Spine Toolbox can set this up for you automatically. Just click the
Kernel spec Editor button, give the spec a name and click Make kernel specification button.

Note: You can install Julia kernel specifications manually and Spine Toolbox will find them. You can select the kernel
spec used in the Jupyter Console from the drop-down menu Select Julia kernel spec.. ..
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CHAPTER
TEN

SETTINGS

Note: The images and some of the text are outdated. See tooltips in the app for up-to-date information.

You can open Spine Toolbox settings from the main window menu File->Settings.. ., or by pressing F1. Settings are
categorized into four tabs; General, Project, Tools, and View. In addition to application settings, each Project item has
user adjustable properties (See Project Items)

* General settings
* Project settings
* Tools settings
* View settings

» Application preferences

» Where are the application settings stored?
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10.1 General settings

General

[E—_ Ge e al
——
Dpen pre\inUS p oject at Star‘tup

" Project [ ] show confirm exit prompt
|:| Save project at exit
}& Tools Show date and time in Event Log messages
@ View |:| Delete data when project item is removed from project
Work directory
Using default directory | 1
Smooth zoom
Curved links
Design View background
() Grid @ solid
Data flow animation speed
Slow Fast

The General tab contains the general application settings.

Open previous project at startup If checked, application opens the project at startup that was open the last time
the application was shut down. If left unchecked, application starts without a project open.

Show confirm exit prompt If checked, confirm exit prompt is shown. If unchecked, application exits without
prompt.

Save project at exit Unchecked: Does not save project and does not show message box. Partially checked:
Shows message box (default). Checked: Saves project and does not show message box.

Show date and time in Event Log messages If checked, every Event Log message is prepended with a date and
time ‘tag’.

Delete data when project item is removed from project Check this box to delete project item’s data when a
project item is removed from project. This means, that the project item directory and its contents will be deleted
from your hard drive. You can find the project item directories from the <proj_dir>/.spinetoolbox/items/
directory, where <proj_dir> is your current project directory.

Work directory Directory where processing the Tool takes place. Default place (if left empty) is the /work
subdirectory of Spine Toolbox install directory. You can change this directory. Make sure to clean up the directory
every now and then.

Smooth zoom Controls the way zooming (by using the mouse wheel) behaves in Design View and in Spine
database editor. Controls if the zoom in/out is continuous or discrete. On older computers, smooth zoom is not
recommended (because it may be slower).
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* Curved links Controls the look of the arrows (connections) on Design View.

* Design View background Choosing grid shows a black grid as the Design View background. Choosing Solid
and then clicking on the square next to it let’s you choose the background color.

* Data flow animation speed This slider controls the speed of the ‘arrow’ animation on Design View when exe-
cution is about to start.

10.2 Project settings

== General Project
MName

%" project |Praject 1
Description

)& Tools

@ View

These settings affect the project that is currently open. To save the project to a new directory use the File->Save
project as... menuitem. Or you can simply copy the project directory anywhere on your file system.

* Name The default name for new projects is the name of the project directory. You can change the project name
here.

* Description You can type a description for your project here.
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10.3 Tools settings

——
+— General GAMS
GAMS executable
l;l Project Using system's default GAMS | |—3
Julia
Tools
2& Julia executable
) Using Julia executable in system path =
@ View | . |
|L|sing Julia home project | =
Use embedded Julia Console
Python
Python interpreter
|L|sing Python interpreter in system path | =
Use embedded Python Console

GAMS executable Path to GAMS executable you wish to use to execute GdxExporter project items and Tool
project items that use a GAMS Tool specification. See Setting up External Tools.

Julia executable Path to Julia executable you wish to use to execute 7ool project items that use a Julia Tool
specification. See Setting up External Tools.

Julia home project Set the Julia home project here.

Use embedded Julia Console Check this box to execute Tool project items that use a Julia Tool specification
in the built-in Julia Console. If you leave this un-checked, Julia Tool specifications will be executed as in the
shell. I.e on Windows this would be the equivalent to running command julia.exe example_script.jlin
the command prompt. If you decide to use the embedded Julia Console, the example_script. jl is included
into the console and executed there.

Python interpreter Path to Python executable you wish to use to execute Tool project items that use a Python
Tool specification. See Setting up External Tools.

Use embedded Python Console Check this box to execute Python Tool specifications in the embedded Python
Console. If you un-check this box, Python Tool specifications will be executed as in the shell. I.e on Windows
this would be the equivalent to running command python.exe script.py in the command prompt. If you
decide to use the embedded Python Console, script.py is executed there instead.
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10.4 View settings

E General
" Project

}& Tools

@ View

Data store view

[m] Commit session when view is closed

[ ] sticky selection in object tree

Cancel

¢ Commit session when view is closed This checkbox controls what happens when you close the Spine database
editor which has uncommitted changes. When this is unchecked, all changes are discarded without notice. When
this is partially checked (default), a message box warning you about uncommitted changes is shown. When this

is checked, a commit message box is shown immediately without first showing the message box.

« Sticky selection in object tree Controls how selecting items in Spine database editor’s Object tree using the
left mouse button works. If unchecked, single selection is enabled and pressing the Ctrl-button down enables
multiple selection. If checked, Multiple selection is enabled and pressing the Ctrl-button down enables single

selection.
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10.5 Application preferences

Spine Toolbox remembers the size, location, and placement of most of the application windows from the previous
session (i.e. when closing and restarting the app).

10.6 Where are the application settings stored?

Application settings and preferences (see above) are saved to a location that depends on your operating system. On
Windows, they are stored into registry key HKEY_CURRENT_USER\Software\SpineProject\Spine Toolbox. Itis
safe to delete this key if you want to reset Spine Toolbox to factory defaults.

Note: If you are looking for information on project item properties, see Project Items.
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CHAPTER
ELEVEN

WELCOME TO SPINE DATABASE EDITOR’S USER GUIDE!

Spine database editor is a dedicated component of Spine Toolbox, that you can use to visualize and edit data in one or
more Spine databases.

11.1 Getting started

* Launching the editor
— From Spine Toolbox

— From the command line

* Knowing the Ul

11.1.1 Launching the editor

From Spine Toolbox

To open a single database in Spine database editor:

1. Create a Data Store project item.

2. Select the Data Store.

3. Enter the url of the database in Data Store Properties.

4. Press the Open editor button in Data Store Properties.
To open multiple databases in Spine database editor:

1. Repeat steps 1 to 3 above for each database.

2. Create a View project item.

3. Connect each Data Store item to the View item.
4. Select the View item.
5

. Press Open editor in View Properties.
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From the command line

To open a single database in Spine database editor, use the spine-db-editor application which comes with Spine
Toolbox:

spine-db-editor

...url of the database..."

Note

that for e.g. an SQLite database, the url should start with ‘sqlite:’.

11.1.2 Knowing the Ul

The form has the following main UI components:

Entity trees (Object tree and Relationship tree): they present the structure of classes and entities in all databases
in the shape of a tree.

Stacked tables (Object parameter value, Object parameter definition, Relationship parameter value, and Rela-
tionship parameter definition): they present object and relationship parameter data in the form of stacked tables.

Pivot table and Frozen table: they present data for a given class in the form of a pivot table, optionally with
frozen dimensions.

Entity graph: it presents the structure of classes and entities in the shape of a graph.
Tool/Feature tree: it presents tools, features, and methods defined in the databases.
Parameter value list: it presents parameter value lists available in the databases.
Alternative/Scenario tree: it presents scenarios and alternatives defined in the databases.

Parameter tag: it presents parameter tags defined in the databases.

Tip:

You can customize the Ul from the View and Pivot sections in the hamburger menu.

11.2 Viewing data

This section describes the available tools to view data.

» Viewing entities and classes
— Using Entity trees
— Using Entity graph
% Building the graph
% Manipulating the graph
» Viewing parameter definitions and values
— Using Stacked tables
» Viewing parameter values and relationships

— Using Pivot table and Frozen table

* Selecting the input type
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* Pivoting and freezing

% Filtering
e Viewing alternatives and scenarios
* Viewing tools and features

» Viewing parameter value lists

» Viewing parameter tags

11.2.1 Viewing entities and classes

Using Entity trees

Entity trees present the structure of classes and entities in all databases in the shape of a tree:

Object tree

name dat™
~ root EXE
v electricity eXE
eXE

Fa exe

- & hode__commodity exe
& €electricity_node eXE

e eXE

v water EXE
eXE

Fa exe

- & hode__commodity exe
& Bastusel_lower eXE

& DBastusel_upper exe

& Bergnds_lower eXE

& DbBergnas_upper exe

& Batfors_lower eXE

& DBatfors_upper exe

& Finnfors_lower eXE

& Finnfors_upper exe

& Gallejaur_lower EXE >

In Object tree:

» To view all object classes from all databases, expand the root item (automatically expanded when loading the
form).

 To view all objects of a class, expand the corresponding object class item.

» To view all relationship classes involving an object class, expand any objects of that class.

11.2. Viewing data 101



Spine Toolbox Documentation, Release 0.6.6.dev0-dev.0

 To view all relationships of a class involving a given object, expand the corresponding relationship class item
under the corresponding object item.

In Relationship tree:

 To view all relationship classes from all databases, expand the root item (automatically expanded when loading
the form).

* To view all relationships of a class, expand the corresponding relationship class item.

Note: To expand an item in Object tree or Relationship tree, double-click on the item or press the right arrow while it’s
active. Items in gray don’t have any children, thus they cannot be expanded. To collapse an expanded item, double-click
on it again or press the left arrow while it’s active.

Tip: To expand or collapse an item and all its descentants in Object tree or Relationship tree, right click on the item
to display the context menu, and select Fully expand or Fully collapse.

Tip: In Object tree, the same relationship appears in many places (as many as it has dimensions). To jump to the next
ocurrence of a relationship item, either double-click on the item, or right-click on it to display the context menu, and
select Find next.

Using Entity graph

Entity graph presents the structure of classes and entities from one database in the shape of a graph:
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Entity graph (=]
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Tip: To see it in action, check out this video.

Building the graph

To build the graph, select any number of items in either Object tree or Relationship tree. What is included in the graph
depends on the specific selection you make:

* Toinclude all objects and relationships from the database, select the root item in either Object tree or Relationship
tree.

 To include all objects of a class, select the corresponding class item in Object tree.
* To include all relationships of a class, select the corresponding class item in Relationship tree.

* To include all relationships of a specific class involving a specific object, select the corresponding relationship
class item under the corresponding object item in Object tree.

* To include specific objects or relationships, select the corresponding item in either Object tree or Relationship
tree.

Note: In Entity graph, a small unnamed vertex represents a relationship, whereas a bigger named vertex represents an
object. An arc between a relationship and an object indicates that the object is a member in that relationship.
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The graph automatically includes relationships whenever all the member objects are included (even if these relation-
ships are not selected in Object tree or Relationship tree). You can change this behavior to automatically include rela-
tionships whenever any of the member objects are included. To do this, enable Auto-expand objects via the Graph
menu, or via Entity graph’s context menu.

Tip: To extend the selection in Object tree or Relationship tree, press and hold the Ctrl key while clicking on the
items.

Tip: Object tree and Relationship tree also support Sticky selection, which allows one to extend the selection by
clicking on items without pressing Ctrl. To enable Sticky selection, select Settings from the hamburger menu, and
check the corresponding box.

Manipulating the graph

You can move items in the graph by dragging them with your mouse. By default, each items moves individually. To
make relationship items move along with their member objects, select Settings from the hamburger menu and check
the box next to, Move relationships along with objects in Entity graph.

To display Entity graph’s context menu, just right-click on an empty space in the graph.

* To save the position of items into the database, select the items in the graph and choose Save positions from
the context menu. To clear saved positions, select the items again and choose Clear saved positions from the
context menu.

* To hide part of the graph, select the items you want to hide and choose Hide from context menu. To show the
hidden items again, select Show hidden from the context menu.

* To prune the graph, select the items you want to prune and then choose Prune entities or Prune classes from
the context menu. To restore specific prunned items, display the context menu, hover Restore and select the
items you want to restore from the popup menu. To restore all prunned items at once, select Restore all from
the context menu.

* To zoom in and out, scroll your mouse wheel over Entity graph or use Zoom buttons in the context menu.

* To rotate clockwise or anti-clockwise, press and hold the Shift key while scrolling your mouse wheel, or use the
Rotate buttons in the context menu.

* To adjust the arcs’ lenght, use the Arc length buttons in the context menu.
* To rebuild the graph after moving items around, select Rebuild graph from the context menu.

 To export the current graph as a PDF file, select Export graph as PDF from the context menu.

Note: Entity graph supports extended selection and rubber-band selection. To extend a selection, press and hold Ctrl
while clicking on the items. To perform rubber-band selection, press and hold Ctrl while dragging your mouse around
the items you want to select.

Note: Prunned items are remembered across graph builds.

To display an object or relationship item’s context menu, just right-click on it.
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* To expand or collapse relationships for an object item, hover Expand or Collapse and select the relationship
class from the popup menu.

11.2.2 Viewing parameter definitions and values

Using Stacked tables

Stacked tables present object and relationship parameter data from all databases in the form of stacked tables:

Object parameter value

object_class_name
& model
K model
K model
&5 node
&= node
&5 node
&= node
&5 node
&5 hode
&= node
&5 node
&= node
&5 node
&5 hode
&= node
&5 node
&= node
&5 node

object_name

instance
instance
instance
Bastusel_upper
Bastusel_upper
Bastusel_upper
Bastusel_upper
Bergnas_upper
Bergnas_upper
Bergnas_upper
Bergnas_upper
Batfors_upper
Batfors_upper
Batfors_upper
Batfors_upper
Finnfors_upper
Finnfors_upper
Finnfors_upper

parameter_name
duration_unit

model_end
model_start
demand
fix_node_state
has_state
node_state_cap
demand
fix_node_state
has_state
node_state_cap
demand
fix_node_state
has_state
node_state_cap
demand
fix_node_state
has_state

hour

value

2019-01-08 00:00:00
2019-01-01 00:00:00

-0.2579768519
Time series

value_true

8208.0
-22.29
Time series

value_true

216120.0
-2.0
Time series

value_true

1330.0
0.0
Time series

value_true

)
database =

example
example
example
example
example
example
example
example
example
example
example
example
example
example
example
example
example
example

-

To filter Stacked tables by any entities and/or classes, select the corresponding items in either Object tree, Relationship
tree, or Entity graph. To remove all these filters, select the root item in either Object tree or Relationship tree.

To filter parameter definitions and values by certain parameter tags, select those tags in Parameter tag toolbar.

To apply a custom filter on a Stacked table, click on any horizontal header. A menu will pop up listing the items in the

corresponding column:
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Remove filters

(4]
5}
[aT]
™
—

(Select All) -
Bastusel_upper

Bergnas_upper

Batfors_upper

Finnfors_upper

Gallejaur_upper

Granfors_upper

Grytfors_upper

Krangfors_upper

irirtFarcmnam  immne

Uncheck the items you don’t want to see in the table and press Ok. Additionally, you can type in the search bar at the
top of the menu to filter the list of items. To remove the current filter, select Remove filters.

Y

To filter a Stacked table according to a selection of items in the table itself, right-click on the selection to show the
context menu, and then select Filter by or Filter excluding. To remove these filters, select Remove filters from the
header menus of the filtered columns.

Tip: You can rearrange columns in Stacked tables by dragging the headers with your mouse. The ordering will be
remembered the next time you open Spine DB editor.

11.2.3 Viewing parameter values and relationships
Using Pivot table and Frozen table

Pivot table and Frozen table present data for an individual class from one database in the form of a pivot table, optionally
with frozen dimensions:
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Pivot table

connection

Bastusel_to_Grytfors_disch
Bastusel_to_Grytfors_spill
Bergnas_to_Slagnas_disch
Bergnas_to_Slagnas_spill
Batfors_to_Finnfors_disch
Batfors_to_Finnfors_spill
Finnfors_to_Granfors_disch
Finnfors_to_Granfors_spill
Gallejaur_to_Vargfors_disch
Gallejaur_to_Vargfors_spill
Granfors_to_Krangfors_disch
Granfors_to_Krangfors_spill
Grytfors_to_Gallejaur_disch
Grytfors_to_Gallejaur_spill
Krangfors_to_Selsfors_disch
Krangfors_to_Selsfors_spill
Rebnis_to_Bergnas_disch
Rebnis_to_Bergnas_spill
Rengard_to_Batfors_disch
Rengard_to_Batfors_spill
Sadva_to_Bergnds_disch
Sadva_to_Bergnas_spill
Selsfors_to_Kvistforsen_disch
Selsfors_to_Kvistforsen_spill
Slagnds_to_Bastusel_disch
Slagnas_to_Bastusel_spill
Vargfors_to_Rengard_disch

VWinwmFrer o oo ied  — el

|

nodel
Grytfors_upper
Grytfors_upper
Slagnas_upper
Slagnas_upper
Finnfors_upper
Finnfors_upper
Granfors_upper
Granfors_upper
Vargfors_upper
Vargfors_upper

Krangfors_upper
Krangfors_upper

Gallejaur _upper
Gallejaur_upper
Selsfors_upper
Selsfors_upper
Bergnas_upper
Bergnas_upper
Batfors_upper

Batfors_upper

Bergnas_upper
Bergnas_upper

Kvistforsen_upper
Kvistforsen_upper

Bastusel_upper
Bastusel_upper
Rengard_upper

Meamefed e e

parameter »

node?2 -

Bastusel_lower
Bastusel_upper
Bergnas_lower
Bergnas_upper
Batfors_lower
Batfors_upper
Finnfors_lower
Finnfors_upper
Gallejaur_lower
Gallejaur_upper
Granfors_lower
Granfors_upper
Grytfors_lower

Grytfors_upper
Krangfors_lower

Krangfors_upper

Rebnis_lower
Rebnis_upper
Rengard_lower
Rengard_upper
Sadva_lower
Sadva_upper
Selsfors_lower
Selsfors_upper
Slagnas_lower
Slagnas_upper
Vargfors_lower

LI R R T

& )

.

connection_... fiy

1h
150m
1h

1h

3h

3h

3h

3h
30m
150m
3h

3h
15m
15m

A

b

To populate the tables with data for a certain class, just select the corresponding class item in either Object tree or

Relationship tree.
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Selecting the input type

Pivot table and Frozen table support four different input types:

* Parameter value (the default): it shows objects, parameter definitions, alternatives, and databases in the headers,
and corresponding parameter values in the table body.

* Index expansion: Similar to the above, but it also shows parameter indexes in the headers. Indexes are extracted
from special parameter values, such as time-series.

* Relationship: it shows objects, and databases in the headers, and corresponding relationships in the table body.
It only works when selecting a relationship class in Relationship tree.

 Scenario: it shows scenarios, alternatives, and databases in the header, and corresponding rank in the table body.

You can select the input type from the Pivot section in the hamburger menu.

Note: In Pivot table, header blocks in the top-left area indicate what is shown in each horizontal and vertical header.
For example, in Parameter value input type, by default, the horizontal header has two rows, listing alternative and
parameter names, respectively; whereas the vertical header has one or more columns listing object names.

Pivoting and freezing

To pivot the data, drag a header block across the top-left area of the table. You can turn a horizontal header into a
vertical header and viceversa, as well as rearrange headers vertically or horizontally.

To freeze a dimension, drag the corresponding header block from Pivot table into Frozen table. To unfreeze a frozen
dimension, just do the opposite.

Note: Your pivoting and freezing selections for any class will be remembered when switching to another class.
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Filtering

To apply a custom filter on Pivot table, click on the arrow next to the name of any header block. A menu will pop up
listing the items in the corresponding row or column:

Remove filters

(]
5]
[aT]
s}
—

(Select All) -
Bastusel_upper

Bergnas_upper

Batfors_upper

Finnfors_upper

Gallejaur_upper

Granfors_upper

Grytfors_upper

Krangfors_upper

L rictFmrmnm  simmne

Uncheck the items you don’t want to see in the table and press Ok. Additionally, you can type in the search bar at the
top of the menu to filter the list of items. To remove the current filter, select Remove filters.

N N

To filter the pivot table by an individual vector across the frozen dimensions, select the corresponding row in Frozen
table.

11.2.4 Viewing alternatives and scenarios

You can find alternatives and scenarios from all databases under Alternative/Scenario tree:
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Alternative/Scenario tree (%
name de
* & input
- -'F alternative
Base
altl
alt2
alt3
Type new alternative name here...
~ EH scenario
b scenl
* scen2
b scen3
Type new scenario name here...
| ¥
To view the alternatives and scenarios from each database, expand the root item for that database. To view all alter-

natives, expand the alternative item. To view all scenarios, expand the scenario item. To view the alternatives for a
particular scenario, expand the scenario_alternative item under the corresponding scenario item.

11.2.5 Viewing tools and features

You can find tools, features, and methods from all databases under Tool/Feature tree:
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Tool/Feature tree () ()

name description

* & input

~ W feature

commodity/fis_active boolean_vz
connection/is_active boolean_vs:
model/is_active boolean_v:
nodefis_active boolean_v:
output/is_active boolean_vs:
reportfis_active boolean_vz

stochastic_scenario/is_active boolean_v:
stochastic_structurefis_active boolean_v:

temporal_block/is_active boolean_vz
unitfis_active boolean_vs:
unit_constraint/is_active boolean_v:
Enter new feature here...

~ A tool

+ object_activity _control
Type new tool name here...

i b

To view the features and tools from each database, expand the root item for that database. To view all features, ex-
pand the feature item. To view all tools, expand the tool item. To view the features for a particular tool, expand the
tool_feature item under the corresponding tool item. To view the methods for a particular tool-feature, expand the
tool_feature_method item under the corresponding tool-feature item.

11.2.6 Viewing parameter value lists

You can find parameter value lists from all databases under Parameter value list:
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Parameter value list 3]
~ & root (example)
¢+ balance_type_list
- commodity_physics_list
commodity_physics_ptdf
commodity_physics _lodf
commodity_physics_none
Type new list value here...
» constraint_sense
+ duration_unit_list
+ node_opf_type_list
+ truth_value_list
+ unit_online_variable_type_..
~ Type new list name here...
Type new list value here...

To view the parameter value lists from each database, expand the root item for that database. To view the values for
each list, expand the corresponding list item.

11.2.7 Viewing parameter tags

You can find parameter tags from all databases under Parameter tag:

Parameter tag @ 6|

tag description

* & input !
W some_tag

Type new tag here...

To view the tags from each database, expand the root item for that database.
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11.3 Adding data

This section describes the available tools to add new data.

* Adding object classes
— From Object tree
* Adding objects
— From Object tree or Entity graph
— From Pivot table
— Duplicating objects
* Adding object groups
* Adding relationship classes
— From Object tree or Relationship tree
* Adding relationships
— From Object tree or Relationship tree
— From Pivot table
— From Entity graph
* Adding parameter definitions
— From Stacked tables
— From Pivot table
* Adding parameter values
— From Stacked tables
— From Pivot table
* Adding tools, features, and methods
* Adding alternatives and scenarios
— From Alternative/Scenario tree
— From Pivot table

» Adding parameter value lists

* Adding parameter tags
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11.3.1 Adding object classes

From Object tree
Right-click on the root item in Object tree to display the context menu, and select Add object classes.

The Add object classes dialog will pop up:

object class name description display icon databases
1 (<) example

Enter the names of the classes you want to add under the object class name column. Optionally, you can enter a descrip-
tion for each class under the description column. To select icons for your classes, double click on the corresponding
cell under the display icon column. Finally, select the databases where you want to add the classes under databases.
When you’re ready, press OKk.

11.3.2 Adding objects

From Object tree or Entity graph

Right-click on an object class item in Object tree, or on an empty space in the Entity graph, and select Add objects
from the context menu.

The Add objects dialog will pop up:
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object class name object name description databases
1 example

Enter the names of the object classes under object class name, and the names of the objects under object name. To
display a list of available classes, start typing or double click on any cell under the object class name column. Optionally,
you can enter a description for each object under the description column. Finally, select the databases where you want
to add the objects under databases. When you’re ready, press OKk.

From Pivot table

To add an object to a specific class, bring the class to Pivot table using any input type (see Using Pivot table and Frozen
table). Then, enter the object name in the last cell of the header corresponding to that class.

Duplicating objects

To duplicate an existing object with all its relationships and parameter values, right-click over the corresponding object
item in Object tree to display the context menu, and select Duplicate object. Enter a name for the duplicate and press
Ok.
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11.3.3 Adding object groups

Right-click on an object class item in Object tree, and select Add object group from the context menu.

The Add object group dialog will pop up:

Add object group €3

Group name: rﬁ;pe group nam... Database input -

Mon members Members
electricity

k>
T

Crganee | ox

Enter the name of the group, adn select the database where you want the group to be created. Select the member objects
under Non members, and press the button in the middle that has a plus sign. Multiple selection works.

When you’re happy with your selections, press Ok to add the group to the database.

11.3.4 Adding relationship classes

From Object tree or Relationship tree

Right-click on an object class item in Object tree, or on the root item in Relationship tree, and select Add relationship
classes from the context menu.

The Add relationship classes dialog will pop up:
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'

Mumber of dimensions |1

object class name (1) relationship class name description databases
1 example

x Cancel + OK

Select the number of dimensions using the spinbox at the top; then, enter the names of the object classes for each
dimension under each object class name column, and the names of the relationship classes under relationship class
name. To display a list of available object classes, start typing or double click on any cell under the object class name
columns. Optionally, you can enter a description for each relationship class under the description column. Finally,
select the databases where you want to add the relationship classes under databases. When you’re ready, press OK.

11.3.5 Adding relationships

From Object tree or Relationship tree

Right-click on a relationship class item either in Object tree or Relationship tree, and select Add relationships from
the context menu.

The Add relationships dialog will pop up:
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Relationship class | connection__from_node (connection,node) -
connection node relationship name databases

1 example

&

Ceona ] o

Select the relationship class from the combo box at the top; then, enter the names of the objects for each member object
class under the corresponding column, and the name of the relationship under relationship name. To display a list of
available objects for a member class, start typing or double click on any cell under that class’s column. Finally, select
the databases where you want to add the relationships under databases. When you’re ready, press OK.

From Pivot table

To add a relationship for a specific class, bring the class to Pivot table using the Relationship input type (see Using Pivot
table and Frozen table). The Pivot table headers will be populated with all possible combinations of objects across the
member classes. Locate the objects you want as members in the new relationship, and check the corresponding box in
the table body.

From Entity graph

Make sure all the objects you want as members in the new relationship are in the graph. To start the relationship, either
double click on one of the object items, or right click on it to display the context menu, and choose Add relationships.
A menu will pop up showing the available relationship classes. Select the class you want; the mouse cursor will adopt
a cross-hairs shape. Click on each of the remaining member objects, one by one and in the right order, to add them to
the relationship. Once you’ve added enough objects for the relationship class, a dialog will pop up. Check the boxes
next to the relationships you want to add, and press Ok.

Tip: All the Add... dialogs support pasting tabular (spreadsheet) data from the clipboard. Just select any cell in the
table and press Ctrl+V. If needed, the table will grow to accommodate the exceeding data. To paste data on multiple
cells, select all the cells you want to paste on and press Ctrl+V.
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11.3.6 Adding parameter definitions

From Stacked tables

To add new parameter definitions for an object class, just fill the last empty row of Object parameter definition. Enter
the name of the class under object_class_name, and the name of the parameter under parameter_name. To display a
list of available object classes, start typing or double click under the object_class_name column. Optionally, you can
also specify a default value, a parameter value list, or any number of parameter tags under the appropriate columns.
The parameter is added when the background of the cells under object_class_name and parameter_name become gray.

To add new parameter definitions for a relationship class, just fill the last empty row of Relationship parameter defini-
tion, following the same guidelines as above.

From Pivot table

To add a new parameter definition for a class, bring the corresponding class to Pivot table using the Parameter value
input type (see Using Pivot table and Frozen table). The parameter header of Pivor table will be populated with
existing parameter definitions for the class. Enter a name for the new parameter in the last cell of that header.

11.3.7 Adding parameter values

From Stacked tables

To add new parameter values for an object, just fill the last empty row of Object parameter value. Enter the name of the
class under object_class_name, the name of the object under object_name, the name of the parameter under parame-
ter_name, and the name of the alternative under alternative_name. Optionally, you can also specify the parameter value
right away under the value column. To display a list of available object classes, objects, parameters, or alternatives,
just start typing or double click under the appropriate column. The parameter value is added when the background of
the cells under object_class_name, object_name, and parameter_name become gray.

To add new parameter values for a relationship class, just fill the last empty row of Relationship parameter value,
following the same guidelines as above.

Note: To add parameter values for an object, the object has to exist beforehand. However, when adding parameter
values for a relationship, you can specify any valid combination of objects under object_name_list, and a relationship
will be created among those objects if one doesn’t yet exist.

From Pivot table

To add parameter value for any object or relationship, bring the corresponding class to Pivot table using the Parameter
value input type (see Using Pivot table and Frozen table). Then, enter the parameter value in the corresponding cell
in the table body.

Tip: All Stacked tables and Pivot table support pasting tabular (e.g., spreadsheet) data from the clipboard. Just select
any cell in the table and press Ctrl+V. If needed, Stacked tables will grow to accommodate the exceeding data. To
paste data on multiple cells, select all the cells you want to paste on and press Ctrl+V.
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11.3.8 Adding tools, features, and methods

To add a new feature, go to Tool/Feature tree and select the last item under feature in the appropriate database, start
typing or press F2 to display available parameter definitions, and select the one you want to become a feature.

Note: Only parameter definitions that have associated a parameter value list can become features.

To add a new tool, just select the last item under tool in the appropriate database, and enter the name of the tool.

To add a feature for a particular tool, drag the feature item and drop it over the tool_feature list under the corresponding
tool.

To add a new method for a tool-feature, select the last item under fool_feature_method (in the appropriate database),
start typing or press F2 to display available methods, and select the one you want to add.

11.3.9 Adding alternatives and scenarios

From Alternative/Scenario tree
To add a new alternative, just select the last item under alternative in the appropriate database, and enter the name of
the alternative.

To add a new scenario, just select the last item under scenario in the appropriate database, and enter the name of the
scenario.

To add an alternative for a particular scenario, drag the alternative item and drop it over the scenario_alternative list
under the corresponding scenario. The position where you drop it determines the alternative’s rank within the scenario.

Note: Alternatives with higher rank have priority when determining the parameter value for a certain scenario. If the
parameter value is specified for two alternatives, and both of them happen to coexist in a same scenario, the value from
the alternative with the higher rank is picked.

From Pivot table

Select the Scenario input type (see Using Pivot table and Frozen table). To add a new scenario, enter a name in the
last cell of the scenario header. To add a new alternative, enter a name in the last cell of the alternative header.

11.3.10 Adding parameter value lists
To add a new parameter value list, go to Parameter value list and select the last item under the appropriate database,
and enter the name of the list.

To add new values for the list, select the last empty item under the corresponding list item, and enter the value. To enter
a complex value, right-click on the empty item and select Open editor from the context menu.

Note: To be actually added to the database, a parameter value list must have at least one value.
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11.3.11 Adding parameter tags

To add a new parameter tag, go to Parameter tag and select the last item under the appropriate database, and enter the
tag’s name.

11.4 Updating data

This section describes the available tools to update existing data.

* Updating entities and classes
— From Object tree, Relationship tree, or Entity graph
— From Pivot table
* Updating parameter definitions and values
— From Stacked tables
— From Pivot table
* Updating alternatives and scenarios
— From Pivot table
— From Alternative/Scenario tree

* Updating tools and features

* Updating parameter value lists

11.4.1 Updating entities and classes

From Object tree, Relationship tree, or Entity graph
Select any number of entity and/or class items in Object tree or Relationship tree, or any number of object and/or
relationship items in Entity graph. Then, right-click on the selection and choose Edit... from the context menu.

One separate Edit... dialog will pop up for each selected entity or class type, and the tables will be filled with the
current data of selected items. E.g.:

object class name description display icon databases
1 commodity A commodity example
2 connection An entity where an energy transfer takes place & example
3/ model e example
4 node An entity where an energy balance takes place Egﬁ example
5 output e example
6 report e example
7 temporal_block A temporal block (L) example =

Modify the field(s) you want under the corresponding column(s). Specify the databases where you want to update each
item under the databases column. When you’re ready, press Ok.
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From Pivot table

To rename an object of a specific class, bring the class to Pivot table using any input type (see Using Pivot table and
Frozen table). Then, just edit the appropriate cell in the corresponding class header.

11.4.2 Updating parameter definitions and values

From Stacked tables

To update parameter data, just go to the appropriate Stacked table and edit the corresponding row.

From Pivot table

To rename parameter definitions for a class, bring the corresponding class to Pivot table using the Parameter value
input type (see Using Pivot table and Frozen table). Then, just edit the appropriate cell in the parameter header.

To modify parameter values for an object or relationship, bring the corresponding class to Pivor table using the Pa-
rameter value input type (see Using Pivot table and Frozen table). Then, just edit the appropriate cell in the table
body.

11.4.3 Updating alternatives and scenarios
From Pivot table

Select the Scenario input type (see Using Pivot table and Frozen table). To rename a scenario, just edit the proper cell
in the scenario header. To rename an alternative, just edit the proper cell in the alternative header.

From Alternative/Scenario tree

To rename a scenario or alternative, just edit the appropriate item in Alfernative/Scenario tree. To change scenario
alternative ranks, just drag and drop the items under scenario_alternatives.

11.4.4 Updating tools and features

To change a feature or method, or rename a tool, just edit the appropriate item in Tool/Feature tree.

11.4.5 Updating parameter value lists

To rename a parameter value list or change any of its values, just edit the appropriate item in Parameter value list.
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11.5 Removing data

This section describes the available tools to remove data.

* Removing entities and classes
— From Object tree, Relationship tree, or Entity graph
— From Pivot table
* Removing parameter definitions and values
— From Stacked tables
— From Pivot table
* Purging items
* Removing alternatives and scenarios
— From Pivot table
— From Alternative/Scenario tree

* Removing tools and features

* Removing parameter value lists

11.5.1 Removing entities and classes

From Object tree, Relationship tree, or Entity graph

Select the items in Object tree, Relationship tree, or Entity graph, corresponding to the entities and classes you want
to remove. Then, right-click on the selection and choose Remove from the context menu.

The Remove items dialog will popup:

type name databases
1 object electricity example
2 object water example

3 relationship class commodity_group__commodity | example
4 relationship class commodity_group__node_group example
5 relationship class node__commodity example
6 relationship class unit_group__commodity_group | example

Specify the databases from where you want to remove each item under the databases column, and press Ok.
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From Pivot table

To remove objects or relationships from a specific class, bring the class to Pivot table using the Parameter value input
type (see Using Pivot table and Frozen table), and select the cells in the table headers corresponding to the objects
and/or relationships you want to remove. Then, right-click on the selection and choose the corresponding Remove
option from the context menu.

Alternatively, to remove relationships for a specific class, bring the class to Pivot table using the Relationship input
type (see Using Pivot table and Frozen table). The Pivot table headers will be populated with all possible combinations
of objects across the member classes. Locate the member objects of the relationship you want to remove, and uncheck
the corresponding box in the table body.

11.5.2 Removing parameter definitions and values

From Stacked tables

To remove parameter definitions or values, go to the relevant Stacked table and select any cell in the row corresponding
to the items you want to remove Then, right-click on the selection and choose the appropriate Remove option from the
context menu.

From Pivot table
To remove parameter definitions and/or values for a certain class, bring the corresponding class to Pivot table using the
Parameter value input type (see Using Pivot table and Frozen table). Then:

1. Select the cells in the parameter header corresponding to the parameter definitions you want to remove, right-
click on the selection and choose Remove parameter definitions from the context menu

2. Select the cells in the table body corresponding to the parameter values you want to remove, right-click on the
selection and choose Remove parameter values from the context menu.
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11.5.3 Purging items

To remove all items of specific types, select Edit -> Purge from the hamburger menu. The Purge items dialog will pop

Databases ltems

up:

v

v input

T L N

object_class
parameter_value_list
parameter_tag
object

entity_group
alternative
scenario_alternative
tool

tool_feature_method

v

v

e T A N S B

relationship_class
parameter_definition
parameter_definition_tag
relationship
parameter_value
scenario

feature

tool_feature

=0 BT

Select the databases from where you want to remove the items under Databases, and the type of items you want to

remove under [tems. Then, press Ok.

11.5.4 Removing alternatives and scenarios

From Pivot table

Select the Scenario input type (see Using Pivot table and Frozen table). To remove scenarios, just select the proper cells
in the scenario header, right-click on the selection and chose Remove from the context menu. To remove alternatives,
just edit the proper cells in the alternative header, right-click on the selection and chose Remove from the context

menu.
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From Alternative/Scenario tree

To remove a scenario or alternative, just select the correspoding items in Alternative/Scenario tree, right-click on the
selection and chose Remove from the context menu.

11.5.5 Removing tools and features

To remove a feature, tool, or method, just select the correspoding items in Tool/Feature tree, right-click on the selection
and chose Remove from the context menu.

11.5.6 Removing parameter value lists

To remove a parameter value list or any of its values, just select the correspoding items in Parameter value list, right-
click on the selection and chose Remove from the context menu.

11.6 Managing data

This section describes the available tools to manage data, i.e., adding, updating or removing data at the same time.

* Managing object groups

* Managing relationships

11.6.1 Managing object groups

To modify object groups, expand the corresponding item in Object tree to display the members item, right-click on
the latter and select Manage members from the context menu. The Manage parameter tags dialog will pop up:

Manage members £3

Group name: DK2 Database |input -
Non members = Members =
1284 5459
5494 5492
5511 i: - 5493
5512 5485
5513 = 5496
5515 C 5497
5516 5498
5517 54599
5518 b 5500 b

o gance | ox
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To add new member objects, select them under Non members, and press the button in the middle that has a plus sign.
To remove current member objects, select them under Members, and press the button in the middle that has a minus
sign. Multiple selection works in both lists.

When you’re happy, press Ok.

Note: Changes made using the Manage members dialog are not applied to the database until you press OKk.

11.6.2 Managing relationships

Select Edit -> Manage relationships from the menu bar. The Manage relationships dialog will pop up:

Relationship class | connection__from_node - Database |example -
Available objects Existing relationships
connection = node = connection node =
Bastusel_to_Grytfors_disch Bastusel_lower 1 | Bastusel_to_Grytfors_disch Bastusel_lower
Bastusel_to_Grytfors_spill Bastusel_upper 2 |Bastusel_to_Grytfors_spill Bastusel_upper
Bergnas_to_Slagnas_disch Bergnds_lower B - .

. . ) . 3 |Bergnas_to_Slagnds_disch Bergnas_lower
Bergnas_to_Slagnas_spill Bergnds_upper = - - .
Batfors_to_Finnfors_disch Batfors_lower 4 |Bergnas_to_Slagnds_spill Bergnas_upper
Batfors_to_Finnfors_spill Batfors_upper 5 |Batfors_to_Finnfors_disch Batfors_lower
Finnfors_to_Granfors_disch Finnfors_lower 6 |Batfors_to_Finnfors_spill Batfors_upper
Finnfors_to_Granfors_spill Finnfors_upper 7 |Finnfors_to_Granfors_disch Finnfors_lower
Gallejaur_to_Vargfors_disch Gallejaur_lower &F > ) . . &

. ; . 8 |Finnfors_to_Granfors_spill Finnfors_upper
Gallejaur_to_Vargfors_spill Gallejaur _upper - - -
Granfors_to_Krangfors_disch Granfors_lower 9 |Gallejaur_to_Vargfors_disch Gallejaur_lower
Granfors_to_Krangfors_spill Granfors_upper 10| Gallejaur _to_Vargfors_spill Gallejaur_upper
Grytfors_to_Gallejaur_disch Grytfors_lower 11| Granfors_to_Krangfors_disch Granfors_lower
Grytfors_to_Gallejaur spill Grytfors_upper 12| Granfors_to_Krangfors_spill Granfors_upper
Kréngfors_to_Selsfors_d|5_ch Krangfors_lower 13 Grytfors_to_Gallejaur_disch Grytfors_lower
Krangfors_to_Selsfors_spill Krangfors_upper . -
Kvistforsen_to_downstream_disch | _ | Kvistforsen_lower 14 Grytfors_to_Gallejaur_spill Grytfors_upper
q ) Kvistforsen_upper - 15 Krangfors_to_Selsfors_disch Krangfors_lo... |~

o [ o]

To get started, select a relationship class and a database from the combo boxes at the top.

To add relationships, select the member objects for each class under Available objects and press the Add relationships
button at the middle of the form. The relationships will appear at the top of the table under Existing relationships.

To add multiple relationships at the same time, select multiple objects for one or more of the classes.

Tip: To extend the selection of objects for a class, press and hold the Ctrl key while clicking on more items.

Note: The set of relationships to add is determined by applying the product operation over the objects selected for
each class.

To remove relationships, select the appropriate rows under Existing relationships and press the Remove relationships
button on the right.

When you’re happy with your changes, press Ok.

Note: Changes made using the Manage relationships dialog are not applied to the database until you press Ok.
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11.7 Importing and exporting data

This section describes the available tools to import and export data.

* Overview
— Excel format
— JSON format
» Importing
» Exporting
— Mass export
— Selective export

— Session export

* Accessing/using exported files

11.7.1 Overview

Spine database editor supports importing and exporting data in three different formats: SQLite, JSON, and Excel.
The SQLite import/export uses the Spine database format. The JSON and Excel import/export use a specific format

described below.

Tip: To create a template file with the JSON or Excel format you can simply export an existing Spine database into

one of those formats.

Excel format

The Excel format consists of one sheet per object and relationship class. Each sheet can have one of four different

formats:

1. Object class with scalar parameter data:
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A | B | ¢ [ o HEEE r |

1 |sheet_type entity
Lenﬁtv_type object
iclass_name node
4 |entity_dim_count 1
Lvalue_tvpe single_wvalue
L index_dim_count 0
_7 ]
inode alternative | demand has_state node_state_cap state_coeff
L‘B@@tﬂ;@]_upper Base -0.2579768519 1 8208 1
10 |Bergnas upper Base -22.29 1 216120 1
L&a\l;fg\r;s_upper Base -2 1 1330 1
12 [Finnfors_upper Base 0 1 300 1
13 |Gallejaur_upper Base 15.356962963 1 3600 1
_ 14 |Granfors upper  Base 0 1 280 1
15 |Grytfors_upper Base -3.78 1 1248 1
imﬁ_upper Base 0 1 330 1
17 |Kvistforsen_upper Base -1.3273809524 1 1120 1
18 |Rebnis_upper Base -3.68 1 205560 1
iggggw_upper Base -10.37 1 1400 1
igggm_upper Base -5.43 1 168000 1
21 |Selsfors_upper Base 0 1 500 1
22 |Slagnds_upper Base 0 1 768 1
23 |Vargfors upper  Base -3.5584953704 1 4008 1
_24 |
_25 |

26

2. Object class with indexed parameter data:

A B c D 2 F

1 |sheet_type entity
2 |entity_type object
3 |class_name node
4 |entity_dim_count 1
5 |value_type time_series
6 |index_dim_count 1
7
& |node Bastusel upper Bergnids_upper Batfors upper FEinnfors_upper Gallejgur_upper
9 |alternative Base Base Base Base Base
10 |index fix_node_state [fix_node_state [fix_node_state fix_node_state fix_node_state
11 |2019-01-01T0O0:00:00 5581.44 114543.6 1117.2 234 1224
12 |2019-01-01T01:00:00 nan nan nan nan 18l
2019-01-07T23:00:00 5417.28 105898.8 891.1 234] 2808
_14 |
15
3. Relationship class with scalar parameter data:
11.7. Importing and exporting data 129



Spine Toolbox Documentation, Release 0.6.6.dev0-dev.0

A | B C D [
1 |sheet_type entity

Tentitv_tvpe relationship

Tclass_name connection__node__node

Tentitv_dim_count 3

Tvalue_tvpe single_wvalue

I index_dim_count 0
7

Tconnecl‘ion node node alternative connection_flow_delay

Tﬁg@(ﬂ;@l_to _Grytfors_disch  |Grytfors_upper Bastusel_lower Base 1h

ng&u;@_tom_spﬂl Grytfors_upper Bastusel_upper Base 150m

Tmmw Slagnds_upper Bergnds lower  Base 1h

Tmtom_spﬂl Slagnds_upper Bergnds upper Base 1h

?gg@f\g\r,s_tom _disch Finnfaors_upper Batfors_lower Base 3h

?%ﬁg\r,s_tom_spﬂl Finnfars_upper Batfors_upper  Base 3h

15 |rinnfors_to_Granfors disch  Granfors upper Finnfors_lower  Base 3h

Tm_tOMQ_spﬂl Granfors_upper Finnfors_upper Base 3h

ngllgim[_to_y@m Vargfars_upper Gallejgur_lower Base 30m

ngllgiwc_to_mm;pﬂl Vargfars_upper Galleiaur_upper Base 150m

19 |granfors_to_Krangfors_disch Krangfors_upper Granfors_lower Base 3h

Relationship class with indexed parameter data:

A | B | C | D E F
1 |sheet_type entity
2 |enfity_type relationship
3 |class_name unit__from_node
4 |entity_dim_count 2
5 |value_type time_series
6 |index_dim_count 1

—?

Tunl’t unitl unit2 unit3 unitd units
O  |node electricity_node  |electricity_node gas_node gas_node Eas_nol
10 |alternative Base Base Base Base Base
11 |index vom_cost vom_cost vom_cost  vom_cost  vom_co
12 |201%-01-01T00:00:00 -162.03 -175.56 -207.34 -178.87 -1
13 (2019-01-01T01:00:00 -156.36 -283.11 -194.95 -174.71 -1
14 (2019-01-01T02:00:00 -151.06 -278.76 -190.41 -168.75 -1
15 |201%-01-01T03:00:00 -153.52 -299.57 -185.4 -172.89 -1
16 [2019-01-01T04:00:00 -158.91 -285.28 -183.41 -172.13 -2:
17 |2019-01-01T05:00:00 -164.02 -207.34 -191.54 -171.66 -2
18 |2019-01-01T064:00:00 -175.56 -194.95 -202.9 -173.27 -t
19 (2019-01-01TO7:00:00 -283.11 -190.41 -197.69 -176.97 =40
20
21
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JSON format

The JSON format consists of a single JSON object with the following OPTIONAL keys:

* object_classes: the value of this key MUST be a JSON array, representing a list of object classes. Each element
in this array MUST be itself a JSON array and MUST have three elements:

— The first element MUST be a JSON string, indicating the object class name.
— The second element MUST be either a JSON string, indicating the object class description, or null.
— The third element MUST be either a JSON integer, indicating the object class icon code, or null.

* relationship_classes: the value of this key MUST be a JSON array, representing a list of relationships classes.
Each element in this array MUST be itself a JSON array and MUST have three elements:

— The first element MUST be a JSON string, indicating the relationship class name.

— The second element MUST be a JSON array, indicating the member object classes. Each element in this
array MUST be a JSON string, indicating the object class name.

— The third element MUST be either a JSON string, indicating the relationship class description, or null.

« parameter_value_lists: the value of this key MUST be a JSON array, representing a list of parameter value lists.
Each element in this array MUST be itself a JSON array and MUST have two elements:

— The first element MUST be a JSON string, indicating the parameter value list name.

— The second element MUST be a JSON array, indicating the values in the list. Each element in this array
MUST be either a JSON object, string, number, or null, indicating the value.

* object_parameters: the value of this key MUST be a JSON array, representing a list of object parameter defini-
tions. Each element in this array MUST be itself a JSON array and MUST have five elements:

The first element MUST be a JSON string, indicating the object class name.

The second element MUST be a JSON string, indicating the parameter name.

The third element MUST be either a JSON object, string, number, or null, indicating the parameter default
value.

The fourth element MUST be a JSON string, indicating the associated parameter value list, or null.

The last element MUST be either a JSON string, indicating the parameter description, or null.

¢ relationship_parameters: the value of this key MUST be a JSON array, representing a list of relationship param-
eter definitions. Each element in this array MUST be itself a JSON array and MUST have five elements:

The first element MUST be a JSON string, indicating the relationship class name.

The second element MUST be a JSON string, indicating the parameter name.

The third element MUST be either a JSON object, string, number, or null, indicating the parameter default
value.

The fourth element MUST be a JSON string, indicating the associated parameter value list, or null

The last element MUST be either a JSON string, indicating the parameter description, or null.

* objects: the value of this key MUST be a JSON array, representing a list of objects. Each element in this array
MUST be itself a JSON array and MUST have three elements:

— The first element MUST be a JSON string, indicating the object class name.
— The second element MUST be a JSON string, indicating the object name.

— The third element MUST be either a JSON string, indicating the object description, or null.
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* relationships: the value of this key MUST be a JSON array, representing a list of relationships. Each element in
this array MUST be itself a JSON array and MUST have two elements:

— The first element MUST be a JSON string, indicating the relationship class name.

— The second element MUST be a JSON array, indicating the member objects. Each element in this array MUST
be a JSON string, indicating the object name.

* object_parameter_values: the value of this key MUST be a JSON array, representing a list of object parameter
values. Each element in this array MUST be itself a JSON array and MUST have four elements:

— The first element MUST be a JSON string, indicating the object class name.

— The second element MUST be a JSON string, indicating the object name.

— The third element MUST be a JSON string, indicating the parameter name.

— The fourth element MUST be either a JSON object, string, number, or null, indicating the parameter value.

¢ relationship_parameter_values: the value of this key MUST be a JSON array, representing a list of relationship
parameter values. Each element in this array MUST be itself a JSON array and MUST have four elements:

The first element MUST be a JSON string, indicating the relationship class name.

The second element MUST be a JSON array, indicating the relationship’s member objects. Each element in
this array MUST be a JSON string, indicating the object name.

The third element MUST be a JSON string, indicating the parameter name.

The fourth element MUST be either a JSON object, string, number, or null, indicating the parameter value.

Example:
{
"object_classes": [
["connection", "An entity where an energy transfer takes place",.
-280378317271233],
["'node", "An entity where an energy balance takes place", 280740554077951],
["unit", "An entity where an energy conversion process takes place",.
>281470681805429],
1,
"relationship_classes": [
["connection__node__node", ["connection", '"node", "node"] , null],
["unit__from_node", ["unit", "node"], null],
["unit__to_node", ["unit", "node"], null],
1,
"parameter_value_lists": [
["balance_type_list", ["\"balance_type_node\"", "\"balance_type_group\"", "\
~"balance_type_none\""]],
["truth_value_list", ["\"value_false\"", "\"value_true\""1],
1,
"object_parameters": [
["connection", "connection_availability_factor", 1.0, null, null],
["node", "balance_type", "balance_type_node", "balance_type_list", null],
1,
"relationship_parameters": [
["connection__node__node", "connection_flow_delay", {"type": "duration", "data":
~"0h"}, null, null],
["unit__from_node", "unit_capacity", null, null, null],
["unit__to_node", "unit_capacity"”, null, null, null],

(continues on next page)
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(continued from previous page)

1,
"objects": [
["connection", "Bastusel_to_Grytfors_disch", null],
["node", "Bastusel_lower", null],
["node", "Bastusel_upper", null],
["node", "Grytfors_upper", null],
["unit", "Bastusel_pwr_plant", null],
1,
"relationships": [
["connection__node__node", ["Bastusel_to_Grytfors_disch", "Grytfors_upper",
—"Bastusel_lower"]],
["unit__from_node", ["Bastusel_pwr_plant", "Bastusel_upper"]],
["unit__to_node", ["Bastusel_pwr_plant", "Bastusel_lower"]],
1,

"object_parameter_values": [
["node", "Bastusel_upper", "demand", -0.2579768519],

["node", "Bastusel_upper", "fix_node_state", {"type": "time_series", "data": {
—"2018-12-31T23:00:00": 5581.44, "2019-01-07T23:00:00": 5417.28}}],
["node", "Bastusel_upper", "has_state", "value_true"],
] ’
"relationship_parameter_values": [
["connection__node__node", ["Bastusel_to_Grytfors_disch", "Grytfors_upper",
—"Bastusel_lower"], "connection_flow_delay", {"type": "duration", "data": "1h"}],
["unit__from_node", ["Bastusel_pwr_plant", "Bastusel_upper"], "unit_capacity",.
-127.57,
]

}

11.7.2 Importing

To import a file, select File —> Import from the hamburger menu. The Import file dialog will pop up. Select the file
type (SQLite, JSON, or Excel), enter the path of the file to import, and accept the dialog.

Tip: You can undo import operations using Edit -> Undo.
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11.7.3 Exporting

Mass export

To export items in mass, select File —> Export from the hamburger menu. The Export items dialog will pop up:

Export items X

tool tool_feature

Databases ltems
V| object_class v relationship_class
V| parameter_value_list v parameter_definition
v parameter_tag ¥ parameter_definition_tag
v object v relationship

v input v entity_group ¥ parameter_value

v alternative v scenario
v scenario_alternative v feature
v v
v

tool_feature_method

Cconce | ok

Select the databases you want to export under Databases, and the type of items under Items, then press OKk. The Export
file dialog will pop up now. Select the file type (SQLite, JSON, or Excel), enter the path of the file to export, and accept

the dialog.

Selective export

To export a specific subset of items, select the corresponding items in either Object tree and Relationship tree, right
click on the selection to bring the context menu, and select Export.

The Export file dialog will pop up. Select the file type (SQLite, JSON, or Excel), enter the path of the file to export,

and accept the dialog.
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Session export
To export only uncommitted changes made in the current session, select File —> Export session from the hamburger
menu.

The Export file dialog will pop up. Select the file type (SQLite, JSON, or Excel), enter the path of the file to export,
and accept the dialog.

Note: Export operations include all uncommitted changes.

11.7.4 Accessing/using exported files
Whenever you successfully export a file, a button with the file name is created in the Exports bar at the bottom of the

form. To open the file in your registered program, press that button. To open the containing folder, click on the arrow
next to the file name and select Open containing folder from the popup menu.

11.8 Committing and rolling back

Note: Changes are not immediately saved to the database(s). They need to be committed separately.

To commit your changes, select Session -> Commit from the hamburger menu, enter a commit message and press
Commit. Any changes made in the current session will be saved into the database.

To undo all changes since the last commit, select Session -> Rollback from the hamburger menu.

Tip: To undo/redo individual changes, use the Undo and Redo actions from the Edit menu.
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CHAPTER
TWELVE

PLOTTING

Basic data visualization is available in the Spine database editors. Currently, it is possible to plot scalar values as well
as time series, arrays and one dimensional maps with some limitations.

To plot a column, select the values from a table and then Plot from the right click popup menu.

ive_name  value

“%1 Data Store 1

m late S 1

Nor  Edit..

Plot...

Plot in window

ﬁ Copy Ctrl+C

m Paste Ctrl+V
Remowve row(s) Ctrl+Del
Filter by

Filter excluding

View metadata
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& Plot --value -- — O x
A€ PQ=Z B
value

g

4 4

3 -

T T T T T T
1.0 12 14 1l& 18 2.0

Selecting data in multiple columns plots the selection in a single window.

To add a plot to an existing window select the target plot window from the Plot in window submenu.

tive_name wvalue da
&) Data Store 1

Iﬂ Edit...

Mor
Plot...

Plot in window r value

Copy Ctrl+C
Paste Ctrl+V

v e

Rermowve row(s) Ctrl+Del

Filter by

Filter excluding

View metadata
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& Plot --value -- — O X
AEI PQEWY B mmmn
value
5
4
3
10 12 14 16 18 20

12.1 X column in pivot table

It is possible to plot a column of scalar values against a designated X column in the pivot table.

To set a column as the X column right click the top empty area above the column header and select Use as X from the
popup menu. (X) in the topmost cell indicates that the column is designated as the X axis.

Plaot single column

parameter » operating_
Plot in window
commodity ¥ | direction v
Useas ®
water from_node 3.4 rer s ¥

When selecting and plotting other columns in the same table the data will be plotted against the values in the X column
instead of row numbers.
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CHAPTER
THIRTEEN

PARAMETER VALUE EDITOR

Parameter value editor is used to edit object and relationship parameter values such as time series, time patterns or
durations. It can also convert between different value types, e.g. from a time series to a time pattern.

The editor is available from a right click popup menu or by double clicking a parameter value in one of the Spine
database editors.

13.1 Choosing value type

Parameter type |Flain value

(®) number ¢ Time series fixed resolution
Time series variable resolution
i) true Time pattern

Array
() falze  |Date time
'D Al Duration

The combo box at the top of the editor window allows changing the type of the current value.
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13.2 Plain values

The simplest parameter values are of the Plain value type. The editor window lets you to write a number or string
directly to the input field or set it to true, false or null as needed.

« Editwvalue -- o- parameter -- — O x

Parameter type  Flain value w

(®) number or string: 2,3

(::l frue
() false
i rull

13.3 Maps

Maps are versatile nested data structures designed to contain complex data including one and multi dimensional indexed
arrays. In Parameter value editor a map is shown as a table where the last non-empty cell on each row contains the
value while the preceding cells contain the value’s indexes.
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« Editvalue -- o- parameter -- — O >
Parameter type Map e
Index Index or value Index or value Value

2021-01-01 00:00:00 2021-01-01 00:00:00 4.3

2021-01-01 00:00:00 2021-01-01 04:00:00 -3

2021-01-01 00:00:00 2021-01-01 08:00:00 | 1,2

2021-01-02 00:00:00 2021-01-02 00:00:00 | 3,2

2021-01-02 00:00:00 2000-01-02 04:00:00 O

2021-01-02 00:00:00 2000-01-02 08:00:00 | -0,2

2021-01-03 00:00:00 T capacity 113

2021-01-03 00:00:00 T02 capacity 123

Convert Leaves to Time Series

The extra gray column on the right allows expanding the map with a new dimension. You can append a value to the map
by editing the bottom gray row. The reddish cells are merely a guide for the eye to indicate that the map has different
nesting depths.

A Right click popup menu gives options to open a value editor for individual cells, to add/insert/remove rows or
columns (effectively changing map’s dimensions), or to trim empty columns from the right hand side.

Copying and pasting data between cells and external programs works using the usual Ctrl-C and Ctrl-V keyboard
shortcuts.

Convert leaves to time series ‘compacts’ the map by converting the last dimension into time series. This works only if
the last dimension’s type is datetime. For example the following map contains two time dimensions. Since the indexes
are datetimes, the ‘inner’ dimension can be converted to time series.
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+ Editvalue -- o- parameter -- — O it
Parameter type Map w
Index Index or value Index or value Value

1 2021-01-071 00:00:00 2021-01-01 00:00:00 4,3
2 2021-01-07 00:00:00 2021-01-01 0:00:00  -31
3 2021-01-01 00:00:00 2021-01-01 08:00:00 1,2
4 2021-01-02 00:00:00 2021-01-02 00:00:00 3,2

5 2021-01-02 00:00:00 2000-01-02 0:00:00 0

-+ §2ﬂ21 -01-02 00:00:00 2000-01-02 02:00:00  -0,2

ConvertL to Time Series

After clicking Convert leaves to time series the map looks like this:

& Editvalue -- o- parameter -- — O >

Parameter type Map =

Index Yalue

1 2021-01-071 00:00:00 Time series

2 2021-01-02 00:00:00 Time series

ConvertL to Time Series
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13.4 Time series

There are two types of time series: variable and fixed resolution. Variable resolution means that the time stamps can
be arbitrary while in fixed resolution series the time steps between consecutive stamps are fixed.

+ Editvalue -- o - parameter -- - O >

Parameter type |Time series variable resolution

|:| Ignore year |:| Repeat

AE>» Q=¥ A

Time stamp Values
1 2000-01-01700:00:00 13
2 2000-01-01T01:00:00 44 60 -
3 2000-01-01702:00:00 32 50
4 2000-01-01T03:00:00 &7 40
5 30 1
20
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+ Editvalue -- o - parameter -- - O >

Parameter type |Time series fixed resolution w

Starttime |2000-01-0100:00:00 | [IONEEIRE ‘_
1
Format: YYYY-MM-DDThh:mm:ss ‘ﬁ é * ‘*. Q = Ii =

Resolution | 1h |

Available units: 5, m, b, O, M, ¥
60 4
|:| Ignore year |:| Repeat
50 4
Time stamp Values
1 2000-01-01T00:00:00 13 40
2 2000-01-01T01:00:00 44 30 4
3 2000-01-01T02:00:00 132 20 1
4 2000-01-01T03:00:00 67 T T T T T . .
5] O ] 3] 5] 5] ]
u“"n 00'3 u“*’g u“*'} u‘l""\’ u‘l'} 0'3"“
5 o o o o o o o

The editor window is split into two in both cases. The left side holds all the options and a table with all the data while
the right side shows a plot of the series. The plot is not editable and is for visualization purposes only.

In the table rows can be added or removed from a popup menu available by a right click. Editing the last gray row
appends a new value to the series. Data can be copied and pasted by Ctrl-C and Ctrl-V. Copying from/to an external
spreadsheet program is supported.

The time steps of a fixed resolution series are edited by the Start time and Resolution fields. The format for the start
time is ISO8601. The Resolution field takes a single time step or a comma separated list of steps. If a list of resolution
steps is provided then the steps are repeated so as to fit the data in the table.

The Ignore year option available for both variable and fixed resolution time series allows the time series to be used
independent of the year. Only the month, day and time information is used by the model.

The Repeat option means that the time series is cycled, i.e. it starts from the beginning once the time steps run out.
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13.5 Time patterns

The time pattern editor holds a single table which shows the fime period on the right column and the corresponding
values on the left. Inserting/removing rows and copy-pasting works as in the time series editor.

« Editvalue -- o- parameter -- — O >
Farameter type |Time pattern e
Tirne pericd Value
1 D1-3,D7 99
2 D4-6 101
3

ncel

I
B
1
o

Time periods consist of the following elements:

* An interval of time in a given time-unit. The format is Ua-b, where U is either Y (for year), M (for month), D (for
day), WD (for weekday), h (for hour), m (for minute), or s (for second); and a and b are two integers corresponding
to the lower and upper bound, respectively.

e An intersection of intervals. The format is s1;s2; ..., where s1, s2, ..., are intervals as described above.

e A union of ranges. The formatis rl,r2,..., where rl, r2, ..., are either intervals or intersections of intervals
as described above.

13.6 Arrays

Arrays are lists of values of a single type. Their editor is split into two: the left side holds the actual array while the
right side contains a plot of the array values versus the values’ positions within the array. Note that not all value types
can be plotted. The type can be selected from the Value type combobox. Inserting/removing rows and copy-pasting
works as in the time series editor.
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+ Editvalue -- o - parameter -- — O *
Parameter type Array w
Value type: |Float '
_— 1
Value ‘ﬁ‘(") "I"Q:l_ﬁ’
1 90
100
2 20
90 +
3 50
4 70 80
5 80 70
6 99
ES TRV i B0 -
7
50 +
T T T T T T
0 1 2 3 4 5

13.7 Datetimes

The datetime value should be entered in ISO8601 format. Clicking small arrow on the input field pops up a calendar
that can be used to select a date.
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+ Editvalue --o- parameter -- —

Parameter type |Date time W

Datetime | 2021-04-28T12:l:00

Format: YY"y --MM-D0Thh:mm:ss

13.8 Durations

A single value or a comma separated list of time durations can be entered to the Duration field.

« Editvalue -- o- parameter-- - O =
Parameter type |Duraﬁnn ;I
Duration |I|J'|
Units: s, m, h, D, M, ¥

13.8. Durations
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CHAPTER
FOURTEEN

IMPORTING AND EXPORTING DATA

This section explains the different ways of importing and exporting data to and from a Spine database.

14.1 Importing data with Importer

Data importing is handled by the Importer project item which can import tabulated and to some degree tree-structured
data into a Spine database from various formats. The same functionality is also available in Spine database editor
from File->Import but using an Importer item is preferred because then the process is documented and repeatable.

Tip: A Tool item can also be connected to Importer to import tool’s output files to a database.

The heart of Importer is the Import Editor window in which the mappings from source data to Spine database entities
are set up. The editor window can be accessed by the Import Editor... button in Importer’s Properties dock. Note,
that you have to select one of the files in the Source files list before clicking the button.

Design View Importer Properties g X

~ import
Source files
| | ChdatayFake dataresults.gex

n 87 ..tron scattering lengths and cross sections.xlsx

Cancel import on error

v L—)

>

The Import Editor windows is divided into two parts: Sources shows all the ‘sheets’ contained in the file, some
options for reading the file correctly, and a preview table to visualize and configure how the data on the selected sheet
would be mapped. Mappings, on the other hand, shows the actual importing settings, the mappings from the input
data to database entities.
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& Import Editor  -- import -- - O X
File
Sources Mappings
O real part BETE New Remove
| imaginary part
Hag header: | e
Skip raws:
Skip columns:
Read until empty column on first row: [
Read until empty row on first column: []
AlD A A2 A Options
1 MNeutron scatter... Class type: Object £ Repeat time serie
2 lsotope conc Cohb e RET LR e
Read data from row:
3 H -3,739
4 1H 99,985 -3,7406
5 2H 0015 6671 Target Source type Source ref.
b 3H 12,32 4,792
Object names MNone
7 He 3,26
3 3He 0,00014 5,74
El AHe 99,9995 3,26 v
< >

The options in the Mappings part declare if the currently selected sheet will be imported as an object or relationship and
what type of parameters, if any, the sheet contains. The table can be used to configure how the input data is interpreted:
which row or column contains the entity class names, parameter values, time stamps and so on.
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Options

Class type: Object o Repeat time serie

Parameter type: Single value -
Read data from row:

Target Source type Source ref,
Object names Mone

Parameter names MNone

It might be helpful to fill in the mapping options using the preview table in the Sources part. Right clicking on the table
cells shows a popup menu that lets one to configure how the rows and colunms are read upon importing.

A0 AT A 2 2 Opt
1 Meutron scatter.., Cla
2 W conc Coh b -5
3 H Map column to... * 29 Re:
Map header to... ’
4 H Map row to... r Object class names
5 2H Map all headers to... * Object names
Parameter names
6 3H 12,32 4
Parameter values
7 Je
/ He 3,26
Parar
8 IHe 0,00014 5,74
9 4He 99,9999 3,26 v .
£ >

An important aspect of data import is whether each item in the input data should be read as a string, a number, a
time stamp, or something else. By default all input data is read as strings. However, more often than not things like
parameter values are actually numbers. It is possible to control what type of data each column (and, sometimes, each
row) contains from the preview table. Clicking the data type indicator button on column headers pops up a menu with
a selection of available data types. Right clicking the column header also gives the opportunity to change the data type
of all columns at once.
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|A 4 Als A

datetime
duration
float
string

integer sequence datetime

5,592 2,05

14.2 Exporting data with Exporter

Exporter writes database data into regular files that can be used by Tools and external software that do not read the
Spine database format. Various tabulated file formats are supported some of which require specific export settings; see
below for more details.

At its heart Exporter maps database items such as entity class or entity names to an output table. Each item has a user
given output position on the table, for example a column number. By default data is mapped to columns but it is also
possible to create pivot tables.

Exporter saves its settings or export mappings as a specification that can be reused by other exporters or even other
projects. The specification can be edited in Exporter specification editor which is accessible by the button in the item’s
Properties dock or by double clicking exporter’s icon on the Design view. A specification that is not associated with
any specific Exporter project item can be created and edited from the Main toolbar.

14.2.1 Properties dock

Exporter’s Properties dock controls project item specific settings that are not part of the item’s specification.
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Exporter Properties g2 X
Exporter 1

Spedification: Epexpnrt data i }'

\.spinetoolbox\items\data_store_1\Data Store L.sglite

Filename: ||:|ut. sy

|:| Time stamp output directories

Cancel export on error

=

Specification used by the active Exporter item can be selected from the Specification combobox. The button opens
Exporter specification editor where it is possible to edit the specification.

Databases available for export from connected project items such as Data stores are listed in separate boxes below the
Specification combobox. An output filename is required for each database.

Checking the Time stamp output directories box adds a time stamp to the item’s output directories preventing output
files from being overwritten. This may be useful for debugging purposes.

The Cancel export on error checkbox controls whether execution bails out on errors that may be otherwise non-fatal.

Exporter’s data directory can be opened in system’s file browser by the button. The output files are written in data
directory’s output subdirectory.

14.2.2 Exporter specification editor

Specification editor is used to create mappings that define how data is exported to the output file. Mappings define
one or more tables and their contents but are otherwise output format agnostic. Some output formats, e.g. SQL and
gdx, interpret the tables in specific ways, however. Other formats which inherently cannot write multiple tables into a
single file, such as csv, may end up exporting multiple files. See the sections below for format specific intricacies.

When opened for the first time Specification editor looks like in the figure below. The window is tabbed allowing
multiple specifications to be edited at the same time. Each tab consists of dock widgets which can be reorganized to
suit the user’s needs. The ‘hamburger’ menu on the top right corner gives access to some important actions such as
Save and Close. Undo and redo can be found from the menu as well.
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B¢ Exporter specification editor - m] X
<unnamed spedfication> @ -+
MName: ‘Enter specification name here... Description: [Enter specification description here. .. E
Export options & X | Preview tables & X | Preview contents g2 X
Format: |csv i ¥ Mapping 1 1 2
<anocnymous table>
Mappings & X | Mapping options g X 1 s
Add Item type: Object dass ~ 2 R
Name Write order Always expart header 1 node Pieksamaki
Ripoinad 1ot Relationship dimensions: 1 = 4 vertex highway-5
Parameter type: Mone ~
3 wertex highway-23
Parameter dimensions: |0 s
[ Fixed table name:
Group function: do not group W
Mapping specification g X
Mapping type Map to Pivoted MNullable Header Filter
Object classes 1 O O Preview controls 5 X
Objects 2 0 Database url: | ..x Projects\exporter user guide'. spinetoolboxjtems\data_store_1\Data Store Lsglite ~ | =
Live preview Max. tables Max. content rows: _

The only requirement for a specification is a name. This can be given on the Name field field on the top bar. The
Description field allows for an additional explanatory text.

The current output format can be changed by the Format combobox on Export options dock.

Mappings [
Ha}r\ne Write order
Mapping 1 1st

Write earlier Write later

Specification’s mappings are listed in the Mappings dock shown above. The Add button adds a new mapping while
the Remove button removes selected mappings. Mappings can be renamed by double clicking their names on the list.

The checkbox in front of mapping’s name shows if the mapping is currently enabled. Use the Toggle enabled button
to toggle the enabled state of all mappings at once.

The tables defined by the mappings are written in the order shown on the mapping list’s Write order column. This may
be important if the tables need to be in certain order in the output file or when multiple mappings output to a single
table. Mappings can be sorted by their write order by clicking the header of the Write order column. The Write earlier
and Write later buttons move the currently selected mapping up and down the list.
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Mapping options g X

Item type: Ohject dass W
Always export header

Relationship dimensions: 1 =
Parameter type: Maone A
Parameter dimensions: 0 =

[] Fixed table name:

Group function: do not group e
Mapping specification g X
Mapping type Map to Pivoted Mullable Header Filter
Object classes 1 ] L]
Objects 2 ]

Currently selected mapping is edited using the controls in Mapping options and Mapping specification docks. The
Mapping options dock contains controls that apply to the mapping as a whole, e.g. what data the output tables contain.
Mapping specification, on the other hand, contains a table which defines the structure of the mapping’s output tables.

What database items the mapping outputs is chosen using the Ifem type combobox in Mapping options dock. For
instance, the Object classes option outputs object classes, objects and, optionally, object parameters and related items
while the Relationship classes option outputs relationship classes and relationships. Checking the Always export header
checkbox outputs a table that has fixed headers even if the table is otherwise empty. If Item type is Relationship class,
the Relationship dimensions spinbox can be used to specify the maximum number of relationships’ dimensions that
the mapping is able to handle. Parameters can be outputted by choosing their value type using the Parameter type
combobox. The Value choice adds rows to Mapping specification for parameter values associated with individual
entities while Default value allows outputting parameters’ default values. The maximum number of value dimensions in
case of indexed values (time series, maps, time patterns, arrays) the mapping can handle is controlled by the Parameter
dimensions spinbox. The Fixed table name checkbox enables giving a user defined table name to the mapping’s output
table. In case the mapping is pivoted and Mapping specification contains items that are hidden, it is possible that
a number of data elements end up in the same output table cell. The Group function combobox offers some basic
functions to aggregate such data into the cells.

The contents of the table on the Mapping specification dock depends on choices on Mapping options, e.g. the item
type, parameter type or dimensions. Each row corresponds to an item in the database: object class names, object
names, parameter values etc. The item’s name is given in the Mapping type column. The colors help to identify the
corresponding elements in the preview. The Map to column defines the position of the item, that is, where the item
is written or otherwise used when the output tables are generated. By default, a plain integral number in this column
means that the item is written to that column in the output table. From the other choices, hidden means that the item will
not show on the output. Table name, on the other hand, uses the item as output table names. For example, outputting
object classes as table names will generate one new table for every object class in the database, each named after the
class. Each table in turn will contain the parameters and objects of the table’s object class. If multiple mappings
generate a table with a common name then each mapping appends to the same table in the order specified by the Write
order column on Mappings dock. The column header position makes the item a column header for a buddy item.
Buddy items have some kind of logical relationship with their column header, for instance the buddy of an object class
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is its objects; setting the object class to column header will write the name of the class as the objects’ column header.

Note: Currently, buddies are fixed and defined only for a small set database items. Therefore, column header will not
always produce sensible results.

Changing the column and pivot header row positions leaves sometimes gaps in the output table. If such gaps are not
desirable the Compact button reorders the positions by removing the gaps. This may be useful when the output format
requires such gapless tables.

The checkboxes in Pivoted column on the Mapping specification dock toggle the mapping into pivoted mode. One
or more items on the table can be set as pivoted. They then act as a pivot header for the data item which is the last
non-hidden item on the list. Once checked as pivoted, an item’s position column defines a pivot header row instead of
output column.

By default a row ends up in the output table only when all mapping items yield some data. For example, when exporting
object classes and objects, only classes that have objects get written to output. However, sometimes it is useful to export
‘empty’ object classes as well. For this purpose a mapping can be set as nullable in the Nullable column. Continuing
the example, checking the Nullable checkbox for Objects would produce an output table with all object classes including
ones without objects. The position where objects would normally be outputted are left empty for those classes.

Besides the column header position it is possible give fixed column headers to items using the Header column in
Mapping specification dock. Note that checking the Always export header option in the Mapping options dock outputs
the fixed headers even if there is no other data in a table.

The Mapping specification dock’s Filter column provides refined control on which database items the mapping outputs.
The column uses regular expressions to filter what gets outputted. See Basic regular expression for filtering.

Preview tables & X Preview contents g X
¥ Mapping 1 1 2
<anocnymous tablex
1 'node Kuopic
2 node Varkaus
1 node Pieksamaki
4 |wertex highway-5
5 wertex highway-23
Preview controls g X
Database url: | ..x Projects\exporter user guidel, spinetoolboxjtems'\data_store_1\Data Store 1.sglite ~ | fame
Live preview Max. tables Max. content rows:
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A preview of what will be written to the output is available in the preview dock widgets. A database connection is
needed to generate the preview. The Preview controls dock provides widgets to choose an existing database or to load
one from a file. Once a database is available and the preview is enabled the mappings and the tables they would output
are listed on the Preview tables dock. Selecting a table from the list shows the table’s contents on the Preview contents
dock. The colors on the table correspond to the colors in Mapping specification dock.

14.2.3 Basic regular expressions for filtering

The Filter field in Mapping specification accepts regular expressions to filter what data gets outputted by that mapping
item. Below are examples on how to create some basic filters.

Single item

Writing the item’s name to the field filters out all other items. For example, to output the object class called ‘node’
only, write node to the Filter field.

OR operator

The vertical bar | serves as the OR operator. node |unit as a filter for object classes would output classes named
‘node’ and ‘unit’.

Excluding an item

While perhaps not the most suitable task for regular expressions it is still possible to ‘negate’ a filter. ~(?/node). would
exclude all items names of which start with ‘node’.

14.2.4 Csv and multiple tables
Csv files are flat text files and therefore do not directly support multiple tables. Instead, multiple tables are handled as
separate output files.

Only mappings that output an anonymous table actually write to the file specified on the Exporter’s properties dock.
Named tables get written to files named after the table plus the .csv extension. For example, a table named node
would result in a file called node.csv.

14.2.5 SQL export

Note: Currently only sqlite is supported.

The SQL backend writes the tables to the target database in a relatively straightforward way:
* Tables are named after the table name provided by the mappings. Anonymous tables are not supported.

 The first row of each table is used as column names in the database. Thus, each column in a mapping should
have a fixed header or a header produced by an item set to column header position.

* Column data types are sniffed from the second row. Empty values or a missing row result in string type.
e There must be an item assigned to each column. Empty columns confuse the SQL backend.

* Pivot tables do not generally make sense with the SQL backend unless the resulting table somehow follows the
above rules.
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14.2.6 GAMS gdx export

Note: You need to have GAMS installed to use this functionality. However, you do not need to own a GAMS license
as the demo version works just as well.

Note: The bitness (32 or 64bit) of GAMS must match the bitness of the Python interpreter.

The gdx backend turns the output tables to GAMS sets, parameters and scalars following the rules below:
* Table names correspond the names of sets, parameters and scalars. Thus, anonymous tables are not supported.
* There must be an item assigned to each column. Empty columns confuse the gdx backend.

* Pivot tables do not generally make sense with the gdx backend unless the resulting table somehow follows the
rules listed here.

» Everything that is not identified as parameter or scalar is considered a GAMS set.
» Each column corresponds to a dimension.

* The first row is used to name the dimension’s domain. Thus, each column in a mapping should have a fixed
header or a header produced by an item set to column header position. Note that * is a valid fixed header and
means that the dimension has no specific domain.

Parameters:
* A table that contains no header in the last (rightmost) column is considered a GAMS parameter.
* The last column should contain the parameter’s values while the other columns contain the values’ dimension.

¢ Dimensions’ domains are taken from the header row, see Sets above. Note, that the value column must not have
a header.

Scalars:

* A table that contains a numerical value in the top left cell is considered a GAMS scalar. Everything else (except
the table name) is ignored.

* The data in the top left cell is the scalar’s value.

14.3 Exporting to GAMS with GdxExporter

Note: GdxExporter is pending for removal and its use in new projects is discouraged. Use Exporter instead.

Note: You need to have GAMS installed to use this functionality. However, you do not need to own a GAMS license
as the demo version works just as well.

Note: The bitness (32 or 64bit) of GAMS has to match the bitness of the Python interpreter.
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Databases can be exported to GAMS . gdx files by the GdxExporter project item. When a project is executed, GdxEx-
porter writes its output files to its data folder and forwards file paths to project items downstream. If a Tool is to use
such a file, remember to add the file as one of the Tool specification’s input files!

The mapping between entities in a Spine database and GAMS is as follows:

Database entity GAMS entity

Object class Universal set (or domain)
Object Universal set member
Object parameter Parameter

Relationship class Subset of universal sets
Relationship Subset member
Relationship parameter | Parameter

Note: Currently, it is not possible to use subsets (relationship classes) as dimensions for other subsets due to technical
limitations. For example, if there is a domain A(*) and a subset foo(A), a subset of foo has to be expressed as bar(A)
instead of bar(foo).

It is also possible to designate a single object class as a Global parameter. The parameters of the objects of that class
will be exported as GAMS scalars.

Some GAMS models need their data to be in a specific order in the . gdx. This is not directly supported by the database.
Rather, user has to specify the desired exporting order using the GdxExporter item’s settings.

14.3.1 GdxExporter Project Iltem

The image below shows the properties dock of GdxExporter with two Data Sources connected to it.

Exporter Properties g X

Gdx export

sqglite:/ / /C:/data/databases/times_mock.sglite

Filename: |Dut.gdx

sglite:/ / /C:/data/databasestimes_test_database_for_table_view.sglite

Filename: |in.gu:|x

For each connected Data Store a box with the database’s URL and export file name field is shown on the dock. The
Settings. .. buttons open Gdx Export settings windows to allow editing database specific export parameters such as the
order in which entities are exported from the database.
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+» Odx Export settings  -- sqliter///C:/data/databases/times_mock.sqlite -- — O >
Sets Set Contents
[ globals first_week
ALL TS second_week
ALL_REG third_week .
- - Alphabetic
COM_GRP Move Up
2 time e
COM Mowe Dawn
REG

COM_DESC

Indexed parameters. ..

Global parameters domain: | globals e

Restore Defaults Cancel

The Gdx Export settings window (see above) contains a Sets list which shows all GAMS sets (gray background) and
subsets that are available in the database. The sets are exported in the order they are shown in the list. The Move Up
and Move Down buttons can be used to move the selected set around. Note that you cannot mix sets with subsets so all
sets always get exported before the subsets.

The checkbox next to the set name is used to control which sets are actually exported. Note that it is not possible to
change this setting for certain sets. Global parameters domain is never exported, only its parameters which become
GAMS scalars. Further, sets created for Indexed paramaters are always exported.

The Set Contents box lists the members of the selected set or subset. Their order of export can be changed the same
way as with sets by Move Up and Move Down. The Alphabetic button sorts the members alphabetically.

Time series and time patterns cannot be exported as-is. They need to be tied up to a GAMS set. This can be achieved
from the window that opens from the Indexed parameters... button. See the Exporting time series and patterns section
below for more information.

Finally, one of the sets can be designated as the global parameter set. This is achieved by choosing the set’s name in
the Global parameters domain box. Note that this set is not exported, only its parameters are. They end up as GAMS
scalars.
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14.3.2 Exporting time series and patterns

Since GAMS has no notion of time series or time patterns these types need special handling when exported to a . gdx
file. Namely, the time stamps or time periods (i.e. parameter indexes) need be available as GAMS sets in the exported
file. It is possible to use an existing set or create a new one for this purpose. The functionality is available in Gdx
Parameter Indexing Settings window accessible from the Indexed Parameters. .. button.

«» Odx Parameter Indexing Settings - sgliter///C:/data/databases/times_mock.sglite -- — a x

size
Parameter successfully indexed.

Indexing domains: (COM_GRP, ALL_TS) Maove Left Maove Right

(®) Use existing domain ALL_TS sweets

ALL_TS 111 first_week

Label picking expression: I:I
St 2 second_week 13.8

() Create new index domain
3 third_week
Domain name:
Description:

Generator expression:

The above figure shows the indexing settings when an existing GAMS set is used to replace the original time stamps of
atime series in a parameter called ‘size’. The choice between using an existing set or creating a new one can be changed
by the Use existing domain and Create new index domain radio buttons. When using an existing set it is selected by
the combobox. In the above figure, ALL TS set is used for indexing.

In case of existing set it is possible that not all the set’s contents are used for indexing. The table occupying the right
side of the above figure shows which of the set’s keys index which parameter values. The first column contains the
keys of the currently selected set whereas the other columns contain the parameter’s values, one column for each object
that has the parameter. Selecting and deselecting rows in the table changes the indexing as only the keys on selected
rows are used to index the parameter. Shift, ctrl and ctrl-A help in manual selection. If the selected indexes have
certain pattern it might be useful to utilize the Label picking expression field which selects the set keys using a Python
expression returning a boolean value. Some examples:

Expression Effect

i==23 Select the third row only
i%2==20 Select even rows

(1+1) %2==0and i != 9 | Select odd rows except row 9

The Indexing domains list allows to shuffie the order of the parameter’s dimensions. The bold dimension is the new
dimension that is added to the parameter. It can be moved around by the Move Left and Move Right buttons.
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«» Odx Parameter Indexing Settings - sgliter///C:/data/databases/times_mock.sqlite -- — a >
~
winterness
Parameter successfully indexed.
Indexing domains: (REG_GRP, time_stamps) Move Left Move Right
(O Use existing domain time_stamps Antarktis Europa
ioli=s 1 2019-01-01T00:... 1.0 15
Label picking expression:
e 2 2019-0401T00:... 2.0 07
(® Create new index domain
3 2019-07-01T00:... 3.0 0.0
Domain name: |time_s'ﬁmps |
Description: |T'-,'|:|E explanatory text...| 4 2015-10-01700:... 2.3 0.2
Generator expression: I:l
Extract index from parameter
W

It is possible to create a new indexing set by choosing Create new index domain as shown in the figure above. Domain
name is mandatory for the new domain. A Description can also be provided but it is optional. There are two options
to generate the index keys: extract the time stamps or time periods from the parameter itself or generate them using a
Python expression. The Extract index from parameter button can be used to extract the keys from the parameter. The
Generator expression field, on the other hand, is used to generate index keys for the new set. The expression should
return Python object that is convertible to string. Below are some example expressions:

Expression Keys

i 1,2,3,...

£"{i - 1:043}" | 0000, 0001, 0002,...
£'T{i:03}" T001, T002, T003,...
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SPINE DATAPACKAGE EDITOR

Note: This section is a work in progress.

This section describes the Spine datapackage editor, used to interact with tabular data and export it into Spine format.

To open the Spine datapackage editor, select a Data Connection with CSV files in it, and press the Datapackage button
in its Properties:

Design View Data Connection Properties & &

| Data Connection 1 |

References

Data Connection 1

3] ..inetoolbox/items/data_connection_ 1/bus_flat.csv
i ..spinetoolboxfitems/data_connection_1/branch.csv
{%] ..2/.spinetoolbox/items/data_connection_1/gen.csv
{3] ..netoolbox/items/data_connection_1/gengroup.csv

== Datapackage
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File Edit View

Resources Data Fields =1
name sourc f_bus t_bus br_r br_x br_b tap rate_a rate_b outage_rate outage_duratiol™ name type  primary key?

bus_flat bus_flat.c || 1 2 0.003 0.014 0451 0 193 200 024 16 f_bus integer
[EEl branch.cs | (1 3 0,055 0.211 0.057 0 208 220 051 10 t_bus integer
gen gen.csv 1 5 0.022 0.085 0.023 0 208 220 033 10 br_r number
gengroup gengroup || 2 4 0.033 0.127 0034 0 208 220 0.39 10 br_x number

2 6 0.05 0.192 0.052 0 208 220 048 10 br_b number

3 9 0.031 0.119 0.032 0 208 220 0.38 10 tap integer

3 24 0002 0.084 0 1015 510 600 0.02 768 rate_a integer

4 9 0.027 0.104 0.028 0 208 220 036 10 rate_b integer

5 10 0.023 0.088 0.024 0 208 220 034 10 outage_rate number

6 10 0.014 0.061 2459 0 193 200 033 35 outage_duration  integer

7 8 0.016 0061 0017 0 208 220 03 10 weighting_factor  number

8 9 0.043 0.165 0.045 0 208 220 044 10 br_status integer

8 10 0.043 0.165 0.045 0 208 220 044 10 angmin integer

9 11 | 0.002 0.084 0 103 510 600 0.02 768 angmax integer

9 12 10.002 0.084 0 103 510 600 0.02 768 shift integer

10 11 0002 0084 0 1015 510 600 0.02 768 internal integer

10 12 | 0.002 0.084 0 1015 510 600 0.02 768

11 13 |0.006 0.048 0.1 0 600 625 0.4 11

11 14 0.005 0.042 0088 0 600 625 039 11

12 13 0006 0.048 0.1 0 600 625 0.4 11 Forelgn keys a®

12 23 0012 0097 0203 0 600 625 052 11

13 23 0.011 0.087 0182 0 600 625 049 11 fields reference resource reference fields

14 16 |0.005 0.059 0082 0 600 625 0.38 11 1

15 |16 0.002 0017 0036 0 600 625 0.33 11

15 |21 0006 0049 0103 0 600 625 041 11

15 21 |0.006 0.049 0103 0 600 625 041 11

15 |24 |0.007 0052 0109 0 600 625 041 11

16 |17 0003 0026 0055 0 600 625 0.35 11

16 19 0003 0023 0049 0 600 625 034 11

17 |18 0002 0014 003 0 600 625 0.32 11

17 |22 0014 0105 0221 0 600 625 0,54 11

18 21 0003 0026 0055 0 600 625 0.35 11

0 600 625 035 11

18 21 0.003 0.026 0.055
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TERMINOLOGY

Here is a list of definitions related to Spine project, SpineOpt.jl, and Spine Toolbox.

Arc Graph theory term. See Connection.

Case study Spine project has 13 case studies that help to improve, validate and deploy different aspects of the
SpineOpt.jl and Spine Toolbox.

Connection an arrow on Spine Toolbox Design View that is used to connect project items to each other to form
a DAG.

Data Connection is a project item used to store a collection of data files that may or may not be in Spine data
format. It facilitates data transfer from original data sources e.g. spreadsheet files to Spine Toolbox. The original
data source file does not need to conform to the format that Spine Toolbox is capable of reading, since there we
can use an interpreting layer (Importer) between the raw data and the Spine format database (Data Store).

Data Package is a data container format consisting of a metadata descriptor file (datapackage.json) and
resources such as data files.

Data sources are all the original, unaltered, sources of data that are used to generate necessary input data for
Spine Toolbox tools.

Data Store is a project item. It’s a Spine Toolbox internal data container which follows the Spine data model. A
data store is implemented using a database, it may be, for example, an SQL database.

Design View A sub-window on Spine Toolbox main window, where project items and connections are visualized.

Direct predecessor Immediate predecessor. E.g. in DAG x->y->z, direct predecessor of node z is node y. See
also predecessor.

Direct successor Immediate successor. E.g. in DAG x->y->z, direct successor of node x is node y. See also
successor.

Directed Acyclic Graph (DAG) Finite directed graph with no directed cycles. It consists of vertices and edges.
In Spine Toolbox, we use project items as vertices and connections as edges to build a DAG that represents a
data processing chain (workflow).

Edge Graph theory term. See Connection

GdxExporter is a project item that allows exporting a Spine data structure from a Data Store into a .gdx file
which can be used as an input file in a Tool.

Importer is a project item that can be used to import data from e.g. an Excel file, transform it to Spine data
structure, and into a Data Store.

Node Graph theory term. See Project item.

Predecessor Graph theory term that is also used in Spine Toolbox. Preceding project items of a certain project
item in a DAG. For example, in DAG x->y->z, nodes x and y are the predecessors of node z.
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Project in Spine Toolbox consists of project items and connections, which are used to build a data processing
chain for solving a particular problem. Data processing chains are built and executed using the rules of Directed
Acyclic Graphs. There can be any number of project items in a project.

Project item Spine Toolbox projects consist of project items. Project items together with connections are used
to build Directed Acyclic Graphs (DAG). Project items act as nodes and connections act as edges in the DAG.
See Project Items for an up-to-date list on project items available in Spine Toolbox.

Scenario A scenario is a meaningful data set for the target tool.

Spine data structure Spine data structure defines the format for storing and moving data within Spine Toolbox.
A generic data structure allows representation of many different modelling entities. Data structures have a class
defining the type of entity they represent, can have properties and can be related to other data structures. Spine
data structures can be manipulated and visualized within Spine Toolbox while SpineOpt.jl will be able to directly
utilize as well as output them.

SpineOpt.jl An interpreter, which formulates a solver-ready mixed-integer optimization problem based on the
input data and the equations defined in the SpineOpt.jl. Outputs the solver results.

Source directory In context of Tool specifications, a source directory is the directory where the main program
file of the Tool specification is located. This is also the recommended place for saving the Tool specification file

(.json).

Successor Graph theory term that is also used in Spine Toolbox. Following project items of a certain project
item in a DAG. For example, in DAG x->y->z, nodes y and z are the successors of node x.

Tool is a project item that is used to execute Python, Julia, GAMS, executable scripts, or simulation models.
This is done by creating a Tool specification defining the script or program the user wants to execute in Spine
Toolbox. Then you need to attach the Tool specification to a Tool project item. Tools can be used to execute a
computational process or a simulation model, or it can also be a process that converts data or calculates a new
variable. In general, Tools may take some data as input and produce an output.

Tool specification is a JSON structure that contains metadata required by Spine Toolbox to execute a compu-
tational process or a simulation model. The metadata contains; type of the program (Python, Julia, GAMS,
executable), main program file (which can be e.g. a Windows batch (.bat) file or for Python scripts this would be
the .py file where the __main__() method is located), All additional required program files, any optional input
files (e.g. data), and output files. Also any command line arguments can be defined in a Tool specification.
SpineOpt.jl is a Tool specification from Spine Toolbox’s point-of-view.

Use case Potential way to use Spine Toolbox. Use cases together are used to test the functionality and stability
of Spine Toolbox and SpineOpt.jl under different potential circumstances.

Vertice Graph theory term. See Project item.
View A project item that can be used for visualizing project data.

Work directory Tool specifications can be executed in Source directory or in work directory. When a Tool
specification is executed in a work directory, Spine Toolbox creates a new work directory, copies all required and
optional files needed for running the Tool specification to this directory and executes it there. After execution
has finished, output or result files can be copied into a timestamped (archive) directory from the work directory.
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Spine Toolbox requires Python 3.7 or Python 3.8. Python 3.9 is not supported yet.

DEPENDENCIES

The dependencies have been split to required packages and development packages. The required packages must be
installed for the application to start. The development packages contain tools that are recommended for developers.
If you want to deploy the application yourself by using the provided cx_Freeze_setup.py file, you need to install the

cx_Freeze package (v6.6 or newer recommended).

At the moment, Spine Toolbox depends on four main packages (spinetoolbox, spine-engine, spine-items, and spinedb-
api) developed in Spine project. For version number limitations, please see requirements.txt and setup.py files in
spinetoolbox, spine-engine, spine-items, and spinedb-api packages

17.1 Dependencies by package

17.1.1 spinetoolbox

Package name | License
spinedb-api LGPL
spine_engine LGPL
spine_items* LGPL
pyside2 LGPL
datapackage MIT
jupyter-client BSD
gtconsole BSD
sqlalchemy MIT
numpy BSD
matplotlib BSD
scipy BSD
networkx BSD
cx_Oracle BSD
pandas BSD
pymysql MIT
pyodbc MIT
psycopg2 LGPL
jill MIT

* spine-items is not a ‘hard’ requirement of Spine Toolbox. The app does start without spine-items but the features in

that case are quite limited.
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17.1.2 spinedb-api

17.1.3 spine-engine

17.1.4 spine-items

Package name | License
sglalchemy MIT
alembic MIT
faker MIT
python-dateutil PSF
numpy BSD
openpyxl MIT/Expat
gdx2py MIT
ijson BSD
Package name | License
spinedb-api LGPL
dagster Apache-2.0
sqlalchemy MIT
numpy BSD
datapackage MIT
Package name | License
spinetoolbox LGPL
spinedb-api LGPL
spine-engine LGPL

17.2 Development packages

Below is a list of development packages in dev-requirements.txt. Sphinx and sphinx_rtd_theme packages are needed
for building the user guide. Black is used for code formatting while pylint does linting. Pre-commit hook enables

automatic code formatting at git commit.

Package name License
black MIT
pre-commit MIT
pyYAML GPL
pylint GPL
sphinx BSD
sphinx_rtd_theme | MIT
recommonmark MIT
sphinx-autoapi MIT
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CONTRIBUTION GUIDE FOR SPINE TOOLBOX

All are welcome to contribute! This guide is based on a set of best practices for open source projects [JF18].

18.1 Reporting Bugs

18.1.1 Due Diligence

Before submitting a bug report, please do the following:
Perform basic troubleshooting steps.

1. Make sure you’re on the latest version. If you're not on the most recent version, your problem may have been
solved already! Upgrading is always the best first step.

2. Try older versions. If you're already on the latest release, try rolling back a few minor versions (e.g. if on 1.7,
try 1.5 or 1.6) and see if the problem goes away. This will help the devs narrow down when the problem first
arose in the commit log.

3. Try switching up dependency versions. If you think the problem may be due to a problem with a dependency
(other libraries, etc.). Try upgrading/downgrading those as well.

4. Search the project’s bug/issue tracker to make sure it’s not a known issue. If you don’t find a pre-existing
issue, consider checking with the maintainers in case the problem is non-bug-related. Spine Toolbox issue tracker
is here.

18.1.2 What to Put in Your Bug Report

Make sure your report gets the attention it deserves: bug reports with missing information may be ignored or punted
back to you, delaying a fix. The below constitutes a bare minimum; more info is almost always better:

1. What version of the Python interpreter are you using? E.g. Python 2.7.3, Python 3.6?

2. What operating system are you on? Windows? (Vista, 7, 8, 8.1, 10). 32-bit or 64-bit? Mac OS X? (e.g. 10.7.4,
10.9.0) Linux (Which distro? Which version of that distro? 32 or 64 bits?) Again, more detail is better.

3. Which version or versions of the software are you using? If you have forked the project from Git, which branch
and which commit? Otherwise, supply the application version number (Help->About menu). Also, ideally you
followed the advice above and have ruled out (or verified that the problem exists in) a few different versions.

4. How can the developers recreate the bug? What were the steps used to invoke it. A screenshot demonstrating the
bug is usually the most helpful thing you can report (if applicable) Relevant output from the Event Log or debug
messages from the console of your run, should also be included.
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18.2 Feature Requests

The developers of Spine Toolbox are happy to hear new ideas for features or improvements to existing functionality.
The format for requesting new features is free. Just fill out the required fields on the issue tracker and give a description
of the new feature. A picture accompanying the description is a good way to get your idea into development faster. But
before you make a new issue, check that there isn’t a related idea already open in the issue tracker. If you have an idea
on how to improve an existing idea, just join the conversation.

18.3 Submitting features/bugfixes

If you feel like you can fix a bug that’s been bothering you or you want to add a new feature to the application but
the devs seem to be too busy with something else, please follow the instructions in the following sections on how to
contribute code.

18.3.1 Coding Style

Follow the style you see used in the repository! Consistency with the rest of the project always trumps other consider-
ations. It doesn’t matter if you have your own style or if the rest of the code breaks with the greater community - just
follow along.

Spine Toolbox coding style follows PEP-8 style guide for Python code with the following variations:
e Maximum line length is 120 characters. Longer lines are acceptable for a good reason.

* Google style docstrings with the title and input parameters are required for all classes, functions, and methods.
For small functions or methods only the summary is necessary. Return types are highly recommended but not
required if it is obvious what the function or method returns.

» Use double-quoted strings instead of single-quoted strings (e.g. "hello").

¢ Other deviations from PEP-8 can be discussed.

18.3.2 Commit messages

The commit message should tell what was changed and why. Details on how it was done can usually be left out, if
the code itself is self-explanatory (remember source comments too!). Separate the subject line from the body with a
blank line. The subjet line (max. 50 chars) should explain in condensed form what happened using imperative mood,
i.e. using verbs like ‘change’, ‘fix’ or ‘add’. Start the subject line with a capital letter. Do not use the issue number on
the subject line, as it does not tell much to a person who’s not aware of that particular issue. For more info see Chris
Beams’ ‘Seven rules of of a great Git commit message’ [CB14].

A good example (insipred by [CB14])

Fix bugs when updating parameters in foo and bar

Body of the commit message starts after a blank line. Explain here in more

detail the reasons why you made the change, how things worked before and how they work.
—Now.

Also explain why

You can use hyphens to make bulleted lists:
- Foo was added because of bar

(continues on next page)
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(continued from previous page)

- Baz was not used so it was deleted
Add references to issue tracker (if any) at the end.

Solves: #123
See also: #456, #789

18.3.3 Contributing to the User Guide

Spine Toolbox uses Sphinx to create HTML pages from restructured text (.rst) files. The .rst files are plain text files that
are formatted in a way that Sphinx understands and is able to turn them into HTML. Please see this brief introduction
for more on reStructured text. You can modify the existing or create new .rst files into docs/source directory. When
you are done editing, run bin/build_doc.bat on Windows or bin/build_doc.py on other systems to build the
HTML pages to check the result before making a commit. The created pages are found in docs/build/html directory.
After a commit, the User Guide is built automatically by readthedocs.org. The latest User Guide is available in https:
/Ispine-toolbox.readthedocs.io/en/latest/.

18.3.4 Contributing to the Spine Toolbox Graphical User Interface

If you want to change or add new widgets into the application, you need to use the bin\build_ui.bat (Windows)
or bin/build_ui.py (other systems) scripts. The main design of the widgets should be done with Qt Designer
(designer.exe or designer) that is included with PySide2. The files produced by Qt Designer are XML files (.ui).
You can also embed graphics (e.g. icons, logos, etc.) into the application by using Qt Designer. When you are done
modifying widgets in the designer, you need to run the build_ui script for the changes to take effect. This script uses
tools provided in the PySide2 package to turn .ui files into Python files, in essence rebuilding the whole Spine Toolbox
user interface.

Styling the widgets should be done with Qt Style Sheets in code. Please avoid using style sheets in Qt Designer.

18.3.5 Version Control Branching

Always make a new branch for your work, no matter how small. This makes it easy for others to take just that one
set of changes from your repository, in case you have multiple unrelated changes floating around. A corollary: don’t
submit unrelated changes in the same branch/pull request! The maintainer shouldn’t have to reject your awesome bugfix
because the feature you put in with it needs more review.

Name your new  branch  descriptively, e.g. issue#XXX-fixing-a-serious-bug or
issue#ZZZ-cool-new-feature. New branches should in general be based on the latest master branch. In
case you want to include a new feature still in development, you can also start working from its branch. The developers
will backport any relevant bug-fixes to previous or upcoming releases under preparation.

If you need to use code from an upstream branch, please use git-rebase if you have not shared your work with others
yet. For example: You started working on an issue, but now the upstream branch (master) has some new commits you
would like to have in your branch too. If you have not yet pushed your branch, you can now rebase your changes on top
of the upstream branch:

$ git pull origin master:master
$ git checkout my_branch
$ git rebase master
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Avoid merging the upstream branch to your issue branch if it’s not necessary. This will lead to a more linear and cleaner
history.

Finally, make a pull request from your branch so that the developers can review your changes. You might be asked to
make additional changes or clarifications or add tests to prove the new feature works as intended.

18.3.6 Test-driven development is your friend
Any bug fix that doesn’t include a test proving the existence of the bug being fixed, may be suspect. Ditto for new
features that can’t prove they actually work.

It is recommended to use test-first development as it really helps make features better designed and identifies potential
edge cases earlier instead of later. Writing tests before the implementation is strongly encouraged.

See Unit testing guidelines for more information.

18.3.7 Full example

Here’s an example workflow. Your username is yourname and you’re submitting a basic bugfix.
Preparing your Fork
1. Click ‘Fork’ on Github, creating e.g. yourname/Spine-Toolbox
2. Clone your project: git clone git@github.com:yourname/Spine-Toolbox
3. cd Spine-Toolbox
4. Create a virtual environment and install requirements
5. Create a branch: git checkout -b foo-the-bars master
Making your Changes
1. Add an entry to CHANGELOG.md.
2. Write tests expecting the correct/fixed functionality; make sure they fail.
3. Hack, hack, hack.
4. Run tests again, making sure they pass.
5. Commit your changes: git commit -m "Foo the bars"
Creating Pull Requests
1. Push your commit to get it back up to your fork: git push origin HEAD
2. Visit Github, click handy ‘Pull request® button that it will make upon noticing your new branch.

3. In the description field, write down issue number (if submitting code fixing an existing issue) or describe the
issue + your fix (if submitting a wholly new bugfix).

4. Hit ‘submit’! And please be patient - the maintainers will get to you when they can.
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CHAPTER
NINETEEN

DEVELOPER DOCUMENTATION

Here you can find developer specific documentation on Spine Toolbox.

19.1 Ul guidelines

19.1.1 Keyboard shortcuts

Qt has a list of ‘standard’ keyboard shortcuts which can be used for inspiration.
» F2: edit current value in-place
e Alt + F2: open separate editor (e.g. Parameter value editor)
* F3: search
* Alt-F4: quit, close without saving changes
* Esc: close, exit without saving changes

 Ctrl + Enter: accept dialog

19.1.2 Action names

e Edit... should open an external editor, e.g. Parameter value editor in Database editor.

19.2 Unit testing guidelines

19.2.1 Test modules, directories

Spine project uses Python standard unittest framework for testing. The tests are organized into Python modules starting
with the prefix test_ under <project root>/tests/. The structure of tests/ mirrors that of the package being
tested. Note that all subdirectories containing test modules under tests/ must have an (empty) __init__.py which
makes them part of the project’s test package.

While there are no strict rules on how to name the individual test modules except for the test_ prefix,
test_<module_name>.py is preferred.
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19.2.2 Running the tests
Tests are run as a GitHub action whenever a branch is pushed to GitHub. This process is configured by <project
root>/.github/workflows/unittest_runner.yml

To execute the tests manually, run python -munittest discover in project’s root.

19.2.3 Helpers

mock_helpers module in Toolbox’s test package contains some helpful functions. Especially the methods to create
mock ToolboxUI and SpineToolboxProject objects come very handy.

When instantiation of QWidget (this includes all GUI testing) is needed, Qt’s main loop must be running during testing.
This can be achieved by e.g. the setUpClass method below:

@classmethod
def setUpClass(cls):
if not QApplication.instance():
QApplication()

Sometimes an in-memory database can be handy because it does not require a temporary files or directories and it may
be faster than an .sqlite file. To create an in-memory database, use sqlite:// as the URL:

db_map = DiffDatabaseMapping('sqlite://", create=True)

Unfortunately, it is not possible to refer to the created database with the same URL prohibiting multiple database maps
the access to the same in-memory database.

19.3 Execution tests

Toolbox contains execution tests that test entire workflows in the headless mode. The tests can be found in <toolbox
repository root>/execution_tests/. Execution tests are otherwise normal Toolbox projects except that the
project root directories contain __init__.py and execution_test.py files. __init__.py makes the directory part
of the execution test suite while execution_test.py contains actual test code. The tests utilize Python’s unittest
package so the test code is practically identical to any unit tests in Toolbox.

19.3.1 Executing the tests
Tests are run as a GitHub action whenever a branch is pushed to GitHub. This process is configured by <project
root>/.github/workflows/executiontest_runner.yml

To execute the tests manually, run python -munittest discover --pattern execution_test.py in project’s
root.
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19.4 Project item development

This document discusses the basics of project item development: what is required make one, how items interact with
the Toolbox GUI and how they are executed.

The core of every project item consists of two classes: a static project item class which is responsible for integrating the
item with the Toolbox GUI and an executable class which does the item’s ‘thing’ and exists only during execution in
Spine Engine. Some additional classes are needed for Toolbox to be able to instantiate project items and to communicate
with the user via the Toolbox GUI.

Specifications are a way to make the settings of an item portable across projects. In a sense a specification is a template
that can specialize an item for a specific purpose such as a Tool that runs certain model with known inputs an outputs.
Items that support specifications need to implement some additional methods and classes.

19.4.1 Getting started

Probably the most convenient way to start developing a new project item is to work with a copy of some simple project
item. For example, View provides a good starting point.

Project items are mostly self-contained Python packages. It is customary to structure the project item packages like the
Toolbox itself: mvcmodels submodule for Qt’s models, ui module for automatically generated Ul forms and widgets
for widgets’ business logic. However, the only actual requirement is that Toolbox expects to find the item’s factory and
item info classes in the package’s root modules as well as an executable_item module.

19.4.2 Item info

A subclass of spine_engine.project_item.project_item_info.ProjectItemInfo must be found in one of
the root modules of an item’s package. It is used by Toolbox to query the type and category of an item. Type identifies
the project item while category is used by the Toolbox GUI to group project items with similar function. Categories
are currently fixed and can be checked from spine_items.category.

19.4.3 Item Factory

The details of constructing a project item and related objects have been abstracted away from Toolbox by a factory
that must be provided by every project item in a root module of the item’s package. The factory is a subclass of
spinetoolbox.project_item.project_item_factory.ProjectItemFactory. Note that methods in the fac-
tory that deal with specifications need to be implemented only by items that support them.

19.4.4 Executable item

A project item must have a root module called executable_item that contains a class named ExecutableItem
which is a subclass of spine_engine.project_item.executable_item_base.ExecutableItemBase
ExecutableItem acts as an access point to Spine Engine and contains the item’s execution logic.
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19.4.5 Toolbox side project item

A project item must subclass spinetoolbox.project_item.project_item.ProjectItem and return the subclass
in its factory’s item_class() method. Also make_item() must return an instance of this class. This class forms the
core of integrating the item with Toolbox.

19.4.6 Specifications

Items that support specifications need to subclass spine_engine.project_item.
project_item_specification_factory.ProjectItemSpecificationFactory which provides an access
point to Toolbox and Spine Engine to generate specifications. The factory must be called SpecificationFactory
and be placed in specification_factory module under item package’s root. The specification itself should be a
subclass of spine_engine.project_item.project_item_specification.ProjectItemSpecification.

19.4.7 Toolbox GUI integration

ProjectItemFactory.icon() returns a URL to the item’s icon resource. This is the item’s ‘symbol’ shown
e.g. on the main toolbar of Toolbox. It should not be confused with the actual icon on Design view which in
turn is a subclass of spinetoolbox.project_item.project_item_icon.ProjectItemIcon and is returned by
ProjectItemFactory.make_icon().

When creating a new item on the Design view Toolbox shows the Add item dialog it gets from ProjectItemFactory.
make_add_item_widget(). Toolbox provides spinetoolbox.widgets.add_project_item_widget.
AddProjectItemiWidget which is a general purpose widget for this purpose though project items are free to
implement their own widgets as needed.

Once the item is on the Design view, the main interaction with it goes through the properties widget which is created
by ProjectItemFactory.make_properties_widget (). The properties widget should have all controls needed to
set up the item.

19.4.8 Saving and restoring project items

Project items are saved in JSON format as part of the project. json file. Item saving is handled by ProjectItem.
item_dict () which should return a JSON compatible dict and contain at least the information returned by the base
class method.

File system paths are handled specifically during saving: all paths outside the project directory should be absolute
while the paths in the project directory should be relative. This is to enable self-contained projects which include
all needed files and can be easily transferred from system to system. As such, paths are saved as special dictio-
naries. spine_engine.utils.serialization.serialize_path(), spine_engine.utils.serialization.
serialize_url() and spine_engine.utils.serialization.deserialize_path() help with dealing with the
paths.

ProjectItem.from_dict() is responsible for restoring a saved project item from the dictionary. ProjectItem.
parse_item_dict() can help to deserialize the basic data needed by the base class.
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19.4.9 Passing data between items: resources

Project items share data by files or via databases. One item writes a file which is then read by another item. Project
item resources are used to communicate the URLSs of these files and databases.

Resources are instances of the spine.engine.project_item.project_item_resource.
ProjectItemResource class.

Both static items and their executable counterparts pass resources. The major difference is that static item’s may pass
resource promises such as files that are generated during the execution. The full path to the promised files or even their
final names may not be known until the items are executed.

During execution resources are propagated only to item’s direct predecessors and successors. Static items offer their
resources to direct successors only. Resources that are communicated to successor items are basically output files that
the successor items can use for input. Currently, the only resource that is propagated to predecessor items is database
URLSs by Data Store project items. As Data Stores leave the responsibility of writing to the database to other items it
has to tell these items where to write their output data.

The table below lists the resources each project item type provides during execution.

Item Notes | Provides to predecessor | Provides to successor
Data Connection | ' n/a File URLs

Data Store z Database URL Database URL

Data Transformer | ° n/a Database URL

Exporter n/a File URLs

GdxExporter n/a File URLs

Gimlet n/a Resources from predecessor
Importer n/a n/a

Tool 4 n/a File URLs

View n/a n/a

The table below lists the resources that might be used by each item type during execution.

Item Notes | Accepts from predecessor | Accepts from successor
Data Connection n/a n/a

Data Store n/a n/a

Data Transformer Database URL n/a

Exporter Database URL n/a

GdxExporter Database URL n/a

Gimlet 3 File URLs, database URLs Database URLs

Importer 0 File URLSs Database URL

Tool 7 File URLs, database URLs Database URLs

View Database URLSs n/a

! Data connection provides paths to local files.

2 Data Store provides a database URL to direct successors and predecessors. Note, that this is the only project item that provides resources to it’s
predecessors.

3 Data Transformer provides its predecessors’ database URLs modified by transformation configuration embedded in the URL.

4 Tool’s output files are specified by a Tool specification.

5 Gimlet’s resources can be passed to the command as command line arguments but are otherwise ignored.

6 Importer requires a database URL from its successor for writing the mapped data. This can be provided by a Data Store.

7 Tool specification specifies tool’s optional and required input files. Database URLSs can be passed to the tool program via command line
arguments but are otherwise ignored by the Tool project item. Currently, there is no mechanism to know if a URL is actually required by a tool
program. For more information, see Tool specification editor.
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19.4.10 Execution

Spine Engine instantiates the executable items in a DAG before the execution starts. Then, Engine declares for-
ward and backward resources for each item using ExecutableItemBase.output_resources(). During execution,
ExecutableItemBase.execute() is invoked with lists of available resources if an item is selected for execution.
Otherwise, ExecutableItemBase.exclude_execution() is called.

19.5 Publishing to PyPI

This document describes the prerequisites and workflow to publish Spine Toolbox (or any Python package) to The
Python Package Index (PyPI). For a complete tutorial, see Packaging Python Projects.

First, make sure you have all the developer packages installed by calling

$ pip install --upgrade -r dev-requirements.txt

inside your Python environment.

19.5.1 Building

Build a source distribution archive and a wheel package with

$ python setup.py sdist bdist_wheel

This will create distribution files under the ‘dist’ directory. Please remember to clean up between subsequent builds:

$ python setup.py clean --all

Before uploading, tag the code revision with

$ git tag --message "Version x.y.z" <version number>

where the version number is a string given by spinetoolbox.__version__.

19.5.2 Uploading

Before making a real upload, please test using TestPyPI which is a separate instance from the real index server. Once
a version has been uploaded to PyPI, it cannot be reverted or modified.

Register an account and ask some of the owners of the Spine Toolbox package (or other relevant package) to add you
as a maintainer.

Upload the distribution using

$ twine upload --repository testpypi dist/*

See Using TestPyPI for more information. To avoid entering your username and password every time, see Keyring
support in twine documentation.

If everything went smoothly, you are ready to upload the real index. Again, you need to register to PyPI and ask to
become a maintainer of the package you want to upload to. Upload the distribution using

$ twine upload dist/*
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CHAPTER
TWENTY

API REFERENCE

This page contains auto-generated API reference documentation'.

20.1 spinetoolbox

spinetoolbox package.

20.1.1 Subpackages

spinetoolbox.mvcmodels

Modules in this package contain classes that represent Spine Toolbox’s models (internal data structures) in the Model-
View-Controller design pattern. The model classes define an interface that is used by views and delegates to access
data in the application.

author
P. Savolainen (VTT)
date 24.9.2019

Submodules
spinetoolbox.mvcmodels.array_model

Contains model for the Array editor widget.
author
A. Soininen (VTT)
date 14.6.2019

! Created with sphinx-autoapi
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Module Contents

Classes

ArraylModel Model for the Array parameter_value type.

class spinetoolbox.mvcmodels.array_model.ArrayModel (parent)
Bases: PySide2.QtCore.QAbstractTableModel

Model for the Array parameter_value type.

Even if the array is empty this model’s rowCount() will still return 1. This is to show an empty row in the table
view.

Parameters parent (QObject) — parent object

array (self)
Returns the array modeled by this model.

batch_set_data(self, indexes, values)
Sets data at multiple indexes at once.

Parameters
¢ indexes (1ist of QModelIndex) — indexes to set
* values (list of str) - values corresponding to the indexes

columnCount (self, parent=QModellndex())
Returns 2.

_convert_to_data_type(self, indexes, values)
Converts values from string to current data type filtering failed conversions.

Parameters
e indexes (1ist of QModelIndex) — indexes
e values (1ist of str)— values to convert
Returns indexes and converted values
Return type tuple

data(self, index, role=Qt.DisplayRole)
Returns model’s data for given role.

flags (self, index)
Returns table cell’s flags.

headerData (self, section, orientation, role=Qt.DisplayRole)
Returns header data.

insertRows (self, row, count, parent=QModellndex())
Inserts rows to the array.

is_expanse_row (self, row)
Returns True if row is the expanse row.

Parameters row (int) —a row
Returns True is row is expanse row, False otherwise

Return type bool
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removeRows (self, row, count, parent=QModellndex())
Removes rows from the array.

reset(self, value)
Resets the model to a new array.

Parameters value (Array) —a new array to model

rowCount (self, parent=QModellndex())
Returns the length of the array.

Note: returns 1 even if the array is empty.

set_array_type(self, new_type)
Changes the data type of array’s elements.

Parameters new_type (Type) — new element type
setHeaderData(self, section, orientation, value, role=Qt.EditRole)

setData(self, index, value, role=Qt.EditRole)
Sets the value at given index.

spinetoolbox.mvcmodels. compound_table_model

Models that vertically concatenate two or more table models.
authors
M. Marin (KTH)
date 9.10.2019

Module Contents

Classes
CompoundTableModel A model that concatenates several sub table models ver-
tically.
CompoundWithEmptyTableModel A compound parameter table model where the last

model is an empty row model.

class spinetoolbox.mvcmodels.compound_table_model.CompoundTableModel (parent=None,
header=None)
Bases: spinetoolbox.mvcmodels.minimal_table_model.MinimalTableModel

A model that concatenates several sub table models vertically.
Initializes model.

Parameters parent (QObject) — the parent object
refreshed

map_to_sub (self, index)
Returns an equivalent submodel index.

Parameters index (QModelIndex) — the compound model index.
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Returns the equivalent index in one of the submodels
Return type QModellndex

map_f£rom_sub (self, sub_model, sub_index)
Returns an equivalent compound model index.

Parameters
¢ sub_model (MinimalTableModel) — the submodel
¢ sub_index (QModelIndex) — the submodel index.
Returns the equivalent index in the compound model
Return type QModellndex

item_at_row(self, row)
Returns the item at given row.

Parameters row (int) —
Returns object

sub_model_at_row(self, row)
Returns the submodel corresponding to the given row in the compound model.

Parameters row (int) —
Returns MinimalTableModel

refresh(self)
Refreshes the layout by computing a new row map.

_do_refresh(self)
Recomputes the row and inverse row maps.

_append_row_map (self, row_map)
Appends given row map to the tail of the model.

Parameters row_map (1ist) — tuples (model, row number)

_row_map_iterator_for_model (self, model)
Yields row map for given model. The base class implementation just yields all model rows.

Parameters model (MinimalTablelModel) —
Yields tuple — (model, row number)

_row_map_for_model (self, model)
Returns row map for given model. The base class implementation just returns all model rows.

Parameters model (MinimalTableModel) —
Returns tuples (model, row number)
Return type list

canFetchlMore (self, parent)
Returns True if any of the submodels that haven’t been fetched yet can fetch more.

fetchMore (self, parent)
Fetches the next sub model and increments the fetched counter.

flags (self, index)
Return index flags.
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data(self, index, role=Qt.DisplayRole)
Returns the data stored under the given role for the item referred to by the index.

Parameters
¢ index (QModelIndex) — Index of item
e role (int) — Data role

Returns Item data for given role.

rowCount (self, parent=QModellndex())
Returns the sum of rows in all models.

batch_set_data(self, indexes, data)
Sets data for indexes in batch. Distributes indexes and values among the different submodels and calls
batch_set_data on each of them.

insertRows (self, row, count, parent=QModellndex())
Inserts count rows after the given row under the given parent. Localizes the appropriate submodel and calls
insertRows on it.

removeRows (self, row, count, parent=QModellndex())
Removes count rows starting with the given row under parent. Localizes the appropriate submodels and
calls removeRows on it.

class spinetoolbox.mvcmodels.compound_table_model .CompoundWithEmptyTableModel (parent=None,
header=None)
Bases: CompoundTableModel

A compound parameter table model where the last model is an empty row model.
Initializes model.
Parameters parent (QObject) — the parent object
property single_models(self)
property empty_model (self)

abstract _create_empty_model (self)
Returns an empty model.

init_model (self)
Initializes the compound model. Basically populates the sub_models list attribute with the result of _cre-
ate_single_models and _create_empty_model.

_connect_single_model (self, model)
Connects signals so changes in the submodels are acknowledge by the compound.

_recompute_empty_row_map (self)
Recomputes the part of the row map corresponding to the empty model.

_handle_empty_rows_removed (self, parent, empty_first, empty_last)
Runs when rows are removed from the empty model. Updates row_map, then emits rowsRemoved so the
removed rows are no longer visible.

_handle_empty_rows_inserted(self, parent, empty_first, empty_last)
Runs when rows are inserted to the empty model. Updates row_map, then emits rowsInserted so the new
rows become visible.

_handle_single_model_about_to_be_reset (self, model)
Runs when given model is about to reset.
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_handle_single_model_reset (self, model)
Runs when given model is reset.

_refresh_single_model (self, model)
_get_insert_position(self, model)
_insert_single_model (self, model)
_get_row_for_insertion(self, pos)
_insert_row_map (self, pos, single_row_map)

clear_model (self)
Clears the model.

spinetoolbox.mvcmodels.empty_row_model

Contains a table model with an empty last row.
authors
M. Marin (KTH)
date 20.5.2018

Module Contents

Classes

EmptyRowModel A table model with a last empty row.

class spinetoolbox.mvcmodels.empty_row_model.EmptyRowModel (parent=None, header=None)
Bases: spinetoolbox.mvcmodels.minimal_table_model.MinimalTableModel

A table model with a last empty row.
Init class.

canFetchMore (self, _parent)
Return True if the model hasn’t been fetched.

fetchMore (self, parent)
Fetch data and use it to reset the model.

flags (self, index)
Return default flags except if forcing defaults.

set_default_row(self, **kwargs)
Set default row data.

clear(self)
Clear all data in model.

reset_model (self, main_data=None)
Reset model.

_handle_data_changed(self, top_left, bottom_right, roles=None)
Insert a new last empty row in case the previous one has been filled with any data other than the defaults.
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removeRows (self, row, count, parent=QModellndex())
Don’t remove the last empty row.

_handle_rows_inserted(self, parent, first, last)
Handle rowslnserted signal.

set_rows_to_default (self, first, last=None)
Set default data in newly inserted rows.

spinetoolbox.mvcmodels. filter_checkbox_list_model

Provides FilterCheckboxListModel for FilterWidget.
author
P. Vennstrom (VTT)
date 1.11.2018

Module Contents

Classes
SimpleFilterCheckboxListModel Init class.
LazyFilterCheckboxListModel Extends SimpleFilterCheckboxListModel to allow for
lazy loading in synch with another model.
DataToValueFilterCheckboxListModel Extends SimpleFilterCheckboxListModel to allow for

translating internal data to a value for display role.

class spinetoolbox.mvcmodels.filter_checkbox_list_model.SimpleFilterCheckboxListModel (parent,
show_empty=True)
Bases: PySide2.QtCore.QAbstractListModel

Init class.

Parameters parent (QWidget) —
_SELECT_ALL_STR = (Select all)
_SELECT_ALL_FILTERED_STR = (Select all filtered)
_EMPTY_STR = (Empty)
_ADD_TO_SELECTION_STR = Add current selection to filter
property _show_empty(self)
property _show_add_to_selection(self)
reset_selection(self)
_handle_select_all_clicked(self)
_check_all_selected(self)
rowCount (self, parent=QModellndex())
data(self, index, role=Qt.DisplayRole)
_handle_index_clicked(self, index)
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set_list(self, data, all_selected=True)
set_selected(self, selected, select_empty=None)
get_selected(self)

get_not_selected(self)

set_filter (self, filter_expression)
search_filter_expression(self, item)

set_base_filter(self, condition)
Sets the base filter. The other filter, the one that works by typing in the search bar, should be applied on top
of this base filter.

Parameters condition (function) — Filter acceptance condition.
apply_filter(self)
_remove_and_add_filtered(self)
_remove_and_replace_filtered(self)
remove_filter (self)
_do_add_items (self, data)
add_items (self, data, selected=None)
remove_items (self, data)

class spinetoolbox.mvcmodels. filter_checkbox_list_model.LazyFilterCheckboxListModel (parent,
source_model,
show_empty=True)
Bases: SimpleFilterCheckboxListModel

Extends SimpleFilterCheckboxListModel to allow for lazy loading in synch with another model.
Init class.
Parameters
e parent (SpineDBEditor) —
* source_model (CompoundParameterlModel) — a model to lazily get data from
canFetchMore (self, parent)
fetchMore (self, parent)

_do_add_items (self, data)
Adds items so the list is always sorted, while assuming that both existing and new items are sorted.

class spinetoolbox.mvcmodels.filter_checkbox_list_model.DataToValueFilterCheckboxListModel (parent,
data_to_value,
show_empty=Tr
Bases: SimpleFilterCheckboxListModel

Extends SimpleFilterCheckboxListModel to allow for translating internal data to a value for display role.
Init class.
Parameters
e parent (SpineDBEditor) —

» data_to_value (method) — a method to translate item data to a value for display role
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data(self, index, role=Qt.DisplayRole)

search_filter_expression(self, item)

spinetoolbox.mvcmodels. filter_execution_model

Contains FilterExecutionModel.
author
M. Marin (KTH)
date 26.11.2020

Module Contents

Classes

FilterExecutionModel

class spinetoolbox.mvcmodels.filter_execution_model.FilterExecutionModel
Bases: PySide2.QtCore.QAbstractItemModel

_item

reset_model (self, item)

index (self, row, column, parent=QModellndex())

parent (self, index)

columnCount (self, parent=QModellndex())

rowCount (self, parent=QModellndex())

headerData(self, section, orientation, role=Qt.DisplayRole)
data(self, index, role=Qt.DisplayRole)

get_log_document (self, filter_id)

get_console(self, filter_id)

spinetoolbox.mvcmodels.indexed_value_table_model

A model for indexed parameter values, used by the parameter_value editors.
authors
A. Soininen (VTT)
date 18.6.2019
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Module Contents

Classes

IndexedValueTableModel A base class for time pattern and time series models.

Attributes

EXPANSE_COLOR

spinetoolbox.mvcmodels.indexed_value_table_model.EXPANSE_COLOR

class spinetoolbox.mvcmodels.indexed_value_table_model.IndexedValueTableModel (value, parent)

Bases: PySide2.QtCore.QAbstractTableModel
A base class for time pattern and time series models.
Parameters
* value (IndexedValue) — a parameter_value
» parent (QObject) — parent object

columnCount (self, parent=QModellndex())
Returns the number of columns which is two.

data(self, index, role=Qt.DisplayRole)
Returns the data at index for given role.

headerData(self, section, orientation=Qt.Horizontal, role=Qt.DisplayRole)
Returns a header.

is_expanse_row(self, row)
Returns True if row is the expanse row.

Parameters row (int) —a row
Returns True if row is the expanse row, False otherwise
Return type bool

reset (self, value)
Resets the model.

rowCount (self, parent=QModellndex())
Returns the number of rows.

setHeaderData (self, section, orientation, value, role=Qt.EditRole)

property value(self)
Returns the parameter_value associated with the model.

192

Chapter 20. API Reference



Spine Toolbox Documentation, Release 0.6.6.dev0-dev.0

spinetoolbox.mvcmodels.map_model

A model for maps, used by the parameter_value editors.
authors
A. Soininen (VTT)
date 11.2.2020

Module Contents

Classes
MapModel A model for Map type parameter values.
Functions
_rows_to_dict(rows) Turns table into nested dictionaries.
_reconstruct_map(tree) Constructs a Map from a nested dictionary.
_data_length(row) Counts the number of non-empty elements at the begin-
ning of row.
_gather_index_names(map_value) Collects index names from Map.
_apply_index_names(map_value, index_names) Applies index names to Map.
Attributes
empty Sentinel for empty cells.

spinetoolbox.mvcmodels.map_model.empty
Sentinel for empty cells.

class spinetoolbox.mvcmodels.map_model.MapModel (map_value, parent)
Bases: PySide2.QtCore.QAbstractTableModel

A model for Map type parameter values.

This model represents the Map as a 2D table. Each row consists of one or more index columns and a value
column. The last columns of a row are padded with Nones.
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Example

Map {
"A": 1.0
"B": Map {"a": -1.0}
"C": 3.0

}

The table corresponding to the above map:

“A” | 1.0 | None
B [ 2" | -1.0
“C” | 3.0 | None

Parameters
* map_value (Map) — a map
» parent (QObject) — parent object
append_column (self)
Appends a new column to the right.

clear (self, indexes)
Clears table cells.

Parameters indexes (1ist of QModelIndex) — indexes to clear

columnCount (self, index=QModellndex())
Returns the number of columns in this model.

convert_leaf_maps(self)

data(self, index, role=Qt.DisplayRole)
Returns the data associated with the given role.

flags (self, index)
Returns flags at index.

headerData(self, section, orientation, role=Qt.DisplayRole)
Returns row numbers for vertical headers and column titles for horizontal ones.

insertColumns (self, column, count, parent=QModellndex())
Inserts new columns into the map.

Parameters

¢ column (int) — column index where to insert

e count (int) — number of new columns

» parent (QModelIndex) — ignored
Returns True if insertion was successful, False otherwise
Return type bool

insertRows (self, row, count, parent=QModellndex())
Inserts new rows into the map.

Parameters

194 Chapter 20

. API Reference




Spine Toolbox Documentation, Release 0.6.6.dev0-dev.0

e row (int) — an index where to insert the new data

e count (int) — number of rows to insert

» parent (QModelIndex) — an index to a parent model
Returns True if the operation was successful
Return type bool

_is_in_expanse (self, row, column)
Returns True, if given row and column is in the right or bottom ‘expanding’ zone

Parameters

e row (int) — row index

e column (int) — column index
Returns True if the cell is in the expanse, False otherwise
Return type bool

is_expanse_column(self, column)
Returns True if given column is the expanse column.

Parameters column (int) — column
Returns True if column is expanse column, False otherwise
Return type bool

is_expanse_row (self, row)
Returns True if given row is the expanse row.

Parameters row (int) — row
Returns True if row is the expanse row, False otherwise
Return type bool

removeColumns (self, column, count, parent=QModellndex())
Removes columns from the map.

Parameters

e column (int) — first column to remove

e count (int) — number of columns to remove

e parent (QModelIndex) — an index to a parent model
Returns True if the operation was successful

removeRows (self, row, count, parent=QModellndex())
Removes rows from the map.

Parameters

e row (int) — first row to remove

e count (int) — number of rows to remove

* parent (QModelIndex) — an index to a parent model
Returns True if the operation was successful

reset (self, map_value)
Resets the model to given map_value.
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rowCount (self, parent=QModellndex())
Returns the number of rows.

set_box (self, top_left, bottom_right, data)
Sets data for several indexes at once.

Parameters

¢ top_left (QModelIndex) — a sequence of model indexes

¢ bottom_right (QModelIndex) — a sequence of values corresponding to the indexes

e data (list of list)- box of data

setData(self, index, value, role=Qt.EditRole)
Sets data in the map.

Parameters
¢ index (QModelIndex) — an index to the model
¢ value (object) — JSON representation of the value
e role (int) — arole
Returns True if the operation was successful
Return type bool
setHeaderData(self, section, orientation, value, role=Qt.EditRole)

trim_columns (self)
Removes empty columns from the right.

value (self)
Returns the Map.

spinetoolbox.mvcmodels.map_model._rows_to_dict (rows)
Turns table into nested dictionaries.

Parameters rows (1ist) — a list of row data
Returns a nested dictionary
Return type dict

spinetoolbox.mvcmodels.map_model._reconstruct_map (free)
Constructs a Map from a nested dictionary.

Parameters tree (dict)— anested dictionary
Returns reconstructed Map
Return type Map

spinetoolbox.mvcmodels.map_model._data_length(row)
Counts the number of non-empty elements at the beginning of row.

Parameters row (1ist)— arow of data
Returns data length
Return type int

spinetoolbox.mvcmodels.map_model._gather_index_names (map_value)
Collects index names from Map.

Returns only the ‘first” index name for nested maps at the same depth.
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Parameters map_value (Map) — map to investigate
Returns index names
Return type list of str

spinetoolbox.mvcmodels.map_model._apply_index_names (map_value, index_names)
Applies index names to Map.

Parameters
* map_value (Map) — target Map

e index_names (1ist of str) - index names

spinetoolbox.mvcmodels.minimal_table_model

Contains a minimal table model.
authors
M. Marin (KTH)
date 20.5.2018

Module Contents

Classes

MinimalTableModel Table model for outlining simple tabular data.

class spinetoolbox.mvcmodels.minimal_table_model.MinimalTableModel (parent=None, header=None,
lazy=True)
Bases: PySide2.QtCore.QAbstractTableModel

Table model for outlining simple tabular data.
Parameters parent (QObject) — the parent object

clear (self)
Clear all data in model.

flags (self, index)
Return index flags.

canFetchMore (self, parent)
Return True if the model hasn’t been fetched.

fetchMore (self, parent)
Fetch data and use it to reset the model.

rowCount (self, parent=QModellndex())
Number of rows in the model.

columnCount (self, parent=QModellndex())
Number of columns in the model.

headerData(self, section, orientation=0t.Horizontal, role=Qt.DisplayRole)
Returns headers.
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set_horizontal_header_labels (self, labels)
Set horizontal header labels.

insert_horizontal_header_labels (self, section, labels)
Insert horizontal header labels at the given section.

horizontal_header_labels(self)

setHeaderData(self, section, orientation, value, role=Qt.EditRole)
Sets the data for the given role and section in the header with the specified orientation to the value supplied.

data(self, index, role=Qt.DisplayRole)
Returns the data stored under the given role for the item referred to by the index.

Parameters
¢ index (QModelIndex) — Index of item
e role (int) — Data role

Returns Item data for given role.

row_data(self, row, role=Qt.DisplayRole)
Returns the data stored under the given role for the given row.

Parameters

e row (int) — Item row

¢ role (int) — Data role
Returns Row data for given role.

setData(self, index, value, role=Qt.EditRole)
Set data in model.

batch_set_data(self, indexes, data)
Batch set data for indexes.

insertRows (self, row, count, parent=QModellndex())
Inserts count rows into the model before the given row. Items in the new row will be children of the item
represented by the parent model index.

Parameters
e row (int) — Row number where new rows are inserted
e count (int) — Number of inserted rows
e parent (QModelIndex) — Parent index
Returns True if rows were inserted successfully, False otherwise

insertColumns (self, column, count, parent=QModellndex())
Inserts count columns into the model before the given column. Items in the new column will be children
of the item represented by the parent model index.

Parameters
e column (int) — Column number where new columns are inserted
e count (int) — Number of inserted columns
e parent (QModelIndex) — Parent index

Returns True if columns were inserted successfully, False otherwise
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removeRows (self, row, count, parent=QModellndex())
Removes count rows starting with the given row under parent.

Parameters
* row (int) — Row number where to start removing rows
e count (int) — Number of removed rows
e parent (QModelIndex) — Parent index
Returns True if rows were removed successfully, False otherwise

removeColumns (self, column, count, parent=QModellndex())
Removes count columns starting with the given column under parent.

Parameters
e column (int) — Column number where to start removing columns
e count (int) — Number of removed columns
e parent (QModelIndex) — Parent index

Returns True if columns were removed successfully, False otherwise

reset_model (self, main_data=None)
Reset model.

spinetoolbox.mvcmodels.minimal_tree_model

Models to represent items in a tree.
authors
P. Vennstrom (VTT), M. Marin (KTH)
date 11.3.2019

Module Contents

Classes
TreelItem A tree item that can fetch its children.
MinimalTreeModel Base class for all tree models.

class spinetoolbox.mvcmodels.minimal_tree_model.TreeItem(model=None)
Bases: PySide2.QtCore.QObject

A tree item that can fetch its children.
Initializes item.

Parameters model (MinimalTreeModel, NoneType)— The model where the item belongs.
fully_fetched

has_children(self)
Returns whether or not this item has or could have children.
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_handle_fully_fetched(self)
Handles fully_fetched.

property model (self)

property child_item_class(self)
Returns the type of child items. Reimplement in subclasses to return something more meaningful.

property children(self)
property parent_item(self)

child(self, row)
Returns the child at given row or None if out of bounds.

last_child(self)
Returns the last child.

child_count (self)
Returns the number of children.

child_number (self)
Returns the rank of this item within its parent or -1 if it’s an orphan.

find_children(self, cond=lambda child: ...)
Returns children that meet condition expressed as a lambda function.

find_child(self, cond=lambda child: ...)
Returns first child that meet condition expressed as a lambda function or None.

next_sibling(self)
Returns the next sibling or None if it’s the last.

previous_sibling(self)
Returns the previous sibling or None if it’s the first.

index (self)
finalize(self)

_do_finalize(self)
Do some final initialization after setting the parent.

insert_children(self, position, children)
Insert new children at given position. Returns a boolean depending on how it went.

Parameters
e position (int) — insert new items here
e children (1ist of Treeltem) - insert items from this iterable

append_children(self, children)
Append children at the end.

remove_children(self, position, count)
Removes count children starting from the given position.

Parameters
* position (int) — position of the first child to remove
e count (int) — number of children to remove

Returns True if operation was successful, False otherwise

Return type bool
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clear_children(self)
Clear children list.

flags (self, column)
Enables the item and makes it selectable.

data(self, column, role=Qt.DisplayRole)
Returns data for given column and role.

can_fetch_more(self)
Returns whether or not this item can fetch more.

fetch_more (self)
Fetches more children.

property display_data(self)
property edit_data(self)

abstract set_data(self, column, value, role)
Sets data for this item.

Parameters

e column (int) — column index

e value (object) — a new value

¢ role (int) - role of the new value
Returns True if data was set successfully, False otherwise
Return type bool

class spinetoolbox.mvcmodels.minimal_tree_model.MinimalTreeModel (parent)
Bases: PySide2.QtCore.QAbstractItemModel

Base class for all tree models.
Init class.
Parameters parent (SpineDBEditor) —

visit_all(self, index=QModellndex(), view=None)
Iterates all items in the model including and below the given index. Iterative implementation so we don’t
need to worry about Python recursion limits.

Parameters
¢ index (QModelIndex) — an index to start. If not given, we start at the root

e view (QTreeView) — a tree view. If given, we only yield items that are visible from that
view. So for example, if a tree item is not expanded then we don’t yield its children.

Yields Treeltem

item_from_index (self, index)
Return the item corresponding to the given index.

index_from_item(self, item)
Return a model index corresponding to the given item.

index (self, row, column, parent=QModellndex())
Returns the index of the item in the model specified by the given row, column and parent index.

parent (self, index)
Returns the parent of the model item with the given index.

20.1. spinetoolbox 201



Spine Toolbox Documentation, Release 0.6.6.dev0-dev.0

columnCount (self, parent=0QModellndex())
rowCount (self, parent=QModellndex())

data(self, index, role=0Qt.DisplayRole)
Returns the data stored under the given role for the index.

setData(self, index, value, role=Qt.EditRole)
Sets data for given index and role. Returns True if successful; otherwise returns False.

flags (self, index)
Returns the item flags for the given index.

hasChildren (self, parent)
canFetchlMore (self, parent)

fetchMore (self, parent)

spinetoolbox.mvcmodels.project_item_model

Contains a class for storing project items.
authors
P. Savolainen (VTT)
date 23.1.2018

Module Contents

Classes

ProjectItemModel Class to store project tree items and ultimately project

items in a tree structure.

class spinetoolbox.mvcmodels.project_item_model.ProjectItemModel (root, parent=None)

Bases: PySide2.QtCore.QAbstractItemModel
Class to store project tree items and ultimately project items in a tree structure.
Parameters
* root (RootProjectTreeItem)— Root item for the project item tree
* parent (QObject) — parent object

root (self)
Returns the root item.

connect_to_project (self, project)
Connects the model to a project.

Parameters project (SpineToolboxProject) — project to connect to

_add_leaf_item(self, name)
Adds a leaf item to the model

Parameters name (str) — project item’s name
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_remove_leaf_item(self, name)
Removes a leaf item from the model.

Parameters name (str) — project item’s name

_rename_item(self, old_name, new_name)
Renames a leaf item.

Parameters
¢ 0ld_name (str) —item’s old name
* new_name (str) — item’s new name

rowCount (self, parent=QModellndex())
Reimplemented rowCount method.

Parameters parent (QModelIndex) — Index of parent item whose children are counted.
Returns Number of children of given parent
Return type int

columnCount (self, parent=QModellndex())
Returns model column count which is always 1.

flags (self, index)
Returns flags for the item at given index

Parameters index (QModelIndex) — Flags of item at this index.

parent (self, index=0QModellndex())
Returns index of the parent of given index.

Parameters index (QModelIndex) — Index of item whose parent is returned
Returns Index of parent item
Return type QModellndex

index (self, row, column, parent=QModellndex())
Returns index of item with given row, column, and parent.

Parameters

e row (int) — Item row

¢ column (int) — Item column

e parent (QModelIndex) — Parent item index
Returns Item index
Return type QModellndex

data(self, index, role=None)
Returns data in the given index according to requested role.

Parameters
* index (QModelIndex) — Index to query
e role (int) — Role to return

Returns Data depending on role.

Return type object
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item(self, index)
Returns item at given index.

Parameters index (QModelIndex) — Index of item
Returns
Item at given index or root project item if index is not valid
Return type RootProjectTreeltem, CategoryProjectTreeltem or LeafProjectTreeltem

find_category (self, category_name)
Returns the index of the given category name.

Parameters category_name (str)— Name of category item to find
Returns index of a category item or None if it was not found
Return type QModellndex

find_item(self, name)
Returns the QModellndex of the leaf item with the given name

Parameters name (str) — The searched project item (long) name
Returns Index of a project item with the given name or None if not found
Return type QModellndex

get_item(self, name)
Returns leaf item with given name or None if it doesn’t exist.

Parameters name (str) — Project item name
Returns LeafProjectTreeltem, NoneType

category_of_item(self, name)
Returns the category item of the category that contains project item with given name

Parameters name (str) — Project item name
Returns category item or None if the category was not found
Return type CategoryProjectTreeltem

insert_item(self, item, parent=QModellndex())

Adds a new item to model. Fails if given parent is not a category item nor a leaf item. New item is inserted

as the last item of its branch.
Parameters

e item (CategoryProjectTreeltem or LeafProjectTreeltem)— Project item to add
to model

e parent (QModelIndex) — Parent project item
Returns True if successful, False otherwise
Return type bool

remove_item(self, item, parent=QModellndex())
Removes item from project.

Parameters
e item (BaseProjectTreeItem)— Item to remove

¢ parent (QModelIndex) — Parent of item that is to be removed
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Returns True if item removed successfully, False if item removing failed
Return type bool

set_leaf_item_name (self, index, name)
Changes the name of the leaf item at given index.

Parameters
¢ index (QModelIndex) — Tree item index
* name (str)— New project item name

items (self, category_name=None)
Returns a list of leaf items in model according to category name. If no category name given, returns all
leaf items in a list.

Parameters category_name (str)— Item category. Data Connections, Data Stores, Importers,
Exporters, Tools or Views permitted.

Returns obj:’list’ of :obj:’LeafProjectTreeltem’: Depending on category_name argument, re-
turns all items or only items according to category. An empty list is returned if there are no
items in the given category or if an unknown category name was given.

n_items (self)
Returns the number of all items in the model excluding category items and root.

Returns Number of items
Return type int

item_names (self)
Returns all leaf item names in a list.

Returns ‘list’ of obj:’str’: Item names
Return type obj

items_per_category (self)
Returns a dict mapping category indexes to a list of items in that category.

Returns dict(QModellndex,list(LeafProjectTreeltem))

leaf_indexes(self)
Yields leaf indexes.

remove_leaves (self)

spinetoolbox.mvcmodels.project_item_specification_models

Contains a class for storing Tool specifications.
authors
P. Savolainen (VTT)
date 23.1.2018
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Module Contents

Classes

ProjectItemSpecificationModel Class to store specs that are available in a project e.g.
GAMS or Julia models.

FilteredSpecificationModel

class spinetoolbox.mvcmodels.project_item_specification_models.ProjectItemSpecificationModel (icons)
Bases: PySide2.QtCore.QAbstractListModel

Class to store specs that are available in a project e.g. GAMS or Julia models.

add_specification(self, name)
Adds a specification to the model.

Parameters name (str) — specification’s name

remove_specification(self, name)
Removes a specification from the model

Parameters name (str) — specification’s name

replace_specification(self, old_name, new_name)
Replaces a specification.

Parameters
e old_name (str) — previous name
* new_name (str)— new name

connect_to_project (self, project)
Connects the model to a project.

Parameters project (SpineToolboxProject) — project to connect to
clear(self)

rowCount (self, parent=None)
Returns the number of specs in the model.

Parameters parent (QModelIndex) — Not used (because this is a list)
Returns Number of rows (available specs) in the model

data(self, index, role=None)
Must be reimplemented when subclassing.

Parameters
 index (QModelIndex) — Requested index
¢ role (int) — Data role

Returns Data according to requested role

flags (self, index)
Returns enabled flags for the given index.

Parameters index (QModelIndex) — Index of spec
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insertRow (self, spec_name, row=None, parent=QModellndex())
Insert row (specification) into model.

Parameters
* spec_name (str)— name of spec added to the model
e row (int, optional)— Row to insert spec to
e parent (QModelIndex) — Parent of child (not used)
Returns Void

removeRow (self, row, parent=QModellndex())
Remove row (spec) from model.

Parameters

* row (int) — Row to remove the spec from

e parent (QModelIndex) — Parent of spec on row (not used)
Returns Boolean variable

specification(self, row)
Returns spec specification on given row.

Parameters row (int) — Row of spec specification
Returns ProjectltemSpecification from specification list or None if given row is zero

specification_row(self, name)
Returns the row on which the given specification is located or -1 if it is not found.

specification_index(self, name)
Returns the QModellndex on which a specification with the given name is located or invalid index if it is
not found.

class spinetoolbox.mvcmodels.project_item_specification_models.FilteredSpecificationModel (item_type)
Bases: PySide2.QtCore.QSortFilterProxyModel

filterAcceptsRow(self, source_row, source_parent)
get_mime_data_text (self, index)

specifications(self)
Yields all specs.

spinetoolbox.mvcmodels.resource_filter_model

Contains ResourceFilterModel.
author
M. Marin (KTH)
date 26.11.2020
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Module Contents

Classes

ResourceFilterModel
param link link whose resources to model

class spinetoolbox.mvcmodels.resource_filter_model.ResourceFilterModel (/ink, undo_stack,

logger)
Bases: PySide2.QtGui.QStandardItemModel

Parameters
e link (Link) - link whose resources to model
* undo_stack (QUndoStack) — an undo stack

* logger (LoggerInterface)—alogger

tree_built

_SELECT_ALL = Select all
_FILTER_TYPES

_FILTER _TYPE_TO_TEXT
_ID_ROLE

property connection(self)

build_tree(self)
Rebuilds model’s contents.

setData(self, index, value, role=Qt.EditRole)

_change_filter_checked_state(self, index, is_on)
Changes the online status of the filter item at index.

Parameters
¢ index (QModelIndex) — item’s index
e is_on (bool) — True if filter are turned online, False otherwise

set_online (self, resource, filter_type, online)
Sets the given filters online or offline.

Parameters
e resource (str)— Resource label

o filter_type (str)—Either SCENARIO_FILTER_TYPE or TOOL_FILTER_TYPE, for
now.

* online (dict) — mapping from scenario/tool id to online flag

_find_filter_type_item(self, resource, filter_type)
Searches for filter type item.

Parameters

e resource (str) —resource label
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« filter_type (str) — filter type identifier
Returns filter type item or None if not found
Return type QStandardltem

_set_all_selected_item(self, resource, filter_type_item, emit_data_changed=False)
Updates ‘Select All” item’s checked state.

Parameters
e resource (str) — resource label
o filter_type_item (QStandardItem) — filter type item

« emit_data_changed (bool) - if True, emit dataChanged signal if the state was updated

spinetoolbox.mvcmodels. shared

Contains stuff that is used by more than one model
author
M. Marin (KTH)
date 23.3.2020

Module Contents

spinetoolbox.mvcmodels. shared.PARSED_ROLE

spinetoolbox.mvcmodels. time_pattern_model

A model for time patterns, used by the parameter_value editors.
authors
A. Soininen (VTT)
date 4.7.2019

Module Contents

Classes

TimePatternlModel A model for time pattern type parameter values.

class spinetoolbox.mvcmodels.time_pattern_model.TimePatternModel (value, parent)
Bases: spinetoolbox.mvcmodels. indexed_value_table_model.IndexedValueTableModel

A model for time pattern type parameter values.
Parameters
* value (IndexedValue) — a parameter_value

* parent (QObject) — parent object
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flags (self, index)
Returns flags at index.

insertRows (self, row, count, parent=QModellndex())
Inserts new time period - value pairs into the pattern.

New time periods are initialized to empty strings and the corresponding values to zeros.
Parameters
e row (int) — an index where to insert the new data
e count (int) — number of time period - value pairs to insert
* parent (QModelIndex) — an index to a parent model
Returns True if the operation was successful
Return type bool

removeRows (self, row, count, parent=QModellndex())
Removes time period - value pairs from the pattern.

Parameters
e row (int) — an index where to remove the data
e count (int) — number of time period - value pairs to remove
e parent (QModelIndex) — an index to a parent model
Returns True if the operation was successful
Return type bool

setData(self, index, value, role=Qt.EditRole)
Sets a time period or a value in the pattern.

Column index 0 corresponds to the time periods while 1 corresponds to the values.
Parameters
¢ index (QModelIndex) — an index to the model
e value (str, float)- anew time period or value
e role (int) —arole
Returns True if the operation was successful
Return type bool

batch_set_data(self, indexes, values)
Sets data for several indexes at once.

Parameters
¢ indexes (Sequence) — a sequence of model indexes

» values (Sequence) — a sequence of time periods/floats corresponding to the indexes
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spinetoolbox.mvcmodels. time_series_model_fixed_resolution

A model for fixed resolution time series, used by the parameter_value editors.
authors
A. Soininen (VTT)
date 4.7.2019

Module Contents

Classes

TimeSeriesModelFixedResolution A model for fixed resolution time series type parameter
values.

class spinetoolbox.mvcmodels.time_series_model_fixed_resolution.TimeSeriesModelFixedResolution(series,
par-
ent)
Bases: spinetoolbox.mvcmodels.indexed_value_table_model.IndexedValueTableModel

A model for fixed resolution time series type parameter values.
Parameters
» series (TimeSeriesFixedResolution) — a time series
» parent (QObject) — parent object

flags (self, index)
Returns flags at index.

property indexes(self)
Returns the time stamps as an array.

insertRows (self, row, count, parent=QModellndex())
Inserts new values to the series.

The new values are set to zero. Start time or resolution are left unchanged.
Parameters
e row (int) — a numeric index to the first stamp/value to insert
» count (int) — number of stamps/values to insert
e parent (QModelIndex) — index to a parent model
Returns True if the operation was successful

removeRows (self, row, count, parent=QModellndex())
Removes values from the series.

Parameters
* row (int) — a numeric index to the series where to begin removing
e count (int) — how many stamps/values to remove

e parent (QModelIndex) — an index to the parent model
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Returns True if the operation was successful.

reset (self, value)
Resets the model with new time series data.

setData(self, index, value, role=Qt.EditRole)
Sets a given value in the series.

Column index 1 refers to values. Note it does not make sense to set the time stamps in fixed resolution
series.

Parameters
¢ index (QModelIndex) — an index to the model
e value (numpy.datetime64, float)— anew stamp or value
e role (int) —arole

Returns True if the operation was successful

batch_set_data(self, indexes, values)
Sets data for several indexes at once.

Only the values of the series are modified as the time stamps are immutable.
Parameters
¢ indexes (Sequence) — a sequence of model indexes
* values (Sequence) — a sequence of floats corresponding to the indexes

set_ignore_year (self, ignore_year)
Sets the ignore_year option of the time series.

set_repeat (self, repeat)
Sets the repeat option of the time series.

set_resolution(self, resolution)
Sets the resolution.

set_start (self, start)
Sets the start datetime.

property values(self)
Returns the values of the time series as an array.

spinetoolbox.mvcmodels.time_series_model_variable_resolution

A model for variable resolution time series, used by the parameter_value editors.
authors
A. Soininen (VTT)
date 5.7.2019
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Module Contents

Classes

TimeSeriesModelVariableResolution A model for variable resolution time series type param-
eter values.

class spinetoolbox.mvcmodels.time_series_model_variable_resolution.TimeSeriesModelVariableResolution(vai

pa
ent
Bases: spinetoolbox.mvcmodels.indexed_value_table_model.IndexedValueTableModel

A model for variable resolution time series type parameter values.
Parameters
* value (IndexedValue) — a parameter_value
» parent (QObject) — parent object

flags (self, index)
Returns the flags for given model index.

property indexes(self)
Returns the time stamps as an array.

insertRows (self, row, count, parent=QModellndex())
Inserts new time stamps and values to the series.

When inserting in the middle of the series the new time stamps are distributed evenly among the time span
between the two time stamps around the insertion point. When inserting at the beginning or at the end
of the series the duration between the new time stamps is set equal to the first/last duration in the original
series.

The new values are set to zero.
Parameters
e row (int) — a numeric index to the first stamp/value to insert
e count (int) — number of stamps/values to insert
» parent (QModelIndex) — index to a parent model
Returns True if the insertion was successful
Return type bool

removeRows (self, row, count, parent=QModellndex())
Removes time stamps/values from the series.

Parameters
e row (int) — a numeric index to the series where to begin removing
e count (int)— how many stamps/values to remove
* parent (QModelIndex) — an index to the parent model

Returns True if the operation was successful.

Return type bool
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reset (self, value)
Resets the model with new time series data.

setData(self, index, value, role=Qt.EditRole)
Sets a given time stamp or value in the series.

Column index O refers to time stamps while index 1 to values.
Parameters
¢ index (QModelIndex) — an index to the model
* value (numpy.datetime64, float)- anew stamp or value
e role (int) —arole
Returns True if the operation was successful
Return type bool

batch_set_data(self, indexes, values)
Sets data for several indexes at once.

Parameters
* indexes (Sequence) — a sequence of model indexes
» values (Sequence) — a sequence of datetimes/floats corresponding to the indexes

set_ignore_year (self, ignore_year)
Sets the ignore_year option of the time series.

set_repeat (self, repeat)
Sets the repeat option of the time series.

property values(self)
Returns the values of the time series as an array.

spinetoolbox.project_item

This subpackage contains base classes for project items.
authors
M. Marin (KTH)
date 8.10.2020

Submodules
spinetoolbox.project_item.project_item

Contains base classes for project items and item factories.
authors
P. Savolainen (VTT)
date 4.10.2018
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Module Contents

Classes

ProjectItem Class for project items that are not category nor root.

class spinetoolbox.project_item.project_item.ProjectItem(name, description, x,y, project)
Bases: spinetoolbox.metaobject.MetaObject

Class for project items that are not category nor root. These items can be executed, refreshed, and so on.

X
horizontal position in the screen
Type float
y
vertical position in the screen
Type float
Parameters

* name (str) — item name

* description (str) — item description

* x (float) — horizontal position on the scene
* y (float) — vertical position on the scene

» project (SpineToolboxProject) — project item’s project

create_data_dir(self)

abstract static item_type()
Item’s type identifier string.

Returns type string
Return type str

abstract static item_category()
Item’s category.

Returns category name

Return type str
property logger (self)
property log_document (self)
property filter_log_documents (self)
property filter_consoles(self)

make_signal_handler_dict (self)
Returns a dictionary of all shared signals and their handlers. This is to enable simpler connecting and
disconnecting. Must be implemented in subclasses.

activate(self)
Restore selections and connect signals.
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deactivate(self)
Save selections and disconnect signals.

restore_selections(self)
Restore selections into shared widgets when this project item is selected.

save_selections(self)
Save selections in shared widgets for this project item into instance variables.

_connect_signals(self)
Connect signals to handlers.

_disconnect_signals(self)
Disconnect signals from handlers and check for errors.

set_properties_ui (self, properties_ui)
Sets the properties tab widget for the item.

Note that this method expects the widget that is generated from the .ui files and initialized with the setupUi()

method rather than the entire properties tab widget.
Parameters properties_ui (QWidget) — item’s properties Ul

specification(self)
Returns the specification for this item.

undo_specification(self)

set_specification(self, specification)
Pushes a new SetltemSpecificationCommand to the toolbox’ undo stack.

do_set_specification(self, specification)
Sets specification for this item. Removes specification if None given as argument.

Parameters specification (ProjectItemSpecification) — specification
None removes the specification.

set_icon(self, icon)
Sets the icon for the item.

Parameters icon (ProjectItemIcon)—item’s icon

get_icon(self)
Returns the graphics item representing this item in the scene.

_check_notifications(self)
Checks if exclamation icon notifications need to be set or cleared.

clear_notifications(self)
Clear all notifications from the exclamation icon.

add_notification(self, text)
Add a notification to the exclamation icon.

remove_notification(self, text)

set_rank (self, rank)
Set rank of this item for displaying in the design view.

property executable_class(self)

handle_execution_successful (self, execution_direction, engine_state)
Performs item dependent actions after the execution item has finished successfully.

Parameters

of this item.
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¢ execution_direction (str) — “FORWARD” or “BACKWARD”
¢ engine_state — engine state after item’s execution

resources_for_direct_successors(self)
Returns resources fOI‘ direct successors.

These resources can include transient files that don’t exist yet, or filename patterns. The default implemen-
tation returns an empty list.

Returns a list of ProjectltemResources
Return type list

resources_for_direct_predecessors(self)
Returns resources for direct predecessors.

These resources can include transient files that don’t exist yet, or filename patterns. The default implemen-
tation returns an empty list.

Returns a list of ProjectltemResources
Return type list

_resources_to_predecessors_changed (self)
Notifies direct predecessors that item’s resources have changed.

_resource_to_predecessors_replaced(self, old, new)
Notifies direct predecessors that one of item’s resources has been replaced.

Parameters
¢ 0old (ProjectItemResource) — old resource
* new (ProjectItemResource) — new resource

upstream_resources_updated (self, resources)
Notifies item that resources from direct predecessors have changed.

Parameters resources (list of ProjectItemResource)— new resources from upstream

replace_resource_from_upstream(self, old, new)
Replaces an existing resource from direct predecessor by a new one.

Parameters
¢ 0old (ProjectItemResource) — old resource
* new (ProjectItemResource) — new resource

_resources_to_successors_changed (self)
Notifies direct successors that item’s resources have changed.

_resource_to_successors_replaced(self, old, new)
Notifies direct successors that one of item’s resources has been replaced.

Parameters
¢ 0old (ProjectItemResource) — old resource
* new (ProjectItemResource) — new resource

downstream_resources_updated(self, resources)
Notifies item that resources from direct successors have changed.

Parameters resources (list of ProjectItemResource) — new resources from down-
stream
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replace_resource_from_downstream(self, old, new)
Replaces an existing resource from direct successor by a new one.

Parameters
¢ 0ld (ProjectItemResource) — old resource
* new (ProjectItemResource) — new resource

invalidate_workflow(self, edges)
Notifies that this item’s workflow is not acyclic.

Parameters edges (1ist)— A list of edges that make the graph acyclic after removing them.
revalidate_workflow(self)

item_dict (self)
Returns a dictionary corresponding to this item.

static parse_item_dict (item_dict)
Reads the information needed to construct the base Projectltem class from an item dict.

Parameters item_dict (dict) — an item dict
Returns item’s name, description as well as x and y coordinates
Return type tuple

copy_local_data(self, item_dict)
Copies local data linked to a duplicated project item.

Parameters item_dict (dict) — serialized item

abstract static from_dict (name, item_dict, toolbox, project)
Deserialized an item from item dict.

Parameters

e name (str) — item’s name

e item_dict (dict) — serialized item

¢ toolbox (ToolboxUTI) — the main window

e project (SpineToolboxProject) — a project
Returns deserialized item
Return type Projectitem

actions(self)
Item specific actions.

Returns item’s actions
Return type list of QAction

rename (self, new_name, rename_data_dir_message)
Renames this item.

If the project item needs any additional steps in renaming, override this method in subclass. See e.g.
rename() method in DataStore class.

Parameters

¢ new_name (str)— New name
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* rename_data_dir_message (str)— Message to show when renaming item’s data direc-
tory

Returns True if item was renamed successfully, False otherwise
Return type bool

open_directory (self, checked=False)
Open this item’s data directory in file explorer.

tear_down (self)
Tears down this item. Called both before closing the app and when removing the item from the project.
Implement in subclasses to eg close all QMainWindows opened by this item.

set_up(self)
Sets up this item. Called when adding the item to the project. Implement in subclasses to eg recreate
attributes destroyed by tear_down.

abstract update_name_label (self)
Updates the name label on the properties widget when renaming an item.

Must be reimplemented by subclasses.

notify_destination(self, source_item)
Informs an item that it has become the destination of a connection between two items.

The default implementation logs a warning message. Subclasses should reimplement this if they need more
specific behavior.

Parameters source_item (ProjectItem)— connection source item

_create_filter_log_document (self, filter_id)
Creates log document for a filter execution if none yet, and returns it

Parameters filter_id (str) — filter identifier
Returns SignedTextDocument

_create_log_document (self)
Creates log document if none yet, and returns it

Parameters filter_id (str) - filter identifier
Returns SignedTextDocument

add_log_message (self, filter_id, message)
Adds a message to the log document.

Parameters
o filter_id (str) — filter identifier
* message (str) — formatted message

add_event_message (self, filter_id, msg_type, msg_text)
Adds a message to the log document.

Parameters
e filter_id (str) — filter identifier
* msg_type (str) — message type
* msg_text (str) — message text

add_process_message (self, filter_id, msg_type, msg_text)
Adds a message to the log document.
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Parameters
e filter_id (str) — filter identifier
* msg_type (str) — message type
* msg_text (str) — message text

static upgrade_v1_to_v2 (item_name, item_dict)
Upgrades item’s dictionary from v1 to v2.

Subclasses should reimplement this method if there are changes between version 1 and version 2.
Parameters
e item_name (str) —item’s name
e item_dict (dict)— Version 1 item dictionary
Returns Version 2 item dictionary
Return type dict

static upgrade_v2_to_v3(item_name, item_dict, project_upgrader)
Upgrades item’s dictionary from v2 to v3.

Subclasses should reimplement this method if there are changes between version 2 and version 3.
Parameters
e item_name (str) —item’s name
e item_dict (dict)— Version 2 item dictionary
* project_upgrader (ProjectUpgrader) — Project upgrader class instance
Returns Version 3 item dictionary

Return type dict

spinetoolbox.project_item.project_item_factory

Contains base classes for project items and item factories.
authors
P. Savolainen (VTT)
date 4.10.2018

Module Contents

Classes

ProjectItemFactory Class for project item factories.

class spinetoolbox.project_item.project_item_factory.ProjectItemFactory
Class for project item factories.

abstract static item_class()
Returns the project item’s class.
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Returns item’s class
Return type type

static is_deprecated()
Queries if item is deprecated.

Returns True if item is deprecated, False otherwise
Return type bool

abstract static icon()
Returns the icon resource path.

Returns str

abstract static icon_color()
Returns the icon color.

Returns icon’s color
Return type QColor

abstract static make_add_item_widget (toolbox, x, y, specification)
Returns an appropriate Add project item widget.

Parameters

¢ toolbox (ToolboxUT) — the main window

e x (int) — Icon coordinates

¢ y (int) — Icon coordinates

» specification (ProjectItemSpecification)— item’s specification
Returns QWidget

abstract static make_icon(foolbox)
Returns a ProjectItemlcon to use with given toolbox, for given project item.

Parameters toolbox (ToolboxUT) —
Returns item’s icon
Return type Projectltemlcon

abstract static make_item(name, item_dict, toolbox, project)
Returns a project item constructed from the given item_dict.

Parameters

e name (str) — item’s name

e item_dict (dict) — serialized project item

¢ toolbox (ToolboxUT) — Toolbox main window

e project (SpineToolboxProject) — the project the item belongs to
Returns Projectltem

abstract static make_properties_widget (foolbox)
Creates the item’s properties tab widget.

Returns item’s properties tab widget

Return type QWidget
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abstract static make_specification_menu(parent, index)
Creates item specification’s context menu.

Subclasses that do not support specifications can still raise NotImplementedError.
Parameters
* parent (QWidget) — menu’s parent widget
¢ index (QModelIndex) — an index from specification model
Returns specification’s context menu
Return type [temSpecificationMenu

abstract static make_specification_editor (toolbox, specification=None, item=None, **kwargs)
Creates the item’s specification widget.

Subclasses that do not support specifications can still raise NotImplementedError.
Parameters
¢ toolbox (ToolboxUI) — Toolbox main window

» specification (ProjectItemSpecification, optional) - a specification to show
in the widget or None for a fresh start

e item (ProjectItem, optional) — a project item. If the specification is accepted, it is
also set for this item

» **kwargs — parameters passed to the specification widget
Returns item’s specification widget
Return type QWidget

static repair_specification(toolbox, specification)
Called right after a spec is added to the project. Finds if there’s something wrong with the spec and proposes
actions to fix it with help from toolbox.

Parameters
¢ toolbox (ToolboxUT) — Toolbox main window

e specification (ProjectItemSpecification) — a specification to check

spinetoolbox.project_item.specification_editor_window

Contains SpecificationEditorWindowBase and ChangeSpecPropertyCommand
author
M. Marin (KTH), P. Savolainen (VTT)
date 12.4.2018
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Module Contents

Classes
ChangeSpecPropertyCommand Command to set specification properties.
SpecificationEditoriWindowBase Base class for spec editors.
_SpecNameDescriptionToolbar A QToolBar to let users set name and description for an
Spec.
Functions
prompt_to_save_changes(parent, settings, Prompts to save changes.

save_callback)

class spinetoolbox.project_item.specification_editor_window.ChangeSpecPropertyCommand (callback,
new_value,
old_value,

cmd_name)
Bases: PySide2.QtWidgets.QUndoCommand

Command to set specification properties.
Parameters
» callback (function) — Function to call to set the spec property.
e new_value (any) — new value
e old_value (any) — old value

e cmd_name (str)— command name

redo(self)
undo (self)
class spinetoolbox.project_item.specification_editor_window.SpecificationEditorWindowBase (foolbox,

spec-
i-
fi-
ca-
tion=None,

item=None)
Bases: PySide2.QtWidgets.QMainWindow

Base class for spec editors.
Parameters
e toolbox (ToolboxUI) — QMainWindow instance

» specification (ProjectItemSpecification, optional) - If given, the form is pre-
filled with this specification

e item (ProjectItem, optional) - Sets the spec for this item if accepted
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property settings_group (self)
Returns the settings group for this spec type.

Returns str

abstract _make_ui (self)
Returns the ui object from Qt designer.

Returns object

_restore_dock_widgets(self)

Restores dockWidgets to some default state. Called in the constructor, before restoring the ui from settings.

Reimplement in subclasses if needed.

abstract _make_new_specification(self, spec_name)
Returns a ProjectltemSpecification from current form settings.

Parameters spec_name (str)— Name of the spec
Returns ProjectltemSpecification
_show_error (self, message)
_show_status_bar_msg(self, msg)
_bopulate_main_menu(self)
_update_window_modified(self, clean)

_save(self)
Saves spec.

Returns True if operation was successful, False otherwise
Return type bool

property _duplicate_kwargs(self)

_duplicate(self)

tear_down (self)

closeEvent (self, event)

class spinetoolbox.project_item.specification_editor_window._SpecNameDescriptionToolbar (parent,

Bases: PySide2.QtWidgets.QToolBar
A QToolBar to let users set name and description for an Spec.
Parameters

e parent (QMainWindow) — QMainWindow instance
* spec (ProjectItemSpecification) — specification that is being edited
» undo_stack (QUndoStack) — an undo stack

_make_main_menu(self)

_set_name (self)

_set_description(self)

do_set_name (self, name)

do_set_description(self, description)

spec,
undo_stack)
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name (self)
description(self)

spinetoolbox.project_item.specification_editor_window.prompt_to_save_changes(parent, settings,
save_callback)
Prompts to save changes.

Parameters
» parent (QWidget) — Spec editor widget
» settings (QSettings) — Toolbox settings

e save_callback (Callable) — A function to call if the user chooses Save. It must return
True or False depending on the outcome of the ‘saving’.

Returns False if the user chooses to cancel, in which case we don’t close the form.

Return type bool

spinetoolbox.spine_db_editor

This subpackage contains GUI files for the Spine db editor.
authors
M. Marin (KTH)
date 13.5.2020

Subpackages
spinetoolbox.spine_db_editor.mvcmodels

Modules in this package contain classes that represent Spine Toolbox’s models (internal data structures) in the Model-
View-Controller design pattern. The model classes define an interface that is used by views and delegates to access
data in the application.

author
M. Marin (KTH)
date 23.5.2020

Submodules
spinetoolbox.spine_db_editor.mvcmodels.alternative_scenario_item

Classes to represent alternative and scenario items in a tree.
authors
P. Vennstrom (VTT)
date 17.6.2020
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Module Contents

Classes
AlternativeRootItem An alternative root item.
ScenarioRootItem A scenario root item.
AlternativeleafItem An alternative leaf item.
ScenariolLeafItem A scenario leaf item.
ScenarioActiveItem A tree item that fetches their children as they are in-
serted.
ScenarioAlternativeRootItem A scenario alternative root item.
ScenarioAlternativeLeafItem A scenario alternative leaf item.
Attributes

_ALTERNATIVE_ICON

_SCENARIO_ICON

spinetoolbox.spine_db_editor.mvcmodels.alternative_scenario_item._ALTERNATIVE_ICON =
spinetoolbox.spine_db_editor.mvcmodels.alternative_scenario_item._SCENARIO_ICON =

class spinetoolbox.spine_db_editor.mvcmodels.alternative_scenario_item.AlternativeRootItem(model=None)
Bases: spinetoolbox.spine_db_editor.mvcmodels.tree_item_utility.EmptyChildRootItem

An alternative root item.
Initializes item.
Parameters model (MinimalTreeModel, NoneType)— The model where the item belongs.
property item_type(self)
property display_data(self)
property icon_code (self)
empty_child(self)

class spinetoolbox.spine_db_editor.mvcmodels.alternative_scenario_item.ScenarioRootItem(model=None)
Bases: spinetoolbox.spine_db_editor.mvcmodels.tree_item_utility.EmptyChildRootItem

A scenario root item.
Initializes item.
Parameters model (MinimalTreeModel, NoneType)— The model where the item belongs.
property item_type(self)
property display_data(self)
property icon_code(self)

empty_child(self)
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class spinetoolbox.spine_db_editor.mvcmodels.alternative_scenario_item.AlternativeLeafItem(identifier=None
Bases: spinetoolbox.spine_db_editor.mvcmodels. tree_item_utility.GrayIfLastMixin,
spinetoolbox.spine_db_editor.mvcmodels. tree_item_utility.EditableMixin, spinetoolbox.
spine_db_editor.mvcmodels. tree_item_utility.LeafItem

An alternative leaf item.
Initializes item.
Parameters model (MinimalTreeModel, NoneType)— The model where the item belongs.
property item_type(self)
property tool_tip(self)
add_item_to_db (self, db_item)
update_item_in_db(self, db_item)

flags (self, column)
Makes items editable.

class spinetoolbox.spine_db_editor.mvcmodels.alternative_scenario_item.ScenarioLeafItem(identifier=None)
Bases: spinetoolbox.spine_db_editor.mvcmodels. tree_item_utility.GrayIfLastMixin,
spinetoolbox.spine_db_editor.mvcmodels.tree_item_utility.EditableMixin, spinetoolbox.
spine_db_editor.mvcmodels. tree_item_utility.LeafItem

A scenario leaf item.
Initializes item.
Parameters model (MinimalTreeModel, NoneType)— The model where the item belongs.
property item_type(self)
add_item_to_db (self, db_item)
update_item_in_db (self, db_item)
property scenario_alternative_root_item(self)

_do_finalize(self)
Do some final initialization after setting the parent.

handle_updated_in_db(self)

class spinetoolbox.spine_db_editor.mvcmodels.alternative_scenario_item.ScenarioActiveItem(model=None)
Bases: spinetoolbox.spine_db_editor.mvcmodels.tree_item_utility.StandardTreeItem

A tree item that fetches their children as they are inserted.
Initializes item.

Parameters model (MinimalTreeModel, NoneType)— The model where the item belongs.
property item_type(self)

flags (self, column)
Enables the item and makes it selectable.

data(self, column, role=Qt.DisplayRole)
Returns data for given column and role.

set_data(self, column, value, role=Qt.EditRole)
Sets data for this item.

Parameters
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¢ column (int) — column index

¢ value (object) — a new value

e role (int) —role of the new value
Returns True if data was set successfully, False otherwise
Return type bool

class spinetoolbox.spine_db_editor.mvcmodels.alternative_scenario_item.ScenarioAlternativeRootItem(mode
Bases: spinetoolbox.spine_db_editor.mvcmodels.tree_item_utility.EmptyChildRootItem

A scenario alternative root item.
Initializes item.
Parameters model (MinimalTreeModel, NoneType)— The model where the item belongs.
empty_child(self)
property item_type(self)
property display_data(self)
property tool_tip(self)
property icon_code(self)
property alternative_id_list(self)

flags (self, column)
Enables the item and makes it selectable.

update_alternative_id_list(self)

class spinetoolbox.spine_db_editor.mvcmodels.alternative_scenario_item.ScenarioAlternativeLeafItem(ident:
Bases: spinetoolbox.spine_db_editor.mvcmodels. tree_item_utility.GrayIfLastMixin,
spinetoolbox.spine_db_editor.mvcmodels. tree_item_utility.LeafItem

A scenario alternative leaf item.
Initializes item.
Parameters model (MinimalTreeModel, NoneType)— The model where the item belongs.
property item_type(self)
property tool_tip(self)
_make_item_data(self)
property item_data(self)
property alternative_id(self)
abstract add_item_to_db(self, db_item)
abstract update_item_in_db(self, db_item)

flags (self, column)
Enables the item and makes it selectable.

set_data(self, column, value, role=Qt.EditRole)
Sets data for this item.

Parameters

e column (int) — column index
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¢ value (object) — a new value
¢ role (int) - role of the new value
Returns True if data was set successfully, False otherwise

Return type bool

spinetoolbox.spine_db_editor.mvcmodels.alternative_scenario_model

Models to represent alternatives, scenarios and scenario alternatives in a tree.
authors
P. Vennstrom (VTT), M. Marin (KTH)
date 17.6.2020

Module Contents

Classes

AlternativeScenarioModel A model to display alternatives and scenarios in a tree
view.

class spinetoolbox.spine_db_editor.mvcmodels.alternative_scenario_model.AlternativeScenarioModel (parent,
db_mng
*db_ma,
Bases: spinetoolbox.spine_db_editor.mvcmodels. tree_model_base.TreeModelBase

A model to display alternatives and scenarios in a tree view.
Parameters

e parent (SpineDBEditor) —

e db_mngr (SpineDBManager) —

» *db_maps — DiffDatabaseMapping instances
static _make_db_item(db_map)
static _top_children()
_scenarios_per_root (self, db_map_data)
_alternatives_per_root (self, db_map_data)
add_alternatives(self, db_map_data)
add_scenarios (self, db_map_data)
update_alternatives(self, db_map_data)
update_scenarios (self, db_map_data)
remove_alternatives(self, db_map_data)
remove_scenarios (self, db_map_data)

supportedDropActions (self)
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mimeData (self, indexes)
Builds a dict mapping db name to item type to a list of ids.

Returns QMimeData
canDropMimeData (self, data, drop_action, row, column, parent)

dropMimeData(self, data, drop_action, row, column, parent)

spinetoolbox.spine_db_editor.mvcmodels.compound_parameter_models

Compound models for object parameter definitions and values. These models concatenate several ‘single’ models and
one ‘empty’ model.

authors
M. Marin (KTH)
date 28.6.2019

Module Contents

Classes

CompoundParameterModel A model that concatenates several single parameter
models

CompoundObjectParameterMixin Implements the interface for populating and filtering a
compound object parameter model.

CompoundRelationshipParameterMixin Implements the interface for populating and filtering a
compound relationship parameter model.

CompoundParameterDefinitionMixin Handles signals from db mngr for parameter_definition
models.

CompoundParameterValueMixin Handles signals from db mngr for parameter_value mod-
els.

CompoundObjectParameterDefinitionModel A model that concatenates several single object param-

eter_definition models
CompoundRelationshipParameterDefinitionModel A model that concatenates several single relationship pa-
rameter_definition models

CompoundObjectParameterValuelModel A model that concatenates several single object param-
eter_value models
CompoundRelationshipParameterValuelodel A model that concatenates several single relationship pa-

rameter_value models

class spinetoolbox.spine_db_editor.mvcmodels.compound_parameter_models.CompoundParameterModel (parent,
db_mngr,
*db_maps)
Bases: spinetoolbox.mvcmodels. compound_table_model.CompoundWithEmptyTableModel

A model that concatenates several single parameter models and one empty parameter model.
Initializes model.
Parameters

* parent (SpineDBEditor) — the parent object
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» db_mngr (SpineDBManager) — the database manager
» *db_maps (DiffDatabaseMapping) — the database maps included in the model

canFetchMore (self, _parent)
Returns True if any of the submodels that haven’t been fetched yet can fetch more.

fetchMore (self, _parent)
Fetches the next sub model and increments the fetched counter.

fetch_successful (self, db_map, item)
fetch_id(self)
abstract _make_header (self)

property entity_class_type(self)
Returns the entity_class type, either ‘object_class’ or ‘relationship_class’.

Returns str

property item_type(self)
Returns the parameter item type, either ‘parameter_definition’ or ‘parameter_value’.

Returns str

property _single_model_type(self)
Returns a constructor for the single models.

Returns SingleParameterModel

property _empty_model_type(self)
Returns a constructor for the empty model.

Returns EmptyParameterModel

property entity_class_id_key(self)
Returns the key corresponding to the entity_class id (either “object_class_id” or “relationship_class_id”)

Returns str
property parameter_definition_id_key(self)

init_model (self)
Initializes the model.

_make_auto_filter_menus (self)
Makes auto filter menus.

get_auto_filter_menu(self, logical_index)
Returns auto filter menu for given logical index from header view.

Parameters logical_index (int) -
Returns ParameterViewFilterMenu

_modify_data_in_filter_menus(self, action, db_map, db_items)
Modifies data in filter menus.

Parameters
e action (str) — either ‘add’, ‘remove’, or ‘update’
¢ db_map (DiffDatabaseMapping) —
e db_items (1ist(dict)) -

_do_add_data_to_filter_menus(self, db_map, db_items)
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_do_update_data_in_filter_menus (self, db_map, db_items)
_do_remove_data_from_filter_menus (self, db_map, db_items)

headerData (self, section, orientation=Qt.Horizontal, role=0Qt.DisplayRole)
Returns an italic font in case the given column has an autofilter installed.

_create_empty_model (self)
Returns the empty model for this compound model.

Returns EmptyParameterModel

filter_accepts_model (self, model)
Returns a boolean indicating whether or not the given model passes the filter for compound model.

Parameters model (SingleParameterModel, EmptyParameterModel)—
Returns bool

_class_filter_accepts_model (self, model)

_auto_filter_accepts_model (self, model)

accepted_single_models(self)
Returns a list of accepted single models by calling filter_accepts_model on each of them, just for conve-
nience.

Returns list

_invalidate_filter(self)
Sets the filter invalid.

set_filter_class_ids(self, class_ids)

set_auto_filter (self, field, values)
Updates and applies the auto filter.

Parameters
e field (str) — the field name
 values (dict) — mapping db_map to entity_class id to accepted values for the field

_set_compound_auto_filter (self, field, values)
Sets the auto filter for given column in the compound model.

Parameters
e field (str) — the field name

¢ values (dict) — maps tuple (database map, entity_class id) to list of accepted ids for the
field

_set_single_auto_filter(self, model, field)
Sets the auto filter for given column in the given single model.

Parameters

¢ model (SingleParameterlModel) — the model

e field (str) — the field name
Returns True if the auto-filtered values were updated, None otherwise
Return type bool

_row_map_iterator_for_model (self, model)
Yields row map for the given model. Reimplemented to take filter status into account.
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Parameters model (SingleParameterModel, EmptyParameterModel)—
Returns tuples (model, row number) for each accepted row
Return type list

_models_with_db_map (self, db_map)
Returns a collection of single models with given db_map.

Parameters db_map (DiffDatabaseMapping) —
Returns list

receive_entity_classes_removed(self, db_map_data)
Runs when entity classes are removed from the dbs. Removes sub-models for the given entity classes and
dbs.

Parameters db_map_data (dict) — list of removed dict-items keyed by DiffDatabaseMapping

_items_per_class(self, items)
Returns a dict mapping entity_class ids to a set of items.

Parameters items (I1ist)—
Returns dict

receive_parameter_data_added(self, db_map_data)
Runs when either parameter definitions or values are added to the dbs. Adds necessary sub-models and
initializes them with data. Also notifies the empty model so it can remove rows that are already in.

Parameters db_map_data (dict) — list of added dict-items keyed by DiffDatabaseMapping
_get_insert_position(self, model)
_create_single_model (self, db_map, entity_class_id, committed)
_add_parameter_data(self, db_map, entity_class_id, ids, committed)

receive_parameter_data_updated(self, db_map_data)
Runs when either parameter definitions or values are updated in the dbs. Emits dataChanged so the param-
eter_name column is refreshed.

Parameters db_map_data (dict) — list of updated dict-items keyed by DiffDatabaseMapping

receive_parameter_data_removed(self, db_map_data)
Runs when either parameter definitions or values are removed from the dbs. Removes the affected rows
from the corresponding single models.

Parameters db_map_data (dict) — list of removed dict-items keyed by DiffDatabaseMapping

_emit_data_changed_for_column(self, field)
Lazily emits data changed for an entire column.

Parameters field (str) — the column header
db_item(self, index)
db_map_id(self, index)

index_name (self, index)
Generates a name for data at given index.

Parameters index (QModelIndex) —index to model
Returns label identifying the data

Return type str
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get_set_data_delayed(self, index)
Returns a function that ParameterValueEditor can call to set data for the given index at any later time, even
if the model changes.

Parameters index (QModelIndex) —

Returns function
get_entity_class_id(self, index, db_map)
filter_by(self, rows_per_column)
filter_excluding(self, rows_per_column)

class spinetoolbox.spine_db_editor.mvcmodels.compound_parameter_models.
CompoundObjectParameterMixin
Implements the interface for populating and filtering a compound object parameter model.

property entity_class_type(self)

class spinetoolbox.spine_db_editor.mvcmodels.compound_parameter_models.
CompoundRelationshipParameterMixin
Implements the interface for populating and filtering a compound relationship parameter model.

property entity_class_type(self)

class spinetoolbox.spine_db_editor.mvcmodels.compound_parameter_models.
CompoundParameterDefinitionMixin
Handles signals from db mngr for parameter_definition models.

property item_type(self)

class spinetoolbox.spine_db_editor.mvcmodels.compound_parameter_models.
CompoundParameterValueMixin
Handles signals from db mngr for parameter_value models.

_filter_entity_ids
_filter_alternative_ids
property item_type(self)

property entity_type(self)
Returns the entity type, either ‘object’ or ‘relationship’ Used by update_single_main_filter.

Returns str
set_filter_entity_ids(self, entity_ids)
set_filter_alternative_ids (self, alternative_ids)
_create_single_model (self, db_map, entity_class_id, committed)

receive_alternatives_updated(self, db_map_data)
Updated alternative column

Parameters db_map_data (dict) — list of updated dict-items keyed by DiffDatabaseMapping

class spinetoolbox.spine_db_editor.mvcmodels.compound_parameter_models.CompoundObjectParameterDefinitio:

Bases: CompoundObjectParameterMixin, CompoundParameterDefinitionMixin,
CompoundParameterModel

A model that concatenates several single object parameter_definition models and one empty object parame-
ter_definition model.
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Initializes model.
Parameters
* parent (SpineDBEditor) — the parent object
» db_mngr (SpineDBManager) — the database manager
» *db_maps (DiffDatabaseMapping) — the database maps included in the model
_make_header (self)

class spinetoolbox.spine_db_editor.mvcmodels.compound_parameter_models.CompoundRelationshipParameterDef

Bases: CompoundRelationshipParameterMixin, CompoundParameterDefinitionMixin,
CompoundParameterModel

A model that concatenates several single relationship parameter_definition models and one empty relationship
parameter_definition model.

Initializes model.
Parameters
* parent (SpineDBEditor) — the parent object
* db_mngr (SpineDBManager) — the database manager
» *db_maps (DiffDatabaseMapping) — the database maps included in the model
_make_header (self)

class spinetoolbox.spine_db_editor.mvcmodels.compound_parameter_models.CompoundObjectParameterValueMode

Bases: CompoundObjectParameterMixin, CompoundParameterValueMixin, CompoundParameterModel

A model that concatenates several single object parameter_value models and one empty object parameter_value
model.

Initializes model.
Parameters
* parent (SpineDBEditor) — the parent object
» db_mngr (SpineDBManager) — the database manager
» *db_maps (DiffDatabaseMapping) — the database maps included in the model
_make_header (self)

property entity_type(self)
Returns the entity type, either ‘object’ or ‘relationship’ Used by update_single_main_filter.

Returns str

class spinetoolbox.spine_db_editor.mvcmodels.compound_parameter_models.CompoundRelationshipParameterVali

Bases: CompoundRelationshipParameterMixin, CompoundParameterValueMixin,
CompoundParameterModel

A model that concatenates several single relationship parameter_value models and one empty relationship pa-
rameter_value model.
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Initializes model.
Parameters
* parent (SpineDBEditor) — the parent object
» db_mngr (SpineDBManager) — the database manager
» *db_maps (DiffDatabaseMapping) — the database maps included in the model
_make_header (self)

property entity_type(self)
Returns the entity type, either ‘object’ or ‘relationship’ Used by update_single_main_filter.

Returns str

spinetoolbox.spine_db_editor.mvcmodels.empty_parameter_models

Empty models for parameter definitions and values.
authors
M. Marin (KTH)
date 28.6.2019

Module Contents

Classes
EmptyParameterModel An empty parameter model.
EmptyParameterDefinitionModel An empty parameter_definition model.
EmptyObjectParameterDefinitionModel An empty object parameter_definition model.
EmptyRelationshipParameterDefinitionModel An empty relationship parameter_definition model.
EmptyParameterValueModel An empty parameter_value model.
EmptyObjectParameterValuelodel An empty object parameter_value model.
EmptyRelationshipParameterValueModel An empty relationship parameter_value model.

class spinetoolbox.spine_db_editor.mvcmodels.empty_parameter_models.EmptyParameterModel (parent,
header,
db_mngr)
Bases: spinetoolbox.mvcmodels. empty_row_model.EmptyRowModel

An empty parameter model.
Initialize class.
Parameters
* parent (Object) — the parent object, typically a CompoundParameterModel
* header (1ist) - list of field names for the header
e db_mngr (SpineDBManager) —

property item_type(self)
The item type, either ‘parameter_value’ or ‘parameter_definition’, required by the value_field property.
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property entity_class_type(self)
Either ‘object_class’ or ‘relationship_class’.

property entity_class_id_key(self)
property entity_class_name_key(self)
property can_be_filtered(self)
property value_field(self)
accepted_rows (self)

db_item(self, _index)

item_id(self, _row)

data(self, index, role=Qt.DisplayRole)
Returns the data stored under the given role for the item referred to by the index.

Parameters
¢ index (QModelIndex) — Index of item
¢ role (int) — Data role

Returns Item data for given role.

_make_unique_id(self, item)
Returns a unique id for the given model item (name-based). Used by receive_parameter_data_added.

receive_parameter_data_added(self, db_map_data)
Runs when parameter definitions or values are added. Finds and removes model items that were successfully
added to the db.

batch_set_data(self, indexes, data)
Sets data for indexes in batch. If successful, add items to db.

abstract add_items_to_db(self, db_map_data)
Add items to db.

Parameters db_map_data (dict)— mapping DiffDatabaseMapping instance to list of items

_make_db_map_data(self, rows)
Returns model data grouped by database map.

Parameters rows (set) — group data from these rows
Returns mapping DiffDatabaseMapping instance to list of items
Return type dict

class spinetoolbox.spine_db_editor.mvcmodels.empty_parameter_models.EmptyParameterDefinitionModel (*args,
*rwa
Bases: spinetoolbox.spine_db_editor.mvcmodels.parameter_mixins.FillInValuelListIdMixin,
spinetoolbox.spine_db_editor.mvcmodels.parameter_mixins.FillInEntityClassIdMixin,
spinetoolbox.spine_db_editor.mvcmodels.parameter_mixins.FillInParameterNameMixin,
EmptyParameterModel

An empty parameter_definition model.
Initializes lookup dicts.

property item_type(self)
The item type, either ‘parameter_value’ or ‘parameter_definition’, required by the value_field property.
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property entity_class_type(self)
See base class.

add_items_to_db (self, db_map_data)
See base class.

_check_item(self, item)
Checks if a db item is ready to be inserted.

class spinetoolbox.spine_db_editor.mvcmodels.empty_parameter_models.EmptyObjectParameterDefinitionModel

Bases: EmptyParameterDefinitionModel
An empty object parameter_definition model.
Initializes lookup dicts.

property entity_class_type(self)
See base class.

class spinetoolbox.spine_db_editor.mvcmodels.empty_parameter_models.EmptyRelationshipParameterDefinitio

Bases: EmptyParameterDefinitionModel
An empty relationship parameter_definition model.
Initializes lookup dicts.

property entity_class_type(self)
See base class.

flags (self, index)
Additional hack to make the object_class_name_list column non-editable.

class spinetoolbox.spine_db_editor.mvcmodels.empty_parameter_models.EmptyParameterValueModel (*args,

**kwargs)
Bases: spinetoolbox.spine_db_editor.mvcmodels.parameter_mixins.
InferEntityClassIdMixin, spinetoolbox.spine_db_editor.mvcmodels.parameter_mixins.
FillInAlternativeIdMixin, spinetoolbox.spine_db_editor.mvcmodels.parameter_mixins.
FillInParameterDefinitionIdsMixin, spinetoolbox.spine_db_editor.mvcmodels.
parameter_mixins.FillInEntityIdsMixin, spinetoolbox.spine_db_editor.mvcmodels.
parameter_mixins.FillInEntityClassIdMixin, EmptyParameterModel

An empty parameter_value model.
Initializes lookup dicts.

property item_type(self)
The item type, either ‘parameter_value’ or ‘parameter_definition’, required by the value_field property.

property entity_type(self)
Either ‘object’ or “relationship’.

property entity_id_key(self)
property entity_name_key(self)
property entity_name_key_in_cache(self)

_make_unique_id(self, item)
Returns a unique id for the given model item (name-based). Used by receive_parameter_data_added.

add_items_to_db(self, db_map_data)
See base class.
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_check_item(self, db_map, item)
Checks if a db item is ready to be inserted.

class spinetoolbox.spine_db_editor.mvcmodels.empty_parameter_models.EmptyObjectParameterValueModel (*args

Bases: EmptyParameterValueModel
An empty object parameter_value model.
Initializes lookup dicts.

property entity_class_type(self)
Either ‘object_class’ or ‘relationship_class’.

property entity_type(self)
Either ‘object’ or “relationship’.

class spinetoolbox.spine_db_editor.mvcmodels.empty_parameter_models.EmptyRelationshipParameterValueMode

Bases: spinetoolbox.spine_db_editor.mvcmodels.parameter_mixins.
MakeRelationshipOnTheFlyMixin, EmptyParameterValueModel

An empty relationship parameter_value model.
Initializes lookup dicts.
_add_entities_on_the_fly = True

property entity_class_type(self)
Either ‘object_class’ or ‘relationship_class’.

property entity_type(self)
Either ‘object’ or “relationship’.

add_items_to_db(self, db_map_data)

See base class.

spinetoolbox.spine_db_editor.mvcmodels.entity_tree_item

Classes to represent entities in a tree.

authors

P. Vennstrom (VTT), M. Marin (KTH)

date 11.3.2019

Module Contents

Classes
EntityRootItem A tree item that may belong in multiple databases.
ObjectTreeRootItem An object tree root item.
RelationshipTreeRootItem A relationship tree root item.
EntityClassItem An entity_class item.
ObjectClassItem An object_class item.

RelationshipClassItem

A relationship_class item.

continues on next page
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Table 28 — continued from previous page

ObjectRelationshipClassItem A relationship_class item.
MemberObjectClassItem A member object class item.
EntityItem An entity item.
ObjectItem An object item.
MemberObjectItem A member object item.
RelationshipItem A relationship item.

class spinetoolbox.spine_db_editor.mvcmodels.entity_tree_item.EntityRootItem(model=None,
db_map_ids=None)
Bases: spinetoolbox.spine_db_editor.mvcmodels.multi_db_tree_item.MultiDBTreelItem

A tree item that may belong in multiple databases.
Init class.
Parameters
* db_mngr (SpineDBManager) — a database manager

e db_map_ids (dict) — maps instances of DiffDatabaseMapping to the id of the item in that
db

item_type = root

property display_id(self)
“See super class.

property display_icon(self)
Returns an icon to display next to the name. Reimplement in subclasses to return something nice.

property display_data(self)
“See super class.

set_data(self, column, value, role)
See base class.

class spinetoolbox.spine_db_editor.mvcmodels.entity_tree_item.ObjectTreeRootItem(model=None,
db_map_ids=None)
Bases: EntityRootItem

An object tree root item.
Init class.
Parameters
* db_mngr (SpineDBManager) — a database manager

* db_map_ids (dict) — maps instances of DiffDatabaseMapping to the id of the item in that
db

item_type = root

property child_item_class(self)
Returns ObjectClassltem.

class spinetoolbox.spine_db_editor.mvcmodels.entity_tree_item.RelationshipTreeRootItem(model=None,
db_map_ids=None)
Bases: EntityRootItem

A relationship tree root item.

Init class.
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Parameters
* db_mngr (SpineDBManager) — a database manager

* db_map_ids (dict) — maps instances of DiffDatabaseMapping to the id of the item in that
db

item_type = root

property child_item_class(self)
Returns RelationshipClassItem.

class spinetoolbox.spine_db_editor.mvcmodels.entity_tree_item.EntityClassItem(*args,
*kkwargs)
Bases: spinetoolbox.spine_db_editor.mvcmodels.multi_db_tree_item.MultiDBTreelItem

An entity_class item.
Overridden method to declare group_child_count attribute.

property display_icon(self)
Returns class icon.

_display_icon(self, for_group=False)

data(self, column, role=Qt.DisplayRole)
Returns data for given column and role.

raise_group_children_by_id(self, db_map_ids)
Moves group children to the top of the list.

Parameters db_map_ids (dict) — set of ids corresponding to newly inserted group children,
keyed by DiffDatabaseMapping

_raise_group_children_by_row(self, rows)
Moves group children to the top of the list.

Parameters rows (set, list)-collection of rows corresponding to newly inserted group chil-
dren

remove_children(self, position, count)
Overriden method to keep the group child count up to date.

fetch_successful (self, db_map, item)

set_data(self, column, value, role)
See base class.

class spinetoolbox.spine_db_editor.mvcmodels.entity_tree_item.ObjectClassItem(*args,
**kwargs)
Bases: EntityClassItem

An object_class item.
Overridden method to declare group_child_count attribute.
item_type = object_class

property child_item_class(self)
Returns Objectltem.

default_parameter_data(self)
Return data to put as default in a parameter table when this item is selected.
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class spinetoolbox.spine_db_editor.mvcmodels.entity_tree_item.RelationshipClassItem(*args,

**kwargs)
Bases: EntityClassItem

A relationship_class item.

Overridden method to declare group_child_count attribute.
visual_key = ['name', 'object_class_name_list']
item_type = relationship_class

property child_item_class(self)
Returns RelationshipItem.

default_parameter_data(self)
Return data to put as default in a parameter table when this item is selected.

class spinetoolbox.spine_db_editor.mvcmodels.entity_tree_item.ObjectRelationshipClassItem(*args,

*rkwargs)
Bases: RelationshipClassItem

A relationship_class item.
Overridden method to declare group_child_count attribute.

set_data(self, column, value, role)
See base class.

fetch_successful (self, db_map, item)

class spinetoolbox.spine_db_editor.mvcmodels.entity_tree_item.MemberObjectClassItem(*args,

*rkwargs)
Bases: ObjectClassItem

A member object class item.
Overridden method to declare group_child_count attribute.
item_type = members

property display_id(self)
Returns an id for display based on the display key. This id must be the same across all db_maps. If it’s not,
this property becomes None and measures need to be taken (see update_children_by_id).

property display_data(self)
Returns the name for display.

db_map_data(self, db_map)
Returns data for this item as if it was indeed an object class.

_display_icon(self, for_group=False)
Returns icon for this item as if it was indeed an object class.

fetch_successful (self, db_map, item)

property child_item_class(self)
Returns MemberObjectltem.

default_parameter_data(self)
Return data to put as default in a parameter table when this item is selected.

data(self, column, role=Qt.DisplayRole)
Returns data for given column and role.
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class spinetoolbox.spine_db_editor.mvcmodels.entity_tree_item.EntityItem(model=None,
db_map_ids=None)
Bases: spinetoolbox.spine_db_editor.mvcmodels.multi_db_tree_item.MultiDBTreeltem

An entity item.
Init class.
Parameters
* db_mngr (SpineDBManager) — a database manager

* db_map_ids (dict) — maps instances of DiffDatabaseMapping to the id of the item in that
db

_has_members_item = False
property members_item(self)

property display_icon(self)
Returns corresponding class icon.

is_group (self)

data(self, column, role=Qt.DisplayRole)
Returns data for given column and role.

set_data(self, column, value, role)
See base class.

class spinetoolbox.spine_db_editor.mvcmodels.entity_tree_item.ObjectItem(model=None,
db_map_ids=None)
Bases: EntityItem

An object item.
Init class.
Parameters
* db_mngr (SpineDBManager) — a database manager

e db_map_ids (dict) — maps instances of DiffDatabaseMapping to the id of the item in that
db

item_type = object

property child_item_class(self)
Child class is always ObjectRelationshipClassItem.

default_parameter_data(self)
Return data to put as default in a parameter table when this item is selected.

fetch_successful (self, db_map, item)

class spinetoolbox.spine_db_editor.mvcmodels.entity_tree_item.MemberObjectItem(model=None,
db_map_ids=None)
Bases: ObjectItem

A member object item.
Init class.
Parameters

* db_mngr (SpineDBManager) — a database manager
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» db_map_ids (dict) — maps instances of DiffDatabaseMapping to the id of the item in that
db

item_type = entity_group
visual_key = ['member_name']

property display_icon(self)
Returns corresponding class icon.

property display_data(self)
“Returns the name for display.

has_children(self)
Returns whether or not this item has or could have children.

can_fetch_more (self)
Returns whether or not this item can fetch more.

class spinetoolbox.spine_db_editor.mvcmodels.entity_tree_item.RelationshipItem(*args,
*rkwargs)
Bases: EntityItem

A relationship item.

Overridden method to make sure we never try to fetch this item.
visual_key = ['name', 'object_name_list']
item_type = relationship

property object_name_list(self)

property display_data(self)
“Returns the name for display.

property edit_data(self)

default_parameter_data(self)
Return data to put as default in a parameter table when this item is selected.

has_children(self)
Returns whether or not this item has or could have children.

can_fetch_more(self)
Returns whether or not this item can fetch more.

is_valid(self)
Checks that the grand parent object is still in the relationship.

spinetoolbox.spine_db_editor.mvcmodels.entity_tree_models

Models to represent entities in a tree.
authors
P. Vennstrom (VTT), M. Marin (KTH)
date 11.3.2019
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Module Contents

Classes
ObjectTreeModel An 'object-oriented' tree model.
RelationshipTreeModel A relationship-oriented tree model.

class spinetoolbox.spine_db_editor.mvcmodels.entity_tree_models.ObjectTreeModel (parent,
db_mngr,
*db_maps)
Bases: spinetoolbox.spine_db_editor.mvcmodels.multi_db_tree_model.MultiDBTreeModel

An ‘object-oriented’ tree model.
Init class.
Parameters
* parent (SpineDBEditor) —
e db_mngr (SpineDBManager) — A manager for the given db_maps
* db_maps (iter) — DiffDatabaseMapping instances

property root_item_type(self)
Implement in subclasses to create a model specific to any entity type.

_barent_object_data(self, db_map_data)
Takes given object data and returns the same data keyed by parent tree-item.

Parameters db_map_data (dict)-— maps DiffDatabaseMapping instances to list of items as dict
Returns maps parent tree-items to DiffDatabaseMapping instances to list of item ids
Return type dict

_parent_relationship_class_data(self, db_map_data)
Takes given relationship_class data and returns the same data keyed by parent tree-item.

Parameters db_map_data (dict)—maps DiffDatabaseMapping instances to list of items as dict
Returns maps parent tree-items to DiffDatabaseMapping instances to list of item ids
Return type dict

_parent_relationship_data(self, db_map_data)
Takes given relationship data and returns the same data keyed by parent tree-item.

Parameters db_map_data (dict)- maps DiffDatabaseMapping instances to list of items as dict
Returns maps parent tree-items to DiffDatabaseMapping instances to list of item ids
Return type dict

_parent_relationship_data_for_update (self, db_map_data)
Takes given relationship data and returns the same data keyed by parent tree-item.

Parameters db_map_data (dict)-— maps DiffDatabaseMapping instances to list of items as dict
Returns maps parent tree-items to DiffDatabaseMapping instances to list of item ids

Return type dict
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_barent_entity_group_data(self, db_map_data)
Takes given entity group data and returns the same data keyed by parent tree-item.

Parameters db_map_data (dict)— maps DiffDatabaseMapping instances to list of items as dict
Returns maps parent tree-items to DiffDatabaseMapping instances to list of item ids
Return type dict

_barent_entity_member_data(self, db_map_data)
Takes given entity member data and returns the same data keyed by parent tree-item.

Parameters db_map_data (dict)-— maps DiffDatabaseMapping instances to list of items as dict
Returns maps parent tree-items to DiffDatabaseMapping instances to list of item ids
Return type dict

add_object_classes(self, db_map_data)

add_objects(self, db_map_data)

add_relationship_classes(self, db_map_data)

add_relationships(self, db_map_data)

add_entity_groups (self, db_map_data)

remove_object_classes(self, db_map_data)

remove_objects (self, db_map_data)

remove_relationship_classes(self, db_map_data)

remove_relationships (self, db_map_data)

remove_entity_groups (self, db_map_data)

update_object_classes(self, db_map_data)

update_objects(self, db_map_data)

update_relationship_classes(self, db_map_data)

update_relationships (self, db_map_data)

find_next_relationship_index (self, index)
Find and return next occurrence of relationship item.

class spinetoolbox.spine_db_editor.mvcmodels.entity_tree_models.RelationshipTreeModel (parent,

db_mngr,
*db_maps)
Bases: spinetoolbox.spine_db_editor.mvcmodels.multi_db_tree_model.MultiDBTreeModel

A relationship-oriented tree model.
Init class.
Parameters
e parent (SpineDBEditor) —
» db_mngr (SpineDBManager) — A manager for the given db_maps
* db_maps (iter) — DiffDatabaseMapping instances

property root_item_type(self)
Implement in subclasses to create a model specific to any entity type.
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_parent_relationship_data(self, db_map_data)
Takes given relationship data and returns the same data keyed by parent tree-item.

Parameters db_map_data (dict)— maps DiffDatabaseMapping instances to list of items as dict
Returns maps parent tree-items to DiffDatabaseMapping instances to list of item ids
Return type dict

add_relationship_classes(self, db_map_data)

add_relationships(self, db_map_data)

remove_relationship_classes(self, db_map_data)

remove_relationships (self, db_map_data)

update_relationship_classes(self, db_map_data)

update_relationships(self, db_map_data)

spinetoolbox.spine_db_editor.mvcmodels. frozen_table_model

Contains FrozenTableModel class.

author
P. Vennstrom (VTT)
date 24.9.2019

Module Contents

Classes

FrozenTableModel Used by custom_qtableview.FrozenTableView

class spinetoolbox.spine_db_editor.mvcmodels. frozen_table_model.FrozenTableModel (parent,

head-

ers=None,

data=None)
Bases: PySide2.QtCore.QAbstractItemModel

Used by custom_qtableview.FrozenTableView
Parameters parent (TabularViewlMixin) -

parent (self, child=None)

index (self, row, column, parent=QModellndex())

reset_model (self, data, headers)

clear_model (self)

rowCount (self, parent=0QModellndex())

columnCount (self, parent=QModellndex())

row(self, index)

data(self, index, role)
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headerData (self, section, orientation, role=Qt.DisplayRole)

property headers(self)

spinetoolbox.spine_db_editor.mvcmodels.multi_db_tree_item

Base classes to represent items from multiple databases in a tree.
authors
P. Vennstrom (VTT), M. Marin (KTH)
date 17.6.2020

Module Contents

Classes

MultiDBTreeItem A tree item that may belong in multiple databases.

class spinetoolbox.spine_db_editor.mvcmodels.multi_db_tree_item.MultiDBTreeItem(model=None,
db_map_ids=None)
Bases: spinetoolbox.mvcmodels.minimal_tree_model.Treeltem

A tree item that may belong in multiple databases.

Init class.
Parameters
* db_mngr (SpineDBManager) — a database manager
» db_map_ids (dict) — maps instances of DiffDatabaseMapping to the id of the item in that
db
item_type

Item type identifier string. Should be set to a meaningful value by subclasses.
visual_key = ['name']

abstract set_data(self, column, value, role)
Sets data for this item.

Parameters
e column (int) — column index
e value (object) — a new value
e role (int) - role of the new value
Returns True if data was set successfully, False otherwise
Return type bool
property db_mngr (self)

property child_item_class(self)
Returns the type of child items. Reimplement in subclasses to return something more meaningful.
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property display_id(self)
Returns an id for display based on the display key. This id must be the same across all db_maps. If it’s not,
this property becomes None and measures need to be taken (see update_children_by_id).

property display_data(self)
Returns the name for display.

property display_database(self)
Returns the database for display.

property display_icon(self)
Returns an icon to display next to the name. Reimplement in subclasses to return something nice.

property first_db_map (self)
Returns the first associated db_map.

property last_db_map (self)
Returns the last associated db_map.

property db_maps (self)
Returns a list of all associated db_maps.

property db_map_ids(self)
Returns dict with db_map as key and id as value

add_db_map_id(self, db_map, id_)
Adds id for this item in the given db_map.

take_db_map (self, db_map)
Removes the mapping for given db_map and returns it.

_deep_refresh_children(self)
Refreshes children after taking db_maps from them. Called after removing and updating children for this
item.

deep_remove_db_map (self, db_map)
Removes given db_map from this item and all its descendants.

deep_take_db_map (self, db_map)
Removes given db_map from this item and all its descendants, and returns a new item from the db_map’s
data.

Returns MultiDBTreeltem, NoneType

deep_merge (self, other)
Merges another item and all its descendants into this one.

db_map_id(self, db_map)
Returns the id for this item in given db_map or None if not present.

db_map_data (self, db_map)
Returns data for this item in given db_map or None if not present.

db_map_data_field(self, db_map, field, default=None)
Returns field from data for this item in given db_map or None if not found.

_create_new_children(self, db_map, children_ids)
Creates new items from ids associated to a db map.

Parameters
e db_map (DiffDatabaseMapping) — create children for this db_map

e children_ids (iter) — create children from these ids
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_merge_children(self, new_children)
Merges new children into this item. Ensures that each children has a valid display id afterwards.

_insert_children_sorted(self, new_children)
Inserts and sorts children.

fetch_successful (self, db_map, item)

_handle_fully_fetched(self)
Notifies the view that the model’s layout has changed. This triggers a repaint so this item may be painted
gray if no children.

property fetch_item_type(self)

can_fetch_more(self)
Returns whether or not this item can fetch more.

fetch_more (self)
Fetches children from all associated databases.

_get_pending_children_ids (self, db_map)
Returns a list of children ids that are in the cache but not added.

fetch_more_if_possible(self)
get_children_ids(self, db_map)

append_children_by_id(self, db_map_ids)
Appends children by id.

Parameters db_map_ids (dict)— maps DiffDatabaseMapping instances to list of ids

remove_children_by_id(self, db_map_ids)
Removes children by id.

Parameters db_map_ids (dict)— maps DiffDatabaseMapping instances to list of ids

is_valid(self)
Checks if the item is still valid after an update operation.

update_children_by_id(self, db_map_ids)
Updates children by id. Essentially makes sure all children have a valid display id after updating the un-
derlying data. These may require ‘splitting’ a child into several for different dbs or merging two or more
children from different dbs.

Examples of problems:
* The user renames an object_class in one db but not in the others —> we need to split
* The user renames an object_class and the new name is already ‘taken’ by another object_class in
another db_map —> we need to merge
Parameters db_map_ids (dict)— maps DiffDatabaseMapping instances to list of ids
insert_children(self, position, children)
Insert new children at given position. Returns a boolean depending on how it went.
Parameters
e position (int) — insert new items here
¢ children (iter) - insert items from this iterable

remove_children(self, position, count)
Removes count children starting from the given position.
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clear_children(self)
Clear children list.

_refresh_child_map (self)
Recomputes the child map.

find_children_by_id(self, db_map, *ids, reverse=True)
Generates children with the given ids in the given db_map. If the first id is None, then generates all children
with the given db_map.

find_rows_by_id(self, db_map, *ids, reverse=True)

_find_unsorted_rows_by_id(self, db_map, *ids)
Generates rows corresponding to children with the given ids in the given db_map. If the only id given is
None, then generates rows corresponding to all children with the given db_map.

data(self, column, role=Qt.DisplayRole)
Returns data for given column and role.

default_parameter_data(self)
Returns data to set as default in a parameter table when this item is selected.

spinetoolbox.spine_db_editor.mvcmodels.multi_db_tree_model

A base model class to represent items from multiple databases in a tree.
authors
P. Vennstrom (VTT), M. Marin (KTH)
date 17.6.2020

Module Contents

Classes

MultiDBTreeModel Base class for all tree models in Spine db editor.

class spinetoolbox.spine_db_editor.mvcmodels.multi_db_tree_model.MultiDBTreeModel (parent,
db_mngr,
*db_maps)
Bases: spinetoolbox.mvcmodels.minimal_tree_model.MinimalTreeModel

Base class for all tree models in Spine db editor.
Init class.
Parameters
e parent (SpineDBEditor) —
* db_mngr (SpineDBManager) — A manager for the given db_maps
* db_maps (iter) — DiffDatabaseMapping instances

property root_item_type(self)
Implement in subclasses to create a model specific to any entity type.

property root_item(self)
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property root_index(self)

build_tree(self)
Builds tree.

columnCount (self, parent=0QModellndex())

headerData (self, section, orientation, role=Qt.DisplayRole)

find_items(self, db_map, path_prefix, fetch=False)
Returns items at given path prefix.

spinetoolbox.spine_db_editor.mvcmodels.parameter_mixins

Miscelaneous mixins for parameter models
authors
M. Marin (KTH)
date 4.10.2019

Module Contents

Classes

ConvertToDBMixin

Base class for all mixins that convert model items (name-
based) into database items (id-based).

FillInAlternativeIdMixin

Fills in alternative names.

FillInParameterNameMixin

Fills in parameter names.

FillInValueListIdMixin

Fills in value list ids.

FillInEntityClassIdMixin

Fills in entity_class ids.

FillInEntityIdsMixin

Fills in entity ids.

FillInParameterDefinitionIdsMixin

Fills in parameter_definition ids.

InferEntityClassIdMixin

Infers entity class ids.

ImposeEntityClassIdMixin

Imposes entity class ids.

MakeRelationshipOnTheFlyMixin

Makes relationships on the fly.

Functions

_parse_csv_1list(csv_list)

spinetoolbox.spine_db_editor.mvcmodels.parameter_mixins._parse_csv_list (csv_list)

class spinetoolbox.spine_db_editor.mvcmodels.parameter_mixins.ConvertToDBMixin
Base class for all mixins that convert model items (name-based) into database items (id-based).

build_lookup_dictionary (self, db_map_data)
Begins an operation to convert items.

_convert_to_db(self, item, db_map)

Returns a db item (id-based) from the given model item (name-based).
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Parameters

e item (dict) — the model item

e db_map (DiffDatabaseMapping) — the database where the resulting item belongs
Returns the db item list: error log
Return type dict

class spinetoolbox.spine_db_editor.mvcmodels.parameter_mixins.FillInAlternativeIdMixin(*args,
**kwargs)
Bases: ConvertToDBMixin

Fills in alternative names.
Initializes lookup dicts.

build_lookup_dictionary (self, db_map_data)
Builds a name lookup dictionary for the given data.

Parameters db_map_data (dict) — lists of model items keyed by DiffDatabaseMapping

_convert_to_db(self, item, db_map)
Returns a db item (id-based) from the given model item (name-based).

Parameters

e item (dict) — the model item

¢ db_map (DiffDatabaseMapping) — the database where the resulting item belongs
Returns the db item list: error log
Return type dict

class spinetoolbox.spine_db_editor.mvcmodels.parameter_mixins.FillInParameterNameMixin
Bases: ConvertToDBMixin

Fills in parameter names.

_convert_to_db (self, item, db_map)
Returns a db item (id-based) from the given model item (name-based).

Parameters

e item (dict) — the model item

e db_map (DiffDatabaseMapping) — the database where the resulting item belongs
Returns the db item list: error log
Return type dict

class spinetoolbox.spine_db_editor.mvcmodels.parameter_mixins.FillInValueListIdMixin(*args,
*kkwargs)
Bases: ConvertToDBMixin

Fills in value list ids.
Initializes lookup dicts.

build_lookup_dictionary (self, db_map_data)
Builds a name lookup dictionary for the given data.

Parameters db_map_data (dict) — lists of model items keyed by DiffDatabaseMapping
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_convert_to_db(self, item, db_map)
Returns a db item (id-based) from the given model item (name-based).

Parameters

e item (dict) — the model item

e db_map (DiffDatabaseMapping) — the database where the resulting item belongs
Returns the db item list: error log
Return type dict

_fill_in_value_list_id(self, item, db_map)
Fills in the value list id in the given db item.

Parameters

e item (dict) — the db item

* db_map (DiffDatabaseMapping) — the database where the given item belongs
Returns error log
Return type list

class spinetoolbox.spine_db_editor.mvcmodels.parameter_mixins.FillInEntityClassIdMixin(*args,
**kwargs)
Bases: ConvertToDBMixin

Fills in entity_class ids.
Initializes lookup dicts.

build_lookup_dictionary (self, db_map_data)
Builds a name lookup dictionary for the given data.

Parameters db_map_data (dict) — lists of model items keyed by DiffDatabaseMapping

_fill_in_entity_class_id(self, item, db_map)
Fills in the entity_class id in the given db item.

Parameters

e item (dict) — the db item

» db_map (DiffDatabaseMapping) — the database where the given item belongs
Returns error log
Return type list

_convert_to_db(self, item, db_map)
Returns a db item (id-based) from the given model item (name-based).

Parameters

e item (dict) — the model item

e db_map (DiffDatabaseMapping) — the database where the resulting item belongs
Returns the db item list: error log
Return type dict

class spinetoolbox.spine_db_editor.mvcmodels.parameter_mixins.FillInEntityIdsMixin(*args,
**kwargs)

Bases: ConvertToDBMixin

254 Chapter 20. API Reference



Spine Toolbox Documentation, Release 0.6.6.dev0-dev.0

Fills in entity ids.
Initializes lookup dicts.
_add_entities_on_the_£fly = False

build_lookup_dictionary (self, db_map_data)
Builds a name lookup dictionary for the given data.

Parameters db_map_data (dict) — lists of model items keyed by DiffDatabaseMapping

_fill_in_entity_ids(self, item, db_map)
Fills in all possible entity ids keyed by entity_class id in the given db item (as there can be more than one
entity for the same name).

Parameters

e item (dict) — the db item

» db_map (DiffDatabaseMapping) — the database where the given item belongs
Returns error log
Return type list

_convert_to_db(self, item, db_map)
Returns a db item (id-based) from the given model item (name-based).

Parameters

e item (dict) — the model item

* db_map (DiffDatabaseMapping) — the database where the resulting item belongs
Returns the db item list: error log
Return type dict

class spinetoolbox.spine_db_editor.mvcmodels.parameter_mixins.FillInParameterDefinitionIdsMixin(*args,
**kwargs

Bases: ConvertToDBMixin
Fills in parameter_definition ids.
Initializes lookup dicts.

build_lookup_dictionary (self, db_map_data)
Builds a name lookup dictionary for the given data.

Parameters db_map_data (dict) — lists of model items keyed by DiffDatabaseMapping

_fill_in parameter_ids(self, item, db_map)
Fills in all possible parameter_definition ids keyed by entity_class id in the given db item (as there can be
more than one parameter_definition for the same name).

Parameters

e item (dict) — the db item

» db_map (DiffDatabaseMapping) — the database where the given item belongs
Returns error log
Return type list

_convert_to_db(self, item, db_map)
Returns a db item (id-based) from the given model item (name-based).
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Parameters

e item (dict) — the model item

e db_map (DiffDatabaseMapping) — the database where the resulting item belongs
Returns the db item list: error log
Return type dict

class spinetoolbox.spine_db_editor.mvcmodels.parameter_mixins.InferEntityClassIdMixin
Bases: ConvertToDBMixin

Infers entity class ids.

_convert_to_db(self, item, db_map)
Returns a db item (id-based) from the given model item (name-based).

Parameters

e item (dict) — the model item

¢ db_map (DiffDatabaseMapping) — the database where the resulting item belongs
Returns the db item list: error log
Return type dict

_infer_and_£fill_in_entity_class_id(self, item, db_map)
Fills the entity_class id in the given db item, by intersecting entity ids and parameter ids. Then picks the
correct entity id and parameter_definition id. Also sets the inferred entity_class name in the model.

Parameters

e item (dict) — the db item

e db_map (DiffDatabaseMapping) — the database where the given item belongs
Returns error log
Return type list

class spinetoolbox.spine_db_editor.mvcmodels.parameter_mixins.ImposeEntityClassIdMixin
Bases: ConvertToDBMixin

Imposes entity class ids.

_convert_to_db(self, item, db_map)
Returns a db item (id-based) from the given model item (name-based).

Parameters

e item (dict) — the model item

» db_map (DiffDatabaseMapping) — the database where the resulting item belongs
Returns the db item list: error log
Return type dict

_impose_entity_class_id(self, item, db_map)
Imposes the entity_class id from the model, to pick the correct entity id and parameter_definition id.

Parameters
e item (dict) — the db item

» db_map (DiffDatabaseMapping) — the database where the given item belongs
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Returns error log

Return type list

class spinetoolbox.spine_db_editor.mvcmodels.parameter_mixins.MakeRelationshipOnTheFlyMixin(*args,

Makes relationships on the fly.
Initializes lookup dicts.

static _make_unique_relationship_id(item)
Returns a unique name-based identifier for db relationships.

build_lookup_dictionaries(self, db_map_data)
Builds a name lookup dictionary for the given data.

Parameters db_map_data (dict) — lists of model items keyed by DiffDatabaseMapping.

_make_relationship_on_the_£1ly (self, item, db_map)
Returns a database relationship item (id-based) from the given model parameter_value item (name-based).

Parameters

e item (dict) — the model parameter_value item

» db_map (DiffDatabaseMapping) — the database where the resulting item belongs
Returns the db relationship item list: error log

Return type dict

spinetoolbox.spine_db_editor.mvcmodels.parameter_value_list_item

Tree items for parameter_value lists.
authors
M. Marin (KTH)
date 28.6.2019

Module Contents

Classes
DBItem An item representing a db.
ListItem A list item.
ValueItem Paints the item gray if it's the last.

class spinetoolbox.spine_db_editor.mvcmodels.parameter_value_list_item.DBItem(db_map)
Bases: spinetoolbox.spine_db_editor.mvcmodels. tree_item_utility.EmptyChildMixin,
spinetoolbox.spine_db_editor.mvcmodels.tree_item_utility.FetchMoreMixin,
spinetoolbox.spine_db_editor.mvcmodels.tree_item_utility.StandardDBItem

An item representing a db.
Init class.

Args db_mngr (SpineDBManager) db_map (DiffDatabaseMapping)
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property item_type(self)
property fetch_item_type (self)
empty_child(self)

remove_wip_items (self, names)

class spinetoolbox.spine_db_editor.mvcmodels.parameter_value_list_item.ListItem(identifier=None,

name=None)
Bases: spinetoolbox.spine_db_editor.mvcmodels. tree_item_utility.GrayIfLastMixin,
spinetoolbox.spine_db_editor.mvcmodels.tree_item_utility.EditableMixin, spinetoolbox.
spine_db_editor.mvcmodels.tree_item_utility.EmptyChildMixin, spinetoolbox.
spine_db_editor.mvcmodels.tree_item_utility.BoldTextMixin, spinetoolbox.
spine_db_editor.mvcmodels. tree_item_utility.LeafItem

A list item.
Initializes item.
Parameters model (MinimalTreeModel, NoneType)— The model where the item belongs.
property item_type(self)
_make_item_data(self)
property value_list(self)

_do_finalize(self)
Do some final initialization after setting the parent.

empty_child(self)

data(self, column, role=Qt.DisplayRole)
Returns data for given column and role.

set_data(self, column, value, role=Qt.EditRole)
Sets data for this item.

Parameters
¢ column (int) — column index
e value (object) — a new value
e role (int) —role of the new value
Returns True if data was set successfully, False otherwise
Return type bool
abstract add_item_to_db(self, db_item)
update_item_in_db (self, db_item)
handle_updated_in_db (self)

class spinetoolbox.spine_db_editor.mvcmodels.parameter_value_list_item.ValueItem(identifier=None)

Bases: spinetoolbox.spine_db_editor.mvcmodels.tree_item_utility.GrayIfLastMixin,
spinetoolbox.spine_db_editor.mvcmodels.tree_item_utility.EditableMixin, spinetoolbox.
spine_db_editor.mvcmodels. tree_item_utility.LeafItem

Paints the item gray if it’s the last.
Initializes item.

Parameters model (MinimalTreeModel, NoneType)— The model where the item belongs.
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property item_type(self)
property value(self)

data(self, column, role=Qt.DisplayRole)
Returns data for given column and role.

_make_item_to_add(self, value)
make_item_to_add(self, db_value)
_make_item_to_update(self, _column, value)
add_item_to_db(self, db_item)
update_item_in_db (self, db_item)

spinetoolbox.spine_db_editor.mvcmodels.parameter_value_list_model

A tree model for parameter_value lists.
authors
M. Marin (KTH)
date 28.6.2019

Module Contents

Classes

ParameterValueListModel A model to display parameter_value_list data in a tree
view.

class spinetoolbox.spine_db_editor.mvcmodels.parameter_value_list_model.ParameterValueListModel (parent,
db_mngr,
*db_map.
Bases: spinetoolbox.spine_db_editor.mvcmodels. tree_model_base.TreeModelBase

A model to display parameter_value_list data in a tree view.
Parameters

e parent (SpineDBEditor) —

e db_mngr (SpineDBManager) —

» *db_maps - DiffDatabaseMapping instances
add_parameter_value_lists(self, db_map_data)
update_parameter_value_lists(self, db_map_data)
remove_parameter_value_lists(self, db_map_data)
static _make_db_item(db_map)
static _top_children()

columnCount (self, parent=QModellndex())
Returns the number of columns under the given parent. Always 1.
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index_name (self, index)

get_set_data_delayed(self, index)

Returns a function that ParameterValueEditor can call to set data for the given index at any later time, even

if the model changes.
Parameters index (QModelIndex) —

Returns Callable

spinetoolbox.spine_db_editor.mvcmodels.pivot_model

Provides PivotModel.
author
P. Vennstrom (VTT)
date 1.11.2018

Module Contents

Classes

PivotModel

class spinetoolbox.spine_db_editor.mvcmodels.pivot_model.PivotModel

reset_model (self, data, index_ids=(), rows=(), columns=(), frozen=(), frozen_value=())
Resets the model.

clear_model (self)
update_model (self, data)
add_to_model (self, data)
remove_from_model (self, data)

_check_pivot (self, rows, columns, frozen, frozen_value)
Checks if given pivot is valid.

Returns error message or None if no error
Return type str, NoneType

_index_key_getter (self, indexes)
Returns an itemgetter that always returns tuples from list of indexes

Parameters indexes (tuple) -
Returns an itemgetter
Return type Callable

—get_unique_index_values (self, indexes)
Returns unique indexes that match the frozen condition.
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Parameters indexes (tuple) — indexes to match
Returns unique indexes
Return type list

set_pivot (self, rows, columns, frozen, frozen_value)
Sets pivot.

set_frozen_value (self, value)
Sets values for the frozen indexes.

get_pivoted_data(self, row_mask, column_mask)
Returns data for indexes in row_mask and column_mask.

Parameters
e row_mask (I1ist) —
e column_mask (Iist) -
Returns list(list)
row_key (self, row)
column_key (self, column)
property rows(self)

property columns(self)

spinetoolbox.spine_db_editor.mvcmodels.pivot_table_models

Provides pivot table models for the Tabular View.
author
P. Vennstrom (VTT)
date 1.11.2018

Module Contents

Classes

_FetchParent

_SimpleFetchParent

_ParameterFetchParent

_EntityFetchParent

_MemberObjectFetchParent

PivotTableModelBase
param parent

continues on next page
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Table 38 — continued from previous page

TopLeftHeaderItem Base class for all 'top left pivot headers'.

TopLeftObjectHeaderItem A top left header for object_class.

TopLeftParameterHeaderItem A top left header for parameter_definition.

TopLeftParameterIndexHeaderItem A top left header for parameter index.

TopLeftAlternativeHeaderItem A top left header for alternative.

TopLeftScenarioHeaderItem A top left header for scenario.

TopLeftDatabaseHeaderItem A top left header for database.

ParameterValuePivotTableModel A model for the pivot table in parameter_value input
type.

IndexExpansionPivotTableModel A model for the pivot table in parameter index expansion
input type.

RelationshipPivotTableModel A model for the pivot table in relationship input type.

ScenarioAlternativePivotTableModel A model for the pivot table in scenario alternative input
type.

PivotTableSortFilterProxy Initialize class.

class spinetoolbox.spine_db_editor.mvcmodels.pivot_table_models._FetchParent

abstract fetch_successful (self, db_map, item)

class spinetoolbox.spine_db_editor.mvcmodels.pivot_table_models._SimpleFetchParent
Bases: _FetchParent

fetch_successful (self, db_map, item)

class spinetoolbox.spine_db_editor.mvcmodels.pivot_table_models._ParameterFetchParent (parent)
Bases: _FetchParent

fetch_successful (self, db_map, item)

class spinetoolbox.spine_db_editor.mvcmodels.pivot_table_models._EntityFetchParent (parent)
Bases: _FetchParent

fetch_successful (self, db_map, item)

class spinetoolbox.spine_db_editor.mvcmodels.pivot_table_models._MemberObjectFetchParent (parent)
Bases: _FetchParent

fetch_successful (self, db_map, item)

class spinetoolbox.spine_db_editor.mvcmodels.pivot_table_models.PivotTableModelBase (parent)
Bases: PySide2.QtCore.QAbstractTableModel

Parameters parent (SpineDBEditor) —
_V_HEADER_WIDTH = 5
_MAX_FETCH_COUNT = 1000
_FETCH_DELAY = 0
model_data_changed

abstract _fetch_item_types(self)
Yields item types to fetch for this model.

Yields str

abstract _fetch_parent (self, item_type)
Returns a parent to fetch items of given type.
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Parameters item_type (str)—

Returns _FetchParent
_can_fetch_more_item_type (self, item_type)
canFetchMore (self, _parent)
_fetch_more_item_type(self, item_type)
fetchMore (self, _parent)

property item_type(self)
Returns the item type.

reset_data_count (self)
start_fetching(self)
fetch_more_rows (self)
fetch_more_columns (self)

abstract call_reset_model (self, pivot=None)

Parameters pivot (tuple, optional) — list of rows, list of columns, list of frozen indexes,
frozen value

abstract static make_delegate(parent)
reset_model (self, data, index_ids, rows=(), columns=(), frozen=(), frozen_value=())
clear_model (self)

update_model (self, data)
Update model with new data, but doesn’t grow the model.

Parameters data (dict) -
add_to_model (self, db_map_data)
_emit_all_data_changed(self)
remove_from_model (self, data)
set_pivot (self, rows, columns, frozen, frozen_value)
set_frozen_value (self, frozen_value)

set_plot_x_column(self, column, is_x)
Sets or clears the X flag on a column

property plot_x_column(self)
Returns the index of the column designated as Y values for plotting or None.

headerRowCount (self)
Returns number of rows occupied by header.

headerColumnCount (self)
Returns number of columns occupied by header.

dataRowCount (self)
Returns number of rows that contain actual data.

dataColumnCount (self)
Returns number of columns that contain actual data.
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emptyRowCount (self)
emptyColumnCount (self)

rowCount (self, parent=QModellndex())
Number of rows in table, number of header rows + datarows + 1 empty row

columnCount (self, parent=0QModellndex())
Number of columns in table, number of header columns + datacolumns + 1 empty columns

flags (self, index)
Roles for data

top_left_indexes(self)
Returns indexes in the top left area.

Returns list(QModellndex): top indexes (horizontal headers, associated to rows) list(QModellndex): left
indexes (vertical headers, associated to columns)

index_within_top_left (self, index)
index_in_top (self, index)
index_in_left (self, index)

index_in_top_left (self, index)
Returns whether or not the given index is in top left corner, where pivot names are displayed

index_in_column_headers (self, index)
Returns whether or not the given index is in column headers (horizontal) area

index_in_row_headers (self, index)
Returns whether or not the given index is in row headers (vertical) area

index_in_headers (self, index)

index_in_empty_column_headers (self, index)
Returns whether or not the given index is in empty column headers (vertical) area

index_in_empty_row_headers (self, index)
Returns whether or not the given index is in empty row headers (vertical) area

index_in_data(self, index)
Returns whether or not the given index is in data area

column_is_index_column (self, column)
Returns True if column is the column containing expanded parameter_value indexes.

headerData(self, section, orientation, role=Qt.DisplayRole)

map_to_pivot (self, index)
Returns a tuple of row and column in the pivot model that corresponds to the given model index.

Parameters index (QModelIndex) —
Returns row int: column
Return type int

top_left_id(self, index)
Returns the id of the top left header corresponding to the given header index.

Parameters index (QModelIndex) —

Returns int, NoneType
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_header_id(self, index)
Returns the id of the given row or column header index.

Parameters index (QModelIndex) —
Returns int, NoneType

_header_ids(self, row, column)
Returns the ids for the headers at given row and column.

Parameters

e row (int) —

e column (int) —
Returns tuple(int)

header_name (self, index)
Returns the name corresponding to the given header index. Used by PivotTableView.

Parameters index (QModelIndex) —

Returns str
_color_data(self, index)
_text_alignment_data(self, index)
_header_data(self, index, role=Qt.DisplayRole)
_header_name (self, top_left_id, header_id)
abstract _data(self, index, role)
data(self, index, role=Qt.DisplayRole)
setData(self, index, value, role=Qt.EditRole)
batch_set_data(self, indexes, values)
_batch_set_inner_data(self, inner_data)
abstract _do_batch_set_inner_data(self, row_map, column_map, data, values)
_batch_set_header_data(self, header_data)
_batch_set_empty_header_data(self, header_data, get top_left_id)
receive_data_added_or_removed (self, db_map_data, action)
receive_objects_added_or_removed (self, db_map_data, action)
receive_relationships_added_or_removed(self, db_map_data, action)
receive_parameter_definitions_added_or_removed(self, db_map_data, action)
receive_alternatives_added_or_removed(self, db_map_data, action)
receive_parameter_values_added_or_removed (self, db_map_data, action)
receive_scenarios_added_or_removed(self, db_map_data, action)

receive_scenarios_updated(self, db_map_data)

class spinetoolbox.spine_db_editor.mvcmodels.pivot_table_models.TopLeftHeaderItem(model)

Base class for all ‘top left pivot headers’. Represents a header located in the top left area of the pivot table.

Parameters model (PivotTablelModelBase) —
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property model (self)
property db_mngr (self)
_get_header_data_from_db (self, item_type, header_id, field_name, role)

class spinetoolbox.spine_db_editor.mvcmodels.pivot_table_models.TopLeftObjectHeaderItem(model,
class_name,
class_id)
Bases: TopLeftHeaderItem

A top left header for object_class.

Parameters model (PivotTableModelBase) —
property header_type (self)
property name (self)
header_data(self, header_id, role=Qt.DisplayRole)
update_data(self, db_map_data)
add_data(self, names)

class spinetoolbox.spine_db_editor.mvcmodels.pivot_table_models.TopLeftParameterHeaderItem(model)
Bases: TopLeftHeaderItem

A top left header for parameter_definition.
Parameters model (PivotTableModelBase) —

property header_type(self)

property name (self)

header_data (self, header_id, role=Qt.DisplayRole)

update_data(self, db_map_data)

add_data(self, names)

class spinetoolbox.spine_db_editor.mvcmodels.pivot_table_models.TopLeftParameterIndexHeaderItem(model)
Bases: TopLeftHeaderItem

A top left header for parameter index.

Parameters model (PivotTablelModelBase) —
property header_type (self)
property name (self)
header_data(self, header_id, role=Qt.DisplayRole)
update_data(self, db_map_data)
add_data(self, _names)

class spinetoolbox.spine_db_editor.mvcmodels.pivot_table_models.TopLeftAlternativeHeaderItem(model)
Bases: TopLeftHeaderItem

A top left header for alternative.
Parameters model (PivotTableModelBase) —
property header_type(self)

property name (self)
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header_data (self, header_id, role=Qt.DisplayRole)
update_data(self, db_map_data)
add_data(self, names)

class spinetoolbox.spine_db_editor.mvcmodels.pivot_table_models.TopLeftScenarioHeaderItem(model)
Bases: TopLeftHeaderItem

A top left header for scenario.

Parameters model (PivotTableModelBase) —
property header_type (self)
property name (self)
header_data (self, header_id, role=Qt.DisplayRole)
update_data(self, db_map_data)
add_data(self, names)

class spinetoolbox.spine_db_editor.mvcmodels.pivot_table_models.TopLeftDatabaseHeaderItem(model)
Bases: TopLeftHeaderItem

A top left header for database.
Parameters model (PivotTableModelBase) —
property header_type (self)
property name (self)
header_data(self, header_id, role=Qt.DisplayRole)

class spinetoolbox.spine_db_editor.mvcmodels.pivot_table_models.ParameterValuePivotTableModel (parent)
Bases: PivotTableModelBase

A model for the pivot table in parameter_value input type.
Parameters parent (SpineDBEditor) —

property item_type(self)
Returns the item type.

_fetch_item_types(self)
Yields item types to fetch for this model.

Yields str

_fetch_parent (self, item_type)
Returns a parent to fetch items of given type.

Parameters item_type (str) -
Returns _FetchParent

db_map_object_ids(self, index)
Returns db_map and object ids for given index. Used by PivotTableView.

Returns DatabaseMapping, list
_db_map_object_ids(self, header_ids)

_all_header_names (self, index)
Returns the object, parameter, alternative, and db names corresponding to the given data index.

Parameters index (QModelIndex) —
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Returns object names str: parameter name str: alternative name str: db name
Return type list(str)

index_name (self, index)
Returns a string that concatenates the object and parameter names corresponding to the given data index.
Used by plotting and ParameterValueEditor.

Parameters index (QModelIndex) —
Returns str

column_name (self, column)
Returns a string that concatenates the object and parameter names corresponding to the given column. Used
by plotting.

Parameters column (int) —
Returns str

call_reset_model (self, pivot=None)
See base class.

static make_delegate(parent)

_default_pivot (self, data)

_data(self, index, role)

_do_batch_set_inner_data(self, row_map, column_map, data, values)
_object_parameter_value_to_add(self, db_map, header_ids, value_and_type)
_relationship_parameter_value_to_add(self, db_map, header_ids, value_and_type, rel_id_lookup)
_make_parameter_value_to_add(self)

static _parameter_value_to_update(id_, header_ids, value_and_type)

_batch_set_parameter_value_data(self, row_map, column_map, data, values)
Sets parameter values in batch.

_add_parameter_values (self, db_map_data)
_update_parameter_values (self, db_map_data)

get_set_data_delayed(self, index)
Returns a function that ParameterValueEditor can call to set data for the given index at any later time, even
if the model changes.

Parameters index (QModelIndex) —

Returns function
receive_objects_added_or_removed (self, db_map_data, action)
receive_relationships_added_or_removed(self, db_map_data, action)
receive_parameter_definitions_added_or_removed(self, db_map_data, action)
receive_alternatives_added_or_removed(self, db_map_data, action)
receive_parameter_values_added_or_removed (self, db_map_data, action)
_load_empty_parameter_value_data(self, *args, **kwargs)

_load_full_parameter_value_data(self, *args, **kwargs)
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class spinetoolbox.spine_db_editor.mvcmodels.pivot_table_models.IndexExpansionPivotTableModel (parent)
Bases: ParameterValuePivotTableModel

A model for the pivot table in parameter index expansion input type.
Parameters parent (SpineDBEditor) —

call_reset_model (self, pivot=None)
See base class.

flags (self, index)
Roles for data

column_is_index_column (self, column)
Returns True if column is the column containing expanded parameter_value indexes.

_load_empty_parameter_value_data(self, *args, **kwargs)
_load_full_parameter_value_data(self, *args, **kwargs)

_datad(self, index, role)

static _parameter_value_to_update(id_, header_ids, value_and_type)
_update_parameter_values(self, db_map_data)

class spinetoolbox.spine_db_editor.mvcmodels.pivot_table_models.RelationshipPivotTableModel (parent)
Bases: PivotTableModelBase

A model for the pivot table in relationship input type.
Parameters parent (SpineDBEditor) —

property item_type(self)
Returns the item type.

_fetch_item_types(self)
Yields item types to fetch for this model.

Yields str

_fetch_parent (self, item_type)
Returns a parent to fetch items of given type.

Parameters item_type (str) -
Returns _FetchParent

call_reset_model (self, pivot=None)
See base class.

static make_delegate(parent)

_default_pivot(self, data)

_datad(self, index, role)

_do_batch_set_inner_data(self, row_map, column_map, data, values)
_batch_set_relationship_data(self, row_map, column_map, data, values)
receive_objects_added_or_removed (self, db_map_data, action)

receive_relationships_added_or_removed(self, db_map_data, action)
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class spinetoolbox.spine_db_editor.mvcmodels.pivot_table_models.ScenarioAlternativePivotTableModel (paren
Bases: PivotTableModelBase

A model for the pivot table in scenario alternative input type.
Parameters parent (SpineDBEditor) —

property item_type(self)
Returns the item type.

_fetch_item_types(self)
Yields item types to fetch for this model.

Yields str

_fetch_parent (self, item_type)
Returns a parent to fetch items of given type.

Parameters item_type (str)—
Returns _FetchParent

call_reset_model (self, pivot=None)
See base class.

static make_delegate(parent)

_default_pivot (self, data)

_datad(self, index, role)

_do_batch_set_inner_data(self, row_map, column_map, data, values)
_batch_set_scenario_alternative_data(self, row_map, column_map, data, values)
receive_scenarios_updated(self, db_map_data)
receive_alternatives_added_or_removed(self, db_map_data, action)
receive_scenarios_added_or_removed(self, db_map_data, action)

class spinetoolbox.spine_db_editor.mvcmodels.pivot_table_models.PivotTableSortFilterProxy (parent=None)
Bases: PySide2.QtCore.QSortFilterProxyModel

Initialize class.
model_data_changed
setSourceModel (self, model)

set_filter (self, identifier, filter_value)
Sets filter for a given index (object_class) name.

Parameters
e identifier (int) - index identifier
o filter_value (set, None)— A set of accepted values, or None if no filter (all pass)
clear_filter(self)
accept_index(self, index, index_ids)

filterAcceptsRow(self, source_row, source_parent)
Returns true if the item in the row indicated by the given source_row and source_parent should be included
in the model; otherwise returns false.
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filterAcceptsColumn (self, source_column, source_parent)
Returns true if the item in the column indicated by the given source_column and source_parent should be
included in the model; otherwise returns false.

batch_set_data(self, indexes, values)

spinetoolbox.spine_db_editor.mvcmodels.single_parameter_models

Single models for parameter definitions and values (as ‘for a single entity’).
authors
M. Marin (KTH)
date 28.6.2019

Module Contents

Classes

HalfSortedTableModel Table model for outlining simple tabular data.

SingleParameterModel A parameter model for a single entity_class to go in a
CompoundParameterModel.

SingleObjectParameterMixin Associates a parameter model with a single object_class.

SingleRelationshipParameterMixin Associates a parameter model with a single relation-
ship_class.

SingleParameterDefinitionMixin A parameter_definition model for a single entity_class.

SingleParameterValueMixin A parameter_value model for a single entity_class.

SingleObjectParameterDefinitionModel An object parameter_definition model for a single ob-
ject_class.

SingleRelationshipParameterDefinitionlModel A relationship parameter_definition model for a single
relationship_class.

SingleObjectParameterValuelodel An object parameter_value model for a single ob-
ject_class.
SingleRelationshipParameterValueModel A relationship parameter_value model for a single rela-

tionship_class.

class spinetoolbox.spine_db_editor.mvcmodels.single_parameter_models.HalfSortedTableModel (parent=None,
header=None,
lazy=True)
Bases: spinetoolbox.mvcmodels.minimal_table_model.MinimalTableModel

Table model for outlining simple tabular data.
Parameters parent (QObject) — the parent object

reset_model (self, main_data=None)
Reset model.

add_rows (self, data)

_sort_key (self, element)
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class spinetoolbox.spine_db_editor.mvcmodels.single_parameter_models.SingleParameterModel (seader,
db_mngr,
db_map,
éen-
tity_class_id,
com-
mit-
ted,
lazy=False)

Bases: HalfSortedTableModel

A parameter model for a single entity_class to go in a CompoundParameterModel. Provides methods to associate
the model to an entity_class as well as to filter entities within the class.

Init class.
Parameters header (1ist) — list of field names for the header
__1t__(self, other)

property item_type(self)
The item type, either ‘parameter_value’ or ‘parameter_definition’, required by the data method.

property entity_class_type(self)
The entity_class type, either ‘object_class’ or ‘relationship_class’.

property entity_class_name_field(self)
property entity_class_name(self)
property entity_class_id_key(self)
property value_field(self)

property fixed_fields(self)

property group_fields(self)

property parameter_definition_id_key(self)
property can_be_filtered(self)
item_id(self, row)

db_item(self, index)

_db_item(self, row)

db_item_from_id(self, id_)

db_items (self)

flags (self, index)
Make fixed indexes non-editable.

get_field_item_data(self, field)
Returns item data for given field.

Parameters field (str) — A field from the header
Returns str, str

get_id_key (self, field)
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get_field_item(self, field, db_item)
Returns a db item corresponding to the given field from the table header, or an empty dict if the field doesn’t
contain db items.

data(self, index, role=Qt.DisplayRole)
Gets the id and database for the row, and reads data from the db manager using the item_type property.
Paint the object_class icon next to the name. Also paint background of fixed indexes gray and apply custom
format to JSON fields.

batch_set_data(self, indexes, data)
Sets data for indexes in batch. Sets data directly in database using db mngr. If successful, updated data will
be automatically seen by the data method.

abstract update_items_in_db(self, items)
Update items in db. Required by batch_set_data

_filter_accepts_row(self, row)
filter_accepts_item(self, item)
set_auto_filter (self, field, values)

_auto_filter_accepts_item(self, item)
Returns the result of the auto filter.

accepted_rows (self)
Yields accepted rows, for convenience.

_get_field_item(self, field, id_)
Returns a item from the db_mngr.get_item depending on the field. If a field doesn’t correspond to a item
in the database then an empty dict is returned.

class
spinetoolbox.spine_db_editor.mvcmodels.single_parameter_models.SingleObjectParameterMixin
Associates a parameter model with a single object_class.

property entity_class_type(self)

class spinetoolbox.spine_db_editor.mvcmodels.single_parameter_models.
SingleRelationshipParameterMixin
Associates a parameter model with a single relationship_class.

property entity_class_type(self)

class spinetoolbox.spine_db_editor.mvcmodels.single_parameter_models.SingleParameterDefinitionMixin (*arg
**k‘
Bases: spinetoolbox.spine_db_editor.mvcmodels.parameter_mixins.
FillInParameterNameMixin, spinetoolbox.spine_db_editor.mvcmodels.parameter_mixins.
FillInValueListIdMixin

A parameter_definition model for a single entity_class.
Initializes lookup dicts.

property item_type(self)

_sort_key (self, element)

update_items_in_db (self, items)
Update items in db.

Parameters item (1ist) — dictionary-items
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class spinetoolbox.spine_db_editor.mvcmodels.single_parameter_models.SingleParameterValueMixin(*args,

*rkwargs)
Bases: spinetoolbox.spine_db_editor.mvcmodels.parameter_mixins.
FillInAlternativeIdMixin, spinetoolbox.spine_db_editor.mvcmodels.parameter_mixins.
ImposeEntityClassIdMixin, spinetoolbox.spine_db_editor.mvcmodels.parameter_mixins.
FillInParameterDefinitionIdsMixin, spinetoolbox.spine_db_editor.mvcmodels.

parameter_mixins.FillInEntityIdsMixin
A parameter_value model for a single entity_class.
Initializes lookup dicts.
_filter_db_map_class_entity_ids
_filter_alternative_ids
_filter_entity_ids

property item_type(self)

property entity_type(self)
Either ‘object’ or “relationship’.

property entity_id_key(self)

property entity_name_key (self)

property entity_name_key_in_cache(self)

_sort_key (self, element)

set_filter_entity_ids(self, db_map_class_entity_ids)
set_filter_alternative_ids(self, db_map_alternative_ids)

filter_accepts_item(self, item)
Reimplemented to also account for the entity and alternative filter.

_entity_filter_accepts_item(self, item)
Returns the result of the entity filter.

_alternative_filter_accepts_item(self, item)
Returns the result of the alternative filter.

update_items_in_db(self, items)
Update items in db.

Parameters item (I1ist) — dictionary-items

class spinetoolbox.spine_db_editor.mvcmodels.single_parameter_models.SingleObjectParameterDefinitionMod

Bases: SingleObjectParameterMixin, SingleParameterDefinitionMixin, SingleParameterModel
An object parameter_definition model for a single object_class.

Initializes lookup dicts.

class spinetoolbox.spine_db_editor.mvcmodels.single_parameter_models.SingleRelationshipParameterDefinit

Bases: SingleRelationshipParameterMixin, SingleParameterDefinitionMixin,
SingleParameterModel

A relationship parameter_definition model for a single relationship_class.

Initializes lookup dicts.
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class spinetoolbox.spine_db_editor.mvcmodels.single_parameter_models.SingleObjectParameterValueModel (*a:

Bases: SingleObjectParameterMixin, SingleParameterValueMixin, SingleParameterModel
An object parameter_value model for a single object_class.
Initializes lookup dicts.

property entity_type(self)
Either ‘object’ or “relationship’.

class spinetoolbox.spine_db_editor.mvcmodels.single_parameter_models.SingleRelationshipParameterValuelMo

Bases: SingleRelationshipParameterMixin, spinetoolbox.spine_db_editor.mvcmodels.
parameter_mixins.MakeRelationshipOnTheFlyMixin, SingleParameterValueMixin,
SingleParameterModel

A relationship parameter_value model for a single relationship_class.
Initializes lookup dicts.

property entity_type(self)
Either ‘object’ or “relationship’.

update_items_in_db (self, items)
Update items in db.

Parameters item (1ist) — dictionary-items

spinetoolbox.spine_db_editor.mvcmodels.tool_feature_item

Classes to represent tool and feature items in a tree.

authors
M. Marin (KTH)
date 1.9.2020

Module Contents

Classes
FeatureRootItem A feature root item.
ToolRootItem A tool root item.
FeatureLeafItem A feature leaf item.
ToolLeafItem A tool leaf item.
ToolFeatureRootItem A tool_feature root item.
ToolFeatureLeafItem A tool feature leaf item.

ToolFeatureRequiredItem

A tool feature required item.

ToolFeatureMethodRootItem

A tool_feature_method root item.

ToolFeatureMethodLeafItem

A tool_feature_method leaf item.
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Attributes

_FEATURE_ICON

_TOOL_ICON

_METHOD_ICON

spinetoolbox.spine_db_editor.mvcmodels.tool_feature_item._FEATURE_ICON =

spinetoolbox.spine_db_editor.mvcmodels.tool_feature_item._TOOL_ICON =

spinetoolbox.spine_db_editor.mvcmodels.tool_feature_item._METHOD_ICON =

class spinetoolbox.spine_db_editor.mvcmodels.tool_feature_item.FeatureRootItem(model=None)

Bases: spinetoolbox.spine_db_editor.mvcmodels.tree_item_utility.EmptyChildRootItem
A feature root item.
Initializes item.

Parameters model (MinimalTreeModel, NoneType)— The model where the item belongs.
property item_type(self)
property display_data(self)
property icon_code (self)

empty_child(self)

class spinetoolbox.spine_db_editor.mvcmodels.tool_feature_item.ToolRootItem(model=None)

Bases: spinetoolbox.spine_db_editor.mvcmodels. tree_item_utility.EmptyChildRootItem
A tool root item.
Initializes item.

Parameters model (MinimalTreeModel, NoneType)- The model where the item belongs.
property item_type(self)
property display_data(self)
property icon_code(self)

empty_child(self)

class spinetoolbox.spine_db_editor.mvcmodels.tool_feature_item.FeatureLeafItem(identifier=None)

Bases: spinetoolbox.spine_db_editor.mvcmodels.tree_item_utility.GrayIfLastMixin,
spinetoolbox.spine_db_editor.mvcmodels.tree_item_utility.EditableMixin, spinetoolbox.
spine_db_editor.mvcmodels. tree_item_utility.LeafItem

A feature leaf item.
Initializes item.
Parameters model (MinimalTreeModel, NoneType)— The model where the item belongs.
property item_type(self)
_make_item_data(self)
property item_data(self)
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property tool_tip(self)
add_item_to_db (self, db_item)
update_item_in_db(self, db_item)

flags (self, column)
Makes items editable.

_make_item_to_add(self, value)
_make_item_to_update (self, column, value)
_get_ids_from_feat_name (self, feature_name)

class spinetoolbox.spine_db_editor.mvcmodels.tool_feature_item.ToolLeafItem(identifier=None)
Bases: spinetoolbox.spine_db_editor.mvcmodels. tree_item_utility.GrayIfLastMixin,
spinetoolbox.spine_db_editor.mvcmodels.tree_item_utility.EditableMixin, spinetoolbox.
spine_db_editor.mvcmodels. tree_item_utility.LeafItem

A tool leaf item.
Initializes item.
Parameters model (MinimalTreeModel, NoneType)— The model where the item belongs.
property item_type(self)
add_item_to_db (self, db_item)
update_item_in_db (self, db_item)

_do_finalize(self)
Do some final initialization after setting the parent.

class spinetoolbox.spine_db_editor.mvcmodels.tool_feature_item.ToolFeatureRootItem(imodel=None)

Bases: spinetoolbox.spine_db_editor.mvcmodels.tree_item_utility.EmptyChildRootItem
A tool_feature root item.
Initializes item.
Parameters model (MinimalTreeModel, NoneType)— The model where the item belongs.
property item_type(self)
property display_data(self)
property tool_tip(self)
property icon_code (self)
property feature_id_list(self)

flags (self, column)
Enables the item and makes it selectable.

empty_child(self)

class spinetoolbox.spine_db_editor.mvcmodels.tool_feature_item.ToolFeatureLeafItem(identifier=None)

Bases: spinetoolbox.spine_db_editor.mvcmodels.tree_item_utility.GrayIfLastMixin,
spinetoolbox.spine_db_editor.mvcmodels. tree_item_utility.LeafItem

A tool feature leaf item.
Initializes item.

Parameters model (MinimalTreeModel, NoneType)— The model where the item belongs.
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property item_type(self)
property item_data(self)

_do_finalize(self)
Do some final initialization after setting the parent.

_make_item_to_add(self, value)
add_item_to_db(self, db_item)
update_item_in_db(self, db_item)

flags (self, column)
Enables the item and makes it selectable.

class spinetoolbox.spine_db_editor.mvcmodels.tool_feature_item.ToolFeatureRequiredItem(model=None)
Bases: spinetoolbox.spine_db_editor.mvcmodels.tree_item_utility.StandardTreeltem

A tool feature required item.
Initializes item.

Parameters model (MinimalTreeModel, NoneType)— The model where the item belongs.
property item_type(self)

flags (self, column)
Enables the item and makes it selectable.

data(self, column, role=Qt.DisplayRole)
Returns data for given column and role.

set_data(self, column, value, role=Qt.EditRole)
Sets data for this item.

Parameters

e column (int) — column index

¢ value (object) — a new value

¢ role (int) - role of the new value
Returns True if data was set successfully, False otherwise
Return type bool

has_children(self)
Returns whether or not this item has or could have children.

class spinetoolbox.spine_db_editor.mvcmodels.tool_feature_item.ToolFeatureMethodRootItem(model=None)
Bases: spinetoolbox.spine_db_editor.mvcmodels.tree_item_utility.EmptyChildRootItem

A tool_feature_method root item.
Initializes item.
Parameters model (MinimalTreeModel, NoneType)— The model where the item belongs.
property item_type(self)
property display_data(self)
property icon_code (self)

empty_child(self)
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class spinetoolbox.spine_db_editor.mvcmodels.tool_feature_item.ToolFeatureMethodLeafItem(identifier=None)
Bases: spinetoolbox.spine_db_editor.mvcmodels. tree_item_utility.GrayIfLastMixin,
spinetoolbox.spine_db_editor.mvcmodels. tree_item_utility.LeafItem

A tool_feature_method leaf item.
Initializes item.
Parameters model (MinimalTreeModel, NoneType)— The model where the item belongs.
property item_type(self)
property tool_feature_item(self)
property item_data(self)
_make_item_data(self)

flags (self, column)
Enables the item and makes it selectable.

_make_item_to_add(self, value)

_make_item_to_update (self, column, value)
—get_method_index(self, parameter_value_list_id, method)
add_item_to_db (self, db_item)

update_item_in_db (self, db_item)

spinetoolbox.spine_db_editor.mvcmodels.tool_feature_model

Models to represent tools and features in a tree.
authors
M. Marin (KTH)
date 1.0.2020

Module Contents

Classes

ToolFeatureModel A model to display tools and features in a tree view.

class spinetoolbox.spine_db_editor.mvcmodels.tool_feature_model.ToolFeatureModel (parent,
db_mngr,
*db_maps)
Bases: spinetoolbox.spine_db_editor.mvcmodels. tree_model_base.TreeModelBase

A model to display tools and features in a tree view.
Parameters
e parent (SpineDBEditor) —
e db_mngr (SpineDBManager) —

» db_maps (iter) — DiffDatabaseMapping instances
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Initialize class

static _make_db_item(db_map)

static _top_children()

static make_feature_name (entity_class_name, parameter_definition_name)
_begin_set_features(self, db_map)
get_all_feature_names(self, db_map)

get_feature_data(self, db_map, feature_name)
_begin_set_feature_method(self, db_map, parameter_value_list_id)
get_all_feature_methods (self, db_map, parameter_value_list_id)
get_method_index (self, db_map, parameter_value_list_id, method)
_tools_per_root (self, db_map_data)

_features_per_root (self, db_map_data)
_tool_features_per_root (self, db_map_data)
_tool_feature_methods_per_root (self, db_map_data)
add_features (self, db_map_data)

add_tools (self, db_map_data)

add_tool_features(self, db_map_data)
add_tool_feature_methods (self, db_map_data)
update_features (self, db_map_data)

update_tools(self, db_map_data)

update_tool_features (self, db_map_data)
update_tool_feature_methods (self, db_map_data)
remove_features (self, db_map_data)

remove_tools (self, db_map_data)

remove_tool_features (self, db_map_data)
remove_tool_feature_methods (self, db_map_data)
supportedDropActions (self)

mimeData (self, indexes)
Builds a dict mapping db name to item type to a list of ids.

Returns QMimeData
canDropMimeData (self, data, drop_action, row, column, parent)

dropMimeData (self, data, drop_action, row, column, parent)
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spinetoolbox.spine_db_editor.mvcmodels.tree_it

A tree model for parameter_value lists.
authors
M. Marin (KTH)
date 28.6.2019

Module Contents

em_utility

Classes
StandardTreeItem A tree item that fetches their children as they are in-
serted.
EditableMixin
GrayIfLastMixin Paints the item gray if it's the last.
BoldTextMixin Bolds text.
EmptyChildMixin Guarantess there's always an empty child.
SortsChildrenMixin
FetchMoreMixin
StandardDBItem An item representing a db.
RootItem A root item.
EmptyChildRootItem Guarantess there's always an empty child.
LeafItem A tree item that fetches their children as they are in-

serted.

class spinetoolbox.spine_db_editor.mvcmodels.tree_item_utility.StandardTreeltem(model=None)
Bases: spinetoolbox.mvcmodels.minimal_tree_model.TreeItem

A tree item that fetches their children as they are inserted.

Initializes item.

Parameters model (MinimalTreeModel, NoneType)- The model where the item belongs.

property item_type(self)
property db_mngr (self)
property display_data(self)
property icon_code(self)
property tool_tip(self)
property display_icon(self)

data(self, column, role=Qt.DisplayRole)
Returns data for given column and role.

set_data(self, column, value, role=Qt.DisplayRole)
Sets data for this item.
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Parameters
e column (int) — column index
e value (object) — a new value
e role (int) —role of the new value
Returns True if data was set successfully, False otherwise
Return type bool
property non_empty_children(self)

class spinetoolbox.spine_db_editor.mvcmodels.tree_item_utility.EditableMixin

flags (self, column)
Makes items editable.

class spinetoolbox.spine_db_editor.mvcmodels.tree_item_utility.GrayIfLastMixin
Paints the item gray if it’s the last.

data(self, column, role=Qt.DisplayRole)

class spinetoolbox.spine_db_editor.mvcmodels.tree_item_utility.BoldTextMixin
Bolds text.

data(self, column, role=Qt.DisplayRole)

class spinetoolbox.spine_db_editor.mvcmodels.tree_item_utility.EmptyChildMixin
Guarantess there’s always an empty child.

property non_empty_children(self)
abstract empty_child(self)
_do_finalize(self)

class spinetoolbox.spine_db_editor.mvcmodels.tree_item_utility.SortsChildrenMixin

insert_children_sorted(self, children)

class spinetoolbox.spine_db_editor.mvcmodels.tree_item_utility.FetchMoreMixin

property fetch_item_type(self)
can_fetch_more(self)
fetch_more (self)

class spinetoolbox.spine_db_editor.mvcmodels.tree_item_utility.StandardDBItem(db_map)
Bases: SortsChildrenMixin, StandardTreeItem

An item representing a db.

Init class.

Args db_mngr (SpineDBManager) db_map (DiffDatabaseMapping)
property item_type(self)

data(self, column, role=Qt.DisplayRole)
Shows Spine icon for fun.
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class spinetoolbox.spine_db_editor.mvcmodels.tree_item_utility.RootItem(model=None)
Bases: SortsChildrenMixin, BoldTextMixin, FetchMoreMixin, StandardTreeItem

A root item.
Initializes item.
Parameters model (MinimalTreeModel, NoneType)— The model where the item belongs.
property item_type(self)
property db_map (self)

class spinetoolbox.spine_db_editor.mvcmodels.tree_item_utility.EmptyChildRootItem(model=None)
Bases: EmptyChildMixin, RootItem

Guarantess there’s always an empty child.
Initializes item.

Parameters model (MinimalTreeModel, NoneType) - The model where the item belongs.
abstract empty_child(self)

class spinetoolbox.spine_db_editor.mvcmodels.tree_item_utility.LeafItem(identifier=None)
Bases: StandardTreeItem

A tree item that fetches their children as they are inserted.
Initializes item.
Parameters model (MinimalTreeModel, NoneType)— The model where the item belongs.
_make_item_data(self)
property item_type(self)
property db_map (self)
property id(self)
property item_data(self)
property name (self)
abstract add_item_to_db(self, db_item)
abstract update_item_in_db (self, db_item)
header_data(self, column)

data(self, column, role=Qt.DisplayRole)
Returns data for given column and role.

set_data(self, column, value, role=Qt.EditRole)
Sets data for this item.

Parameters

e column (int) — column index

e value (object) — a new value

e role (int) - role of the new value
Returns True if data was set successfully, False otherwise
Return type bool

_make_item_to_add(self, value)

20.1. spinetoolbox 283



Spine Toolbox Documentation, Release 0.6.6.dev0-dev.0

_make_item_to_update (self, column, value)
handle_updated_in_db (self)

can_fetch_more (self)
Returns whether or not this item can fetch more.

spinetoolbox.spine_db_editor.mvcmodels.tree_model_base

Models to represent things in a tree.
authors
M. Marin (KTH)
date 1.0.2020

Module Contents

Classes

TreeModelBase A base model to display items in a tree view.

class spinetoolbox.spine_db_editor.mvcmodels.tree_model_base.TreeModelBase (parent, db_mngr,
*db_maps)
Bases: spinetoolbox.mvcmodels.minimal_tree_model.MinimalTreeModel

A base model to display items in a tree view.
Parameters
e parent (SpineDBEditor) —
e db_mngr (SpineDBManager) —
» *db_maps — DiffDatabaseMapping instances

columnCount (self, parent=0QModellndex())
Returns the number of columns under the given parent. Always 2.

Returns column count
Return type int
headerData (self, section, orientation, role=Qt.DisplayRole)

build_tree(self)
Builds tree.

abstract static _make_db_item(db_map)
abstract static _top_children()
_items_per_db_item(self, db_map_data)
_items_per_root (self, db_map_data, root_number=0)
static _db_map_data_per_id(db_map_data, id_key)
_update_leaf_items(self, root_item, ids)

static _remove_leaf_ items(roor item, ids)
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static _insert_items(parent_item, db_items, make_child)
Inserts items at right positions. Items with commit_id are kept sorted. Items without a commit_id are put
at the end.

Parameters
e parent_item (Treeltem)—
e db_items (list of dict)- database items
e make_child (function) — A function that receives an integer id and returns a Treeltem
static db_item(item)

db_row (self, item)

spinetoolbox.spine_db_editor.ui

Automatically generated UI modules for Spine db editor.
authors
M. Marin (KTH)
date 13.5.2020

Submodules

spinetoolbox.spine_db_editor.ui.scenario_generator

Module Contents

Classes

Ui_Form

class spinetoolbox.spine_db_editor.ui.scenario_generator.Ui_Form
Bases: object

setupUi (self, Form)

retranslateUi (self, Form)

spinetoolbox.spine_db_editor.ui.spine_db_editor_window

Module Contents

Classes

Ui_MainWindow
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class spinetoolbox.spine_db_editor.ui.spine_db_editor_window.Ui_MainWindow

Bases: object
setupUi (self, MainWindow)

retranslateUi (self, MainWindow)

spinetoolbox.spine_db_editor.widgets

Interface logic for Spine db editor.
authors
M. Marin (KTH)
date 13.5.2020

Submodules

spinetoolbox.spine_db_editor.widgets.add_items_dialogs

Classes for custom QDialogs to add items to databases.
author
M. Marin (KTH)
date 13.5.2018

Module Contents

Classes

AddReadyRelationshipsDialog

A dialog to let the user add new 'ready' relationships.

AddItemsDialog

A dialog to query user's preferences for new db items.

AddObjectClassesDialog

A dialog to query user's preferences for new object
classes.

AddObjectsDialog

A dialog to query user's preferences for new objects.

AddRelationshipClassesDialog

A dialog to query user's preferences for new relationship
classes.

AddOrManageRelationshipsDialog

A dialog to query user's preferences for new relation-
ships.

AddRelationshipsDialog

A dialog to query user's preferences for new relation-
ships.

ManageRelationshipsDialog

A dialog to query user's preferences for managing rela-
tionships.

ObjectGroupDialogBase

param parent data store widget

AddObjectGroupDialog
param parent data store widget
continues on next page
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Table 47 — continued from previous page

ManagelMembersDialog
param parent data store widget

class spinetoolbox.spine_db_editor.widgets.add_items_dialogs.AddReadyRelationshipsDialog(parent,
re-
la-
tion-
ships_class,
re-
la-
tion-
ships,
db_mngr,
*db_maps)

Bases: spinetoolbox.spine_db_editor.widgets.manage_items_dialogs.ManageItemsDialogBase

A dialog to let the user add new ‘ready’ relationships.
Parameters

e parent (SpineDBEditor) —

e relationships_class (dict) —

e relationships (1ist(list(str))—

e db_mngr (SpineDBManager) —

» *db_maps - DiffDatabaseMapping instances
make_table_view(self)
populate_table_view(self)

connect_signals(self)
Connect signals to slots.

_handle_table_view_cell_clicked(self, row, column)
_handle_table_view_current_changed(self, current, _previous)
accept(self)

class spinetoolbox.spine_db_editor.widgets.add_items_dialogs.AddItemsDialog(parent, db_mngr,
*db_maps)
Bases: spinetoolbox.spine_db_editor.widgets.manage_items_dialogs.ManageItemsDialog

A dialog to query user’s preferences for new db items.
Parameters
e parent (SpineDBEditor) —
e db_mngr (SpineDBManager) —
» *db_maps - DiffDatabaseMapping instances

connect_signals(self)
Connect signals to slots.

remove_selected_rows (self, checked=True)
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all_databases(self, row)
Returns a list of db names available for a given row. Used by delegates.

class spinetoolbox.spine_db_editor.widgets.add_items_dialogs.AddObjectClassesDialog(parent,
db_mngr,
*db_maps)
Bases: spinetoolbox.spine_db_editor.widgets.manage_items_dialogs.
ShowIconColorEditorMixin, AddItemsDialog

A dialog to query user’s preferences for new object classes.
Parameters
* parent (SpineDBEditor) —
e db_mngr (SpineDBManager) —
» *db_maps — DiffDatabaseMapping instances
connect_signals(self)
Connect signals to slots.
all_db_maps (self, row)
Returns a list of db maps available for a given row. Used by ShowIconColorEditorMixin.
accept (self)

Collect info from dialog and try to add items.

class spinetoolbox.spine_db_editor.widgets.add_items_dialogs.AddObjectsDialog(parent,
parent_item,
db_mngr,
*db_maps,
force_default=False)

Bases: spinetoolbox.spine_db_editor.widgets.manage_items_dialogs.
GetObjectClassesMixin, AddItemsDialog

A dialog to query user’s preferences for new objects.
Parameters
e parent (SpineDBEditor) —
e parent_item (MultiDBTreeIltem) —
¢ db_mngr (SpineDBManager) —
» *db_maps — DiffDatabaseMapping instances
e force_default (bool) — if True, defaults are non-editable

accept(self)
Collect info from dialog and try to add items.

class spinetoolbox.spine_db_editor.widgets.add_items_dialogs.AddRelationshipClassesDialog(parent,
par-
ent_item,
db_mngr,
*db_maps,
force_default=Fa
Bases: spinetoolbox.spine_db_editor.widgets.manage_items_dialogs.
ShowIconColorEditorMixin, spinetoolbox.spine_db_editor.widgets.manage_items_dialogs.
GetObjectClassesMixin, AddItemsDialog

A dialog to query user’s preferences for new relationship classes.
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Parameters
e parent (SpineDBEditor) —
e parent_item (MultiDBTreeIltem) —
e db_mngr (SpineDBManager) —
» *db_maps - DiffDatabaseMapping instances
e force_default (bool) — if True, defaults are non-editable

connect_signals(self)
Connect signals to slots.

_handle_spin_box_value_changed(self, i)
insert_column(self)
remove_column (self)

_handle_model_data_changed(self, top_left, bottom_right, roles)
Reimplement in subclasses to handle changes in model data.

accept (self)
Collect info from dialog and try to add items.

class spinetoolbox.spine_db_editor.widgets.add_items_dialogs.AddOrManageRelationshipsDialog(parent,
db_mngr,
*db_maps)
Bases: spinetoolbox.spine_db_editor.widgets.manage_items_dialogs.
GetRelationshipClassesMixin, spinetoolbox.spine_db_editor.widgets.
manage_items_dialogs.GetObjectsMixin, AddItemsDialog

A dialog to query user’s preferences for new relationships.
Parameters
e parent (SpineDBEditor) —
e db_mngr (SpineDBManager) —
» *db_maps - DiffDatabaseMapping instances
abstract make_model (self)

connect_signals(self)
Connect signals to slots.

abstract reset_model (self, index)

Called when relationship_class’s combobox’s index changes. Update relationship_class attribute accord-
ingly and reset model.

class spinetoolbox.spine_db_editor.widgets.add_items_dialogs.AddRelationshipsDialog(parent,
par-
ent_item,
db_mngr,
*db_maps,
force_default=False)
Bases: AddOrManageRelationshipsDialog

A dialog to query user’s preferences for new relationships.
Parameters

» parent (SpineDBEditor) —
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e parent_item (MultiDBTreeltem) —

e db_mngr (SpineDBManager) —

» *db_maps — DiffDatabaseMapping instances

e force_default (bool) — if True, defaults are non-editable
make_model (self)

reset_model (self, index)
Setup model according to current relationship_class selected in combobox.

_handle_model_data_changed(self, top_left, bottom_right, roles)
Reimplement in subclasses to handle changes in model data.

accept(self)
Collect info from dialog and try to add items.

class spinetoolbox.spine_db_editor.widgets.add_items_dialogs.ManageRelationshipsDialog(parent,
par-
ent_item,
db_mngr,
*db_maps)
Bases: AddOrManageRelationshipsDialog

A dialog to query user’s preferences for managing relationships.
Parameters
* parent (SpineDBEditor) — data store widget
e parent_item (MultiDBTreeltem) —
e db_mngr (SpineDBManager) — the manager to do the removal
» *db_maps - DiffDatabaseMapping instances

» relationship_class_key (str, optional) — relationships class name, object_class
name list string.

make_model (self)
splitter_widgets(self)

connect_signals(self)
Connect signals to slots.

reset_relationship_class_combo_box (self, database, relationship_class_key=None)
add_relationships(self, checked=True)

reset_model (self, index)
Setup model according to current relationship_class selected in combobox.

resize_window_to_columns (self, height=None)

accept (self)
Collect info from dialog and try to add items.

class spinetoolbox.spine_db_editor.widgets.add_items_dialogs.ObjectGroupDialogBase (parent,
ob-
Ject_class_item,
db_mngr,
*db_maps)
Bases: PySide2.QtWidgets.QDialog
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Parameters
» parent (SpineDBEditor) — data store widget
e object_class_item (ObjectClassItem)—
e db_mngr (SpineDBManager) —
» *db_maps — database mappings

connect_signals(self)
Connect signals to slots.

reset_list_widgets(self, database)
abstract initial_member_ids(self)
abstract initial_entity_id(self)
add_members (self, checked=False)
remove_members (self, checked=False)
_check_validity(self)

class spinetoolbox.spine_db_editor.widgets.add_items_dialogs.AddObjectGroupDialog(parent,
ob-
Ject_class_item,
db_mngr,
*db_maps)
Bases: ObjectGroupDialogBase

Parameters

* parent (SpineDBEditor) — data store widget
e object_class_item (ObjectClassItem)—
e db_mngr (SpineDBManager) —
» *db_maps — database mappings

initial_member_ids(self)

initial_entity_id(self)

check_validity(self)

accept(self)
class spinetoolbox.spine_db_editor.widgets.add_items_dialogs.ManageMembersDialog(parent, ob-
Ject_item,
db_mngr,
*db_maps)

Bases: ObjectGroupDialogBase
Parameters
* parent (SpineDBEditor) — data store widget
e object_item (entity_tree_item.ObjectItem)—
e db_mngr (SpineDBManager) —
» *db_maps — database mappings

_entity_groups(self)
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initial_member_ids(self)
initial_entity_id(self)

accept (self)

spinetoolbox.spine_db_editor.widgets.commit_viewer

Contains the CommitViewer class.
author
M. Marin (KTH)
date 26.11.2018

Module Contents

Classes

_DBCommitViewer

_CommitItem

_CommitContents

CommitViewer

param

gsettings

class spinetoolbox.spine_db_editor.widgets

Bases: PySide2.QtWidgets.QWidget
_select_commit (self, current, previous)

class spinetoolbox.spine_db_editor.widgets
Bases: PySide2.QtWidgets.QWidget

class spinetoolbox.spine_db_editor.widgets
Bases: PySide2.QtWidgets.QTreelWidget

moveEvent (self, ev)
sizeHint (self)

class spinetoolbox.spine_db_editor.widgets

Bases: PySide2.QtWidgets.QMainWindow
Parameters
» gsettings (QSettings) —

e db_mngr (SpineDBManager) —

.commit_viewer

.commit_viewer

.commit_viewer

.commit_viewer

» db_maps (DiffDatabaseMapping) —

._DBCommi tViewer (db_mngr, db_map,

parent=None)

. _CommitItem(commit, parent=None)

._CommitContents (items, parent=None)

.Commi tViewer (gsettings, db_mngr,
*db_maps,
parent=None)
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_carry_splitter_state(self, index)

closeEvent (self, ev)

spinetoolbox.spine_db_editor.widgets.custom_delegates

Custom item delegates.
author
M. Marin (KTH)
date 1.9.2018

Module Contents

Classes

RelationshipPivotTableDelegate

A delegate that places a fully functioning QCheckBox.

ScenarioAlternativeTableDelegate

A delegate that places a QCheckBox but draws a number

instead of the check.

ParameterPivotTableDelegate

param parent

ParameterValueElementDelegate

Delegate for Array and Map editors' table cells.

ParameterDelegate

Base class for all custom parameter delegates.

DatabaseNameDelegate

A delegate for the database name.

ParameterValueOrDefaultValueDelegate

A delegate for the either the value or the default value.

ParameterDefaultValueDelegate

A delegate for the default value.

ParameterValueDelegate

A delegate for the parameter_value.

ValueListDelegate

A delegate for the parameter value list.

ObjectClassNameDelegate

A delegate for the object_class name.

RelationshipClassNameDelegate

A delegate for the relationship_class name.

ParameterNameDelegate

A delegate for the object parameter name.

ObjectNameDelegate

A delegate for the object name.

AlternativeNameDelegate

A delegate for the object name.

ObjectNameListDelegate

A delegate for the object name list.

ToolFeatureDelegate

A delegate for the tool feature tree.

AlternativeScenarioDelegate

A delegate for the alternative scenario tree.

ParameterValuelListDelegate

A delegate for the parameter value list tree.

ManageItemsDelegate A custom delegate for the model in
{ Add/Edit}ItemDialogs.
ManageEntityClassesDelegate A custom delegate for the model in
{ Add/Edit}ItemDialogs.
ManageObjectClassesDelegate A delegate for the model and view in
{ Add/Edit} ObjectClassesDialog.
ManageObjectsDelegate A delegate for the model and view in

{ Add/Edit}ObjectsDialog.

ManageRelationshipClassesDelegate

A delegate for the model and view
{ Add/Edit}RelationshipClassesDialog.

in

continues on next page

20.1. spinetoolbox

293



Spine Toolbox Documentation, Release 0.6.6.dev0-dev.0

Table 49 — continued from previous page

ManageRelationshipsDelegate A delegate for the model and view in
{ Add/Edit}RelationshipsDialog.

RemoveEntitiesDelegate A delegate for the model and view in RemoveEntities-
Dialog.

class spinetoolbox.spine_db_editor.widgets.custom_delegates.RelationshipPivotTableDelegate (parent)
Bases: spinetoolbox.widgets.custom_delegates.CheckBoxDelegate

A delegate that places a fully functioning QCheckBox.
Parameters parent (SpineDBEditor) —
data_committed

static _is_relationship_index(index)
Checks whether or not the given index corresponds to a relationship, in which case we need to use the check
box delegate.

Returns bool

setModelData (self, editor, model, index)
Send signal.

setEditorData(self, editor, index)
Do nothing. We’re setting editor data right away in createEditor.

paint (self, painter, option, index)
Paint a checkbox without the label.

editorEvent (self, event, model, option, index)
Change the data in the model and the state of the checkbox when user presses left mouse button and this
cell is editable. Otherwise do nothing.

createEditor (self, parent, option, index)
Important, otherwise an editor is created if the user clicks in this cell. ** Need to hook up a signal to the
model.

class spinetoolbox.spine_db_editor.widgets.custom_delegates.ScenarioAlternativeTableDelegate(parent)
Bases: spinetoolbox.widgets.custom_delegates.RankDelegate

A delegate that places a QCheckBox but draws a number instead of the check.
Parameters parent (SpineDBEditor) —
data_committed

static _is_scenario_alternative_index (index)
Checks whether or not the given index corresponds to a scenario alternative, in which case we need to use
the rank delegate.

Returns bool

setModelData (self, editor, model, index)
Send signal.

setEditorData(self, editor, index)
Do nothing. We’re setting editor data right away in createEditor.

paint (self, painter, option, index)
Paint a checkbox without the label.
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editorEvent (self, event, model, option, index)
Change the data in the model and the state of the checkbox when user presses left mouse button and this
cell is editable. Otherwise do nothing.

createEditor (self, parent, option, index)

Important, otherwise an editor is created if the user clicks in this cell. ** Need to hook up a signal to the
model.

class spinetoolbox.spine_db_editor.widgets.custom_delegates.ParameterPivotTableDelegate (parent)
Bases: PySide2.QtWidgets.QStyledItemDelegate

Parameters parent (SpineDBEditor) —
parameter_value_editor_requested
data_committed

setModelData (self, editor, model, index)
Send signal.

setEditorData(self, editor, index)
Do nothing. We’re setting editor data right away in createEditor.

createEditor (self, parent, option, index)

class spinetoolbox.spine_db_editor.widgets.custom_delegates.ParameterValueElementDelegate
Bases: PySide2.QtWidgets.QStyledItemDelegate

Delegate for Array and Map editors’ table cells.

value_editor_requested
Emitted when editing the value requires the full blown editor dialog.

setModelData (self, editor, model, index)
Sets data in the model.

editor (CustomLineEditor): editor widget model (QAbstractlitemModel): model index (QModellndex):
target index

createEditor (self, parent, option, index)
Creates an editor widget or emits value_editor_requested for complex values.

Parameters

* parent (QWidget) — parent widget

e option (QStyleOptionViewItem) — unused

¢ index (QModelIndex) — element’s model index
Returns editor widget
Return type ParameterValuelLineEditor

class spinetoolbox.spine_db_editor.widgets.custom_delegates.ParameterDelegate (parent,
db_mngr)
Bases: PySide2.QtWidgets.QStyledItemDelegate

Base class for all custom parameter delegates.

db_mngr
database manager

Type SpineDBManager

Parameters
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* parent (QWidget) — parent widget

¢ db_mngr (SpineDBManager) — database manager

data_committed

setModelData (self, editor, model, index)
Send signal.

setEditorData(self, editor, index)
Do nothing. We’re setting editor data right away in createEditor.

updateEditorGeometry (self, editor, option, index)

_close_editor (self, editor, index)
Closes editor. Needed by SearchBarEditor.

_get_db_map (self, index)
Returns the db_map for the database at given index or None if not set yet.

class spinetoolbox.spine_db_editor.widgets.custom_delegates.DatabaseNameDelegate (parent,
db_mngr)
Bases: ParameterDelegate

A delegate for the database name.
Parameters
* parent (QWidget) — parent widget
* db_mngr (SpineDBManager) — database manager

createEditor (self, parent, option, index)
Returns editor.

class spinetoolbox.spine_db_editor.widgets.custom_delegates.ParameterValueOrDefaultValueDelegate (parent,

db_mng
Bases: ParameterDelegate
A delegate for the either the value or the default value.
Parameters
* parent (QWidget) — parent widget
* db_mngr (SpineDBManager) — database manager
parameter_value_editor_requested
setModelData (self, editor, model, index)
Send signal.
_Create_or_request_parameter_value_editor (self, parent, option, index, db_map)
Emits the signal to request a standalone ParameterValueEditor from parent widget.
createEditor (self, parent, option, index)
If the parameter has associated a value list, returns a SearchBarEditor. Otherwise returns or requests a
dedicated parameter_value editor.
class spinetoolbox.spine_db_editor.widgets.custom_delegates.ParameterDefaultValueDelegate (parent,
db_mngr)

Bases: ParameterValueOrDefaultValueDelegate
A delegate for the default value.

Parameters
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* parent (QWidget) — parent widget
¢ db_mngr (SpineDBManager) — database manager

_get_value_list_id(self, index, db_map)
Returns a value list item for the given index and db_map.

class spinetoolbox.spine_db_editor.widgets.custom_delegates.ParameterValueDelegate (parent,
db_mngr)
Bases: ParameterValueOrDefaultValueDelegate

A delegate for the parameter_value.
Parameters
* parent (QWidget) — parent widget
e db_mngr (SpineDBManager) — database manager

—_get_value_list_id(self, index, db_map)
Returns a value list item for the given index and db_map.

class spinetoolbox.spine_db_editor.widgets.custom_delegates.ValueListDelegate (parent,
db_mngr)
Bases: ParameterDelegate

A delegate for the parameter value list.
Parameters
* parent (QWidget) — parent widget
* db_mngr (SpineDBManager) — database manager

createEditor (self, parent, option, index)
Returns editor.

class spinetoolbox.spine_db_editor.widgets.custom_delegates.ObjectClassNameDelegate (parent,
db_mngr)
Bases: ParameterDelegate

A delegate for the object_class name.
Parameters
* parent (QWidget) — parent widget
» db_mngr (SpineDBManager) — database manager

createEditor (self, parent, option, index)
Returns editor.

class spinetoolbox.spine_db_editor.widgets.custom_delegates.RelationshipClassNameDelegate (parent,
db_mngr)
Bases: ParameterDelegate

A delegate for the relationship_class name.
Parameters
* parent (QWidget) — parent widget
e db_mngr (SpineDBManager) — database manager

createEditor (self, parent, option, index)
Returns editor.
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class spinetoolbox.spine_db_editor.widgets.custom_delegates.ParameterNameDelegate (parent,
db_mngr)
Bases: ParameterDelegate

A delegate for the object parameter name.
Parameters
* parent (QWidget) — parent widget
* db_mngr (SpineDBManager) — database manager

createEditor (self, parent, option, index)
Returns editor.

class spinetoolbox.spine_db_editor.widgets.custom_delegates.ObjectNameDelegate (parent,
db_mngr)
Bases: ParameterDelegate

A delegate for the object name.
Parameters
* parent (QWidget) — parent widget
* db_mngr (SpineDBManager) — database manager

createEditor (self, parent, option, index)
Returns editor.

class spinetoolbox.spine_db_editor.widgets.custom_delegates.AlternativeNameDelegate (parent,
db_mngr)
Bases: ParameterDelegate

A delegate for the object name.
Parameters
* parent (QWidget) — parent widget
» db_mngr (SpineDBManager) — database manager

createEditor (self, parent, option, index)
Returns editor.

class spinetoolbox.spine_db_editor.widgets.custom_delegates.ObjectNameListDelegate (parent,
db_mngr)
Bases: ParameterDelegate

A delegate for the object name list.
Parameters
* parent (QWidget) — parent widget
¢ db_mngr (SpineDBManager) — database manager
object_name_list_editor_requested

createEditor (self, parent, option, index)
Returns editor.

class spinetoolbox.spine_db_editor.widgets.custom_delegates.ToolFeatureDelegate(*args,
**kwargs)
Bases: PySide2.QtWidgets.QStyledItemDelegate

A delegate for the tool feature tree.
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data_committed
_get_names (self, item, model)
static _get_index_data(item, index)

setModelData(self, editor, model, index)
Send signal.

setEditorData(self, editor, index)
Do nothing. We’re setting editor data right away in createEditor.

createEditor (self, parent, option, index)
Returns editor.

updateEditorGeometry (self, editor, option, index)

_close_editor (self, editor, index)
Closes editor. Needed by SearchBarEditor.

class spinetoolbox.spine_db_editor.widgets.custom_delegates.AlternativeScenarioDelegate (*args,

**kwargs)
Bases: PySide2.QtWidgets.QStyledItemDelegate

A delegate for the alternative scenario tree.
data_committed

setModelData (self, editor, model, index)
Send signal.

setEditorData(self, editor, index)
Do nothing. We'’re setting editor data right away in createEditor.

_get_names (self, item, model)
static _get_index_data(item, index)

createEditor (self, parent, option, index)
Returns editor.

updateEditorGeometry (self, editor, option, index)

_close_editor (self, editor, index)
Closes editor. Needed by SearchBarEditor.

class spinetoolbox.spine_db_editor.widgets.custom_delegates.ParameterValueListDelegate
Bases: PySide2.QtWidgets.QStyledItemDelegate

A delegate for the parameter value list tree.
data_committed
parameter_value_editor_requested

setModelData (self, editor, model, index)
Send signal.

setEditorData(self, editor, index)
Do nothing. We’re setting editor data right away in createEditor.

createEditor (self, parent, option, index)
Returns editor.

_close_editor (self, editor, index)
Closes editor.
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class spinetoolbox.spine_db_editor.widgets.custom_delegates.ManageItemsDelegate
Bases: PySide2.QtWidgets.QStyledItemDelegate

A custom delegate for the model in { Add/Edit}ItemDialogs.
data_committed

setModelData (self, editor, model, index)
Send signal.

close_editor (self, editor, index, model)
updateEditorGeometry (self, editor, option, index)

connect_editor_signals(self, editor, index)
Connect editor signals if necessary.

_create_database_editor (self, parent, option, index)

createEditor (self, parent, option, index)
Returns an editor.

class spinetoolbox.spine_db_editor.widgets.custom_delegates.ManageEntityClassesDelegate
Bases: ManageItemsDelegate

A custom delegate for the model in { Add/Edit}ItemDialogs.

paint (self, painter, option, index)
Get a pixmap from the index data and paint it in the middle of the cell.

class spinetoolbox.spine_db_editor.widgets.custom_delegates.ManageObjectClassesDelegate
Bases: ManageEntityClassesDelegate

A delegate for the model and view in { Add/Edit}ObjectClassesDialog.
icon_color_editor_requested

createEditor (self, parent, option, index)
Return editor.

class spinetoolbox.spine_db_editor.widgets.custom_delegates.ManageObjectsDelegate
Bases: ManageItemsDelegate

A delegate for the model and view in { Add/Edit}ObjectsDialog.

createEditor (self, parent, option, index)
Return editor.

class
spinetoolbox.spine_db_editor.widgets.custom_delegates.ManageRelationshipClassesDelegate
Bases: ManageEntityClassesDelegate

A delegate for the model and view in { Add/Edit}RelationshipClassesDialog.
icon_color_editor_requested

createEditor (self, parent, option, index)
Return editor.

class spinetoolbox.spine_db_editor.widgets.custom_delegates.ManageRelationshipsDelegate
Bases: ManageItemsDelegate

A delegate for the model and view in { Add/Edit}RelationshipsDialog.

createEditor (self, parent, option, index)
Return editor.
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class spinetoolbox.spine_db_editor.widgets.custom_delegates.RemoveEntitiesDelegate
Bases: ManageItemsDelegate

A delegate for the model and view in RemoveEntitiesDialog.

createEditor (self, parent, option, index)
Return editor.

spinetoolbox.spine_db_editor.widgets.custom_menus

Classes for custom context menus and pop-up menus.
author
M. Marin (KTH)
date 13.5.2020

Module Contents

Classes
MainMenu
ParameterViewFilterMenu Filter menu.
TabularViewFilterMenu Filter menu to use together with FilterWidget in Tabu-

larViewMixin.

class spinetoolbox.spine_db_editor.widgets.custom_menus.MainMenu
Bases: PySide2.QtWidgets.QMenu

event (self, ev)
Intercepts shortcurts and instead sends an equivalent event with the ‘Alt” modifier, so that mnemonics works
with just the key. Also sends a key press event with the ‘Alt” key when this menu shows, so that mnemonics
are underligned on windows.

class spinetoolbox.spine_db_editor.widgets.custom_menus.ParameterViewFilterMenu(parent,
source_model,
field,
show_empty=True)
Bases: spinetoolbox.widgets.custom_menus.FilterMenuBase

Filter menu.
Parameters
* parent (SpineDBEditor) —
» source_model (CompoundParameterModel) — a model to lazily get data from
o field (str) — the field name
filterChanged

_handle_source_model_refreshed(self)
Updates the menu to only present values that are actually shown in the source model.

set_filter_accepted_values(self, accepted_values)

20.1. spinetoolbox 301



Spine Toolbox Documentation, Release 0.6.6.dev0-dev.0

set_filter_rejected_values(self, rejected_values)
_get_value_to_remove (self, action, db_map, db_item)
_get_value_to_add(self, action, db_map, db_item)

modify_menu_data(self, action, db_map, db_items)
Modifies data in the menu.

Parameters
e action (str) — either ‘add’, ‘remove’, or ‘update’
e db_map (DiffDatabaseMapping) —
e db_items (1ist(dict))—

_build_auto_filter (self, valid_values)
Builds the auto filter given valid values.

Parameters valid_values (Sequence) — Values accepted by the filter.
Returns mapping db_map, to entity_class_id, to set of accepted parameter_value/definition ids
Return type dict

emit_filter_changed(self, valid_values)
Builds auto filter and emits signal.

Parameters valid_values (Sequence) — Values accepted by the filter.

class spinetoolbox.spine_db_editor.widgets.custom_menus.TabularViewFilterMenu(parent,
identifier,
data_to_value,
show_empty=True)
Bases: spinetoolbox.widgets.custom_menus.FilterMenuBase

Filter menu to use together with FilterWidget in TabularViewMixin.
Parameters
* parent (SpineDBEditor) —
e identifier (int) - index identifier
» data_to_value (method) — a method to translate item data to a value for display role
filterChanged
emit_filter_changed(self, valid_values)

event (self, event)

spinetoolbox.spine_db_editor.widgets.custom_ggraphicsviews

Classes for custom QGraphicsViews for the Entity graph view.
authors
P. Savolainen (VTT), M. Marin (KTH)
date 6.2.2018
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Module Contents

Classes

EntityQGraphicsView QGraphicsView for the Entity Graph View.

class spinetoolbox.spine_db_editor.widgets.custom_qgraphicsviews.EntityQGraphicsView(parent)
Bases: spinetoolbox.widgets.custom_qgraphicsviews.CustomQGraphicsView

QGraphicsView for the Entity Graph View.

Parameters parent (QWidget) — Graph View Form’s (QMainWindow) central widget
(self.centralwidget)

graph_selection_changed
property _gsettings(self)
property db_mngr (self)
property entity_items(self)

handle_scene_selection_changed(self)
Filters parameters by selected objects in the graph.

connect_spine_db_editor (self, spine_db_editor)
populate_context_menu(self)
increase_arc_length(self)
decrease_arc_length(self)

_update_actions_visibility(self)
Enables or disables actions according to current selection in the graph.

make_items_menu(self)
set_auto_expand_objects(self, checked=False)
add_objects_at_position(self, checked=False)

edit_selected(self, _=False)
Edits selected items.

remove_selected(self, _=False)
Removes selected items.

_get_selected_entity_names(self)

hide_selected_items (self, checked=False)
Hides selected items.

_hide_class(self, action)
Hides some class.

show_all_hidden_items (self, checked=False)
Shows all hidden items.

show_hidden_items (self, action)
Shows some hidden items.

prune_selected_items (self, checked=False)
Prunes selected items.
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_brune_class(self, action)
Prunnes some class.

restore_all_pruned_items (self, checked=False)
Reinstates all pruned items.

restore_pruned_items (self, action)
Reinstates some pruned items.

select_position_parameters(self, checked=False)
_set_position_parameters(self, parameter_pos_x, parameter_pos_y)
save_positions(self, checked=False)

clear_saved_positions(self, checked=False)

export_as_pdf (self, checked=False)

_populate_add_heat_map_menu(self)
Populates the menu ‘Add heat map’ with parameters for currently shown items in the graph.

add_heat_map (self, action)
Adds heat map for the parameter in the action text.

_clean_up_heat_map_items (self)

set_cross_hairs_items (self, relationship_class, cross_hairs_items)
Sets ‘cross_hairs’ items for relationship creation.

Parameters
e relationship_class (dict) —
e cross_hairs_items (1ist (QGraphicsItems)) —
clear_cross_hairs_items(self)
_cross_hairs_has_valid_target (self)

mousePressEvent (self, event)
Handles relationship creation if one it’s in process.

mouseMoveEvent (self, event)
Updates the hovered object item if we’re in relationship creation mode.

_update_cross_hairs_pos(self, pos)
Updates the hovered object item and sets the ‘cross_hairs’ icon accordingly.

Parameters pos (QPoint) — the desired position in view coordinates

mouseReleaseEvent (self, event)
Reestablish scroll hand drag mode.

_scroll_scene_by (self, dx, dy)

keyPressEvent (self, event)
Aborts relationship creation if user presses ESC.

contextMenuEvent (self, ¢)
Shows context menu.

Parameters e (QContextMenuEvent) — Context menu event
_compute_max_zoom(self)

_use_smooth_zoom(self)
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—zoom(self, factor)
apply_zoom(self)

wheelEvent (self, event)

Zooms in/out. If user has pressed the shift key, rotates instead.

Parameters event (QWheelEvent) — Mouse wheel event

_handle_rotation_time_line_advanced(self, pos)
Performs rotation whenever the smooth rotation time line advances.

_rotate(self, angle)

rotate_clockwise(self)

Performs a rotate clockwise with fixed angle.

rotate_anticlockwise (self)

Performs a rotate anticlockwise with fixed angle.

spinetoolbox.spine_db_editor.widgets.custom_qgtableview

Custom QTableView classes that support copy-paste and the like.

author
M. Marin (KTH)
date 18.5.2018

Module Contents

Classes

ParameterTableView

Custom QTableView class with autofilter functionality.

ObjectParameterTableMixin

RelationshipParameterTableMixin

ParameterDefinitionTableView

Custom QTableView class with autofilter functionality.

ParameterValueTableView

Custom QTableView class with autofilter functionality.

ObjectParameterDefinitionTableView

A custom QTableView for the object parame-
ter_definition pane in Spine db editor.

RelationshipParameterDefinitionTableView

A custom QTableView for the relationship parame-
ter_definition pane in Spine db editor.

ObjectParameterValueTableView

A custom QTableView for the object parameter_value
pane in Spine db editor.

RelationshipParameterValueTableView

A custom QTableView for the relationship parame-
ter_value pane in Spine db editor.

PivotTableView

Custom QTableView class with pivot capabilities.

FrozenTableView
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Functions

_set_parameter_data(index, new_value) Updates (object or relationship) parameter_definition or
value with newly edited data.

spinetoolbox.spine_db_editor.widgets.custom_qtableview._set_parameter_data(index, new_value)
Updates (object or relationship) parameter_definition or value with newly edited data.

class spinetoolbox.spine_db_editor.widgets.custom_qtableview.ParameterTableView(parent)
Bases: spinetoolbox.widgets.custom_qtableview.AutoFilterCopyPasteTableView

Custom QTableView class with autofilter functionality.
Initialize the view.

property value_column_header (self)
Either “default value” or “value”. Used to identifiy the value column for advanced editting and plotting.

connect_spine_db_editor (self, spine_db_editor)
Connects a Spine db editor to work with this view.

Parameters spine_db_editor (SpineDBEditor) —

_make_delegate (self, column_name, delegate_class)
Creates a delegate for the given column and returns it.

Parameters

¢ column_name (str) —

¢ delegate_class (ParameterDelegate) —
Returns ParameterDelegate

create_delegates(self)
Creates delegates for this view

open_in_editor(self)
Opens the current index in a parameter_value editor using the connected Spine db editor.

plot (self, checked=False)
Plots current index.

plot_in_window(self, action)
Plots current index in the window given by action’s name.

populate_context_menu(self)
Creates a context menu for this view.

contextMenuEvent (self, event)
Shows context menu.

Parameters event (QContextMenuEvent) —

_selected_rows_per_column(self)
Computes selected rows per column.

Returns Mapping columns to selected rows in that column.
Return type dict
filter_by_selection(self, checked=Fulse)

filter_excluding_selection(self, checked=False)
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remove_selected(self)
Removes selected indexes.

class spinetoolbox.spine_db_editor.widgets.custom_qgtableview.ObjectParameterTableMixin

create_delegates(self)

class
spinetoolbox.spine_db_editor.widgets.custom_gtableview.RelationshipParameterTableMixin

create_delegates(self)

class spinetoolbox.spine_db_editor.widgets.custom_gtableview.ParameterDefinitionTableView(parent)
Bases: ParameterTableView

Custom QTableView class with autofilter functionality.
Initialize the view.

property value_column_header (self)
Either “default value” or “value”. Used to identifiy the value column for advanced editting and plotting.

create_delegates(self)
Creates delegates for this view

class spinetoolbox.spine_db_editor.widgets.custom_qtableview.ParameterValueTableView(parent)
Bases: ParameterTableView

Custom QTableView class with autofilter functionality.
Initialize the view.

property value_column_header (self)
Either “default value” or “value”. Used to identifiy the value column for advanced editting and plotting.

create_delegates(self)
Creates delegates for this view

populate_context_menu(self)
Creates a context menu for this view.

show_value_metadata (self)

class spinetoolbox.spine_db_editor.widgets.custom_qtableview.ObjectParameterDefinitionTableView(parent)
Bases: ObjectParameterTableMixin, ParameterDefinitionTableView

A custom QTableView for the object parameter_definition pane in Spine db editor.
Initialize the view.

class spinetoolbox.spine_db_editor.widgets.custom_qgtableview.RelationshipParameterDefinitionTableView(p.
Bases: RelationshipParameterTableMixin, ParameterDefinitionTableView

A custom QTableView for the relationship parameter_definition pane in Spine db editor.
Initialize the view.

class spinetoolbox.spine_db_editor.widgets.custom_qtableview.ObjectParameterValueTableView(parent)
Bases: ObjectParameterTableMixin, ParameterValueTableView

A custom QTableView for the object parameter_value pane in Spine db editor.

Initialize the view.
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create_delegates(self)
Creates delegates for this view

class spinetoolbox.spine_db_editor.widgets.custom_gtableview.RelationshipParameterValueTableView(parent)
Bases: RelationshipParameterTableMixin, ParameterValueTableView

A custom QTableView for the relationship parameter_value pane in Spine db editor.
Initialize the view.

create_delegates(self)
Creates delegates for this view

class spinetoolbox.spine_db_editor.widgets.custom_gtableview.PivotTableView(parent=None)
Bases: spinetoolbox.widgets.custom_qtableview.CopyPasteTableView

Custom QTableView class with pivot capabilities.

Uses ‘contexts’ to provide different Ul elements (table headers, context menus,...) depending on what data the
pivot table currently contains.

Parameters parent (QWidget, optional) — parent widget

class _ContextBase (view, db_editor, horizontal_header, vertical_header)
Base class for pivot table view’s contexts.

Parameters

e view (PivotTableView) — parent view

¢ db_editor (SpineDBEditor) — database editor

e horizontal_header (QHeaderView) — horizontal header

e vertical_header (QHeaderView) — vertical header
_REMOVE_OBJECT = Remove objects
_REMOVE_RELATIONSHIP = Remove relationships
_REMOVE_PARAMETER = Remove parameter definitions
_REMOVE_ALTERNATIVE = Remove alternatives
_REMOVE_SCENARIO = Remove scenarios

_clear_selection_lists(self)
Clears cached selected index lists.

abstract populate_context_menu(self)
Generates context menu.

_refresh_selected_indexes(self)
Caches selected index lists.

remove_alternatives(self)
Removes selected alternatives from the database.

show_context_menu(self, position)
Shows the context menu.

_to_selection_lists(self, index, source_model)
Caches given index to corresponding selected index list.
Parameters
e index (QModelIndex) — index to cache
» source_model (PivotTableModelBase) — underlying model
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abstract _update_actions_availability(self)
Enables/disables context menu entries before the menu is shown.

class _EntityContextBase (view, db_editor, horizontal_header, vertical_header)
Bases: PivotTableView._ContextBase

Base class for contexts that contain entities and entity classes.
Parameters
e view (PivotTableView) — parent view
¢ db_editor (SpineDBEditor) — database editor
e horizontal_header (QHeaderView) — horizontal header
e vertical_header (QHeaderView) — vertical header

_can_remove_relationships(self)
Checks if it makes sense to remove selected relationships from the database.
Returns True if relationships can be removed, False otherwise
Return type bool

_clear_selection_lists(self)
See base class.

abstract populate_context_menu(self)
See base class.

remove_objects(self)
Removes selected objects from the database.

remove_relationships (self)
Removes selected relationships from the database.

abstract _update_actions_availability(self)
See base class.

class _ParameterValueContext (view, db_editor)
Bases: PivotTableView._EntityContextBase

Context for showing parameter values in the pivot table.
Parameters
e view (PivotTableView) — parent view
¢ db_editor (SpineDBEditor) — database editor

_clear_selection_lists(self)
See base class.

populate_context_menu(self)
See base class.

open_in_editor(self)
Opens the parameter value editor for the first selected cell.

plot(self)
Plots the selected cells.

_plot_in_window(self, action)
Plots the selected cells in an existing window.

remove_parameters(self)
Removes selected parameter definitions from the database.
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remove_values (self)
Removes selected parameter values from the database.

_show_context_menu(self, position)
See base class.

_to_selection_lists(self, index, source_model)
See base class.

_update_actions_availability(self)
See base class.

class _IndexExpansionContext (view, db_editor)
Bases: PivotTableView._ParameterValueContext

Context for expanded parameter values
Parameters
» view (PivotTableView) — parent view
¢ db_editor (SpineDBEditor) — database editor

class _RelationshipContext (view, db_editor)
Bases: PivotTableView._EntityContextBase

Context for presenting relationships in the pivot table.
Parameters
e view (PivotTableView) — parent view
¢ db_editor (SpineDBEditor) — database editor

populate_context_menu(self)
See base class.

_update_actions_availability(self)
See base class.

class _ScenarioAlternativeContext (view, db_editor)
Bases: PivotTableView._ContextBase

Context for presenting scenarios and alternatives
Parameters
e view (PivotTableView) — parent view
¢ db_editor (SpineDBEditor) — database editor

_clear_selection_lists(self)
See base class.

populate_context_menu(self)
See base class.

remove_scenarios (self)
Removes selected scenarios from the database.

_to_selection_lists(self, index, source_model)
See base class.

_update_actions_availability(self)
See base class.
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_open_scenario_generator (self)
Opens the scenario generator dialog.

_toggle_checked_state(self)
Toggles the checked state of selected alternatives.

header_changed

property source_model (self)

property db_mngr (self)
connect_spine_db_editor (self, spine_db_editor)

_change_context (self)
Changes the Ul engine according to pivot model type.

contextMenuEvent (self, event)
Shows context menu.

Parameters event (QContextMenuEvent) —
setModel (self, model)
_fetch_more_visible(self)

class spinetoolbox.spine_db_editor.widgets.custom_qtableview.FrozenTableView
Bases: PySide2.QtWidgets.QTableView

header_dropped

property area(self)
dragEnterEvent (self, event)
dragMoveEvent (self, event)
dropEvent (self, event)

spinetoolbox.spine_db_editor.widgets.custom_qtreeview

Classes for custom QTreeView.
author
M. Marin (KTH)
date 25.4.2018

Module Contents

Classes
EntityTreeView Tree view base class for object and relationship tree
views.
ObjectTreeView Custom QTreeView class for the object tree in
SpineDBEditor.
RelationshipTreeView Custom QTreeView class for the relationship tree in
SpineDBEditor.

continues on next page
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Table 54 — continued from previous page

ItemTreeView

Base class for all non-entity tree views.

ToolFeatureTreeView Custom QTreeView class for tools

SpineDBEditor.

and features in

AlternativeScenarioTreeView

in SpineDBEditor.

Custom QTreeView class for the alternative scenario tree

ParameterValueListTreeView

SpineDBEditor.

Custom QTreeView class for parameter_value_list in

class spinetoolbox.spine_db_editor.widgets.custom_qgtreeview.EntityTreeView(parent)

Bases: spinetoolbox.widgets.custom_qtreeview.CopyTreeView
Tree view base class for object and relationship tree views.

Initialize the view.

tree_selection_changed

connect_spine_db_editor (self, spine_db_editor)
Connects a Spine db editor to work with this view.

Parameters spine_db_editor (SpineDBEditor) —

_add_middle_actions(self)
Adds action at the middle of the context menu. Subclasses can reimplement at will.

_Create_context_menu(self)
Creates a context menu for this view.

edit (self, index, trigger, event)
Edit all selected items.

connect_signals(self)
Connects signals.

rowsInserted(self, parent, start, end)
rowsRemoved (self, parent, start, end)

setModel (self, model)
_fetch_more_visible(self)
verticalScrollbarValueChanged (self, value)

_handle_selection_changed(self, selected, deselected)
Classifies selection by item type and emits signal.

_refresh_selected_indexes(self)

clear_any_selections(self)
Clears the selection if any.

fully_expand(self)
Expands selected indexes and all their children.

fully_collapse(self)
Collapses selected indexes and all their children.

export_selected(self)
Exports data from selected indexes using the connected Spine db editor.

remove_selected(self)
Removes selected indexes using the connected Spine db editor.
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manage_relationships (self)

show_entity_metadata(self)
Shows entity’s metadata.

contextMenuEvent (self, event)
Shows context menu.

Parameters event (QContextMenuEvent) —

mousePressEvent (self, event)
Overrides selection behaviour if the user has selected sticky selection in Settings. If sticky selection is
enabled, multiple-selection is enabled when selecting items in the Object tree. Pressing the Ctrl-button
down, enables single selection.

Parameters event (QMouseEvent) —
_add_relationship_actions(self)

update_actions_availability(self)
Updates the visible property of actions according to whether or not they apply to given item.

edit_selected(self)
Edits all selected indexes using the connected Spine db editor.

class spinetoolbox.spine_db_editor.widgets.custom_qtreeview.ObjectTreeView(parent)
Bases: EntityTreeView

Custom QTreeView class for the object tree in SpineDBEditor.
Initialize the view.

update_actions_availability(self)
Updates the visible property of actions according to whether or not they apply to given item.

_add_middle_actions(self)
Adds action at the middle of the context menu. Subclasses can reimplement at will.

connect_signals(self)
Connects signals.

rowsInserted(self, parent, start, end)
add_object_classes(self)
add_objects(self)
add_relationship_classes(self)
add_relationships(self)

find_next_relationship(self)
Finds the next occurrence of the relationship at the current index and expands it.

_do_find_next_relationship (self)

duplicate_object (self)
Duplicates the object at the current index using the connected Spine db editor.

add_object_group (self)
manage_members (self)

class spinetoolbox.spine_db_editor.widgets.custom_gtreeview.RelationshipTreeView(parent)
Bases: EntityTreeView

Custom QTreeView class for the relationship tree in SpineDBEditor.
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Initialize the view.

_add_middle_actions(self)
Adds action at the middle of the context menu. Subclasses can reimplement at will.

update_actions_availability(self)
Updates the visible property of actions according to whether or not they apply to given item.

add_relationship_classes(self)
add_relationships(self)

class spinetoolbox.spine_db_editor.widgets.custom_qtreeview.ItemTreeView(parent)
Bases: spinetoolbox.widgets.custom_qtreeview.CopyTreeView

Base class for all non-entity tree views.
Initialize the view.

connect_signals(self)
Connects signals.

abstract remove_selected(self)
Removes items selected in the view.

abstract update_actions_availability(self, item)
Updates the visible property of actions according to whether or not they apply to given item.

connect_spine_db_editor (self, spine_db_editor)

populate_context_menu(self)
Creates a context menu for this view.

contextMenuEvent (self, event)
Shows context menu.

Parameters event (QContextMenuEvent) —

class spinetoolbox.spine_db_editor.widgets.custom_qtreeview.ToolFeatureTreeView(parent)
Bases: ItemTreeView

Custom QTreeView class for tools and features in SpineDBEditor.
Initialize the view.

connect_spine_db_editor (self, spine_db_editor)
see base class

remove_selected(self)
See base class.

update_actions_availability(self, item)
See base class.

dragMoveEvent (self, event)
dragEnterEvent (self, event)

class spinetoolbox.spine_db_editor.widgets.custom_qtreeview.AlternativeScenarioTreeView(parent)
Bases: ItemTreeView

Custom QTreeView class for the alternative scenario tree in SpineDBEditor.
Initialize the view.

alternative_selection_changed
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connect_signals(self)
Connects signals.

connect_spine_db_editor (self, spine_db_editor)
see base class

populate_context_menu(self)
See base class.

_db_map_alt_ids_from_selection(self, selection)
_db_map_scen_alt_ids_£from_selection(self, selection)

_handle_selection_changed (self, selected, deselected)
Emits alternative_selection_changed with the current selection.

remove_selected(self)
See base class.

update_actions_availability(self, item)
See base class.

dragMoveEvent (self, event)
dragEnterEvent (self, event)

_open_scenario_generator (self)
Opens the scenario generator dialog.

class spinetoolbox.spine_db_editor.widgets.custom_qtreeview.ParameterValueListTreeView(parent)
Bases: TtemTreeView

Custom QTreeView class for parameter_value_list in SpineDBEditor.
Initialize the view.

connect_spine_db_editor (self, spine_db_editor)
see base class

populate_context_menu(self)
Creates a context menu for this view.

update_actions_availability(self, item)
See base class.

open_in_editor (self)
Opens the parameter_value editor for the first selected cell.

remove_selected(self)
See base class.

spinetoolbox.spine_db_editor.widgets.custom_qwidgets

Custom QWidgets.
author
M. Marin (KTH)
date 13.5.2018
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Module Contents

Classes
DataToValueFilterWidget Filter widget class.
LazyFilterWidget Filter widget class.
OpenFileButton A button to open files or show them in the folder.
OpenSQLiteFileButton A button to open sqlite files, show them in the folder, or
add them to the project.
ShootingLabel

class spinetoolbox.spine_db_editor.widgets.custom_qwidgets.DataToValueFilterWidget (parent,

data_to_value,

show_empty=True)
Bases: spinetoolbox.widgets.custom_qwidgets.FilterWidgetBase

Filter widget class.
Init class.
Parameters
* parent (QWidget) —
» data_to_value (method) — a method to translate item data to a value for display role

class spinetoolbox.spine_db_editor.widgets.custom_qwidgets.LazyFilterWidget (parent,
source_model,

show_empty=True)
Bases: spinetoolbox.widgets.custom_qwidgets.FilteriWidgetBase

Filter widget class.
Init class.
Parameters
e parent (SpineDBEditor) —

* source_model (CompoundParameterlModel, optional) — a model to lazily get data
from

set_model (self)

class spinetoolbox.spine_db_editor.widgets.custom_qwidgets.OpenFileButton(file_path,

db_editor)
Bases: PySide2.QtWidgets.QToolButton

A button to open files or show them in the folder.
open_file(self, checked=False)
open_containing_folder (self, checked=False)

class spinetoolbox.spine_db_editor.widgets.custom_qwidgets.OpenSQLiteFileButton (file_path,

db_editor)
Bases: OpenFileButton

A button to open sqlite files, show them in the folder, or add them to the project.
open_f£file(self, checked=False)
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class spinetoolbox.spine_db_editor.widgets.custom_gwidgets.ShootingLabel (origin, destination,

parent=None,
duration=1200)
Bases: PySide2.QtWidgets.QLabel

_handle_value_changed (self, value)

show(self)

spinetoolbox.spine_db_editor.widgets.edit_or_remove_items_dialogs

Classes for custom QDialogs to edit items in databases.
author
M. Marin (KTH)
date 13.5.2018

Module Contents

Classes

EditOrRemoveItemsDialog A dialog with a CopyPasteTableView and a QDialogBut-
tonBox. Base class for all

EditObjectClassesDialog A dialog to query user's preferences for updating object
classes.

EditObjectsDialog A dialog to query user's preferences for updating objects.

EditRelationshipClassesDialog A dialog to query user's preferences for updating rela-
tionship classes.

EditRelationshipsDialog A dialog to query user's preferences for updating rela-
tionships.

RemoveEntitiesDialog A dialog to query user's preferences for removing tree
items.

class spinetoolbox.spine_db_editor.widgets.edit_or_remove_items_dialogs.EditOrRemoveItemsDialog(parent,

Bases: spinetoolbox.spine_db_editor.widgets.manage_items_dialogs.ManageItemsDialog

A dialog with a CopyPasteTableView and a QDialogButtonBox. Base class for all dialogs to query user’s pref-
erences for adding/editing/managing data items.

Init class.
Parameters
* parent (SpineDBEditor) — data store widget
e db_mngr (SpineDBManager) —

all_databases(self, row)
Returns a list of db names available for a given row. Used by delegates.
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class spinetoolbox.spine_db_editor.widgets.edit_or_remove_items_dialogs.EditObjectClassesDialog(parent,
db_mngr,
se-
lected)
Bases: spinetoolbox.spine_db_editor.widgets.manage_items_dialogs.
ShowIconColorEditorMixin, EditOrRemovelItemsDialog

A dialog to query user’s preferences for updating object classes.
Init class.
Parameters
* parent (SpineDBEditor) — data store widget
e db_mngr (SpineDBManager) — the manager to do the update
» selected (set) — set of ObjectClassltem instances to edit

connect_signals(self)
Connect signals to slots.

all_db_maps (self, row)
Returns a list of db maps available for a given row. Used by ShowIconColorEditorMixin.

accept (self)
Collect info from dialog and try to update items.

class spinetoolbox.spine_db_editor.widgets.edit_or_remove_items_dialogs.EditObjectsDialog(parent,
db_mngr,
se-
lected)
Bases: EditOrRemoveItemsDialog

A dialog to query user’s preferences for updating objects.
Init class.
Parameters
* parent (SpineDBEditor) — data store widget
e db_mngr (SpineDBManager) — the manager to do the update
» selected (set) — set of Objectltem instances to edit

accept(self)
Collect info from dialog and try to update items.

class spinetoolbox.spine_db_editor.widgets.edit_or_remove_items_dialogs.EditRelationshipClassesDialog(p
di
RY:
le
Bases: spinetoolbox.spine_db_editor.widgets.manage_items_dialogs.
ShowIconColorEditorMixin, EditOrRemoveltemsDialog

A dialog to query user’s preferences for updating relationship classes.
Init class.
Parameters
* parent (SpineDBEditor) — data store widget

* db_mngr (SpineDBManager) — the manager to do the update
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» selected (set) — set of RelationshipClassItem instances to edit

connect_signals(self)
Connect signals to slots.

accept (self)
Collect info from dialog and try to update items.

class spinetoolbox.spine_db_editor.widgets.edit_or_remove_items_dialogs.EditRelationshipsDialog(parent,

db_mngr,
se-
lected,
class_key
Bases: spinetoolbox.spine_db_editor.widgets.manage_items_dialogs.
GetRelationshipClassesMixin, spinetoolbox.spine_db_editor.widgets.

manage_items_dialogs.GetObjectsMixin, EditOrRemoveItemsDialog

A dialog to query user’s preferences for updating relationships.

Init class.
Parameters
* parent (SpineDBEditor) — data store widget
* db_mngr (SpineDBManager) — the manager to do the update
* selected (set) — set of RelationshipItem instances to edit
* class_key (tuple) — (class_name, object_class_name_list) for identifying the relation-
ship_class
accept(self)

Collect info from dialog and try to update items.

class spinetoolbox.spine_db_editor.widgets.edit_or_remove_items_dialogs.RemoveEntitiesDialog(parent,
db_mngr,
se-
lected)
Bases: EditOrRemoveItemsDialog

A dialog to query user’s preferences for removing tree items.
Init class.
Parameters
* parent (SpineDBEditor) — data store widget
* db_mngr (SpineDBManager) — the manager to do the removal
» selected (dict) — maps item type (class) to instances

accept (self)
Collect info from dialog and try to remove items.
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spinetoolbox.spine_db_editor.widgets.graph_layout_generator

Contains the GraphViewMixin class.
author
M. Marin (KTH)
date 26.11.2018

Module Contents

Classes

ProgressBarWidget

GraphLayoutGenerator Computes the layout for the Entity Graph View.

Functions

make_heat_map(x, y, values)

spinetoolbox.spine_db_editor.widgets.graph_layout_generator.make_heat_map (x, y, values)

class spinetoolbox.spine_db_editor.widgets.graph_layout_generator.ProgressBarWidget
Bases: PySide2.QtWidgets.QWidget

set_layout_generator (self, layout_generator)
paintEvent (self, event)

class spinetoolbox.spine_db_editor.widgets.graph_layout_generator.GraphLayoutGenerator (identifier,
ver-
tex_count,
src_inds=(),
dst_inds=(),
spread=0,
heavy_positions=Nor
it-

er-
a-

tions=12,
weight_exp=-
2

Bases: PySide2.QtCore.QRunnable
Computes the layout for the Entity Graph View.

class Signals
Bases: PySide2.QtCore.Q0Object

finished
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layout_available

progressed

msg
stop (self, _checked=False)
set_show_previews (self, checked)
emit_layout_available(self, x, y)
emit_finished(self)

shortest_path_matrix(self)
Returns the shortest-path matrix.

sets(self)
Returns sets of vertex pairs indices.

run(self)
Computes and returns x and y coordinates for each vertex in the graph, using VSGD-MS.

spinetoolbox.spine_db_editor.widgets.graph_view_mixin

Contains the GraphViewMixin class.
author
M. Marin (KTH)
date 26.11.2018

Module Contents

Classes

GraphViewMixin Provides the graph view for the DS form.

class spinetoolbox.spine_db_editor.widgets.graph_view_mixin.GraphViewMixin(*args, **kwargs)
Provides the graph view for the DS form.

VERTEX_EXTENT = 64

_ARC_WIDTH

_ARC_LENGTH_HINT
_stop_extending_graph (self, _=False)
init_models (self)

connect_signals(self)
Connects signals.

receive_objects_added(self, db_map_data)
Runs when objects are added to the db. Adds the new objects to the graph if needed.

Parameters db_map_data (dict) - list of dictionary-items keyed by DiffDatabaseMapping in-
stance.
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receive_relationships_added(self, db_map_data)
Runs when relationships are added to the db. Adds the new relationships to the graph if needed.

Parameters db_map_data (dict) — list of dictionary-items keyed by DiffDatabaseMapping in-
stance.

receive_object_classes_updated(self, db_map_data)
receive_relationship_classes_updated(self, db_map_data)

receive_objects_updated(self, db_map_data)
Runs when objects are updated in the db. Refreshes names of objects in graph.

Parameters db_map_data (dict) - list of dictionary-items keyed by DiftDatabaseMapping in-
stance.

receive_objects_removed(self, db_map_data)
Runs when objects are removed from the db. Rebuilds graph if needed.

Parameters db_map_data (dict) - list of dictionary-items keyed by DiffDatabaseMapping in-
stance.

receive_relationships_updated(self, db_map_data)
Runs when relationships are updated in the db.

Parameters db_map_data (dict) — list of dictionary-items keyed by DiffDatabaseMapping in-
stance.

receive_relationships_removed(self, db_map_data)
Runs when relationships are removed from the db. Rebuilds graph if needed.

Parameters db_map_data (dict) — list of dictionary-items keyed by DiffDatabaseMapping in-
stance.

restore_removed_entities(self, added_ids)
Restores any entities that have been previously removed and returns their ids. This happens in the context
of undo/redo.

Parameters added_ids (set (int)) — Set of newly added ids.
Returns set(int)

hide_removed_entities(self, db_map_data)
Hides removed entities while saving them into a list attribute. This allows entities to be restored in case the
user undoes the operation.

refresh_icons (self, db_map_data)
Runs when entity classes are updated in the db. Refreshes icons of entities in graph.

Parameters db_map_data (dict) — list of dictionary-items keyed by DiffDatabaseMapping in-
stance.

_handle_entity_graph_visibility_changed(self, visible)

rebuild_graph (self, selected=None)
Stores the given selection of entity tree indexes and builds graph.

build_graph(self, persistent=False)
Builds the graph.

Parameters persistent (bool, optional) - If True, elements in the current graph (if any)
retain their position in the new one.

_stop_layout_generators (self)
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_complete_graph (self, layout_gen_id, x, y)

Parameters
e layout_gen_id (object) —
¢ x (1ist)— Horizontal coordinates
e y (1ist) — Vertical coordinates

_get_selected_entity_ids(self)
Returns a set of ids corresponding to selected entities in the trees.

Returns selected object ids set: selected relationship ids
Return type set
_get_all_relationships_for_graph (self, object_ids, relationship_ids)

_update_graph_data(self)
Updates data for graph according to selection in trees.

_update_src_dst_inds (self, object_id_lists)
_get_parameter_positions(self, parameter_name)

_make_layout_generator (self)
Returns a layout generator for the current graph.

Returns GraphLayoutGenerator

_make_new_items (self, x, y)
Returns new items for the graph.

Parameters
e x(list) -
e y(list) -
_add_new_items (self)

start_relationship (self, relationship_class, obj_item)
Starts a relationship from the given object item.

Parameters
e relationship_class (dict) —
e obj_item (.graphics_items.ObjectItem)—

finalize_relationship (self, relationship_class, *object_items)
Tries to add relationships between the given object items.

Parameters

e relationship_class (dict) —

e object_items (.graphics_items.ObjectItem)—
_begin_add_relationships(self)
_end_add_relationships(self)
add_objects_at_position(self, pos)
get_pdf_file_path(self)
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closeEvent (self, event)
Handle close window.

Parameters event (QCloseEvent) — Closing event

spinetoolbox.spine_db_editor.widgets.manage_items_dialogs

Classes for custom QDialogs to add edit and remove database items.
author
M. Marin (KTH)
date 13.5.2018

Module Contents

Classes

ManageItemsDialogBase Init class.

ManageItemsDialog A dialog with a CopyPasteTableView and a QDialogBut-
tonBox. Base class for all

GetObjectClassesMixin Provides a method to retrieve object classes for AddOb-
jectsDialog and AddRelationshipClassesDialog.

GetObjectsMixin Provides a method to retrieve objects for AddRelation-
shipsDialog and EditRelationshipsDialog.

GetRelationshipClassesMixin Provides a method to retrieve relationship classes for Ad-
dRelationshipsDialog and EditRelationshipsDialog.

ShowIconColorEditorMixin Provides methods to show an IconColorEditor upon re-
quest.

class spinetoolbox.spine_db_editor.widgets.manage_items_dialogs.ManageItemsDialogBase (parent,
db_mngr)
Bases: PySide2.QtWidgets.QDialog

Init class.
Parameters
* parent (SpineDBEditor) — data store widget
e db_mngr (SpineDBManager) —
make_table_view(self)

connect_signals(self)
Connect signals to slots.

resize_window_to_columns (self, height=None)

class spinetoolbox.spine_db_editor.widgets.manage_items_dialogs.ManageItemsDialog(parent,
db_mngr)
Bases: ManageItemsDialogBase

A dialog with a CopyPasteTableView and a QDialogButtonBox. Base class for all dialogs to query user’s pref-
erences for adding/editing/managing data items.
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Init class.
Parameters
* parent (SpineDBEditor) — data store widget
e db_mngr (SpineDBManager) —

connect_signals(self)
Connect signals to slots.

_handle_model_data_changed(self, top_left, bottom_right, roles)
Reimplement in subclasses to handle changes in model data.

set_model_data(self, index, data)
Update model data.

_handle_model_reset (self)
Resize columns and form.

class spinetoolbox.spine_db_editor.widgets.manage_items_dialogs.GetObjectClassesMixin
Provides a method to retrieve object classes for AddObjectsDialog and AddRelationshipClassesDialog.

make_db_map_obj_cls_lookup (self)

object_class_name_list (self, row)
Return a list of object_class names present in all databases selected for given row. Used by ManageOb-
JectsDelegate.

class spinetoolbox.spine_db_editor.widgets.manage_items_dialogs.GetObjectsMixin
Provides a method to retrieve objects for AddRelationshipsDialog and EditRelationshipsDialog.

make_db_map_obj_lookup (self)

object_name_list (self, row, column)
Return a list of object names present in all databases selected for given row. Used by ManageRelation-
shipsDelegate.

class
spinetoolbox.spine_db_editor.widgets.manage_items_dialogs.GetRelationshipClassesMixin
Provides a method to retrieve relationship classes for AddRelationshipsDialog and EditRelationshipsDialog.

make_db_map_rel_cls_lookup (self)

class spinetoolbox.spine_db_editor.widgets.manage_items_dialogs.ShowIconColorEditorMixin
Provides methods to show an IconColorEditor upon request.

show_icon_color_editor (self, index)

spinetoolbox.spine_db_editor.widgets.mass_select_items_dialogs

Classes for custom QDialogs to add edit and remove database items.
author
M. Marin (KTH)
date 13.5.2018
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Module Contents

Classes
MassSelectItemsDialog A dialog to query a selection of dbs and items from the
user.
MassRemoveItemsDialog A dialog to query user's preferences for mass removing
db items.
MassExportItemsDialog A dialog to let users chose items for JSON export.
Functions

_batch_set_check_state(check_boxes, checked)

class spinetoolbox.spine_db_editor.widgets.mass_select_items_dialogs.MassSelectItemsDialog(parent,
db_mngr,
*db_maps)
Bases: PySide2.QtWidgets.QDialog

A dialog to query a selection of dbs and items from the user.
Initialize class.
Parameters
* parent (SpineDBEditor) —
e db_mngr (SpineDBManager) —
e db_maps (Di ffDatabaseMapping) — the dbs to select items from
_MARGIN = 3

_ITEM_TYPES = ['object_class', 'relationship_class', 'parameter_value_list',
'parameter_definition', 'object',...

_COLUMN_COUNT = 3
_add_check_boxes (self, group_box, check_boxes)
_handle_check_box_state_changed(self, _checked)

spinetoolbox.spine_db_editor.widgets.mass_select_items_dialogs._batch_set_check_state(check_boxes,
checked)

class spinetoolbox.spine_db_editor.widgets.mass_select_items_dialogs.MassRemoveItemsDialog(parent,
db_mngr,
*db_maps)
Bases: MassSelectItemsDialog

A dialog to query user’s preferences for mass removing db items.
Initialize class.
Parameters

e parent (SpineDBEditor) —
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e db_mngr (SpineDBManager) —

e db_maps (DiffDatabaseMapping) — the dbs to select items from

accept (self)
class spinetoolbox.spine_db_editor.widgets.mass_select_items_dialogs.MassExportItemsDialog(parent,
db_mngr,
*db_maps)

Bases: MassSelectItemsDialog
A dialog to let users chose items for JSON export.
Initialize class.
Parameters
e parent (SpineDBEditor) —
¢ db_mngr (SpineDBManager) —
e db_maps (Di ffDatabaseMapping) — the dbs to select items from
data_submitted

accept (self)

spinetoolbox.spine_db_editor.widgets.multi_spine_db_editor

Contains the MultiSpineDBEditor class.
author
M. Marin (KTH)
date 12.12.2020

Module Contents

Classes

MultiSpineDBEditor Database editor's tabbed main window.
_FileOpenToolBar

class spinetoolbox.spine_db_editor.widgets.multi_spine_db_editor.MultiSpineDBEditor (db_mngr,
db_url_codenames=Non
Bases: spinetoolbox.widgets.multi_tab_window.MultiTabWindow

Database editor’s tabbed main window.
Parameters
e db_mngr (SpineDBManager) — database manager
* db_url_codenames (dict, optional)— mapping from database URL to its codename

_make_other (self)
Creates a new MultiTabWindow of this type.

Returns new MultiTabWindow
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Return type MultiTabWindow

others(self)
List of other MultiTabWindows of the same type.

Returns other MutliTabWindows windows
Return type list of MultiTabWindow

_connect_tab_signals(self, tab)
Connects signals from a tab contents widget.

Parameters tab (QWidget) — tab contents widget
Returns True if signals were connected successfully, False otherwise
Return type bool

_disconnect_tab_signals(self, index)
Disconnects signals from given tab.

Parameters index (int) — tab index
Returns True if signals were disconnected successfully, False otherwise
Return type bool

_make_new_tab (self, db_url_codenames=None)
Creates a new tab.

Parameters
» *args — positional arguments neede to make a new tab
o **kwargs — keyword arguments needed to make a new tab

show_plus_button_context_menu(self, global_pos)
Opens a context menu for the tool bar.

Parameters global_pos (QPoint) — menu position on screen

make_context_menu(self, index)
Creates a context menu for given tab.

Parameters index (int) — tab index
Returns context menu or None if tab was not found
Return type QMenu

_insert_statusbar_button(self, button)
Inserts given button to the ‘beginning’ of the status bar and decorates it with a shooting label.

Parameters button (OpenFileButton)—
insert_sqlite_file_open_button(self, file_path)
insert_file_open_button(self, file_path)

_open_sqlite_url (self, url, codename)
Opens sqlite url.

show_user_guide (self, checked=False)
Opens Spine db editor documentation page in browser.

class spinetoolbox.spine_db_editor.widgets.multi_spine_db_editor._FileOpenToolBar (parent=None)
Bases: PySide2.QtWidgets.QToolBar
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preppend_widget (self, widget)

remove_widget (self, widget)

spinetoolbox.spine_db_editor.widgets.object_name_list_editor

Contains the ObjectNameListEditor class.
author
M. Marin (KTH)
date 27.11.2019

Module Contents

Classes
SearchBarDelegate A custom delegate to use with ObjectNameListEditor.
ObjectNamelListEditor A dialog to select the object name list for a relationship

using Google-like search bars.

class spinetoolbox.spine_db_editor.widgets.object_name_list_editor.SearchBarDelegate
Bases: PySide2.QtWidgets.QItemDelegate

A custom delegate to use with ObjectNameListEditor.
data_committed

setModelData (self, editor, model, index)
createEditor (self, parent, option, index)
updateEditorGeometry (self, editor, option, index)
close_editor (self, editor, index, model)

eventFilter (self, editor, event)

class spinetoolbox.spine_db_editor.widgets.object_name_list_editor.ObjectNameListEditor (parent,

in-
dex,

ob-

Ject_class_names,

ob-

Jject_names_lists,

cur-

rent_object_names)

Bases: spinetoolbox.spine_db_editor.widgets.manage_items_dialogs.ManageItemsDialog
A dialog to select the object name list for a relationship using Google-like search bars.
Initializes widget.
Parameters
* parent (SpineDBEditor) —
» index (QModelIndex) —
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» object_class_names (1ist) — string object_class names
* object_names_lists (1ist) - lists of string object names
e current_object_names (1ist)—
init_model (self, object_class_names, object_names_lists, current_object_names)

accept(self)

spinetoolbox.spine_db_editor.widgets.parameter_view_mixin

Contains the ParameterViewMixin class.
author
M. Marin (KTH)
date 26.11.2018

Module Contents

Classes

ParameterViewMixin Provides stacked parameter tables for the Spine db edi-
tor.

class spinetoolbox.spine_db_editor.widgets.parameter_view_mixin.ParameterViewMixin(*args,
**kwargs)
Provides stacked parameter tables for the Spine db editor.

connect_signals(self)
Connects signals to slots.

init_models (self)
Initializes models.

show_object_name_list_editor (self, index, rel_cls_id, db_map)
Shows the object names list editor.

Parameters
¢ index (QModelIndex) —
e rel_cls_id (int) -
e db_map (DiffDatabaseMapping) —

_set_default_parameter_data(self, index=None)
Sets default rows for parameter models according to given index.

Parameters index (QModelIndex) — and index of the object or relationship tree
set_default_parameter_data(self, default_data)

reset_filters(self)
Resets filters.

_handle_graph_selection_changed(self, selected_items)
Resets filter according to graph selection.
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_handle_object_tree_selection_changed(self, selected_indexes)
Resets filter according to object tree selection.

_handle_relationship_tree_selection_changed(self, selected_indexes)
Resets filter according to relationship tree selection.

_handle_alternative_selection_changed(self, selected_db_map_alt_ids)
Resets filter according to selection in alternative tree view.

restore_ui (self)
Restores Ul state from previous session.

save_window_state(self)
Saves window state parameters (size, position, state) via QSettings.

receive_alternatives_updated(self, db_map_data)
receive_parameter_definitions_added(self, db_map_data)
receive_parameter_values_added(self, db_map_data)
receive_parameter_definitions_updated(self, db_map_data)
receive_parameter_values_updated(self, db_map_data)
receive_object_classes_removed(self, db_map_data)
receive_relationship_classes_removed(self, db_map_data)
receive_parameter_definitions_removed(self, db_map_data)

receive_parameter_values_removed (self, db_map_data)

spinetoolbox.spine_db_editor.widgets.pivot_table_header_view

Contains custom QHeaderView for the pivot table.
author
M. Marin (KTH)
date 2.12.2019

Module Contents

Classes
PivotTableHeaderView Header view for the pivot table.
ParameterValuePivotHeaderView Header view for the pivot table in parameter value and
index expansion mode.
ScenarioAlternativePivotHeaderView Header view for the pivot table in parameter value and

index expansion mode.

class spinetoolbox.spine_db_editor.widgets.pivot_table_header_view.PivotTableHeaderView (orientation,

Bases: PySide2.QtWidgets.QHeaderView

Header view for the pivot table.

area,
pivot_table_view)
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Parameters

e orientation (int) — Qt.Horizontal or Qt.Vertical
* area (str)— which pivot area the header represents: “columns”, “rows” or “frozen”
» pivot_table_view (PivotTableView) — parent view

header_dropped

property area(self)

dragEnterEvent (self, event)

dragMoveEvent (self, event)

dropEvent (self, event)

class spinetoolbox.spine_db_editor.widgets.pivot_table_header_view.ParameterValuePivotHeaderView(orientat
area,
pivot_ta
Bases: PivotTableHeaderView

Header view for the pivot table in parameter value and index expansion mode.
Parameters
e orientation (int) — Qt.Horizontal or Qt.Vertical
* area (str) — which pivot area the header represents: “columns”, “rows” or “frozen”
* pivot_table_view (PivotTableView) — parent view

—add_column_to_plot(self, action)
Adds a single column to existing plot window.

_plot_column(self)
Plots a single column not the selection.

_set_x_flag(self)
Sets the X flag for a column.

contextMenuEvent (self, event)
Shows context menu.

Parameters event (QContextMenuEvent) —

class spinetoolbox.spine_db_editor.widgets.pivot_table_header_view.ScenarioAlternativePivotHeaderView (o
ai

D
Bases: PivotTableHeaderView

Header view for the pivot table in parameter value and index expansion mode.
Parameters
e orientation (int) — Qt.Horizontal or Qt.Vertical
* area (str)— which pivot area the header represents: “columns”, “rows” or “frozen”

» pivot_table_view (PivotTableView) — parent view

context_menu_requested
Requests a header context menu be shown at given global position.

contextMenuEvent (self, event)
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spinetoolbox.spine_db_editor.widgets.scenario_generator

Contains a dialog for generating scenarios from selected alternatives.
authors A.Soininen (VTT)
date 7.9.2021

Module Contents

Classes
_ScenarioNameResolution Generic enumeration.
ScenarioGenerator A dialog where users can generate scenarios from given

alternatives.

class spinetoolbox.spine_db_editor.widgets.scenario_generator._ScenarioNameResolution
Bases: enum. Enum

Generic enumeration.

Derive from this class to define new enumerations.
NO_CONFLICT

OVERWRITE

LEAVE_AS_IS

CANCEL_OPERATION

class spinetoolbox.spine_db_editor.widgets.scenario_generator.ScenarioGenerator (parent,
db_map,
alternatives,
spine_db_editor)
Bases: PySide2.QtWidgets.QWidget

A dialog where users can generate scenarios from given alternatives.
Parameters
* parent (QWidget) — parent widget
» db_map (DiffDatabaseMapping) — database mapping that contains the alternatives

e alternatives (Iterable of CacheItem) — alternatives from which the scenarios are
generated

e spine_db_editor (SpineDBEditor) — database editor instance
_TYPE_LABELS = ['All combinations', 'Scenario for each alternative']

accept (self)
Generates scenarios and closes the dialog.

The operation may get cancelled by user if there are conflicts in scenario names.

_generate_scenarios (self, new_scenarios, scenarios_to_modify, scenario_alternatives)
Generates scenarios with all possible combinations of given alternatives.

Parameters
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e new_scenarios (Iterable of str)- names of new scenarios to create
e scenarios_to_modify (Iterable of str)- names of scenarios to modify
e scenario_alternatives (1ist of list) - alternative items for each scenario

_check_existing_scenarios(self, proposed_scenario_names, existing_scenario_names)
Checks if proposed scenarios exist, and if so, prompts users what to do.

Parameters
e proposed_scenario_names (Iterable of str) - proposed scenario names
* existing_scenario_names (set of str) - existing scenario names
Returns action to take

Return type _ScenarioNameResolution

spinetoolbox.spine_db_editor.widgets.select_position_parameters_dialog

Classes for custom QDialogs to add items to databases.
author
M. Marin (KTH)
date 13.5.2018

Module Contents

Classes

SelectPositionParametersDialog

ParameterNameDelegate A delegate for the database name.

class spinetoolbox.spine_db_editor.widgets.select_position_parameters_dialog.SelectPositionParametersDi

Bases: PySide2.QtWidgets.QDialog
selection_made

accept(self)
_parameter_position_x(self)
_barameter_position_y(self)

class spinetoolbox.spine_db_editor.widgets.select_position_parameters_dialog.ParameterNameDelegate (paren
db_m
*db_j

Bases: PySide2.QtWidgets.QStyledItemDelegate

A delegate for the database name.

setModelData (self, editor, model, index)
Send signal.
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setEditorData(self, editor, index)
Do nothing. We’re setting editor data right away in createEditor.

updateEditorGeometry (self, editor, option, index)

_close_editor (self, editor, index)
Closes editor. Needed by SearchBarEditor.

createEditor (self, parent, option, index)
Returns editor.

spinetoolbox.spine_db_editor.widgets.spine_db_editor

Contains the SpineDBEditor class.
author
M. Marin (KTH)
date 26.11.2018

Module Contents

Classes
SpineDBEditorBase Base class for SpineDBEditor (i.e. Spine database edi-
tor).
SpineDBEditor A widget to visualize Spine dbs.

class spinetoolbox.spine_db_editor.widgets.spine_db_editor.SpineDBEditorBase (db_mngr)
Bases: PySide2.QtWidgets.QMainWindow

Base class for SpineDBEditor (i.e. Spine database editor).
Initializes form.
Parameters db_mngr (SpineDBManager) — The manager to use
msg
link msg
msg_error
file_exported
sqlite_file_exported
property toolbox(self)
property settings_subgroup (self)
property db_names (self)
property first_db_map(self)
property db_url_codenames (self)
load_db_urls(self, db_url_codenames, create=False, update_history=True)

init_add_undo_redo_actions(self)
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load_previous_urls(self, _=False)
load_next_urls(self, _=False)
open_db_file(self, _=Fulse)
add_db_file(self, _=False)
create_db_file(self, _=False)

_make_docks_menu(self)
Returns a menu with all dock toggle/view actions. Called by self.add_main_menu().

Returns QMenu

add_main_menu(self)
Adds a menu with main actions to toolbar.

_browse_commits (self)

connect_signals(self)
Connects signals to slots.

update_undo_redo_actions (self, index)
_replace_undo_redo_actions (self, new_undo_action, new_redo_action)
_refresh_undo_redo_actions(self)

update_commit_enabled(self, _clean=False)

init_models (self)
Initializes models.

add_message (self, msg)
Pushes message to notification stack.

Parameters msg (str) — String to show in the notification

add_link_msg(self, msg, open_link=None)
Pushes link message to notification stack.

Parameters
e msg (str) — String to show in notification

e open_link (Callable, optional) — callback to invoke when notification’s link is
opened

refresh_copy_paste_actions(self)
Runs when menus are about to show. Enables or disables actions according to selection status.

copy (self, checked=False)
Copies data to clipboard.

paste(self, checked=False)
Pastes data from clipboard.

import_data(self, data)

import_£file(self, checked=False)
Import file. It supports SQLite, JSON, and Excel.

import_£from_json(self, file_path)
import_from_sqlite(self, file_path)

import_from_excel (self, file_path)
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show_mass_export_items_dialog(self, checked=False)
Shows dialog for user to select dbs and items for export.

export_session(self, checked=False)
Exports changes made in the current session as reported by DiffDatabaseMapping.

mass_export_items (self, db_map_item_types)

duplicate_object (self, object_item)
Duplicates the object at the given object tree model index.

Parameters index (QModelIndex) —

export_data(self, db_map_ids_for_export)
Exports data from given dictionary into a file.

Parameters db_map_ids_for_export — Dictionary mapping db maps to keyword arguments
for spinedb_api.export_data

static _parse_db_map_metadata(db_map_metadata)
show_db_map_entity_metadata(self, db_map_ids)
show_db_map_parameter_value_metadata(self, db_map_ids)
refresh_session(self, checked=False)

commit_session(self, checked=False)
Commits dirty database maps.

rollback_session(self, checked=False)
Rolls back dirty datbase maps.

receive_session_committed(self, db_maps, cookie)
receive_session_rolled_back(self, db_maps)
receive_session_refreshed(self, db_maps)
show_mass_remove_items_form(self, checked=False)

show_parameter_value_editor (self, index, plain=False)
Shows the parameter_value editor for the given index of given table view.

receive_error_msg(self, db_map_error_log)

log_changes (self, action, item_type, db_map_data)
Enables or disables actions and informs the user about what just happened.

receive_scenarios_added(self, db_map_data)
receive_alternatives_added(self, db_map_data)
receive_object_classes_added(self, db_map_data)
receive_objects_added(self, db_map_data)
receive_relationship_classes_added(self, db_map_data)
receive_relationships_added(self, db_map_data)
receive_entity_groups_added(self, db_map_data)
receive_parameter_definitions_added (self, db_map_data)
receive_parameter_values_added(self, db_map_data)

receive_parameter_value_lists_added(self, db_map_data)
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receive_features_added (self, db_map_data)
receive_tools_added(self, db_map_data)
receive_tool_features_added(self, db_map_data)
receive_tool_feature_methods_added(self, db_map_data)
receive_scenarios_updated(self, db_map_data)
receive_alternatives_updated(self, db_map_data)
receive_object_classes_updated(self, db_map_data)
receive_objects_updated(self, db_map_data)
receive_relationship_classes_updated(self, db_map_data)
receive_relationships_updated(self, db_map_data)
receive_parameter_definitions_updated(self, db_map_data)
receive_parameter_values_updated(self, db_map_data)
receive_parameter_value_lists_updated(self, db_map_data)
receive_features_updated(self, db_map_data)
receive_tools_updated(self, db_map_data)
receive_tool_features_updated(self, db_map_data)
receive_tool_feature_methods_updated(self, db_map_data)
receive_scenarios_removed(self, db_map_data)
receive_alternatives_removed(self, db_map_data)
receive_object_classes_removed(self, db_map_data)
receive_objects_removed(self, db_map_data)
receive_relationship_classes_removed(self, db_map_data)
receive_relationships_removed(self, db_map_data)
receive_entity_groups_removed(self, db_map_data)
receive_parameter_definitions_removed(self, db_map_data)
receive_parameter_values_removed (self, db_map_data)
receive_parameter_value_lists_removed(self, db_map_data)
receive_features_removed(self, db_map_data)
receive_tools_removed(self, db_map_data)
receive_tool_features_removed(self, db_map_data)
receive_tool_feature_methods_removed(self, db_map_data)

restore_ui (self)
Restore Ul state from previous session.

save_window_state(self)

Save window state parameters (size, position, state) via QSettings.

tear_down(self)
Performs clean up duties.
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Returns True if editor is ready to close, False otherwise
Return type bool

_prompt_to_commit_changes(self)
Prompts the user to commit or rollback changes to ‘dirty’ db maps.

Returns QMessageBox status code
Return type int

_get_commit_msg(self, db_names)
Prompts user for commit message.

Parameters db_names (Iterable of str)-— database names
Returns commit message
Return type str

_get_rollback_confirmation(self, db_names)
Prompts user for confirmation before rolling back the session.

Parameters db_names (Iterable of str)— database names
Returns True if user confirmed, False otherwise
Return type bool

closeEvent (self, event)
Handle close window.

Parameters event (QCloseEvent) — Closing event

scenario_items (self, db_map)
Gathers scenario items from alternative scenario tree for given database.

Parameters db_map (DiffDatabaseMapping) — database map
Returns scenario items
Return type list of CachedItem

class spinetoolbox.spine_db_editor.widgets.spine_db_editor.SpineDBEditor (db_mngr,
db_url_codenames=None)

Bases: spinetoolbox.spine_db_editor.widgets. tabular_view_mixin.TabularViewMixin,
spinetoolbox.spine_db_editor.widgets.graph_view_mixin.GraphViewMixin, spinetoolbox.
spine_db_editor.widgets.parameter_view_mixin.ParameterViewMixin, spinetoolbox.

spine_db_editor.widgets.tree_view_mixin.TreeViewMixin, SpineDBEditorBase
A widget to visualize Spine dbs.
Initializes everything.

Parameters db_mngr (SpineDBManager) — The manager to use

connect_signals(self)
Connects signals to slots.

_restart_timer_refresh_tab_order (self, _visible=False)
_refresh_tab_order (self)

tabify_and_raise(self, docks)
Tabifies docks in given list, then raises the first.

Parameters docks (1ist)—
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restore_dock_widgets (self)
Docks all floating and or hidden QDockWidgets back to the window.

begin_style_change (self)
Begins a style change operation.

end_style_change (self)
Ends a style change operation.

apply_stacked_style(self, checked=False)
Applies the stacked style, inspired in the former tree view.

apply_pivot_style(self, _action)
Applies the pivot style, inspired in the former tabular view.

apply_graph_style(self, checked=False)
Applies the graph style, inspired in the former graph view.

static _get_base_dir()

spinetoolbox.spine_db_editor.widgets.tabular_view_header_widget

Contains TabularViewHeaderWidget class.
authors
P. Vennstrom (VTT), M. Marin (KTH)
date 2.12.2019

Module Contents

Classes

TabularViewHeaderWidget A draggable QWidget.

class spinetoolbox.spine_db_editor.widgets.tabular_view_header_widget.TabularViewHeaderWidget (identifier,
area,
menu=None
par-
ent=None)
Bases: PySide2.QtWidgets.QFrame

A draggable QWidget.
Parameters
e identifier (str) -

EEINT3

e area (str) — either “rows”, “columns”, or “frozen”
* menu (FilterMenu, optional)—
» parent (QWidget, optional) — Parent widget
header_dropped

_H_MARGIN = 3
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_SPACING = 16
property identifier(self)
property area(self)

mousePressEvent (self, event)
Register drag start position

mouseMoveEvent (self, event)
Start dragging action if needed

mouseReleaseEvent (self, event)
Forget drag start position

dragEnterEvent (self, event)
dropEvent (self, event)

spinetoolbox.spine_db_editor.widgets.tabular_view_mixin

Contains TabularViewMixin class.
author
P. Vennstrom (VTT)
date 1.11.2018

Module Contents

Classes

TabularViewMixin Provides the pivot table and its frozen table for the
Database editor.

class spinetoolbox.spine_db_editor.widgets.tabular_view_mixin.TabularViewMixin(*args,
**kwargs)
Provides the pivot table and its frozen table for the Database editor.

_PARAMETER_VALUE = &Value
_INDEX_EXPANSION = &Index
_RELATIONSHIP = Re&lationship
_SCENARIO_ALTERNATIVE = &Scenario
_PARAMETER = parameter
_ALTERNATIVE = alternative
_INDEX = index
populate_pivot_action_group(self)

connect_signals(self)
Connects signals to slots.
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_connect_pivot_table_header_signals(self)
Connects signals of pivot table’s header views.

init_models (self)
Initializes models.

_set_model_data(self, index, value)

property current_object_class_id_list(self)
property current_object_class_name_list(self)
property current_object_class_ids(self)

static _is_class_index(index)
Returns whether or not the given tree index is a class index.

Parameters index (QModelIndex) — index from object or relationship tree

Returns bool
_handle_pivot_action_triggered(self, action)
_handle_pivot_table_visibility_changed(self, visible)
_handle_frozen_table_visibility_changed(self, visible)
_handle_object_tree_selection_changed(self, selected_indexes)
_handle_relationship_tree_selection_changed(self, selected_indexes)
_handle_entity_tree_current_changed(self, current_index)

_update_class_attributes(self, current_index)
Updates current class (type and id) and reloads pivot table for it.

static _get_current_class_item(current_index)

static _make_get_id(action)
Returns a function to compute the db_map-id tuple of an item.

_get_db_map_entities(self)
Returns a dict mapping db maps to a list of dict entity items in the current class.

Returns dict

load_empty_relationship_data(self, db_map_class_objects=None)
Returns a dict containing all possible relationships in the current class.

Parameters db_map_class_objects (dict)—
Returns Key is db_map-object_id tuple, value is None.
Return type dict

load_full_relationship_data(self, db_map_relationships=None, action="add")
Returns a dict of relationships in the current class.

Parameters db_map_relationships (dict) -
Returns Key is db_map-object id tuple, value is relationship id.
Return type dict

load_relationship_data(self)
Returns a dict that merges empty and full relationship data.

Returns Key is object id tuple, value is True if a relationship exists, False otherwise.
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Return type dict

load_scenario_alternative_data(self, db_map_scenarios=None, db_map_alternatives=None)
Returns a dict containing all scenario alternatives.

Returns Key is db_map-id tuple, value is None or rank.
Return type dict

_get_db_map_parameter_value_or_def_ids(self, item_type)
Returns a dict mapping db maps to a list of integer parameter (value or def) ids from the current class.

Parameters item_type (str) — either “parameter_value” or “parameter_definition”
Returns dict

_get_db_map_parameter_values_or_defs(self, item_type)
Returns a dict mapping db maps to list of dict parameter (value or def) items from the current class.

Parameters item_type (str) — either “parameter_value” or “parameter_definition”
Returns dict

load_empty_parameter_value_data(self, db_map_entities=None, db_map_parameter_ids=None,
db_map_alternative_ids=None)
Returns a dict containing all possible combinations of entities and parameters for the current class in all
db_maps.

Parameters

e db_map_entities (dict, optional) — if given, only load data for these db maps and
entities

e db_map_parameter_ids (dict, optional)-if given, only load data for these db maps
and parameter definitions

e db_map_alternative_ids (dict, optional) — if given, only load data for these db
maps and alternatives

Returns Key is a tuple object_id, ..., parameter_id, value is None.
Return type dict

load_full_parameter_value_data(self, db_map_parameter_values=None, action="add")
Returns a dict of parameter values for the current class.

Parameters
¢ db_map_parameter_values (1ist, optional)—
e action (str) —
Returns Key is a tuple object_id, ..., parameter_id, value is the parameter_value.
Return type dict
_indexes (self, value)

load_empty_expanded_parameter_value_data(self, db_map_entities=None,
db_map_parameter_ids=None,
db_map_alternative_ids=None)
Makes a dict of expanded parameter values for the current class.

Parameters

¢ db_map_parameter_values (1ist, optional)—
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e action (str)—
Returns mapping from unique value id tuple to value tuple
Return type dict

load_full_expanded_parameter_value_data(self, db_map_parameter_values=None,
Makes a dict of expanded parameter values for the current class.

Parameters
¢ db_map_parameter_values (1ist, optional)—
e action (str) -
Returns mapping from unique value id tuple to value tuple
Return type dict

load_parameter_value_data(self)
Returns a dict that merges empty and full parameter_value data.

Returns Key is a tuple object_id, ..., parameter_id, value is the parameter_value
specified.

Return type dict

load_expanded_parameter_value_data(self)

action="add")

or None if not

Returns all permutations of entities as well as parameter indexes and values for the current class.

Returns Key is a tuple object_id, ..., index, while value is None.
Return type dict

get_pivot_preferences(self)
Returns saved pivot preferences.

Returns pivot tuple, or None if no preference stored
Return type tuple, NoneType

do_reload_pivot_table(self)
Reloads pivot table.

_can_build_pivot_table(self)
clear_pivot_table(self)
wipe_out_filter_menus (self)

make_pivot_headers(self)
Turns top left indexes in the pivot table into TabularViewHeaderWidget.

_resize_pivot_header_columns (self)

make_frozen_headers(self)
Turns indexes in the first row of the frozen table into TabularViewHeaderWidget.

create_filter_menu(self, identifier)
Returns a filter menu for given given object_class identifier.

Parameters identifier (int) -
Returns TabularViewFilterMenu

create_header_widget (self, identifier, area, with_menu=True)
Returns a TabularViewHeaderWidget for given object_class identifier.
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Parameters

e identifier (str) -

e area (str)—

e with_menu (bool) —
Returns TabularViewHeaderWidget

static _get_insert_index(pivot_list, catcher, position)
Returns an index for inserting a new element in the given pivot list.

Returns int

handle_header_dropped (self, dropped, catcher, position="")
Updates pivots when a header is dropped.

Parameters
e dropped (TabularViewHeaderWidget) —

e catcher (TabularViewHeaderWidget, PivotTableHeaderView,
FrozenTableView) —

LEINT3

e position (str) — either “before”, “after”, or

135

get_frozen_value (self, index)
Returns the value in the frozen table corresponding to the given index.

Parameters index (QModelIndex) —
Returns tuple

change_frozen_value (self, current, previous)
Sets the frozen value from selection in frozen table.

change_filter (self, identifier, valid_values, has_filter)

reload_frozen_table(self)
Resets the frozen model according to new selection in entity trees.

find_frozen_values(self, frozen)
Returns a list of tuples containing unique values (object ids) for the frozen indexes (object_class ids).

Parameters frozen (tuple(int))— A tuple of currently frozen indexes
Returns list(tuple(list(int)))
static refresh_table_view(table_view)
update_filter_menus (self, action)
receive_objects_added_or_removed (self, db_map_data, action)
receive_relationships_added_or_removed(self, db_map_data, action)
receive_parameter_definitions_added_or_removed(self, db_map_data, action)
receive_alternatives_added_or_removed(self, db_map_data, action)
receive_parameter_values_added_or_removed (self, db_map_data, action)
receive_scenarios_added_or_removed (self, db_map_data, action)
receive_db_map_data_updated(self, db_map_data, get_class_id)

receive_classes_updated(self, db_map_data)

20.1. spinetoolbox 345



Spine Toolbox Documentation, Release 0.6.6.dev0-dev.0

receive_classes_removed(self, db_map_data)

receive_alternatives_added(self, db_map_data)
Reacts to alternatives added event.

receive_scenarios_added(self, db_map_data)
Reacts to scenarios added event.

receive_objects_added(self, db_map_data)
Reacts to objects added event.

receive_relationships_added(self, db_map_data)
Reacts to relationships added event.

receive_parameter_definitions_added (self, db_map_data)
Reacts to parameter definitions added event.

receive_parameter_values_added(self, db_map_data)
Reacts to parameter values added event.

receive_alternatives_updated(self, db_map_data)
Reacts to alternatives updated event.

receive_object_classes_updated(self, db_map_data)
Reacts to object classes updated event.

receive_relationship_classes_updated(self, db_map_data)
Reacts to relationship classes updated event.

receive_objects_updated(self, db_map_data)
Reacts to objects updated event.

receive_relationships_updated(self, db_map_data)
Reacts to relationships updated event.

receive_parameter_values_updated(self, db_map_data)
Reacts to parameter values added event.

receive_parameter_definitions_updated(self, db_map_data)
Reacts to parameter definitions updated event.

receive_scenarios_updated(self, db_map_data)

receive_alternatives_removed(self, db_map_data)
Reacts to alternatives removed event.

receive_scenarios_removed (self, db_map_data)
Reacts to scenarios removed event.

receive_object_classes_removed(self, db_map_data)
Reacts to object classes removed event.

receive_relationship_classes_removed(self, db_map_data)
Reacts to relationship classes remove event.

receive_objects_removed(self, db_map_data)
Reacts to objects removed event.

receive_relationships_removed(self, db_map_data)
Reacts to relationships removed event.

receive_parameter_definitions_removed(self, db_map_data)
Reacts to parameter definitions removed event.
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receive_parameter_values_removed (self, db_map_data)
Reacts to parameter values removed event.

receive_session_rolled_back(self, db_maps)
Reacts to session rolled back event.

spinetoolbox.spine_db_editor.widgets.tree_view_mixin

Contains the TreeViewMixin class.
author
M. Marin (KTH)
date 26.11.2018

Module Contents

Classes

TreeViewMixin Provides object and relationship trees for the Spine db
editor.

class spinetoolbox.spine_db_editor.widgets.tree_view_mixin.TreeViewMixin(*args, **kwargs)
Provides object and relationship trees for the Spine db editor.

_object_classes_added
_relationship_classes_added
_object_classes_fetched

_relationship_classes_fetched
Emitted from fetcher thread, connected to Slots in GUI thread.

connect_signals(self)
Connects signals to slots.

init_models (self)
Initializes models.

static _db_map_items (indexes)
Groups items from given tree indexes by db map.

Returns lists of dictionary items keyed by DiffDatabaseMapping
Return type dict

_db_map_ids(self, indexes)

_db_map_class_ids(self, indexes)

export_selected(self, selected_indexes)
Exports data from given indexes in the entity tree.

show_add_object_classes_form(self)
Shows dialog to add new object classes.

20.1. spinetoolbox 347



Spine Toolbox Documentation, Release 0.6.6.dev0-dev.0

show_add_objects_form(self, parent_item)
Shows dialog to add new objects.

show_add_object_group_form(self, object_class_item)
Shows dialog to add new object group.

show_manage_members_form(self, object_item)
Shows dialog to manage an object group.

show_add_relationship_classes_form(self, parent_item)
Shows dialog to add new relationship_class.

show_add_relationships_form(self, parent_item)
Shows dialog to add new relationships.

show_manage_relationships_form(self, parent_item)

edit_entity_tree_items(self, selected_indexes)
Starts editing given indexes.

show_edit_object_classes_form(self, items)
show_edit_objects_form(self, items)
show_edit_relationship_classes_form(self, items)

show_remove_alternative_tree_items_form(self)
Shows form to remove items from object treeview.

show_edit_relationships_form(self, items)

show_remove_entity_tree_items_form(self, selected_indexes)
Shows form to remove items from object treeview.

update_export_enabled(self)

log_changes (self, action, item_type, db_map_data)
Enables or disables actions and informs the user about what just happened.

receive_alternatives_added(self, db_map_data)
receive_scenarios_added(self, db_map_data)
receive_object_classes_added(self, db_map_data)
receive_objects_added(self, db_map_data)
receive_relationship_classes_added(self, db_map_data)
receive_relationships_added(self, db_map_data)
receive_entity_groups_added(self, db_map_data)
receive_parameter_value_lists_added(self, db_map_data)
receive_features_added (self, db_map_data)
receive_tools_added(self, db_map_data)
receive_tool_features_added(self, db_map_data)
receive_tool_feature_methods_added(self, db_map_data)
receive_alternatives_updated(self, db_map_data)
receive_scenarios_updated(self, db_map_data)

receive_object_classes_updated(self, db_map_data)
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receive_objects_updated(self, db_map_data)
receive_relationship_classes_updated(self, db_map_data)
receive_relationships_updated(self, db_map_data)
receive_parameter_value_lists_updated(self, db_map_data)
receive_features_updated(self, db_map_data)
receive_tools_updated(self, db_map_data)
receive_tool_features_updated(self, db_map_data)
receive_tool_feature_methods_updated(self, db_map_data)
receive_alternatives_removed(self, db_map_data)
receive_scenarios_removed (self, db_map_data)
receive_object_classes_removed(self, db_map_data)
receive_objects_removed(self, db_map_data)
receive_relationship_classes_removed(self, db_map_data)
receive_relationships_removed(self, db_map_data)
receive_entity_groups_removed(self, db_map_data)
receive_parameter_value_lists_removed(self, db_map_data)
receive_features_removed(self, db_map_data)
receive_tools_removed(self, db_map_data)
receive_tool_features_removed(self, db_map_data)
receive_tool_feature_methods_removed(self, db_map_data)

restore_ui (self)
Restores Ul state from previous session.

save_window_state(self)
Saves window state parameters (size, position, state) via QSettings.

spinetoolbox.spine_db_editor.widgets.url_toolbar

Contains the UrlToolBar class and helpers.
author
M. Marin (KTH)
date 13.5.2020
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Module Contents

Classes

UrlToolBar

class spinetoolbox.spine_db_editor.widgets.url_toolbar.UrlToolBar (db_editor)
Bases: PySide2.QtWidgets.QToolBar

property line_edit(self)
_add_open_project_url_menu(self)
_update_ds_url_menu_enabled(self)
_connect_project_item_model_signals(self, slot)
_disconnect_project_item_model_signals(self, slot)
_update_open_project_url_menu(self)

_open_ds_url (self, action)

add_main_menu(self, menu)
_update_history_actions_availability(self)

add_urls_to_history(self, db_urls)
Adds url to history.

Parameters db_urls (1ist of str)-

get_previous_urls(self)
Returns previous urls in history.

Returns list of str

get_next_urls(self)
Returns next urls in history.

Returns list of str
_handle_line_edit_return_pressed(self)

set_current_urls(self, urls)

Submodules
spinetoolbox.spine_db_editor.graphics_items

Classes for drawing graphics items on graph view’s QGraphicsScene.
authors
M. Marin (KTH), P. Savolainen (VTT)
date 4.4.2018
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Module Contents

Classes
EntityItem Base class for Objectltem and RelationshipItem.
RelationshipItem Represents a relationship in the Entity graph.
ObjectItem Represents an object in the Entity graph.
ArcItem Connects a Relationshipltem to an Objectltem.
CrossHairsItem Creates new relationships directly in the graph.

CrossHairsRelationshipItem

Represents the relationship that's being created using the
CrossHairsItem.

CrossHairsArcItem Connects a CrossHairsRelationshipltem with the
CrossHairsItem,
ObjectLabelItem Provides a label for Objectltem's.
Functions

make_figure_graphics_item(scene, z=0,

static=True)

Creates a FigureCanvas and adds it to the given scene.

spinetoolbox.spine_db_editor.graphics_items.make_figure_graphics_item(scene, z=0, static=True)
Creates a FigureCanvas and adds it to the given scene. Used for creating heatmaps and associated colorbars.

Parameters

* scene (QGraphicsScene) —

e z(int, optional) - z value. Defaults to 0.

e static (bool, optional) - if True (the default) the figure canvas is not movable

Returns the graphics item that represents the canvas Figure: the figure in the canvas

Return type QGraphicsProxyWidget

class spinetoolbox.spine_db_editor.graphics_items.EntityItem(spine_db_editor, x,y, extent,

Bases: PySide2.QtWidgets.QGraphicsRectItem

Base class for Objectltem and Relationshipltem.

Parameters

db_map_entity_id)

e spine_db_editor (SpineDBEditor) — ‘owner’

* X (float) — x-coordinate of central point

* y (float) — y-coordinate of central point

* extent (int) — Preferred extent

e db_map_entity_id (tuple) - db_map, entity id

abstract _make_tool_tip(self)
abstract default_parameter_data(self)

property entity_type(self)
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property entity_name (self)
property entity_class_type(self)
property entity_class_id(self)
property entity_class_name(self)
property db_map (self)

property entity_id(self)
property first_db_map(self)
property display_data(self)
property display_database(self)
property db_maps (self)
db_map_data(self, _db_map)
db_map_id(self, _db_map)
boundingRect (self)

moveBy (self, dx, dy)

_init_bg(self)

refresh_icon(self)
Refreshes the icon.

_set_renderer (self, renderer)

shape (self)

Returns a shape containing the entire bounding rect, to work better with icon transparency.

paint (self, painter, option, widget=None)
Shows or hides the selection halo.

_baint_as_selected(self)
_paint_as_deselected(self)

add_arc_item(self, arc_item)
Adds an item to the list of arcs.

Parameters arc_item (ArcItem)—

apply_zoom(self, factor)
Applies zoom.

Parameters factor (float) — The zoom factor.

apply_rotation(self, angle, center)
Applies rotation.

Parameters
* angle (float) — The angle in degrees.
* center (QPointF) — Rotates around this point.
block_move_by (self, dx, dy)

mouseMoveEvent (self, event)
Moves the item and all connected arcs.
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Parameters event (QGraphicsSceneMouseEvent) —

update_arcs_line(self)
Moves arc items.

itemChange (self, change, value)
Keeps track of item’s movements on the scene.

Parameters
 change (GraphicsItemChange) — a flag signalling the type of the change
* value - a value related to the change

Returns the same value given as input

setVisible(self, on)
Sets visibility status for this item and all arc items.

Parameters on (bool) —
_make_menu (self)

contextMenuEvent (self, ¢)
Shows context menu.

Parameters e (QGraphicsSceneMouseEvent)— Mouse event

class spinetoolbox.spine_db_editor.graphics_items.RelationshipItem(spine_db_editor, x,y, extent,
db_map_entity_id)
Bases: EntityItem

Represents a relationship in the Entity graph.
Initializes the item.
Parameters

e spine_db_editor (GraphViewForm) — ‘owner’
* x (float) — x-coordinate of central point
* y (float) — y-coordinate of central point
* extent (int) — preferred extent
e db_map_entity_id (tuple)— db_map, relationship id

default_parameter_data(self)
Return data to put as default in a parameter table when this item is selected.

property entity_type(self)

property object_class_id_list(self)
property object_name_list(self)
property object_id_list(self)
property entity_class_name(self)
property db_representation(self)
_make_tool_tip(self)

_init_bg(self)

follow_object_by(self, dx, dy)
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add_arc_item(self, arc_item)
Adds an item to the list of arcs.

Parameters arc_item (ArcItem)—

itemChange (self, change, value)
Rotates svg item if the relationship is 2D. This makes it possible to define e.g. an arow icon for relationships
that express direction.

_rotate_svg_item(self)

class spinetoolbox.spine_db_editor.graphics_items.ObjectItem(spine_db_editor, x, y, extent,
db_map_entity_id)
Bases: EntityItem

Represents an object in the Entity graph.
Initializes the item.
Parameters

e spine_db_editor (GraphViewForm) — ‘owner’
* X (float) — x-coordinate of central point
* y (float) — y-coordinate of central point
* extent (int) — preferred extent
e db_map_entity_id (tuple)— db_map, object id

default_parameter_data(self)
Return data to put as default in a parameter table when this item is selected.

property entity_type(self)
property db_representation(self)

shape (self)
Returns a shape containing the entire bounding rect, to work better with icon transparency.

update_name (self, name)
Refreshes the name.

_make_tool_tip(self)
block_move_by (self, dx, dy)
mouseDoubleClickEvent (self, ¢)
_make_menu (self)

_duplicate(self)
_refresh_relationship_classes(self)

_populate_expand_collapse_menu(self, menu)
Populates the ‘Expand’ or ‘Collapse’ menu.

Parameters menu (QMenu) —

_pbopulate_add_relationships_menu(self, menu)
Populates the ‘Add relationships’ menu.

Parameters menu (QMenu) —

_get_relationship_ids_to_expand_or_collapse (self, action)
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_expand (self, action)
_collapse(self, action)
_start_relationship(self, action)

class spinetoolbox.spine_db_editor.graphics_items.ArcItem(rel_item, obj_item, width)
Bases: PySide2.QtWidgets.QGraphicsPathItem

Connects a RelationshipItem to an Objectltem.
Initializes item.
Parameters

e rel_item (spinetoolbox.widgets.graph_view_graphics_items.
RelationshipItem) — relationship item

e obj_item (spinetoolbox.widgets.graph_view_graphics_items.ObjectItem) —
object item

e width (float) — Preferred line width
_make_pen(self)

moveBy (self, dx, dy)
Does nothing. This item is not moved the regular way, but follows the Entityltems it connects.

update_line(self)

mousePressEvent (self, event)
Accepts the event so it’s not propagated.

other_item(self, item)

apply_zoom(self, factor)
Applies zoom.

Parameters factor (float) - The zoom factor.

class spinetoolbox.spine_db_editor.graphics_items.CrossHairsItem(*args, **kwargs)
Bases: RelationshipItem

Creates new relationships directly in the graph.
Initializes the item.
Parameters
* spine_db_editor (GraphViewForm) — ‘owner’
* X (float) — x-coordinate of central point
* y (float) — y-coordinate of central point
* extent (int) — preferred extent
e db_map_entity_id (tuple)— db_map, relationship id
property entity_class_name(self)
property entity_name (self)
_make_tool_tip(self)

refresh_icon(self)
Refreshes the icon.

set_plus_icon(self)
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set_check_icon(self)
set_normal_icon(self)
set_ban_icon(self)

set_icon(self, unicode, color=0)
Refreshes the icon.

mouseMoveEvent (self, event)
Moves the item and all connected arcs.

Parameters event (QGraphicsSceneMouseEvent) —
block_move_by (self, dx, dy)

contextMenuEvent (self, ¢)
Shows context menu.

Parameters e (QGraphicsSceneMouseEvent)— Mouse event

class spinetoolbox.spine_db_editor.graphics_items.CrossHairsRelationshipItem(*args,
**kwargs)
Bases: RelationshipItem

Represents the relationship that’s being created using the CrossHairsItem.
Initializes the item.
Parameters

e spine_db_editor (GraphViewForm) — ‘owner’

* x (float) — x-coordinate of central point

* y (float) — y-coordinate of central point

* extent (int) — preferred extent

e db_map_entity_id (tuple)— db_map, relationship id
_make_tool_tip(self)

refresh_icon(self)
Refreshes the icon.

contextMenuEvent (self, e)
Shows context menu.

Parameters e (QGraphicsSceneMouseEvent)— Mouse event

class spinetoolbox.spine_db_editor.graphics_items.CrossHairsArcItem(rel_item, obj_item, width)
Bases: ArcItem

Connects a CrossHairsRelationshipItem with the CrossHairsItem, and with all the ObjectItem’s in the relation-
ship so far.

Initializes item.
Parameters

e rel_item (spinetoolbox.widgets.graph_view_graphics_items.
RelationshipItem) — relationship item

e obj_item (spinetoolbox.widgets.graph_view_graphics_items.ObjectItem) —
object item

e width (float) — Preferred line width
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_make_pen(self)

class spinetoolbox.spine_db_editor.graphics_items.ObjectLabelItem(entity_item)
Bases: PySide2.QtWidgets.QGraphicsTextItem

Provides a label for Objectltem’s.
Initializes item.

Parameters entity_item (spinetoolbox.widgets.graph_view_graphics_items.
EntityItem)— The parent item.

entity_name_edited

setPlainText (self, text)
Set texts and resets position.

Parameters text (str)—

reset_position(self)
Adapts item geometry so text is always centered.

spinetoolbox.spine_db_editor.main
Module Contents

Functions

main() Launches Spine Db Editor as it's own application.

spinetoolbox.spine_db_editor.main.main()
Launches Spine Db Editor as it’s own application.

Parameters argv (1ist) — Command line arguments

spinetoolbox.spine_db_editor.scenario_generation

Contains functions for automatically generating scenarios from a set of alternatives.
authors A.Soininen (VTT)
date 7.9.2021

Module Contents

Functions
all_combinations(alternatives) Creates all possible combinations of alternatives.
unique_alternatives(alternatives) Creates all possible single-alternative scenarios.

spinetoolbox.spine_db_editor.scenario_generation.all_combinations (alternatives)
Creates all possible combinations of alternatives.

Parameters alternatives (Iterable of Any) - alternatives
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Returns tuples containing alternatives for each scenario
Return type list of tuple

spinetoolbox.spine_db_editor.scenario_generation.unique_alternatives (alternatives)
Creates all possible single-alternative scenarios.

Parameters alternatives (Iterable of Any) — alternatives
Returns tuples containing alternatives for each scenario

Return type list of tuple

spinetoolbox.widgets

Init file for widgets package. Intentionally empty.
author
P. Savolainen (VTT)
date 3.1.2018

Submodules
spinetoolbox.widgets.about_widget

A widget for presenting basic information about the application.
author
P. Savolainen (VTT)
date 14.12.2017

Module Contents

Classes

AboutWidget About widget class.

class spinetoolbox.widgets.about_widget.AboutWidget (foolbox)
Bases: PySide2.QtWidgets.QWidget

About widget class.
Parameters toolbox (ToolboxUI) — QMainWindow instance

calc_pos(self)
Calculate the top-left corner position of this widget in relation to main window position and size in order
to show about window in the middle of the main window.

setup_license_text (self)
Add license to QTextBrowser.

keyPressEvent (self, ¢)
Close form when Escape, Enter, Return, or Space bar keys are pressed.
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Parameters e (QKeyEvent) — Received key press event.

closeEvent (self, event=None)
Handle close window.

Parameters event (QEvent) — Closing event if ‘X’ is clicked.

mousePressEvent (self, ¢)
Save mouse position at the start of dragging.

Parameters e (QMouseEvent) — Mouse event

mouseReleaseEvent (self, e)
Save mouse position at the end of dragging.

Parameters e (QMouseEvent) — Mouse event

mouseMoveEvent (self, e)
Moves the window when mouse button is pressed and mouse cursor is moved.

Parameters e (QMouseEvent) — Mouse event

spinetoolbox.widgets.add_project_item_widget

Widget shown to user when a new Project Item is created.
author
P. Savolainen (VTT)
date 19.1.2017

Module Contents

Classes

AddProjectItemiWidget A widget to query user's preferences for a new item.

class spinetoolbox.widgets.add_project_item_widget.AddProjectItemWidget (toolbox, x,y, class_,
spec="")
Bases: PySide2.QtWidgets.QWidget

A widget to query user’s preferences for a new item.

toolbox
Parent widget

Type ToolboxUI

X coordinate of new item

Type int

Y coordinate of new item

Type int

Initialize class.
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connect_signals(self)

Connect signals to slots.

handle_name_changed (self)
Update label to show upcoming folder name.

handle_ok_clicked(self)

Check that given item name is valid and add it to project.

abstract call_add_item(self)
Creates new Item according to user’s selections.

Must be reimplemented by subclasses.

keyPressEvent (self, ¢)

Close Setup form when escape key is pressed.

Parameters e (QKeyEvent) — Received key press event.

closeEvent (self, event=None)
Handle close window.

Parameters event (QEvent) — Closing event if ‘X’ is clicked.

spinetoolbox.widgets.add_up_spine_opt_wizard

Classes for custom QDialogs for julia setup.

author
M. Marin (KTH)
date 13.5.2018

Module Contents

Classes
_PageId Enum where members are also (and must be) ints
AddUpSpineOptWizard A wizard to install & upgrade SpineOpt.
IntroPage
SelectJuliaPage

CheckPreviousInstallPage

AddUpSpineOptPage A QWizards page with a log. Useful for pages that need
to capture the output of a process.

SuccessPage

FailurePage

TroubleshootProblemsPage

continues on next page
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Table 80 — continued from previous page

TroubleshootSolutionPage

ResetRegistryPage

A QWizards page with a log. Useful for pages that need
to capture the output of a process.

AddUpSpineOptAgainPage

A QWizards page with a log. Useful for pages that need
to capture the output of a process.

TotalFailurePage

Functions

_clear_layout(layout)

class spinetoolbox.widgets.add_up_spine_opt_wizard._PageId

Bases: enum.IntEnum

Enum where members are also (and must be) ints

Initialize self. See help(type(self)) for accurate signature.

INTRO
SELECT_JULIA

CHECK_PREVIOUS_INSTALL

ADD_UP_SPINE_OPT
SUCCESS
FAILURE

TROUBLESHOOT_PROBLEMS
TROUBLESHOOT_SOLUTION
RESET_REGISTRY
ADD_UP_SPINE_OPT_AGAIN
TOTAL_FAILURE

class spinetoolbox.widgets.add_up_spine_opt_wizard.AddUpSpineOptWizard (parent, julia_exe,

Julia_project)
Bases: PySide2.QtWidgets.QWizard

A wizard to install & upgrade SpineOpt.
Initialize class.

Parameters parent (QWidget) — the parent widget (SettingsWidget)

class spinetoolbox.widgets.add_up_spine_opt_wizard.IntroPage (parent)

Bases: PySide2.QtWidgets.QWizardPage
nextId(self)
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class spinetoolbox.widgets.add_up_spine_opt_wizard.SelectJuliaPage(parent, julia_exe,
Jjulia_project)
Bases: PySide2.QtWidgets.QWizardPage

initializePage(self)
_select_julia_exe(self)
_select_julia_project(self)
nextId(self)

class spinetoolbox.widgets.add_up_spine_opt_wizard.CheckPreviousInstallPage (parent)
Bases: PySide2.QtWidgets.QWizardPage

isComplete(self)

cleanupPage (self)

initializePage(self)
_handle_check_install_finished(self, ret)
nextId(self)

class spinetoolbox.widgets.add_up_spine_opt_wizard.AddUpSpineOptPage (parent)
Bases: spinetoolbox.widgets.custom_qgwidgets.QWizardProcessPage

A QWizards page with a log. Useful for pages that need to capture the output of a process.
initializePage(self)

_handle_spine_opt_add_up_finished(self, ret)

nextId(self)

class spinetoolbox.widgets.add_up_spine_opt_wizard.SuccessPage(parent)
Bases: PySide2.QtWidgets.QWizardPage

initializePage(self)
nextId(self)

class spinetoolbox.widgets.add_up_spine_opt_wizard.FailurePage(parent)
Bases: PySide2.QtWidgets.QWizardPage

_handle_check_box_clicked(self, checked=False)
initializePage(self)
nextId(self)

class spinetoolbox.widgets.add_up_spine_opt_wizard.TroubleshootProblemsPage (parent)
Bases: PySide2.QtWidgets.QWizardPage

isComplete(self)
_show_log(self, _=False)
nextId(self)

class spinetoolbox.widgets.add_up_spine_opt_wizard.TroubleshootSolutionPage (parent)
Bases: PySide2.QtWidgets.QWizardPage

cleanupPage (self)
initializePage(self)

_initialize_page_solutionl(self)
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_initialize_page_solution2 (self)
nextId(self)

class spinetoolbox.widgets.add_up_spine_opt_wizard.ResetRegistryPage (parent)
Bases: spinetoolbox.widgets.custom_qwidgets.QWizardProcessPage

A QWizards page with a log. Useful for pages that need to capture the output of a process.
initializePage(self)

_handle_registry_reset_finished(self, ret)

nextId(self)

class spinetoolbox.widgets.add_up_spine_opt_wizard.AddUpSpineOptAgainPage (parent)
Bases: AddUpSpineOptPage

A QWizards page with a log. Useful for pages that need to capture the output of a process.
nextId(self)

class spinetoolbox.widgets.add_up_spine_opt_wizard.TotalFailurePage (parent)
Bases: PySide2.QtWidgets.QWizardPage

nextId(self)

spinetoolbox.widgets.add_up_spine_opt_wizard._clear_layout (layout)

spinetoolbox.widgets.array_editor

Contains an editor widget for array type parameter values.
author
A. Soininen (VTT)
date 25.3.2020

Module Contents

Classes

ArrayEditor Editor widget for Arrays.

class spinetoolbox.widgets.array_editor.ArrayEditor (parent=None)
Bases: PySide2.QtWidgets.QWidget

Editor widget for Arrays.
Parameters parent (QWidget, optional) — parent widget

set_value(self, value)
Sets the parameter_value for editing in this widget.

Parameters value (Array) — value for editing

value(self)
Returns the array currently being edited.

Returns array
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Return type Array

_check_if_plotting_enabled(self, type_name)
Checks is array’s data type allows the array to be plotted.

Parameters type_name (str) — data type’s name
_change_value_type(self, type_name)

open_value_editor (self, index)
Opens an editor widget for array element.

Parameters index (QModelIndex) — element’s index

_show_table_context_menu(self, position)
Shows the table’s context menu.

Parameters position (QPoint)— menu’s position on the table

_update_plot (self, topLeft=None, bottomRight=None, roles=None)
Updates the plot widget.

_open_header_editor (self, column)

spinetoolbox.widgets.array_value_editor

An editor dialog for Array elements.
author
A. Soininen (VTT)
date 10.11.2020

Module Contents

Classes

ArrayValueEditor Editor widget for Array elements.

class spinetoolbox.widgets.array_value_editor.ArrayValueEditor (index, value_type, parent=None)
Bases: spinetoolbox.widgets.parameter_value_editor_base.ParameterValueEditorBase

Editor widget for Array elements.
Parameters
* index (QModelIndex) — an index to a parameter_value in parent_model
* parent (QWidget, optional) — a parent widget

_set_data(self, value)
See base class.
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spinetoolbox.widgets.code_text_edit

Provides simple text editor for programming purposes.
author
M. Marin (KTH)
date 28.1.2020

Module Contents

Classes
CodeTextEdit A plain text edit with syntax highlighting and line num-
bers.
LineNumberArea

class spinetoolbox.widgets.code_text_edit.CodeTextEdit (*arg, **kwargs)
Bases: PySide2.QtWidgets.QPlainTextEdit

A plain text edit with syntax highlighting and line numbers.
insertFromMimeData (self, source)

set_lexer_name (self, lexer_name)

setDocument (self, doc)

line_number_area_width(self)
_update_line_number_area_width(self, _new_block_count=0)
_update_line_number_area(self, rect, dy)

resizeEvent (self, event)

line_number_area_paint_event (self, ev)

class spinetoolbox.widgets.code_text_edit.LineNumberArea (editor)
Bases: PySide2.QtWidgets.QWidget

sizeHint (self)

paintEvent (self, ev)

spinetoolbox.widgets.commit_dialog

Classes for custom QDialogs to add edit and remove database items.
author
M. Marin (KTH)
date 13.5.2018
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Module Contents

Classes

CommitDialog A dialog to query user's preferences for new commit.

class spinetoolbox.widgets.commit_dialog.CommitDialog(parent, *db_names)
Bases: PySide2.QtWidgets.QDialog

A dialog to query user’s preferences for new commit.
Parameters
* parent (QWidget) — the parent widget
e db_names (Iterable of str)— database names

receive_text_changed(self)
Called when text changes in the commit msg text edit. Enable/disable commit button accordingly.

spinetoolbox.widgets.console_window

Window for the ‘base’ Julia Console and Python Console.
author
P. Savolainen (VTT)
date 5.2.2021

Module Contents

Classes

Consoleliindow Class for a separate window for the Python or Julia Con-
sole.

class spinetoolbox.widgets.console_window.ConsoleWindow (toolbox, spine_console, language)
Bases: PySide2.QtWidgets.QMainWindow

Class for a separate window for the Python or Julia Console.
Parameters
¢ toolbox (ToolboxUTI) — QMainWindow instance
e spine_console (JupyterConsoleWidget) — Qt Console
* language (str) — ‘python’ or ‘julia’

start (self)
Starts the kernel.

closeEvent (self, ¢)
Shuts down the running kernel and calls ToolboxUI method to destroy this window.

Parameters e (QCloseEvent)— Event
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spinetoolbox.widgets.custom_combobox

A widget for presenting basic information about the application.
author
P. Savolainen (VTT)
date 14.12.2017

Module Contents

Classes

ElidedCombobox Combobox with elided text.

OpenProjectDialogComboBox

class spinetoolbox.widgets.custom_combobox.ElidedCombobox
Bases: PySide2.QtWidgets.QComboBox

Combobox with elided text.

paintEvent (self, event)

class spinetoolbox.widgets.custom_combobox.OpenProjectDialogComboBox

Bases: PySide2.QtWidgets.QComboBox

keyPressEvent (self, ¢)

Interrupts Enter and Return key presses when QComboBox is in focus. This is needed to prevent showing

the ‘Not a valid Spine Toolbox project’ Notifier every time Enter is pressed.

Parameters e (QKeyEvent) — Received key press event.

spinetoolbox.widgets.custom_delegates

Custom item delegates.
author
M. Marin (KTH)
date 1.9.2018

Module Contents

Classes
ComboBoxDelegate
CheckBoxDelegate A delegate that places a fully functioning QCheckBox.
RankDelegate A delegate that places a QCheckBox but draws a number

instead of the check.
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class spinetoolbox.widgets.custom_delegates.ComboBoxDelegate (items)
Bases: PySide2.QtWidgets.QStyledItemDelegate

createEditor (self, parent, option, index)

paint (self, painter, option, index)
setEditorData(self, editor, index)
setModelData (self, editor, model, index)
updateEditorGeometry (self, editor, option, index)
_finalize_editing(self, editor)

class spinetoolbox.widgets.custom_delegates.CheckBoxDelegate (parent, centered=True)
Bases: PySide2.QtWidgets.QStyledItemDelegate

A delegate that places a fully functioning QCheckBox.
Parameters
e parent (QWiget) —
» centered (bool) — whether or not the checkbox should be center-aligned in the widget
data_committed

createEditor (self, parent, option, index)
Important, otherwise an editor is created if the user clicks in this cell. ** Need to hook up a signal to the
model.

paint (self, painter, option, index)
Paint a checkbox without the label.

static _do_paint (painter, checkbox_style_option, index)

editorEvent (self, event, model, option, index)
Change the data in the model and the state of the checkbox when user presses left mouse button and this
cell is editable. Otherwise do nothing.

setModelData (self, editor, model, index)
Do nothing. Model data is updated by handling the data_committed signal.

get_checkbox_rect (self, option)

class spinetoolbox.widgets.custom_delegates.RankDelegate (parent, centered=True)
Bases: CheckBoxDelegate

A delegate that places a QCheckBox but draws a number instead of the check.
Parameters
* parent (QWiget) —
» centered (bool) — whether or not the checkbox should be center-aligned in the widget

static _do_paint (painter, checkbox_style_option, index)
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spinetoolbox.widgets.custom_editors

Custom editors for model/view programming.
author
M. Marin (KTH)
date 2.9.2018

Module Contents

Classes

CustomlLineEditor A custom QLineEdit to handle data from models.

ParameterValuelineEditor A custom QLineEdit to handle data from models.

_CustomLineEditDelegate A delegate for placing a CustomLineEditor on the first
row of SearchBarEditor.

SearchBarEditor A Google-like search bar, implemented as a QTableView
with a _CustomLineEditDelegate in the first row.

CheckListEditor A check list editor.

_IconPainterDelegate A delegate to highlight decorations in a QListWidget.

IconColorEditor An editor to let the user select an icon and a color for an

object_class.

class spinetoolbox.widgets.custom_editors.CustomLineEditor
Bases: PySide2.QtWidgets.QLineEdit

A custom QLineEdit to handle data from models.

set_data(self, data)
Sets editor’s text.

Parameters data (Any) — anything convertible to string

data(self)
Returns editor’s text.

Returns editor’s text
Return type str

keyPressEvent (self, event)
Prevents shift key press to clear the contents.

class spinetoolbox.widgets.custom_editors.ParameterValueLineEditor
Bases: CustomLineEditor

A custom QLineEdit to handle data from models.

set_data(self, data)
Sets editor’s text.

Parameters data (Any) — anything convertible to string

data(self)
Returns editor’s text.

Returns editor’s text
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Return type str

class spinetoolbox.widgets.custom_editors._CustomLineEditDelegate

Bases: PySide2.QtWidgets.QStyledItemDelegate

A delegate for placing a CustomLineEditor on the first row of SearchBarEditor.
text_edited

setModelData (self, editor, model, index)

createEditor (self, parent, option, index)
Create editor and ‘forward’ textEdited signal.

eventFilter (self, editor, event)
Handle all sort of special cases.

class spinetoolbox.widgets.custom_editors.SearchBarEditor (parent, tutor=None)

Bases: PySide2.QtWidgets.QTableView
A Google-like search bar, implemented as a QTableView with a _CustomLineEditDelegate in the first row.
Initializes instance.
Parameters
* parent (QWidget) — parent widget
* tutor (QWidget, optional) - another widget used for positioning.
data_committed

set_data(self, current, items)
Populates model.

Parameters
e current (str) —item that is currently selected from given items
e items (Sequence(str)) — items to show in the list
set_base_size(self, size)
set_base_offset (self, offset)

update_geometry (self)
Updates geometry.

refit(self)
data(self)

_handle_delegate_text_edited(self, text)
Filters model as the first row is being edited.

_proxy_model_filter_accepts_row(self, source_row, source_parent)
Always accept first row.

keyPressEvent (self, event)
Sets data from current index into first index as the user navigates through the table using the up and down
keys.

currentChanged (self, current, previous)

edit_first_index(self)
Edits first index if valid and not already being edited.
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mouseMoveEvent (self, event)
Sets the current index to the one hovered by the mouse.

mousePressEvent (self, event)
Commits data.

class spinetoolbox.widgets.custom_editors.CheckListEditor (parent, tutor=None, ranked=False)
Bases: PySide2.QtWidgets.QTableView

A check list editor.
Initialize class.
_make_icon(self, i=None)

keyPressEvent (self, event)
Toggles checked state if the user presses space.

toggle_selected(self, index)
Adds or removes given index from selected items.

Parameters index (QModelIndex) — index to toggle
_select_item(self, gitem, rank)
_deselect_item(self, gitem, update_ranks=False)

mouseMoveEvent (self, event)
Sets the current index to the one under mouse.

mousePressEvent (self, event)
Toggles checked state of pressed index.

set_data(self, items, checked_items)
Sets data and updates geometry.

Parameters
e items (Sequence(str)) — All items.
» checked_items (Sequence (str)) — Initially checked items.

data(self)
Returns a comma separated list of checked items.

Returns str
set_base_size(self, size)

update_geometry (self)
Updates geometry.

class spinetoolbox.widgets.custom_editors._IconPainterDelegate
Bases: PySide2.QtWidgets.QStyledItemDelegate

A delegate to highlight decorations in a QListWidget.

paint (self, painter, option, index)
Paints selected items using the highlight brush.

class spinetoolbox.widgets.custom_editors.IconColorEditor (parent)
Bases: PySide2.QtWidgets.QDialog

An editor to let the user select an icon and a color for an object_class.

Init class.

20.1. spinetoolbox 371



Spine Toolbox Documentation, Release 0.6.6.dev0-dev.0

_proxy_model_filter_accepts_row(self, source_row, source_parent)
Filters icons according to search terms.

connect_signals(self)
Connects signals to slots.

set_data(self, data)
data(self)

spinetoolbox.widgets.custom_menus

Classes for custom context menus and pop-up menus.
author
P. Savolainen (VTT)
date 9.1.2018

Module Contents

Classes
CustomContextMenu Context menu master class for several context menus.
OpenProjectDialogComboBoxContextMenu Context menu master class for several context menus.
CustomPopupMenu Popup menu master class for several popup menus.
ItemSpecificationMenu Context menu class for item specifications.
RecentProjectsPopupMenu Recent projects menu embedded to 'File-Open recent'

QAction.

FilterMenuBase Filter menu.
SimpleFilterMenu Filter menu.

class spinetoolbox.widgets.custom_menus.CustomContextMenu(parent, position)
Bases: PySide2.QtWidgets.QMenu

Context menu master class for several context menus.
Parameters
* parent (QWidget) — Parent for menu widget (ToolboxUI)
e position (QPoint) — Position on screen

add_action(self, text, icon=Qlcon(), enabled=True)
Adds an action to the context menu.

Parameters
* text (str) — Text description of the action
e icon (QIcon) — Icon for menu item
¢ enabled (bool) — Is action enabled?

set_action(self, option)
Sets the action which was clicked.

Parameters option (str) — string with the text description of the action
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get_action(self)
Returns the clicked action, a string with a description.

class spinetoolbox.widgets.custom_menus.OpenProjectDialogComboBoxContextMenu(parent,

position)
Bases: CustomContextMenu

Context menu master class for several context menus.
Parameters
* parent (QWidget) — Parent for menu widget
e position (QPoint) — Position on screen

class spinetoolbox.widgets.custom_menus.CustomPopupMenu(parent)
Bases: PySide2.QtWidgets.QMenu

Popup menu master class for several popup menus.
Parameters parent (QWidget) — Parent widget of this pop-up menu

add_action(self, text, slot, enabled=True, tooltip=None)
Adds an action to the popup menu.

Parameters
* text (str)— Text description of the action
¢ slot (method) — Method to connect to action’s triggered signal
¢ enabled (bool) - Is action enabled?
e tooltip (str) — Tool tip for the action

class spinetoolbox.widgets.custom_menus.ItemSpecificationMenu(toolbox, index, item=None)
Bases: CustomPopupMenu

Context menu class for item specifications.
Parameters
* toolbox (ToolboxUT) — Toolbox that requests this menu, used as parent.
e index (QModelIndex) — the index
e item (ProjectItem, optional)— passed to show_specification_form

class spinetoolbox.widgets.custom_menus.RecentProjectsPopupMenu(parent)
Bases: CustomPopupMenu

Recent projects menu embedded to ‘File-Open recent’ QAction.

Parameters parent (QWidget) — Parent widget of this menu (ToolboxUT)

add_recent_projects(self)
Reads the previous project names and paths from QSettings. Adds them to the QMenu as QActions.

call_open_project (self, checked, p)
Slot for catching the user selected action from the recent projects menu.

Parameters
* checked (bool) — Argument sent by triggered signal
* p (str)—Full path to a project file
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class spinetoolbox.widgets.custom_menus.FilterMenuBase (parent)
Bases: PySide2.QtWidgets.QMenu

Filter menu.

Parameters parent (QWidget) — a parent widget
connect_signals(self)
set_filter_list (self, data)
add_items_to_filter_list(self, items)
remove_items_from_filter_list (self, items)
_clear_filter(self)
_check_filter(self)
_change_filter(self)
abstract emit_filter_changed(self, valid_values)
wipe_out (self)

class spinetoolbox.widgets.custom_menus.SimpleFilterMenu(parent, show_empty=True)
Bases: FilterMenuBase

Filter menu.
Parameters parent (SpineDBEditor) —
filterChanged

emit_filter_changed(self, valid_values)

spinetoolbox.widgets.custom_gcombobox

Class for a custom QComboBox.
author
P. Savolainen (VTT)
date 16.10.2020

Module Contents

Classes

CustomQComboBox A custom QComboBox for showing kernels in Settings-
>Tools.

class spinetoolbox.widgets.custom_gcombobox.CustomQComboBox
Bases: PySide2.QtWidgets.QComboBox

A custom QComboBox for showing kernels in Settings->Tools.

mouseMoveEvent (self, e)
Catch mouseMoveEvent and accept it because the comboBox popup (QListView) has mouse tracking on
as default. This makes sure the comboBox popup appears in correct position and clicking on the combobox

374 Chapter 20. API Reference



Spine Toolbox Documentation, Release 0.6.6.dev0-dev.0

repeatedly does not move the Settings window.

spinetoolbox.widgets.custom_ggraphicsscene

Custom QGraphicsScene used in the Design View.
author
P. Savolainen (VTT)
date 13.2.2019

Module Contents

Classes
CustomGraphicsScene A custom QGraphicsScene. It provides signals to notify
about items,
DesignGraphicsScene A scene for the Design view.

class spinetoolbox.widgets.custom_qggraphicsscene.CustomGraphicsScene
Bases: PySide2.QtWidgets.QGraphicsScene

A custom QGraphicsScene. It provides signals to notify about items, and a method to center all items in the
scene.

At the moment it’s used by DesignGraphicsScene and the GraphViewMixin

item_move_finished
Emitted when an item has finished moving.

item_removed
Emitted when an item has been removed.

center_items(self)
Centers toplevel items in the scene.

class spinetoolbox.widgets.custom_ggraphicsscene.DesignGraphicsScene (parent, toolbox)
Bases: CustomGraphicsScene

A scene for the Design view.
Mainly, it handles drag and drop events of ProjectltemDragMixin sources.
Parameters
» parent (QObject) — scene’s parent object
¢ toolbox (ToolboxUT) — reference to the main window
clear_icons_and_links(self)

mouseMoveEvent (self, event)
Moves link drawer.

mousePressEvent (self, event)
Puts link drawer to sleep and log message if it looks like the user doesn’t know what they’re doing.

mouseReleaseEvent (self, event)
Makes link if drawer is released over a valid connector button.
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emit_connection_failed(self)

keyPressEvent (self, event)
Puts link drawer to sleep if user presses ESC.

connect_signals(self)
Connect scene signals.

project_item_icons(self)

handle_selection_changed(self)
Synchronizes selection with the project tree.

set_bg_color (self, color)
Change background color when this is changed in Settings.

Parameters color (QColor) — Background color

set_bg_choice(self, bg_choice)
Set background choice when this is changed in Settings.

Parameters bg (str)— “grid”, “tree”, or “solid”

dragLeaveEvent (self, event)
Accept event.

dragEnterEvent (self, event)
Accept event. Then call the super class method only if drag source is not a Projectltem

dragMoveEvent (self, event)

DragMixin.

Accept event. Then call the super class method only if drag source is not a ProjectltemDragMixin.

dropEvent (self, event)

Only accept drops when the source is an instance of ProjectltemDragMixin. Capture text from event’s

mimedata and show the appropriate ‘Add Item form.’

event (self, event)

Accepts GraphicsSceneHelp events without doing anything, to not interfere with our usage of

QToolTip.showText in graphics_items.Exclamationlcon.

drawBackground (self, painter, rect)
Reimplemented method to make a custom background.

Parameters
* painter (QPainter) — Painter that is used to paint background
* rect (QRectF) — The exposed (viewport) rectangle in scene coordinates

_draw_solid_bg(self, painter, rect)
Draws solid bg.

_draw_grid_bg(self, painter, rect)
Draws grid bg.

_draw_tree_bg(self, painter, rect)
Draws ‘tree of life’ bg.

select_link_drawer (self, drawer_type)
Selects current link drawer.

Parameters drawer_type (LinkType) — selected link drawer’s type
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spinetoolbox.widgets.custom_qggraphicsviews

Classes for custom QGraphicsViews for the Design and Graph views.
authors
P. Savolainen (VTT), M. Marin (KTH)
date 6.2.2018

Module Contents

Classes
CustomQGraphicsView Super class for Design and Entity QGraphicsViews.
DesignQGraphicsView QGraphicsView for the Design View.

class spinetoolbox.widgets.custom_ggraphicsviews.CustomQGraphicsView(parent)
Bases: PySide2.QtWidgets.QGraphicsView

Super class for Design and Entity QGraphicsViews.

parent
Parent widget

Type QWidget
Init CustomQGraphicsView.
property _gsettings(self)
property zoom_factor (self)

reset_zoom(self)
Resets zoom to the default factor.

keyPressEvent (self, event)
Overridden method. Enable zooming with plus and minus keys (comma resets zoom). Send event down-
stream to QGraphicsltems if pressed key is not handled here.

Parameters event (QKeyEvent) — Pressed key

mousePressEvent (self, event)
Set rubber band selection mode if Control pressed. Enable resetting the zoom factor from the middle mouse
button.

mouseReleaseEvent (self, event)
Reestablish scroll hand drag mode.

_use_smooth_zoom(self)

wheelEvent (self, event)
Zooms in/out.

Parameters event (QWheelEvent) — Mouse wheel event

resizeEvent (self, event)
Updates zoom if needed when the view is resized.

Parameters event (QResizeEvent) — aresize event
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setScene(self, scene)
Sets a new scene to this view.

Parameters scene (ShrinkingScene) — a new scene
_handle_item_move_finished(self, item)

_update_zoom_limits(self)
Updates the minimum zoom limit and the zoom level with which the view fits all the items in the scene.

abstract _compute_max_zoom(self)

_handle_zoom_time_line_advanced(self, pos)
Performs zoom whenever the smooth zoom time line advances.

_handle_transformation_time_line_finished(self)
Cleans up after the smooth transformation time line finishes.

_handle_resize_time_line_finished(self)
Cleans up after resizing time line finishes.

zoom_in(self)
Perform a zoom in with a fixed scaling.

zoom_out (self)
Perform a zoom out with a fixed scaling.

gentle_zoom(self, factor, zoom_focus=None)
Perform a zoom by a given factor.

Parameters
» factor (float) — a scaling factor relative to the current scene scaling
» zoom_focus (QPoint) — focus of the zoom, e.g. mouse pointer position
_zoom(self, factor)

_get_viewport_scene_rect (self)
Returns the viewport rect mapped to the scene.

Returns QRectF

_ensure_item_visible(self, item)
Resets zoom if item is not visible.

_set_preferred_scene_rect (self)
Sets the scene rect to the result of uniting the scene viewport rect and the items bounding rect.

class spinetoolbox.widgets.custom_ggraphicsviews.DesignQGraphicsView(parent)
Bases: CustomQGraphicsView

QGraphicsView for the Design View.
Parameters parent (QWidget) — parent widget
property _gsettings(self)

set_ui (self, toolbox)
Set a new scene into the Design View when app is started.

reset_zoom(self)
Resets zoom to the default factor.

_compute_max_zoom(self)
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add_icon(self, item_name)
Adds project item’s icon to the scene.

Parameters item_name (str) — project item’s name

remove_icon(self, item_name)
Removes project item’s icon from scene.

Parameters item_name (str)— name of the icon to remove

add_link(self, src_connector, dst_connector)
Pushes an AddLinkCommand to the toolbox undo stack.

Parameters
e src_connector (ConnectorButton) — source connector button
¢ dst_connector (ConnectorButton) — destination connector button

do_add_link (self, connection)
Adds given connection to the Design view.

Parameters connection (Connection) — the connection to add

do_replace_link(self, original_connection, new_connection)
Replaces a link on the Design view.

Parameters
¢ original_connection (Connection) — connection that was replaced
¢ new_connection (Connection) — replacing connection

remove_links (self, links)
Pushes a RemoveConnectionsCommand to the Toolbox undo stack.

Parameters links (1ist of Link) - links to remove

do_remove_link (self, connection)
Removes a link from the scene.

Parameters connection (ConnectionBase) — link’s connection
remove_selected_links(self)

take_link (self, link)
Remove link, then start drawing another one from the same source connector.

add_jump Cself, src_connector, dst_connector)
Pushes an AddJumpCommand to the Toolbox undo stack.

Parameters
e src_connector (ConnectorButton) — source connector button
¢ dst_connector (ConnectorButton) — destination connector button

do_add_jump (self, jump)
Adds given jump to the Design view.

Parameters jump (Jump) — jump to add

do_replace_jump (self, original_jump, new_jump)
Replaces a jump link on the Design view.

Parameters

e original_jump (Jump) — jump that was replaced
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e new_jump (Jump) — replacing jump

do_remove_jump (self, jump)
Removes a jump from the scene.

Parameters jump (Jump) — link’s jump

contextMenuEvent (self, event)
Shows context menu for the blank view

Parameters event (QContextMenuEvent) — Event

spinetoolbox.widgets.custom_glineedits

Classes for custom line edits.
authors
M. Marin (KTH), P. Savolainen (VTT)
date 11.10.2018

Module Contents

Classes
PropertyQLineEdit A custom QLineEdit for Project Item Properties.
CustomQLineEdit A custom QLineEdit that accepts file drops and displays

the path.

class spinetoolbox.widgets.custom_qlineedits.PropertyQLineEdit
Bases: PySide2.QtWidgets.QLineEdit

A custom QLineEdit for Project Item Properties.

keyPressEvent (self, ¢)
Overridden to catch and pass on the Undo and Redo commands when this line edit has the focus.

Parameters e (QKeyEvent) — Event

setText (self, text)
Overridden to prevent the cursor going to the end whenever the user is still editing. This happens because
we set the text programmatically in undo/redo implementations.

class spinetoolbox.widgets.custom_glineedits.CustomQLineEdit
Bases: PropertyQLineEdit

A custom QLineEdit that accepts file drops and displays the path.

parent
Parent for line edit widget

Type QMainWindow
file_dropped

dragEnterEvent (self, event)
Accept a single file drop from the filesystem.
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dragMoveEvent (self, event)
Accept event.

dropEvent (self, event)

Emit file_dropped signal with the file for the dropped url.

spinetoolbox.widgets.custom_qgtableview

Custom QTableView classes that support copy-paste and the like.

author
M. Marin (KTH)
date 18.5.2018

Module Contents

Classes

CopyPasteTableView

Custom QTableView class with copy and paste methods.

AutoFilterCopyPasteTableView

Custom QTableView class with autofilter functionality.

IndexedParameterValueTableViewBase

Custom QTableView base class with copy and paste
methods for indexed parameter values.

TimeSeriesFixedResolutionTableView

A QTableView for fixed resolution time series table.

IndexedValueTableView

A QTableView class with for variable resolution time se-
ries and time patterns.

ArrayTableView Custom QTableView with copy and paste methods for
single column tables.
MapTableView Custom QTableView with copy and paste methods for
map tables.
Functions
_range(selection) Returns the top left and bottom right corners of selec-

tion.

_could_be_time_stamp(s)

Evaluates if given string could be a time stamp.

system_1c_numeric()
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Attributes

_NOT_TIME_STAMP

spinetoolbox.widgets.custom_gtableview._

class spinetoolbox.widgets.custom_qtableview.CopyPasteTableView
Bases: PySide2.QtWidgets.QTableView

Custom QTableView class with copy and paste methods.

keyPressEvent (self, event)
Copies and pastes to and from clipboard in Excel-like format.

delete_content (self)
Deletes content from editable indexes in current selection.

can_copy (self)

copy (self)
Copies current selection to clipboard in excel format.

can_paste(self)

paste(self)
Paste data from clipboard.

static _read_pasted_text (fext)
Parses a tab separated CSV text table.

Parameters text (str)-a CSV formatted table
Returns a list of rows
Return type list

paste_on_selection(self)
Pastes clipboard data on selection, but not beyond. If data is smaller than selection, repeat data to fit
selection.

paste_normal (self)
Pastes clipboard data, overwriting cells if needed.

class spinetoolbox.widgets.custom_qtableview.AutoFilterCopyPasteTableView(parent)
Bases: CopyPasteTableView

Custom QTableView class with autofilter functionality.
Parameters parent (QObject) —

keyPressEvent (self, event)
Shows the autofilter menu if the user presses Alt + Down.

Parameters event (QEvent) —

setModel (self, model)
Disconnects the sectionPressed signal which seems to be connected by the super method. Otherwise press-
ing the header just selects the column.

Parameters model (QAbstractItemModel) —
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show_auto_filter_menu(self, logical_index)
Called when user clicks on a horizontal section header. Shows/hides the auto filter widget.

Parameters logical_index (int) -

class spinetoolbox.widgets.custom_qgtableview.IndexedParameterValueTableViewBase
Bases: CopyPasteTableView

Custom QTableView base class with copy and paste methods for indexed parameter values.

copy (self)
Copies current selection to clipboard in CSV format.

abstract static _read_pasted_text(rext)
Reads CSV formatted table.

abstract paste(self)
Pastes data from clipboard to selection.

class spinetoolbox.widgets.custom_qtableview.TimeSeriesFixedResolutionTableView
Bases: IndexedParameterValueTableViewBase

A QTableView for fixed resolution time series table.

paste(self)
Pastes data from clipboard.

static _read_pasted_text (fexr)
Parses the given CSV table. Parsing is locale aware.

Parameters text (str)—a CSV table containing numbers
Returns A list of floats
Return type list of float

_paste_to_values_column(self, values, first_row, paste_length)
Pastes data to the Values column.

Parameters

¢ values (list) — alist of float values to paste

o first_row (int) — index of the first row where to paste

» paste_length (int) — length of the paste selection (can be different from len(values))
Returns A tuple (list(pasted indexes), list(pasted values))
Return type tuple

class spinetoolbox.widgets.custom_qgtableview.IndexedValueTableView
Bases: IndexedParameterValueTableViewBase

A QTableView class with for variable resolution time series and time patterns.

paste(self)
Pastes data from clipboard.

_baste_two_columns (self, data_indexes, data_values, first_row, paste_length)
Pastes data indexes and values.

Parameters
e data_indexes (1ist) — a list of data indexes (time stamps/durations)

¢ data_values (1ist) — a list of data values
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e first_row (int) — first row index

* paste_length (int) — selection length for pasting
Returns a tuple (modified model indexes, modified model values)
Return type tuple

_baste_single_column(self, values, first_row, first_column, paste_length)
Pastes a single column of data.

Parameters
» values (1ist) — alist of data to paste (data indexes or values)
o first_row (int) — first row index
¢ paste_length (int) — selection length for pasting
Returns a tuple (modified model indexes, modified model values)
Return type tuple

static _read_pasted_text (fexr)
Parses a given CSV table.

Parameters text (str)-—a CSV table
Returns a tuple (data indexes, data values)
Return type tuple

class spinetoolbox.widgets.custom_qtableview.ArrayTableView
Bases: IndexedParameterValueTableViewBase

Custom QTableView with copy and paste methods for single column tables.

copy (self)
Copies current selection to clipboard in CSV format.

paste(self)
Pastes data from clipboard.

static _read_pasted_text (fexr)
Reads the first column of given CSV table.

Parameters text (str)-—a CSV table
Returns data column
Return type list of str

class spinetoolbox.widgets.custom_qgtableview.MapTableView
Bases: CopyPasteTableView

Custom QTableView with copy and paste methods for map tables.

copy (self)
Copies current selection to clipboard in Excel compatible CSV format.

delete_content (self)
Deletes content in current selection.

paste(self)
Pastes data from clipboard.

Returns True if data was pasted successfully, False otherwise
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Return type bool

static _read_pasted_text (fext)
Parses a given CSV table.

Parameters text (str)-—a CSV table
Returns a list of table rows
Return type list of list

spinetoolbox.widgets.custom_qtableview._range (selection)
Returns the top left and bottom right corners of selection.

Parameters selection (QItemSelection) — a list of selected QItemSelection objects

Returns a tuple (top row, bottom row, left column, right column)

Return type tuple of ints
spinetoolbox.widgets.custom_qgtableview._NOT_TIME_STAMP

spinetoolbox.widgets.custom_qtableview._could_be_time_stamp(s)
Evaluates if given string could be a time stamp.

This is to deal with special cases that are not intended as time stamps but could end up as one by the very greedy

DateTime constructor.
Parameters s (str) — string to evaluate
Returns True if s could be a time stamp, False otherwise
Return type bool

spinetoolbox.widgets.custom_qtableview.system_lc_numeric()

spinetoolbox.widgets.custom_gtextbrowser

Class for a custom QTextBrowser for showing the logs and tool output.
author
P. Savolainen (VTT)
date 6.2.2018

Module Contents

Classes
SignedTextDocument
param owner The item that owns the doc-
ument.
CustomQTextBrowser Custom QTextBrowser class.
MonoSpaceFontTextBrowser Custom QTextBrowser class.

class spinetoolbox.widgets.custom_qtextbrowser.SignedTextDocument (owner=None)
Bases: PySide2.QtGui.QTextDocument
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Parameters owner (ProjectItem, optional)— The item that owns the document.

class spinetoolbox.widgets.custom_gtextbrowser.CustomQTextBrowser (parent)

Bases: PySide2.QtWidgets.QTextBrowser

Custom QTextBrowser class.

Parameters parent (QWidget) — Parent widget

set_override_document (self, document)

Sets the given document as the current document.

Parameters document (QTextDocument) —

restore_original_document (self)
Restores the original document

scroll_to_bottom(self)

append (self, text)

Appends new text block to the end of the original document.

If the document contains more text blocks after the addition than a set limit, blocks are deleted at the start

of the contents.

Parameters text (str) — text to add

contextMenuEvent (self, event)

Reimplemented method to add a clear action into the default context menu.

Parameters event (QContextMenuEvent) — Received event

property max_blocks (self)

int: the upper limit of text blocks that can be appended to the widget.

class spinetoolbox.widgets.custom_gtextbrowser.MonoSpaceFontTextBrowser (parent)

Bases: CustomQTextBrowser

Custom QTextBrowser class.

Parameters parent (QWidget) — Parent widget

spinetoolbox.widgets.custom_qtreeview

Classes for custom QTreeView.

author

M. Marin (KTH)

date 25.4.2018

Module Contents

Classes
CopyTreeView Custom QTreeView class with copy support.
SourcesTreeView Custom QTreeView class for 'Sources' in Tool specifica-
tion editor widget.
continues on next page
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Table 99 — continued from previous page
CustomTreeView Custom QTreeView class for Tool specification editor
form to enable keyPressEvent.

class spinetoolbox.widgets.custom_gtreeview.CopyTreeView(parent)
Bases: PySide2.QtWidgets.QTreeView

Custom QTreeView class with copy support.
Initialize the view.
can_copy (self)

copy (self)
Copy current selection to clipboard in excel format.

class spinetoolbox.widgets.custom_gtreeview.SourcesTreeView(parent)
Bases: PySide2.QtWidgets.QTreeView

Custom QTreeView class for ‘Sources’ in Tool specification editor widget.

parent
The parent of this view

Type QWidget
Initialize the view.
files_dropped
del_key_pressed

dragEnterEvent (self, event)
Accept file and folder drops from the filesystem.

dragMoveEvent (self, event)
Accept event.

dropEvent (self, event)
Emit files_dropped signal with a list of files for each dropped url.

keyPressEvent (self, event)
Overridden method to make the view support deleting items with a delete key.

class spinetoolbox.widgets.custom_gtreeview.CustomTreeView(parent)
Bases: PySide2.QtWidgets.QTreeView

Custom QTreeView class for Tool specification editor form to enable keyPressEvent.

parent
The parent of this view

Type QWidget
Initialize the view.
del_key_pressed

keyPressEvent (self, event)
Overridden method to make the view support deleting items with a delete key.
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spinetoolbox.widgets.custom_qgwidgets

Custom QWidgets for Filtering and Zooming.
author
P. Vennstrom (VTT)
date 4.12.2018

Module Contents

Classes
FilterWidgetBase Filter widget class.
SimpleFilterWidget Filter widget class.
CustomiWidgetAction A QWidgetAction with custom hovering.
ToolBarWidgetAction An action with a tool bar.
ToolBarWidgetBase A toolbar on the right, with enough space to print a text
beneath.
ToolBarWidget A toolbar on the right, with enough space to print a text

beneath.

MenuItemToolBarWidget

A menu item with a toolbar on the right.

_MenuToolBar A custom tool bar for MenuItemToolBarWidget.

TitleWidgetAction A titled separator.

WrapLabel A QLabel that always wraps text.

HyperTextLabel A QLabel that supports hyperlinks.

QWizardProcessPage A QWizards page with a log. Useful for pages that need
to capture the output of a process.

LabelWithCopyButton A read only QLabel with a QToolButton that copies the

text to clipboard.

class spinetoolbox.widgets.custom_qwidgets.FilterWidgetBase (parent)

Bases: PySide2.QtWidgets.QWidget
Filter widget class.
Init class.

Parameters parent (QWidget) —
okPressed
cancelPressed
connect_signals(self)

save_state(self)

Saves the state of the FilterCheckboxListModel.

reset_state(self)

Sets the state of the FilterCheckboxListModel to saved state.

clear_filter(self)

Selects all items in FilterCheckBoxListModel.
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has_filter(self)
Returns true if any item is filtered in FilterCheckboxListModel false otherwise.

set_filter_list(self, data)
Sets the list of items to filter.

_apply_filter(self)
Apply current filter and save state.

_cancel_filter(self)
Cancel current edit of filter and set the state to the stored state.

_filter_list(self)
Filter list with current text.

_text_edited(self, new_text)

Callback for edit text, starts/restarts timer. Start timer after text is edited, restart timer if text is edited before
last time out.

class spinetoolbox.widgets.custom_gwidgets.SimpleFilterWidget (parent, show_empty=True)
Bases: FilteriWidgetBase

Filter widget class.
Init class.
Parameters parent (QWidget) —

class spinetoolbox.widgets.custom_qwidgets.CustomWidgetAction (parent=None)
Bases: PySide2.QtWidgets.QWidgetAction

A QWidgetAction with custom hovering.
Class constructor.
Parameters parent (QMenu) — the widget’s parent

_handle_hovered(self)

Hides other menus that might be shown in the parent widget and repaints it. This is to emulate the behavior
of QAction.

class spinetoolbox.widgets.custom_gwidgets.ToolBarWidgetAction(text, parent=None,

compact=False)
Bases: CustomWidgetAction

An action with a tool bar.
tool_bar
Type QToolBar
Class constructor.
Parameters parent (QMenu) — the widget’s parent
eventFilter (self, obj, ev)

_handle_hovered(self)

Hides other menus that might be shown in the parent widget and repaints it. This is to emulate the behavior
of QAction.

class spinetoolbox.widgets.custom_gwidgets.ToolBarWidgetBase (fext, parent=None)
Bases: PySide2.QtWidgets.QWidget

A toolbar on the right, with enough space to print a text beneath.
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tool_bar
Type QToolBar
Class constructor.
Parameters
* text (str)—
* parent (QWidget) — the widget’s parent

class spinetoolbox.widgets.custom_qwidgets.ToolBarWidget (text, parent=None)
Bases: ToolBarliidgetBase

A toolbar on the right, with enough space to print a text beneath.
tool_bar
Type QToolBar
Class constructor.
Parameters
* text (str)-—
* parent (QWidget) — the widget’s parent

class spinetoolbox.widgets.custom_gwidgets.MenuItemToolBarWidget (text, parent=None,
compact=False)
Bases: ToolBarliidgetBase

A menu item with a toolbar on the right.
tool_bar
Type QToolBar
Class constructor.
Parameters
e text (str) -
* parent (QWidget) — the widget’s parent
» compact (bool) - if True, the widget uses the minimal space

paintEvent (self, event)
Draws the menu item, then calls the super() method to draw the tool bar.

class spinetoolbox.widgets.custom_gwidgets._MenuToolBar (parent=None)
Bases: PySide2.QtWidgets.QToolBar

A custom tool bar for MenuItemToolBarWidget.
enabled_changed

_align_buttons(self)
Align all buttons to bottom so frames look good.

add_£frame (self, left, right, title)
Add frame around given actions, with given title.

Parameters

e left (QAction) —
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e right (QAction) —
e title (str)—
is_enabled(self)

addActions (self, actions)
Overriden method to customize tool buttons.

addAction(self, *args, **kwargs)
Overriden method to customize the tool button.

sizeHint (self)
Make room for frames if needed.

paintEvent (self, ev)
Paint the frames.

_setup_action_button(self, action)

Customizes the QToolButton associated with given action:
1. Makes sure that the text honors the action’s mnemonics.
2. Installs this as event filter on the button (see self.eventFilter()).
Must be called everytime an action is added to the tool bar.
Parameters QAction —

actionEvent (self, ev)
Updates self._enabled: True if at least one non-separator action is enabled, False otherwise. Emits
self.enabled_changed accordingly.

eventFilter (self, obj, ev)
Installed on each action’s QToolButton. Ignores Up and Down key press events, so they are handled by the
toolbar for custom navigation.

keyPressEvent (self, ev)
Navigates over the tool bar buttons.

hideEvent (self, ev)

class spinetoolbox.widgets.custom_qwidgets.TitleWidgetAction(title, parent=None)
Bases: CustomiWidgetAction

A titled separator.
Class constructor.
Parameters parent (QMenu) — the widget’s parent
H_MARGIN = 5
V_MARGIN = 2
static _add_line(widget, layout)
isSeparator (self)

class spinetoolbox.widgets.custom_gwidgets.WrapLabel (text=", parent=None)
Bases: PySide2.QtWidgets.QLabel

A QLabel that always wraps text.
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class spinetoolbox.widgets.custom_gwidgets.HyperTextLabel (text=", parent=None)
Bases: WrapLabel

A QLabel that supports hyperlinks.

class spinetoolbox.widgets.custom_qwidgets.QWizardProcessPage (parent)
Bases: PySide2.QtWidgets.QWizardPage

A QWizards page with a log. Useful for pages that need to capture the output of a process.

class _ExecutionManager
A descriptor that stores a QProcessExecutionManager. When execution_finished is emitted, it shows
the button to copy the process log.

public_name
private_name
__set_name__ (self, owner, name)
__get__{(self, obj, objtype=None)
__set__(self, obj, value)
msg
msg_warning
msg_error
msg_success
msg_proc
msg_proc_error
_exec_mngr
_connect_signals(self)
_handle_copy_clicked(self, _=False)
_add_msg(self, msg)
_add_msg_warning(self, msg)
_add_msg_error (self, msg)
_add_msg_succes (self, msg)
isComplete(self)
cleanupPage (self)

class spinetoolbox.widgets.custom_qwidgets.LabelWithCopyButton(text=", parent=None)
Bases: PySide2.QtWidgets.QWidget

A read only QLabel with a QToolButton that copies the text to clipboard.
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spinetoolbox.widgets.datetime_editor

An editor widget for editing datetime database (relationship) parameter values.
author
A. Soininen (VTT)
date 28.6.2019

Module Contents

Classes
DatetimeEditor An editor widget for DateTime type parameter values.
Functions
_QDateTime_to_datetime(dt) Converts a QDateTime object to Python's date-
time.datetime type.
_datetime_to_QDateTime(dt) Converts Python's datetime.datetime object to QDate-
Time.

spinetoolbox.widgets.datetime_editor._QDateTime_to_datetime (dt)
Converts a QDateTime object to Python’s datetime.datetime type.

spinetoolbox.widgets.datetime_editor._datetime_to_QDateTime (dr)
Converts Python’s datetime.datetime object to QDateTime.

class spinetoolbox.widgets.datetime_editor.DatetimeEditor (parent=None)
Bases: PySide2.QtWidgets.QWidget

An editor widget for DateTime type parameter values.

parent
a parent widget

Type QWidget

_change_datetime (self, new_datetime)
Updates the internal DateTime value

set_value (self, value)
Sets the value to be edited.

value(self)
Returns the editor’s current value.
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spinetoolbox.widgets.duration_editor

An editor widget for editing duration database (relationship) parameter values.
author
A. Soininen (VTT)
date 28.6.2019

Module Contents

Classes

DurationEditor An editor widget for Duration type parameter values.

class spinetoolbox.widgets.duration_editor.DurationEditor (parent=None)
Bases: PySide2.QtWidgets.QWidget

An editor widget for Duration type parameter values.

parent
a parent widget

Type QWidget

_change_duration(self)
Updates the value being edited.

set_value(self, value)
Sets the value for editing.

value (self)
Returns the current Duration.

spinetoolbox.widgets.indexed_value_table_context_menu

Context menus for parameter value editor widgets.
author
A. Soininen (VTT)
date 5.7.2019

Module Contents

Classes
ContextMenuBase Context menu base for parameter value editor tables.
ArrayTableContextMenu Context menu for array editor tables.
IndexedValueTableContextMenu Context menu for time series and time pattern editor ta-

bles.

continues on next page
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Table 104 — continued from previous page

MapTableContextMenu Context menu for map editor tables.

Functions
_unique_row_ranges(selections) Merged ranges in given selections to unique ranges.
_unique_column_ranges(selections) Merged ranges in given selections to unique ranges.
_merge_intervals(intervals) Merges given intervals if they overlap.

Attributes

_INSERT_SINGLE_COLUMN_AFTER

_INSERT_SINGLE_ROW_AFTER

_INSERT_MULTIPLE_COLUMNS_AFTER

_INSERT_MULTIPLE_ROWS_AFTER

_INSERT_SINGLE_COLUMN_BEFORE

_INSERT_SINGLE_ROW_BEFORE

_INSERT_MULTIPLE_COLUMNS_BEFORE

_INSERT_MULTIPLE_ROWS_BEFORE

_OPEN_EDITOR

_REMOVE_COLUMNS

_REMOVE_ROWS

_TRIM_COLUMNS

spinetoolbox.widgets.indexed_value_table_context_menu._INSERT_SINGLE_COLUMN_AFTER =
Insert column after

spinetoolbox.widgets.indexed_value_table_context_menu._INSERT_SINGLE_ROW_AFTER = Insert
row after

spinetoolbox.widgets.indexed_value_table_context_menu._INSERT_MULTIPLE_COLUMNS_AFTER =
Insert columns after...

spinetoolbox.widgets.indexed_value_table_context_menu._INSERT_MULTIPLE_ROWS_AFTER =
Insert rows after...

spinetoolbox.widgets.indexed_value_table_context_menu._INSERT_SINGLE_COLUMN_BEFORE =
Insert column before
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spinetoolbox.widgets.indexed_value_table_context_menu

row before

spinetoolbox.widgets.indexed_value_table_context_menu

Insert columns before...

spinetoolbox.widgets.indexed_value_table_context_menu

Insert rows before...

. _INSERT_SINGLE_ROW_BEFORE = Insert

. _INSERT_MULTIPLE_COLUMNS_BEFORE =

. _INSERT_MULTIPLE_ROWS_BEFORE =

spinetoolbox.widgets.indexed_value_table_context_menu._OPEN_EDITOR = Open value editor...

spinetoolbox.widgets.indexed_value_table_context_menu._REMOVE_COLUMNS = Remove columns

spinetoolbox.widgets.indexed_value_table_context_menu._REMOVE_ROWS = Remove rows

spinetoolbox.widgets

.indexed_value_table_context_menu._TRIM_COLUMNS = Trim columns

class spinetoolbox.widgets.indexed_value_table_context_menu.ContextMenuBase (fable_view,

Bases: PySide2.QtWidgets.QMenu
Context menu base for parameter value editor tables.
Parameters
e table_view (QTableView) — the view where the menu is invoked
* position (QPoint) — menu’s position on the table view

_add_default_actions(self)
Adds default actions to the menu.

_first_row(self)
Returns the first selected row.

Returns index to the first row
Return type int

_insert_multiple_rows_after(self)
Prompts for row count, then inserts new rows below the current selection.

_insert_multiple_rows_before(self)
Prompts for row count, then inserts new rows above the current selection.

_insert_single_row_after (self)
Inserts a single row below the current selection.

_insert_single_row_before(self)
Inserts a single row above the current selection.

_last_row(self)
Returns the last selected row.

Returns index to the last row
Return type int

_prompt_row_count (self)
Prompts for number of rows to insert.

Returns number of rows
Return type int

_remove_rows (self)
Removes selected rows.

position)
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class spinetoolbox.widgets.indexed_value_table_context_menu.ArrayTableContextMenu(editor,
ta-
ble_view,
position)
Bases: ContextMenuBase

Context menu for array editor tables.
Parameters
» editor (ArrayEditor) — array editor widget
e table_view (QTableView) — the view where the menu is invoked
* position (QPoint) — menu’s position

_show_value_editor (self)
Opens the value element editor.

class spinetoolbox.widgets.indexed_value_table_context_menu.IndexedValueTableContextMenu(table_view,

po-
Si-
tion)
Bases: ContextMenuBase

Context menu for time series and time pattern editor tables.
Parameters
e table_view (QTableView) — the view where the menu is invoked
* position (QPoint) — menu’s position

class spinetoolbox.widgets.indexed_value_table_context_menu.MapTableContextMenu (editor,
table_view,
position)
Bases: ContextMenuBase

Context menu for map editor tables.
Parameters
» editor (MapEditor)— map editor widget
e table_view (QTableView) — the view where the menu is invoked
e position (QPoint) — table cell index

_first_column(self)
Returns the first selected column.

Returns index to the first column
Return type int

_insert_multiple_columns_after (self)
Prompts for column count, then inserts new columns right from the current selection.

_insert_multiple_columns_before(self)
Prompts for column count, then inserts new columns left from the current selection.

_insert_single_column_before(self)
Inserts a single column left from the current selection.

_insert_single_column_after (self)
Inserts a single column right from the current selection.
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_last_column(self)
Returns the last selected column.

Returns index to the last column
Return type int

_prompt_column_count (self)
Prompts for number of column to insert.

Returns number of columns
Return type int

_remove_columns (self)
Removes selected columns

_show_value_editor (self)
Opens the value element editor.

_trim_columns (self)
Removes excessive columns from the table.

spinetoolbox.widgets.indexed_value_table_context_menu._unique_row_ranges (selections)
Merged ranges in given selections to unique ranges.

Parameters selections (1ist of QItemSelectionRange) — selected ranges
Returns a list of [first_row, last_row] ranges
Return type list of list

spinetoolbox.widgets.indexed_value_table_context_menu._unique_column_ranges (selections)
Merged ranges in given selections to unique ranges.

Parameters selections (1ist of QItemSelectionRange) — selected ranges
Returns a list of [first_row, last_row] ranges
Return type list of list

spinetoolbox.widgets.indexed_value_table_context_menu._merge_intervals (intervals)
Merges given intervals if they overlap.

Parameters intervals (1ist of list) - alist of intervals in the form [first, last]
Returns merged intervals in the form [first, last]

Return type list of list

spinetoolbox.widgets.install_julia_wizard

Classes for custom QDialogs for julia setup.
author
M. Marin (KTH)
date 13.5.2018
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Module Contents

Classes

_Pageld Enum where members are also (and must be) ints
InstallJjuliaWizard A wizard to install julia
JillNotFoundPage

IntroPage

SelectDirsPage

InstallJuliaPage A QWizards page with a log. Useful for pages that need
to capture the output of a process.

SuccessPage

FailurePage

Attributes

jill_install

spinetoolbox.widgets.install_julia_wizard.jill_install

class spinetoolbox.widgets.install_julia_wizard._Pageld
Bases: enum. IntEnum

Enum where members are also (and must be) ints
Initialize self. See help(type(self)) for accurate signature.
INTRO

SELECT_DIRS

INSTALL

SUCCESS

FAILURE

class spinetoolbox.widgets.install_julia_wizard.InstallJuliaWizard(parent)
Bases: PySide2.QtWidgets.QWizard

A wizard to install julia
Initialize class.
Parameters parent (QWidget) — the parent widget (SettingsWidget)
julia_exe_selected
set_julia_exe(self)

accept (self)
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class spinetoolbox.widgets.install_julia_wizard.JillNotFoundPage (parent)
Bases: PySide2.QtWidgets.QWizardPage

class spinetoolbox.widgets.install_julia_wizard.IntroPage (parent)
Bases: PySide2.QtWidgets.QWizardPage

nextId(self)

class spinetoolbox.widgets.install_julia_wizard.SelectDirsPage(parent)
Bases: PySide2.QtWidgets.QWizardPage

initializePage(self)
_select_install_dir(self)
_select_symlink_dir(self)
nextId(self)

class spinetoolbox.widgets.install_julia_wizard.InstallJuliaPage (parent)
Bases: spinetoolbox.widgets.custom_gwidgets.QWizardProcessPage

A QWizards page with a log. Useful for pages that need to capture the output of a process.
cleanupPage (self)

initializePage(self)

_handle_julia_install_finished(self, ret)

nextId(self)

class spinetoolbox.widgets.install_julia_wizard.SuccessPage (parent)
Bases: PySide2.QtWidgets.QWizardPage

initializePage(self)
nextId(self)

class spinetoolbox.widgets.install_julia_wizard.FailurePage (parent)
Bases: PySide2.QtWidgets.QWizardPage

initializePage(self)

nextId(self)

spinetoolbox.widgets. jump_properties_widget

Contains jump properties widget’s business logic.
author
A. Soininen (VTT)
date 23.6.2021
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Module Contents

Classes

JumpPropertiesliidget Widget for jump link properties.

class spinetoolbox.widgets. jump_properties_widget.JumpPropertiesWidget (foolbox)
Bases: PySide2.QtWidgets.QWidget

Widget for jump link properties.
Parameters toolbox (ToolboxUI) — The toolbox instance where this widget should be embedded

set_link(self, link)
Hooks the widget to given link, so that user actions are reflected in the link’s configuration.

Parameters link (JumpLink) — link to hook into

unset_link(self)
Releases the widget from any links.

set_condition(self, jump, condition)

_change_condition(self)
Stores jump condition to link.

spinetoolbox.widgets. jupyter_console_widget

Class for a custom RichJupyterWidget that can run Tool instances.
authors
M. Marin (KTH), P. Savolainen (VTT)
date 22.10.2019

Module Contents

Classes
JupyterConsoleWidget Base class for all embedded console widgets that can run
tool instances.
Attributes

traitlets_logger

asyncio_logger

spinetoolbox.widgets. jupyter_console_widget.traitlets_logger
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spinetoolbox.widgets. jupyter_console_widget.asyncio_logger

class spinetoolbox.widgets. jupyter_console_widget.JupyterConsoleWidget (toolbox,
target_kernel_name,
owner=None)
Bases: qtconsole.rich_jupyter_widget.RichJupyterWidget

Base class for all embedded console widgets that can run tool instances.
Parameters
¢ toolbox (ToolboxUTI) — QMainWindow instance
» target_kernel_name (str) — Kernel name, e.g. ‘julia-1.6’
e owner (ProjectItem, NoneType) - Item that owns the console.

name (self)
Returns console name for display purposes.

property owner_names (self)

start_console (self, checked=False)
Starts chosen Python/Julia kernel if available and not already running. Context menu start action handler.

restart_console(self, checked=False)
Restarts current Python/Julia kernel. Starts a new kernel if it is not running or if chosen kernel has been
changed in Settings. Context menu restart action handler.

call_start_kernel (self)
Finds a valid kernel and calls start_kernel () with it.

start_kernel (self, k_path)
Starts a kernel manager and kernel client and attaches the client to this Console.

Parameters k_path (str) — Directory where the the kernel specs are located

shutdown_kernel (self)
Shut down Julia/Python kernel.

dragEnterEvent (self, ¢)
Don’t accept project item drops.

_handle_status(self, msg)
Handles status message.

enterEvent (self, event)
Sets busy cursor during console (re)starts.

abstract _is_complete(self, source, interactive)
See base class.

_context_menu_make (self, pos)
Reimplemented to add actions to console context-menus.

copy_input (self)
Copies only input.

_replace_client (self)

connect_to_kernel (self, kernel_name, connection_file)
Connects to an existing kernel. Used when Spine Engine is managing the kernel for project execution.

Parameters

* kernel_name (str) —
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e connection_file (str) — Path to the connection file of the kernel

interrupt (self)

[TODO: Remove?] Sends interrupt signal to kernel.

spinetoolbox.widgets.kernel_editor

Dialog for selecting a kernel or creating a new Julia or Python kernel.

author
P. Savolainen (VTT)
date 7.10.2020

Module Contents

Classes
KernelEditorBase Base class for kernel editors.
KernelEditor Class for a Python and Julia kernel editor.

MiniKernelEditorBase

Base class for kernel editors.

MiniPythonKernelEditor

A reduced version of KernelEditor that basically just
takes care of installing one Python kernel.

MiniJuliaKernelEditor

A reduced version of KernelEditor that basically just
takes care of installing one Julia kernel.

Functions

find_kernels()

Returns a dictionary mapping kernel names to kernel
paths.

find_python_kernels()

Returns a dictionary of Python kernels. Keys are ker-
nel_names, values are kernel paths.

find_julia_kernels()

Returns a dictionary of Julia kernels.
nel_names, values are kernel paths.

Keys are ker-

find_unknown_kernels()

Returns a dictionary of kernels that are neither Python
nor Julia kernels.

format_event_message(msg_type,
show_datetime=True)

message,

Formats message for the kernel editor text browser.

format_process_message(msg_type, message)

Formats process message for the kernel editor text
browser.

class spinetoolbox.widgets.kernel_editor.KernelEditorBase (parent, python_or_julia)

Bases: PySide2.QtWidgets.QDialog
Base class for kernel editors.

Parameters

* parent (QSettingsWidget) — Toolbox settings widget

» python_or_julia (str) — kernel type; valid values: “julia”,

EEINNT3

python”
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setup_dialog_style(self)
Sets windows icon and stylesheet. This can be removed when SettingsWidget inherits stylesheet from
Toolbox UL

connect_signals(self)
Connects signals to slots.

check_options(self, prgm, kernel_name, display_name, python_or_julia)
Checks that user options are valid before advancing with kernel making.

Parameters
e prgm (str) — Full path to Python or Julia program
¢ kernel_name (str)— Kernel name
¢ display_name (str) — Kernel display name
e python_or_julia (str) — Either ‘python’ or ‘julia’
Returns True if all user input is valid for making a new kernel, False otherwise
Return type bool
abstract _python_kernel_name(self)
abstract _python_kernel_display_name (self)
abstract _python_interpreter_name (self)

make_python_kernel (self, checked=False)
Makes a new Python kernel. Offers to install ipykernel package if it is missing from the selected Python
environment. Overwrites existing kernel with the same name if this is ok by user.

static is_package_installed(python_path, package_name)
Checks if given package is installed to given Python environment.

Parameters
* python_path (str) — Full path to selected Python interpreter
* package_name (str) — Package name

Returns True if installed, False if not

Return type (bool)

start_package_install_process(self, python_path, package_name)
Starts installing the given package using pip.

Parameters
e python_path (str) — Full path to selected Python interpreter
» package_name (str) — Package name to install using pip

handle_package_install_process_finished(self, retval)
Handles installing package finished.

Parameters retval (int) — Process return value. 0: success, !0: failure

start_kernelspec_install_process(self, prgm, k_name, d_name)
Installs kernel specifications for the given Python environment. Runs e.g. this command in QProcess

python -m ipykernel install —user —-name python-X.Y —display-name PythonX.Y

Creates new kernel specs into %APPDATA%jupyterkernels. Existing directory will be overwritten.
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Note: We cannot use —sys.prefix here because if we have selected to create a kernel for some other python
that was used in launching the app, the kernel will be created into a location that is not discoverable by
jupyter and hence not by Spine Toolbox. E.g. when sys.executable is C:Python36python.exe, and we have
selected that as the python for Spine Toolbox (Settings->Tools->Python interpreter is empty), creating a
kernel with —sys-prefix creates kernel specs into C:Python36sharejupyterkernelspython-3.6. This is ok and
the kernel spec is discoverable by jupyter and Spine Toolbox.

BUT when sys.executable is C:Python36python.exe, and we have selected another python for Spine Toolbox
(Settings->Tools->Python interpreter is C:Python38python.exe), creating a kernel with —sys-prefix creates
a kernel into C:Python38sharejupyterkernelspython-3.8-sys-prefix. This is not discoverable by jupyter nor
Spine Toolbox. You would need to start the app using C:Python38python.exe to see and use that kernel
spec.

Using —user option instead, creates kernel specs that are discoverable by any python that was used in starting
Spine Toolbox.

Parameters
* prgm (str) — Full path to Python interpreter for which the kernel is created
¢ k_name (str)— Kernel name
¢ d_name (str) — Kernel display name

handle_kernelspec_install_process_finished(self, retval)
Handles case when the process for installing the kernel has finished.

Parameters retval (int) — Process return value. 0: success, !0: failure
abstract _julia_kernel_name(self)
abstract _julia_executable(self)
abstract _julia_project(self)

make_julia_kernel (self, checked=False)
Makes a new Julia kernel. Offers to install IJulia package if it is missing from the selected Julia project.
Overwrites existing kernel with the same name if this is ok by user.

_is_rebuild_ijulia_needed(self)

is_ijulia_installed(self, program, project)
Checks if IJulia is installed for the given project. Note: Trying command ‘using IJulia’ does not work since
it automatically tries loading it from the LOAD_PATH if not it’s not found in the active project.

Returns 0 when process failed to start, 1 when IJulia is installed, 2 when IJulia is not installed.
Return type int

start_ijulia_install_process(self, julia, project)
Starts installing [Julia package to given Julia project.

Parameters
¢ julia (str) — Full path to selected Julia executable
e project (str) — Julia project (e.g. dir path or ‘@.’, or *.")

handle_ijulia_install_finished(self, ret)
Runs when [Julia install process finishes.

Parameters ret (int) — Process return value. 0: success, !0: failure

start_ijulia_rebuild_process(self, program, project)
Starts rebuilding [Julia.
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handle_ijulia_rebuild_finished(self, ret)
Runs when [Julia rebuild process finishes.

Parameters ret (int) — Process return value. 0: success, !0: failure

start_ijulia_installkernel_process(self, program, project, kernel_name)
Installs the kernel using IJulia.installkernel function. Given kernel_name is actually the new kernel DIS-
PLAY name. IJulia strips the whitespace and uncapitalizes this to make the kernel name automatically.
Julia version is concatenated to both names automatically (This cannot be changed).

handle_installkernel_process_finished(self, retval)
Checks whether or not the IJulia.installkernel process finished successfully.

Parameters retval (int) — Process return value. O: success, !0: failure

restore_dialog_dimensions (self)
Restore widget location, dimensions, and state from previous session.

add_message (self, msg)
Append regular message to kernel editor text browser.

Parameters msg (str) — String written to QTextBrowser

add_success_message (self, msg)
Append message with green text color to kernel editor text browser.

Parameters msg (str) — String written to QTextBrowser

add_error_message (self, msg)
Append message with red color to kernel editor text browser.

Parameters msg (str) — String written to QTextBrowser

add_warning_message (self, msg)
Append message with yellow (golden) color to kernel editor text browser.

Parameters msg (str) — String written to QTextBrowser

add_process_message (self, msg)
Writes message from stdout to kernel editor text browser.

Parameters msg (str) — String written to QTextBrowser

add_process_error_message (self, msg)
Writes message from stderr to kernel editor text browser.

Parameters msg (str) — String written to QTextBrowser
_save_ui (self)

class spinetoolbox.widgets.kernel_editor.KernelEditor (parent, python, julia, python_or_julia,
current_kernel)
Bases: KernelEditorBase

Class for a Python and Julia kernel editor.
Parameters
» parent (QWidget) — Parent widget (Settings widget)
» python (str) — Python interpreter, may be empty string
* julia (str) - Julia executable, may be empty string
» python_or_julia (str) — Setup KernelEditor according to selected mode

» current_kernel (str) — Current selected Python or Julia kernel name
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connect_signals(self)
Connects signals to slots.

_julia_kernel_name (self)

_julia_executable(self)

_julia_project(self)

_bython_kernel_name (self)

_python_kernel_display_name (self)
_bython_interpreter_name (self)
_handle_kernel_selection_changed(self, _selected, _deselected)
_update_ok_button_enabled(self)

python_kernel_name_edited(self, txt)
Updates the display name place holder text and the command QCustomLabel tool tip.

select_julia_clicked(self, checked=False)
Opens file browser where user can select a Julia executable for the new kernel.

select_julia_project_clicked(self, checked=False)
Opens file browser where user can select a Julia project path for the new kernel.

select_python_clicked(self, checked=False)
Opens file browser where user can select the python interpreter for the new kernel.

update_python_cmd_tooltip(self)
Updates Python command (CustomQLabel) tooltip according to selections.

update_julia_cmd_tooltip(self)
Updates Julia command (CustomQLabel) tooltip according to selections.

set_kernel_selected(self, k_name)
Finds row index of given kernel name from the model, sets it selected and scrolls the view so that it’s visible.

Parameters k_name (str) — Kernel name to find and select

_check_kernel_is_ok(self, current, previous)
Shows a notification if there are any known problems with selected kernel.

Parameters
* current (QModelIndex) — Currently selected index
¢ previous (QModelIndex) — Previously selected index

find_column (self, label)
Returns the column number from the kernel model with the given label.

Parameters label (str)— Header column label
Returns Column number or -1 if label not found
Return type int

check_options(self, prgm, kernel_name, display_name, python_or_julia)
Checks that user options are valid before advancing with kernel making.

Parameters
* prgm (str) — Full path to Python or Julia program

¢ kernel_name (str) — Kernel name
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¢ display_name (str) — Kernel display name
e python_or_julia (str) — Either ‘python’ or ‘julia’
Returns True if all user input is valid for making a new kernel, False otherwise
Return type bool
_is_rebuild_ijulia_needed(self)

handle_kernelspec_install_process_finished(self, retval)
Handles case when the process for installing the kernel has finished.

Parameters retval (int) — Process return value. O: success, !0: failure

handle_installkernel_process_finished(self, retval)
Checks whether or not the [Julia.installkernel process finished successfully.

Parameters retval (int) — Process return value. O: success, !0: failure

populate_kernel_model (self)
Populates the kernel model with kernels found in user’s system either with Python or Julia kernels. Un-
knows, invalid, and unsupported kernels are appended to the end.

static get_kernel_deats (kernel_path)
Reads kernel.json from given kernel path and returns the details in a dictionary.

Parameters kernel_path (str) — Full path to kernel directory

Returns language (str), path to interpreter (str), display name (str), project (str) (NA for Python
kernels)

Return type dict

show_kernel_list_context_menu(self, pos)
Shows the context-menu in the kernel list table view.

_open_kernel_json(self, checked=False)
Opens kernel.json file using the default application for .json files.

_open_kernel_dir (self, checked=False)
Opens kernel directory in OS file browser.

_remove_kernel (self, checked=False)
Removes selected kernel by deleting the kernel directory.

mousePressEvent (self, ¢)
Saves mouse position at the start of dragging.

Parameters e (QMouseEvent) — Mouse event

mouseReleaseEvent (self, ¢)
Saves mouse position at the end of dragging.

Parameters e (QMouseEvent) — Mouse event

mouseMoveEvent (self, e)
Moves the window when mouse button is pressed and mouse cursor is moved.

Parameters e (QMouseEvent) — Mouse event

done (self, r)
Overridden QDialog method. Sets the selected kernel instance attribute so that it can be read by the Set-
tingsForm after this dialog has been closed.

Parameters r (int) —
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closeEvent (self, event=None)
Handles dialog closing.

Parameters event (QCloseEvent) — Close event

class spinetoolbox.widgets.kernel_editor.MiniKernelEditorBase (parent, python_or_julia)
Bases: KernelEditorBase

Base class for kernel editors.
Parameters
* parent (QSettingsWidget) — Toolbox settings widget
» python_or_julia (str) — kernel type; valid values: “julia”, “python”
_python_interpreter_name (self)
_julia_executable(self)
_julia_project(self)
_show_close_button(self, failed=False)
make_kernel (self)
abstract _do_make_kernel (self)

class spinetoolbox.widgets.kernel_editor.MiniPythonKernelEditor (parent, python_exe)
Bases: MiniKernelEditorBase

A reduced version of KernelEditor that basically just takes care of installing one Python kernel. The python exe
is passed in the constructor, then calling make_kernel starts the process.

Parameters
* parent (QSettingsWidget) — Toolbox settings widget
» python_or_julia (str) — kernel type; valid values: “julia”, “python”
_bython_kernel_name (self)
_python_kernel_display_name (self)
_do_make_kernel (self)

handle_kernelspec_install_process_finished(self, retval)
Handles case when the process for installing the kernel has finished.

Parameters retval (int) — Process return value. 0: success, !0: failure

class spinetoolbox.widgets.kernel_editor.MiniJuliaKernelEditor (parent, julia_exe, julia_project)
Bases: MiniKernelEditorBase

A reduced version of KernelEditor that basically just takes care of installing one Julia kernel. The julia exe and
project are passed in the constructor, then calling make_kernel starts the process.

Parameters
» parent (QSettingsWidget) — Toolbox settings widget
» python_or_julia (str) — kernel type; valid values: “julia”, “python”
_julia_kernel_name (self)
_do_make_kernel (self)

handle_installkernel_process_finished(self, retval)
Checks whether or not the IJulia.installkernel process finished successfully.
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Parameters retval (int) — Process return value. O: success, !0: failure

spinetoolbox.widgets.kernel_editor.find_kernels()
Returns a dictionary mapping kernel names to kernel paths.

spinetoolbox.widgets.kernel_editor.find_python_kernels()
Returns a dictionary of Python kernels. Keys are kernel_names, values are kernel paths.

spinetoolbox.widgets.kernel_editor.find_julia_kernels()
Returns a dictionary of Julia kernels. Keys are kernel_names, values are kernel paths.

spinetoolbox.widgets.kernel_editor.find_unknown_kernels()
Returns a dictionary of kernels that are neither Python nor Julia kernels.

spinetoolbox.widgets.kernel_editor.format_event_message(msg_type, message, show_datetime=True)
Formats message for the kernel editor text browser. This is a copy of helpers.format_event_message() but the
colors have been edited for a text browser with a white background.

spinetoolbox.widgets.kernel_editor.format_process_message (msg_type, message)
Formats process message for the kernel editor text browser.

spinetoolbox.widgets.link_properties_widget

Link properties widget.
author
M. Marin (KTH)
date 27.11.2020

Module Contents

Classes

LinkPropertiesWidget Widget for connection link properties.

class spinetoolbox.widgets.link_properties_widget.LinkPropertiesWidget (foolbox)
Bases: PySide2.QtWidgets.QWidget

Widget for connection link properties.
Parameters toolbox (ToolboxUI) — The toolbox instance where this widget should be embedded

set_link(self, link)
Hooks the widget to given link, so that user actions are reflected in the link’s filter configuration.

Parameters link (Link) —

unset_link(self)
Releases the widget from any links.

_handle_use_datapackage_state_changed(self, _state)

load_connection_options(self)
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spinetoolbox.widgets.map_editor

An editor widget for editing a map type parameter values.
author
A. Soininen (VTT)
date 11.2.2020

Module Contents

Classes

MapEditor A widget for editing maps.

class spinetoolbox.widgets.map_editor.MapEditor (parent=None)
Bases: PySide2.QtWidgets.QWidget

A widget for editing maps.
parent

Type QWidget
_convert_leaves(self, )

_show_table_context_menu(self, position)
Opens table context menu.

Parameters position (QPoint)— menu’s position

set_value (self, value)
Sets the parameter_value to be edited.

value (self)
Returns the parameter_value currently being edited.

open_value_editor (self, index)
Opens value editor dialog for given map model index.

Parameters index (QModelIndex) — index

_open_header_editor (self, column)

spinetoolbox.widgets.map_value_editor

An editor dialog for map indexes and values.
author
A. Soininen (VTT)
date 2.11.2020
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Module Contents

Classes

MapValueEditor Dialog for editing parameter values in Map value editor.

class spinetoolbox.widgets.map_value_editor.MapValueEditor (index, parent=None)
Bases: spinetoolbox.widgets.parameter_value_editor_base.ParameterValueEditorBase

Dialog for editing parameter values in Map value editor.
Parameters
* index (QModelIndex) — an index to a parameter_value in parent_model
* parent (QWidget, optional)— a parent widget

_set_data(self, value)
See base class.

spinetoolbox.widgets.multi_tab_spec_editor

Contains the MultiTabSpecEditor class.
author
M. Marin (KTH)
date 12.12.2020

Module Contents

Classes

MultiTabSpecEditor A main window that has a tab widget as its central wid-
get.

class spinetoolbox.widgets.multi_tab_spec_editor.MultiTabSpecEditor (foolbox, item_type)
Bases: spinetoolbox.widgets.multi_tab_window.MultiTabWindow

A main window that has a tab widget as its central widget.
Parameters
» gsettings (QSettings) — Toolbox settings
* settings_group (str) — this window’s settings group in gsettings

_make_other (self)
Creates a new MultiTabWindow of this type.

Returns new MultiTabWindow
Return type MultiTabWindow

others(self)
List of other MultiTabWindows of the same type.
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Returns other MutliTabWindows windows
Return type list of MultiTabWindow

_make_new_tab (self, *args, **kwargs)
Creates a new tab.

Parameters
* *args — positional arguments neede to make a new tab
o **kwargs — keyword arguments needed to make a new tab

property new_tab_title(self)
Title for new tabs.

show_plus_button_context_menu(self, global_pos)
Opens a context menu for the tool bar.

Parameters global_pos (QPoint) — menu position on screen

spinetoolbox.widgets.multi_tab_window

Contains the MultiTabWindow and TabBarPlus classes.
author
M. Marin (KTH)
date 12.12.2020

Module Contents

Classes
MultiTabWindow A main window that has a tab widget as its central wid-
get.
TabBarPlus Tab bar that has a plus button floating to the right of the
tabs.

class spinetoolbox.widgets.multi_tab_window.MultiTabWindow(gsettings, settings_group)
Bases: PySide2.QtWidgets.QMainWindow

A main window that has a tab widget as its central widget.
Parameters
* gsettings (QSettings) — Toolbox settings
» settings_group (str) — this window’s settings group in gsettings
_tab_slots

abstract _make_other(self)
Creates a new MultiTabWindow of this type.

Returns new MultiTabWindow

Return type MultiTabWindow
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abstract others(self)
List of other MultiTabWindows of the same type.

Returns other MutliTabWindows windows
Return type list of MultiTabWindow

abstract _make_new_tab(self, *args, **kwargs)
Creates a new tab.

Parameters
* *args — positional arguments neede to make a new tab
» **kwargs — keyword arguments needed to make a new tab

abstract show_plus_button_context_menu(self, global_pos)
Opens a context menu for the tool bar.

Parameters global_pos (QPoint) — menu position on screen

property new_tab_title(self)
Title for new tabs.

connect_signals(self)
Connects window’s signals.

name (self)
Generates name based on the current tab and total tab count.

Returns a name
Return type str

all_tabs(self)
Iterates over tab contents widgets.

Yields QWidget — tab contents widget

add_new_tab (self, *args, **kwargs)
Creates a new tab and adds it at the end of the tab bar.

Parameters
¢ *args — parameters forwarded to MutliTabWindow._make_new_tab()
o **kwargs — parameters forwarded to MultiTabwindow._make_new_tab()

insert_new_tab(self, index, *args, **kwargs)
Creates a new tab and inserts it at the given index.

Parameters
e index (int) — insertion point index
* *args — parameters forwarded to MutliTabWindow._make_new_tab()
» **kwargs — parameters forwarded to MultiTabwindow._make_new_tab()

_add_connect_tab (self, tab, text)
Appends a new tab and connects signals.

Parameters
e tab (QWidget) — tab contents widget

* text (str)— appended tab title
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_insert_connect_tab (self, index, tab, text)
Inserts a new tab and connects signals.

Parameters
e index (int) — insertion point index
 tab (QWidget) — tab contents widget
e text (str) — inserted tab title

_remove_disconnect_tab (self, index)
Disconnects and removes a tab.

Parameters index (int) — tab index

_connect_tab(self, index)
Connects signals from a tab contents widget.

Parameters index (int) — tab index

_connect_tab_signals(self, tab)
Connects signals from a tab contents widget.

Parameters tab (QWidget) — tab contents widget
Returns True if signals were connected successfully, False otherwise
Return type bool

_disconnect_tab_signals(self, index)
Disconnects signals from given tab.

Parameters index (int) — tab index
Returns True if signals were disconnected successfully, False otherwise
Return type bool

_handle_tab_window_title_changed(self, rab, title)
Updates tab’s title.

Parameters
¢ tab (QWidget) — tab’s content widget
e title (str) — new tab title; if emtpy, one will be generated

_take_tab(self, index)
Removes a tab and returns its contents.

Parameters index (int) — tab index
Returns widget the tab was holding and tab’s title
Return type tuple

move_tab (self, index, other=None)
Moves a tab to another MultiTabWindow.

Parameters
e index (int) — tab index
e other (MultiTabWindow, optional) - target window; if None, creates a new window

detach(self, index, hot_spot, offset=0)
Detaches the tab at given index into another MultiTabWindow window and starts dragging it.
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Parameters
¢ index (int) -
¢ hot_spot (QPoint) —
e offset (int) -

start_drag(self, hot_spot, offset=0)
Starts dragging a detached tab.

Parameters
* hot_spot (QPoint) — The anchor point of the drag in widget coordinates.
e offset (int) — Horizontal offset of the tab in the bar.

_frame_height (self)
Calculates the total ‘thickness’ of window frame in vertical direction.

Returns frame height
Return type int

timerEvent (self, event)
Performs the drag, i.e., moves the window with the mouse cursor. As soon as the mouse hovers the tab bar
of another MultiTabWindow, reattaches it.

mouseReleaseEvent (self, event)
Stops the drag. This only happens when the detached tab is not reattached to another window.

reattach(self, index, tab, text)
Reattaches a tab that has been dragged over this window’s tab bar.

Parameters
¢ index (int) — Index in this widget’s tab bar where the detached tab has been dragged.
* tab (QWidget) — The widget in the tab being dragged.
¢ text (str) — The title of the tab.

_close_tab (self, index)
Closes the tab at index.

Parameters index (int) — tab index

set_current_tab (self, tab)
Sets the tab that is shown on the window.

Parameters tab (QWidget) — tab’s contents widget

make_context_menu(self, index)
Creates a context menu for given tab.

Parameters index (int) — tab index
Returns context menu or None if tab was not found
Return type QMenu

restore_ui (self)
Restore Ul state from previous session.

save_window_state(self)
Save window state parameters (size, position, state) via QSettings.

closeEvent (self, event)
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class spinetoolbox.widgets.multi_tab_window.TabBarPlus (parent)
Bases: PySide2.QtWidgets.QTabBar

Tab bar that has a plus button floating to the right of the tabs.
Parameters parent (MultiSpineDBEditor) —
plus_clicked

resizeEvent (self, event)
Sets the dimension of the plus button. Also, makes the tab bar as wide as the parent.

tabLayoutChange (self)

_move_plus_button(self)
Places the plus button at the right of the last tab.

mousePressEvent (self, event)
Registers the position of the press, in case we need to detach the tab.

mouseMoveEvent (self, event)
Detaches a tab either if the user moves beyond the limits of the tab bar, or if it’s the only one.

_send_release_event (self, pos)
Sends a mouse release event at given position in local coordinates. Called just before detaching a tab.

Parameters pos (QPoint) —
mouseReleaseEvent (self, event)

start_dragging(self, index)
Stars dragging the given index. This happens when a detached tab is reattached to this bar.

Parameters index (int) —

index_under_mouse (self)
Returns the index under the mouse cursor, or None if the cursor isn’t over the tab bar. Used to check for
drop targets.

Returns int or NoneType

contextMenuEvent (self, event)

spinetoolbox.widgets.notification

Contains a notification widget.
author
P. Savolainen (VTT)
date 12.12.2019
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Module Contents

Classes

Notification Custom pop-up notification widget with fade-in and
fade-out effect.

InteractiveNotification A notification that doesn't dissapear when the cursor is
on it.

ButtonNotification A notification with a button.

LinkNotification A notification that may have a link.

NotificationStack

ChangeNotifier

param parent

class spinetoolbox.widgets.notification.Notification(parent, txt, anim_duration=500,
life_span=None, word_wrap=True,
corner=0Qt.TopRightCorner)
Bases: PySide2.QtWidgets.QFrame

Custom pop-up notification widget with fade-in and fade-out effect.
Parameters

* parent (QWidget) — Parent widget
* txt (str) — Text to display in notification
e anim_duration (int) — Duration of the animation in msecs
» life_span (int) — How long does the notification stays in place in msecs
e word_wrap (bool) —
e corner (Qt.Corner) —

opacity

show (self)

get_opacity(self)
opacity getter.

set_opacity(self, op)
opacity setter.

update_opacity (self, value)
Updates graphics effect opacity.

start_self destruction(self)
Starts fade-out animation and closing of the notification.

enterEvent (self, ¢)
dragEnterEvent (self, ¢)

remaining_time (self)
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class spinetoolbox.widgets.notification.InteractiveNotification(parent, txt, anim_duration=500,
life_span=None,
word_wrap=True,
corner=0Qt.TopRightCorner)
Bases: Notification

A notification that doesn’t dissapear when the cursor is on it.
Parameters

* parent (QWidget) — Parent widget
* txt (str) — Text to display in notification
e anim_duration (int) — Duration of the animation in msecs
* life_span (int) — How long does the notification stays in place in msecs
e word_wrap (bool) -
e corner (Qt.Corner) —

enterEvent (self, e)
Pauses timer as the mouse hovers the notification.

leaveEvent (self, ¢)
Starts self destruction after the mouse leaves the notification.

class spinetoolbox.widgets.notification.ButtonNotification(*args, button_text=",
button_slot=None, **kwargs)
Bases: InteractiveNotification

A notification with a button.
Parameters

* parent (QWidget) — Parent widget
* txt (str) - Text to display in notification
e anim_duration (int) — Duration of the animation in msecs
* life_span (int) — How long does the notification stays in place in msecs
e word_wrap (bool) —
e corner (Qt.Corner) —

class spinetoolbox.widgets.notification.LinkNotification(*args, open_link=None, **kwargs)
Bases: InteractiveNotification

A notification that may have a link.
Parameters
* parent (QWidget) — Parent widget
* txt (str) — Text to display in notification
e anim_duration (int) — Duration of the animation in msecs
» life_span (int) — How long does the notification stays in place in msecs
e word_wrap (bool) —

e corner (Qt.Corner) —
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class spinetoolbox.widgets.notification.NotificationStack(parent, anim_duration=500,
life_span=None)
Bases: PySide2.QtCore.QObject

push_notification(self, notification)
Pushes a notification to the stack with the given text.

push (self, txt)
push_link(self, txt, open_link=None)

handle_notification_destroyed(self, notification, height)
Removes from the stack the given notification and move up subsequent ones.

class spinetoolbox.widgets.notification.ChangeNotifier (parent, undo_stack, settings, settings_key,
corner=Qt.BottomLeftCorner)
Bases: PySide2.QtCore.QObject

Parameters
* parent (QWidget) —
» undo_stack (QUndoStack) —
e settings (QSettings) —
e settings_key (str) —

_push_notification(self, index)

spinetoolbox.widgets.open_project_widget

Contains a class for a widget that represents a ‘Open Project Directory’ dialog.
author
P. Savolainen (VTT)
date 1.11.2019

Module Contents

Classes
OpenProjectDialog A dialog that let's user select a project to open either by
choosing
CustomQFileSystemModel Custom file system model.
DirValidator

class spinetoolbox.widgets.open_project_widget.OpenProjectDialog(foolbox)
Bases: PySide2.QtWidgets.QDialog

A dialog that let’s user select a project to open either by choosing an old .proj file or by choosing a project
directory.

Parameters toolbox (ToolboxUI) — QMainWindow instance
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set_keyboard_shortcuts(self)
Creates keyboard shortcuts for the ‘Root’, ‘Home’, etc. buttons.

connect_signals(self)
Connects signals to slots.

expand_and_resize(self, p)
Expands, resizes, and scrolls the tree view to the current directory when the file model has finished loading
the path. Slot for the file model’s directoryLoaded signal. The directoryLoaded signal is emitted only if the
directory has not been cached already. Note, that this is only used when the open project dialog is opened

Parameters p (str) — Directory that has been loaded

validator_state_changed (self)
Changes the combobox border color according to the current state of the validator.

current_index_changed(self, i)
Combobox selection changed. This slot is processed when a new item is selected from the drop-down list.
This is not processed when new item txt is QValidotor.Intermediate.

Parameters i (int) - Selected row in combobox

current_changed (self, current, previous)
Processed when the current item in file system tree view has been changed with keyboard or mouse. Updates
the text in combobox.

Parameters
» current (QModelIndex) — Currently selected index
e previous (QModelIndex) — Previously selected index

set_selected_path(self, index)
Sets the text in the combobox as the selected path in the file system tree view.

Parameters index (QModelIndex) — The index which was mouse clicked.

combobox_text_edited(self, text)
Updates selected path when combobox text is edited. Note: pressing enter in combobox does not trigger
this.

selection(self)
Returns the selected path from dialog.

go_root (self, checked=False)
Slot for the ‘Root’ button. Scrolls the treeview to show and select the user’s root directory.

Note: We need to expand and scroll the tree view here after setCurrentIndex just in case the directory has
been loaded already.

go_home (self, checked=False)
Slot for the ‘Home’ button. Scrolls the treeview to show and select the user’s home directory.

go_documents (self, checked=False)
Slot for the ‘Documents’ button. Scrolls the treeview to show and select the user’s documents directory.

go_desktop (self, checked=False)
Slot for the ‘Desktop’ button. Scrolls the treeview to show and select the user’s desktop directory.

open_project (self, index)
Opens project if index contains a valid Spine Toolbox project. Slot for the mouse doubleClicked signal.
Prevents showing the ‘Not a valid spine toolbox project’ notification if user just wants to collapse a directory.

Parameters index (QModelIndex) — File model index which was double clicked
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done (self, r)
Checks that selected path exists and is a valid Spine Toolbox directory when ok button is clicked or when
enter is pressed without the combobox being in focus.

Parameters r (int) —

static update_recents(entry, gsettings)
Adds a new entry to QSettings variable that remembers the five most recent project storages.

Parameters

* entry (str) — Abs. path to a directory that most likely contains other Spine Toolbox
Projects as well. First entry is also used as the initial path for File->New Project dialog.

¢ gsettings (QSettings) — Toolbox gsettings object

static remove_directory_from_recents(p, gsettings)
Removes directory from the recent project storages.

Parameters
e p (str) — Full path to a project directory
e gsettings (QSettings) — Toolbox gsettings object

show_context_menu(self, pos)
Shows the context menu for the QCombobox with a ‘Clear history’ entry.

Parameters pos (QPoint) — Mouse position

closeEvent (self, event=None)
Handles dialog closing.

Parameters event (QCloseEvent) — Close event

class spinetoolbox.widgets.open_project_widget.CustomQFileSystemModel
Bases: PySide2.QtWidgets.QFileSystemModel

Custom file system model.

columnCount (self, parent=0QModellndex())
Returns one.

class spinetoolbox.widgets.open_project_widget.DirValidator (parent=None)
Bases: PySide2.QtGui.QValidator

validate(self, txt, pos)
Returns Invalid if input is invalid according to this validator’s rules, Intermediate if it is likely that a little
more editing will make the input acceptable and Acceptable if the input is valid.

Parameters
e txt (str) - Text to validate
* pos (int) — Cursor position
Returns Invalid, Intermediate, or Acceptable

Return type QValidator.State

422 Chapter 20. API Reference



Spine Toolbox Documentation, Release 0.6.6.dev0-dev.0

spinetoolbox.widgets.parameter_value_editor

An editor dialog for editing database (relationship) parameter values.
author
A. Soininen (VTT)
date 28.6.2019

Module Contents

Classes

ParameterValueEditor Dialog for editing parameter values in Database editor.

class spinetoolbox.widgets.parameter_value_editor.ParameterValueEditor (index, parent=None,
plain=False)
Bases: spinetoolbox.widgets.parameter_value_editor_base.ParameterValueEditorBase

Dialog for editing parameter values in Database editor.
Parameters
* index (QModelIndex) — an index to a parameter_value in parent_model
» parent (QWidget, optional) — a parent widget
* plain (bool) —if True, allow only plain value editing, otherwise allow all parameter types

_set_data(self, value)
See base class.

spinetoolbox.widgets.parameter_value_editor_base

A base for editor windows for editing parameter values.
author
A. Soininen (VTT)
date 2.11.2020

Module Contents

Classes
ValueType Enum to identify value types that use different editors.
ParameterValueEditorBase Dialog for editing parameter values.
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Attributes

_SELECTORS

class spinetoolbox.widgets.parameter_value_editor_base.ValueType
Bases: enum. Enum

Enum to identify value types that use different editors.

PLAIN_VALUE

MAP

TIME_SERIES_FIXED_RESOLUTION

TIME_SERIES_VARIABLE_RESOLUTION

TIME_PATTERN

ARRAY

DATETIME

DURATION
spinetoolbox.widgets.parameter_value_editor_base._SELECTORS

class spinetoolbox.widgets.parameter_value_editor_base.ParameterValueEditorBase (index, edi-
tor_widgets,
par-
ent=None)
Bases: PySide2.QtWidgets.QWidget

Dialog for editing parameter values.

The dialog takes an index and shows a specialized editor corresponding to the value type in a stack widget. The
user can change the value type by changing the specialized editor using a combo box. When the dialog is closed
the value from the currently shown specialized editor is written back to the given index.

Parameters
* index (QModelIndex) — an index to a parameter_value in parent_model
» editor_widgets (dict) — a mapping from ValueType to QWidget
* parent (QWidget, optional) — a parent widget

accept(self)
Saves the parameter_value shown in the currently selected editor widget to the database manager.

_change_parameter_type (self, selector_index)
Handles switching between value types.

Does a rude conversion between fixed and variable resolution time series. In other cases, a default ‘empty’
value is used.

Parameters selector_index (int) — an index to the selector combo box

_select_editor(self, value)
Shows the editor widget corresponding to the given value type on the editor stack.

_use_default_editor (self, message=None)
Opens the default editor widget. Optionally, displays a warning dialog indicating the problem.
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Parameters message (str, optional) -

_use_editor (self, value, value_type)
Sets a value to edit on an editor widget.

Parameters
e value (object) — value to edit
¢ value_type (ValueType) — type of value

abstract _set_data(self, value)
Writes parameter value back to the model.

Parameters value (object) — value to write
Returns True if the operation was successful, False otherwise

Return type bool

spinetoolbox.widgets.persistent_console_widget

Module Contents

Classes
PersistentConsoleLineEdit A line edit for the prompt of PersistentConsoleWidget.
PersistentConsoleWidget A widget to interact with a persistent process.
PersistentRunnableBase Base class for runnables that talk to the persistent pro-

cess in another QThread.

Restarter A runnable that restarts a persistent process.
Interrupter A runnable that interrupts a persistent process.
CommandIssuer A runnable that issues a command.

class spinetoolbox.widgets.persistent_console_widget.PersistentConsoleLineEdit (parent)
Bases: PySide2.QtWidgets.QPlainTextEdit

A line edit for the prompt of PersistentConsoleWidget.

This widget is fully transparent. It’s only there to provide user interaction. The contents are constantly reflected
in the console widget.

Parameters parent (PersistentConsoleWidget) —
_adjust_size(self)

_get_current_text (self)
Returns current text.

Returns the complete text str: the text before the cursor (for autocompletion)
Return type str
keyPressEvent (self, ev)

class spinetoolbox.widgets.persistent_console_widget.PersistentConsoleWidget (toolbox, key,
language,
owner=None)
Bases: PySide2.QtWidgets.QPlainTextEdit
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A widget to interact with a persistent process.
Parameters
e toolbox (ToolboxUI) —
 key (tuple) — persistent process identifier
* language (str) - for syntax highlighting and prompting, etc.
e owner (ProjectItemBase, optional) - console owner

name (self)
Returns console name for display purposes.

property owner_names (self)
_make_prompt (self)
_make_cont_prompt (self)

_reposition_line_edit(self)
Moves line edit vertically to the position of the last block.

_insert_formatted_text (self, cursor, text)
Inserts formatted text.

Parameters
e cursor (QTextCursor) —
e text (str)—

reflect_line_edit_contents(self)
Reflects contents of line edit.

move_history (self, text, step)
Moves history.

Parameters
* text (str)—
e step (int) —

autocomplete (self, text, partial_text)
Autocompletes current text in the prompt (or print options if multiple matches).

Parameters
e text (str) -
e partial_text (str) -

_commit_line_edit(self)
Clears line edit and moves it to the end of the document.

issue_command (self, text)
Issues command.

Parameters text (str)—
_scroll_to_bottom(self)

_cursor_at_start_of_prompt (self)
Returns a cursor at the start of the prompt.

Returns QTextCursor
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_insert_text_before_prompt (self, text, with_prompt=False, text_format=QTextCharFormat())
Inserts given text before the prompt. Used when adding input and output from external execution.

Parameters text (str)—

add_stdin(self, data)
Adds new prompt with data. Used when adding stdin from external execution.

Parameters data (str) -

add_stdout (self, data)
Adds new line to stdout. Used when adding stdout from external execution.

Parameters data (str)—

add_stderr (self, data)
Adds new line to stderr. Used when adding stderr from external execution.

Parameters data (str) —

_add_prompt (self, is_complete=True)
Adds a prompt at the end of the document.

_restart_persistent (self, _=Fulse)
Restarts underlying persistent process.

_interrupt_persistent (self, _=False)
Interrupts underlying persistent process.

paintEvent (self, ev)
Repositions line edit.

focusInEvent (self, _ev)
Gives focus to the line edit.

resizeEvent (self, ev)
Makes line edit as wide as this.

_extend_menu (self, menu)
Adds two more actions: Restart, and Interrupt.

contextMenuEvent (self, event)
Reimplemented to extend menu with custom actions.

class spinetoolbox.widgets.persistent_console_widget.PersistentRunnableBase (engine_server_address,

persistent_key)
Bases: PySide2.QtCore.QRunnable

Base class for runnables that talk to the persistent process in another QThread.

Parameters

* engine_server_address (str) — address of the remote engine, currently should always
be an empty string

» persistent_key (tuple) — persistent process identifier

class Signals
Bases: PySide2.QtCore.Q0Object

finished

class spinetoolbox.widgets.persistent_console_widget.Restarter (engine_server_address,

persistent_key)
Bases: PersistentRunnableBase
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A runnable that restarts a persistent process.
Parameters

* engine_server_address (str) — address of the remote engine, currently should always
be an empty string

» persistent_key (tuple) — persistent process identifier
run(self)

class spinetoolbox.widgets.persistent_console_widget.Interrupter (engine_server_address,
persistent_key)
Bases: PersistentRunnableBase

A runnable that interrupts a persistent process.
Parameters

* engine_server_address (str) — address of the remote engine, currently should always
be an empty string

» persistent_key (tuple) — persistent process identifier
run(self)

class spinetoolbox.widgets.persistent_console_widget.CommandIssuer (engine_server_address,
persistent_key, command)
Bases: PersistentRunnableBase

A runnable that issues a command.
Parameters

* engine_server_address (str) — address of the remote engine, currently should always
be an empty string

» persistent_key (tuple) — persistent process identifier
e command (str) — command to execute

class Signals
Bases: PySide2.QtCore.Q0Object

finished
stdin_msg
stdout_msg
stderr_msg
run(self)

spinetoolbox.widgets.plain_parameter_value_editor

An editor widget for editing plain number database (relationship) parameter values.
author
A. Soininen (VTT)
date 28.6.2019
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Module Contents

Classes

PlainParameterValueEditor A widget to edit float or boolean type parameter values.

class spinetoolbox.widgets.plain_parameter_value_editor.PlainParameterValueEditor (parent widget=None)
Bases: PySide2.QtWidgets.QWidget

A widget to edit float or boolean type parameter values.

parent_widget
a parent widget

Type QWidget
_set_number_or_string_enabled(self, on)

set_value(self, value)
Sets the value to be edited in this widget.

value (self)
Returns the value currently being edited.

spinetoolbox.widgets.plot_canvas

A Qt widget to use as a matplotlib backend.
author
A. Soininen (VTT)
date 3.6.2019

Module Contents

Classes

PlotCanvas A widget for plotting with matplotlib.

class spinetoolbox.widgets.plot_canvas.PlotCanvas (parent=None)
Bases: matplotlib.backends.backend_qt5agg.FigureCanvasQTAgg

A widget for plotting with matplotlib.
Parameters parent (QWidget) — a parent widget

property axes(self)
matplotlib.axes.Axes: figure’s axes
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spinetoolbox.widgets.plot_widget

A Qt widget showing a toolbar and a matplotlib plotting canvas.
author
A. Soininen (VTT)
date 27.6.2019

Module Contents

Classes

PlotWidget A widget that contains a toolbar and a plotting canvas.
Functions

_prepare_plot_in_window_menu(menu) Fills a given menu with available plot window names.

class spinetoolbox.widgets.plot_widget.PlotWidget (parent=None)
Bases: PySide2.QtWidgets.QWidget

A widget that contains a toolbar and a plotting canvas.

canvas
the plotting canvas

Type PlotCanvas

plot_type
type of currently plotted data or None

Type type

plot_windows
A global list of plot windows.

closeEvent (self, event)
Removes the window from plot_windows and closes.

infer_plot_type(self, values)
Decides suitable plot_type according to a list of values.

use_as_window (self, parent_window, document_name)
Prepares the widget to be used as a window and adds it to plot_windows list.

Parameters
¢ parent_window (QWidget) — a parent window
¢ document_name (str) — a string to add to the window title

static _unique_window_name (document name)
Returns an unique identifier for a new plot window.

spinetoolbox.widgets.plot_widget._prepare_plot_in_window_menu(menu)
Fills a given menu with available plot window names.
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spinetoolbox.widgets.plugin_manager_widgets

Contains PluginManager dialogs and widgets.
author
M. Marin (KTH)
date 21.2.2021

Module Contents

Classes
_InstallPluginModel
_ManagePluginsModel
InstallPluginDialog Initialize class
ManagePluginsDialog Initialize class

class spinetoolbox.widgets.plugin_manager_widgets._InstallPluginModel
Bases: PySide2.QtGui.QStandardItemModel

data(self, index, role=None)

class spinetoolbox.widgets.plugin_manager_widgets._ManagePluginsModel
Bases: _InstallPluginModel

flags (self, index)

class spinetoolbox.widgets.plugin_manager_widgets.InstallPluginDialog(parent)
Bases: PySide2.QtWidgets.QDialog

Initialize class

item_selected

populate_list (self, names)
_handle_search_text_changed(self, _text)
_filter_model (self)

_handle_ok_clicked(self, _=False)
_emit_item_selected(self, index)
_update_ok_button_enabled(self, _selected, _deselected)

class spinetoolbox.widgets.plugin_manager_widgets.ManagePluginsDialog(parent)
Bases: PySide2.QtWidgets.QDialog

Initialize class
item_removed
item_updated
populate_list (self, names)

_create_plugin_widget (self, plugin_name, can_update)
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_emit_item_removed(self, plugin_name)

_emit_item_updated(self, plugin_name)

spinetoolbox.widgets.project_item_drag

Classes for custom QListView.
author
M. Marin (KTH)
date 14.11.2018

Module Contents

Classes

ProjectItemDragMixin

Custom class with dragging support.

ProjectItemButtonBase

Custom class with dragging support.

ProjectItemButton

Custom class with dragging support.

ProjectItemSpecButton

Custom class with dragging support.

ShadeMixin

ShadeProjectItemSpecButton

Custom class with dragging support.

ShadeButton

_ChoppedIcon

_ChoppedIconEngine

ProjectItemSpecArray An array of ProjectltemSpecButton that can be ex-

panded/collapsed.

class spinetoolbox.widgets.project_item drag.ProjectItemDragMixin(*args, **kwargs)
Custom class with dragging support.

drag_about_to_start

mouseMoveEvent (self, event)
Start dragging action if needed

mouseReleaseEvent (self, event)
Forget drag start position

class spinetoolbox.widgets.project_item_drag.ProjectItemButtonBase (foolbox, item_type, icon,
parent=None)
Bases: ProjectItemDragMixin, PySide2.QtWidgets.QToolButton

Custom class with dragging support.
set_colored_icons(self, colored)

_handle_drag_about_to_start(self)
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mousePressEvent (self, event)
Register drag start position

abstract _make_mime_data_text(self)

class spinetoolbox.widgets.project_item_drag.ProjectItemButton(toolbox, item_type, icon,
parent=None)
Bases: ProjectItemButtonBase

Custom class with dragging support.
double_clicked
_make_mime_data_text (self)
mouseDoubleClickEvent (self, event)

class spinetoolbox.widgets.project_item_drag.ProjectItemSpecButton(foolbox, item_type, icon,
spec_name=",
parent=None)
Bases: ProjectItemButtonBase

Custom class with dragging support.
set_orientation(self, orientation)
property spec_name (self)
_make_mime_data_text (self)
contextMenuEvent (self, event)
mouseDoubleClickEvent (self, event)

class spinetoolbox.widgets.project_item_drag.ShadeMixin

paintEvent (self, ev)

class spinetoolbox.widgets.project_item_drag.ShadeProjectItemSpecButton(toolbox, item_type,
icon, spec_name=",
parent=None)
Bases: ShadeMixin, ProjectItemSpecButton

Custom class with dragging support.
clone(self)

class spinetoolbox.widgets.project_item_drag.ShadeButton
Bases: ShadeMixin, PySide2.QtWidgets.QToolButton

class spinetoolbox.widgets.project_item_drag._ChoppedIcon(icon, size)
Bases: PySide2.QtGui.QIcon

update(self)

class spinetoolbox.widgets.project_item_drag._ChoppedIconEngine (icon, size)
Bases: PySide2.QtGui.QIconEngine

update (self)
pixmap (self, size, mode, state)

class spinetoolbox.widgets.project_item_drag.ProjectItemSpecArray (toolbox, model, item_type,
icon)
Bases: PySide2.QtWidgets.QToolBar
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An array of ProjectltemSpecButton that can be expanded/collapsed.
Parameters
e toolbox (ToolboxUI) —
e model (FilteredSpecificationModel) -
e item_type (str) -
e icon (ColoredIcon) -
set_colored_icons (self, colored)
update (self)
_update_button_visible_icon_color (self)
set_color (self, color)
paintEvent (self, ev)

_get_first_chopped_index (self)
Returns the index of the first chopped action (chopped = not drawn because of space).

Returns list(QAction) int or NoneType

—add_£illing(self, actions, ind)
Adds a button to fill empty space after the last visible action.

Parameters
e actions (1ist (QAction)) — actions
e ind (int or NoneType) — index of the first chopped one or None if all are visible

_get_£illing(self, previous)
Returns the position and size of the filling widget.

Parameters previous (QWidget) — last visible widget
Returns position x int: position y int: width int: height
Return type int

_populate_extension_menu(self, actions, ind)
Populates extension menu with chopped actions.

Parameters
e actions (1ist (QAction)) — actions
e ind (int or NoneType) — index of the first chopped one or None if all are visible
showEvent (self, ev)

_update_button_geom(self, orientation=None)
Updates geometry of buttons given the orientation

Parameters orientation (Qt.Orientation) —
_show_spec_form(self, _checked=False)
toggle_visibility(self, _checked=Fualse)
set_visible(self, visible)

_insert_specs(self, parent, first, last)

_remove_specs (self, parent, first, last)
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_change_spec_data(self, top_left, bottom_right, roles)
_reset_specs(self)

_add_spec(self, row)

spinetoolbox.widgets.rename_project_dialog

A widget for editing project name and description

Module Contents

Classes

RenameProjectDialog Rename project dialog.

class spinetoolbox.widgets.rename_project_dialog.RenameProjectDialog(toolbox, project)
Bases: PySide2.QtWidgets.QDialog

Rename project dialog.
Parameters

¢ toolbox (ToolboxUTI) — QMainWindow instance
e project (SpineToolboxProject) —

property name (self)

property description(self)

_set_ok_enabled(self)

accept(self)

spinetoolbox.widgets.report_plotting_failure

Functions to report failures in plotting to the user.
author
A. Soininen (VTT)
date 10.7.2019

Module Contents

Functions

report_plotting_failure(error, parent_widget) Reports a PlottingError exception to the user.

spinetoolbox.widgets.report_plotting_failure.report_plotting_failure(error, parent_widget)
Reports a PlottingError exception to the user.
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spinetoolbox.widgets.settings_widget

Widget for controlling user settings.
author
P. Savolainen (VTT)
date 17.1.2018

Module Contents

Classes

SettingsWidgetBase
param qsettings Toolbox settings

SpineDBEditorSettingsMixin

SpineDBEditorSettingsWidget A widget to change user's preferred settings, but only for
the Spine db editor.

SettingsWidget A widget to change user's preferred settings.

Functions

_get_python_kernel_name_by_exe(python_exe) Returns a kernel name corresponding to given python
exe, or an empty string if none available.

_get_julia_kernel_name_by_env(julia_exe, Returns a kernel name corresponding to given julia exe

julia_project) and project, or an empty string if none available.

_samefile(a, b)

class spinetoolbox.widgets.settings_widget.SettingsWidgetBase (gsettings)
Bases: PySide2.QtWidgets.QWidget

Parameters gsettings (QSettings) — Toolbox settings
property gsettings(self)

connect_signals(self)
Connect signals.

keyPressEvent (self, ¢)
Close settings form when escape key is pressed.

Parameters e (QKeyEvent) — Received key press event.

mousePressEvent (self, )
Save mouse position at the start of dragging.

Parameters e (QMouseEvent) — Mouse event

mouseReleaseEvent (self, )
Save mouse position at the end of dragging.
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Parameters e (QMouseEvent) — Mouse event

mouseMoveEvent (self, ¢)
Moves the window when mouse button is pressed and mouse cursor is moved.

Parameters e (QMouseEvent) — Mouse event

update_ui (self)
Updates UI to reflect current settings. Called when the user choses to cancel their changes. Undoes all
temporary UI changes that resulted from the user playing with certain settings.

save_settings(self)
Gets selections and saves them to persistent memory.

update_ui_and_close(self, checked=False)
Updates UI to reflect current settings and close.

save_and_close(self, checked=False)
Saves settings and close.

class spinetoolbox.widgets.settings_widget.SpineDBEditorSettingsMixin

connect_signals(self)
Connect signals.

read_settings(self)
Read saved settings from app QSettings instance and update UI to display them.

save_settings(self)
Get selections and save them to persistent memory.

update_ui (self)

class spinetoolbox.widgets.settings_widget.SpineDBEditorSettingsWidget (multi_db_editor)
Bases: SpineDBEditorSettingsMixin, SettingsWidgetBase

A widget to change user’s preferred settings, but only for the Spine db editor.
Initialize class.

show (self)

set_auto_expand_objects(self, checked=False)

class spinetoolbox.widgets.settings_widget.SettingsWidget (foolbox)
Bases: SpineDBEditorSettingsMixin, SettingsiidgetBase

A widget to change user’s preferred settings.
Parameters toolbox (ToolboxUTI) — Parent widget.

connect_signals(self)
Connect signals.

_update_python_widgets_enabled(self, state)
_update_julia_widgets_enabled(self, state)
_show_install_julia_wizard(self)
_show_add_up_spine_opt_wizard(self)
set_auto_expand_objects(self, checked=False)

browse_gams_button_clicked(self, checked=False)
Calls static method that shows a file browser for selecting a Gams executable.
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browse_julia_button_clicked(self, checked=False)
Calls static method that shows a file browser for selecting a Julia path.

browse_julia_project_button_clicked(self, checked=False)
Calls static method that shows a folder browser for selecting a Julia project.

browse_python_button_clicked(self, checked=False)
Calls static method that shows a file browser for selecting a Python interpreter.

browse_conda_button_clicked(self, checked=False)
Calls static method that shows a file browser for selecting a Conda executable.

show_python_kernel_editor (self, checked=False)
Opens kernel editor, where user can make a kernel for the Python Console.

python_kernel_editor_closed(self, ret_code)
Catches the selected Python kernel name when the editor is closed.

show_julia_kernel_editor (self, checked=False)
Opens kernel editor, where user can make a kernel the Julia Console.

julia_kernel_editor_closed(self, ret_code)
Catches the selected Julia kernel name when the editor is closed.

browse_work_path(self, checked=False)
Open file browser where user can select the path to wanted work directory.

show_color_dialog(self, checked=False)
Let user pick the bg color.

Parameters checked (boolean)— Value emitted with clicked signal

update_bg_color (self)
Set tool button icon as the selected color and update Design View scene background color.

update_scene_bg(self, checked=False)
Draw background on scene depending on radiobutton states.

Parameters checked (boolean) — Toggle state
update_links_geometry (self, checked=False)
set_toolbar_colored_icons (self, checked=False)

read_settings(self)
Read saved settings from app QSettings instance and update UI to display them.

save_settings(self)
Get selections and save them to persistent memory. Note: On Linux, True and False are saved as boolean
values into QSettings. On Windows, booleans and integers are saved as strings. To make it consistent, we
should use strings.

_get_julia_settings(self)

set_work_directory (self, new_work_dir)
Sets new work directory.

Parameters new_work_dir (str) — Possibly a new work directory

update_ui (self)
Updates UI to reflect current settings. Called when the user choses to cancel their changes. Undoes all
temporary UI changes that resulted from the user playing with certain settings.

spinetoolbox.widgets.settings_widget._get_python_kernel_name_by_exe (python_exe)
Returns a kernel name corresponding to given python exe, or an empty string if none available.
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Parameters python_exe (str)—
Returns str

spinetoolbox.widgets.settings_widget._get_julia_kernel_name_by_env (julia_exe, julia_project)
Returns a kernel name corresponding to given julia exe and project, or an empty string if none available.

Parameters

e julia_exe (str) -

e julia_project (str) -
Returns str

spinetoolbox.widgets.settings_widget._samefile(a, b)

spinetoolbox.widgets.statusbars

Functions to make and handle QStatusBars.

Module Contents

Classes
MainStatusBar A status bar for the main toolbox window.
_LogButton A button to report unseen log messages, and show said
log if clicked.
_EventLogButton A button to report unseen log messages, and show said
log if clicked.
_ItemLogButton Reimplemented to store the document currently in the

log and the character count,

class spinetoolbox.widgets.statusbars.MainStatusBar (foolbox)
Bases: PySide2.QtWidgets.QStatusBar

A status bar for the main toolbox window.
Parameters toolbox (ToolboxUI) -

_handle_item_log_visibility_changed(self, visible)
Stores item log visible status to create _ItemLogButton instances later. See
_handle_item_log_text_changed

_handle_item_log_text_changed(self)
Runs when the text of the item log document changes. Creates an _ItemLogButton for the current item
and adds it to the status bar.

class spinetoolbox.widgets.statusbars._LogButton(widget, log, icon, visible=False, color_name=",
parent=None)
Bases: PySide2.QtWidgets.QToolButton

A button to report unseen log messages, and show said log if clicked.
Parameters

» widget (QDockWidget) — the dock widget that contains the log

20.1. spinetoolbox 439



Spine Toolbox Documentation, Release 0.6.6.dev0-dev.0

* log (CustomQTextBrowser) — the log

e icon (str) —icon for the button

* visible (bool) — whether or not the widget is visible at the moment of creating this button
¢ color_name (str) — color for the button

* parent (QObject) — passed to QToolButton constructor

_handle_clicked(self, checked)
Runs when the button is clicked, shows and raises the widget.

abstract _handle_widget_visibility_changed(self, visible)
abstract _handle_log_changed(self)

class spinetoolbox.widgets.statusbars._EventLogButton(widget, log, icon, visible=False,
color_name=", parent=None)
Bases: _LogButton

A button to report unseen log messages, and show said log if clicked.
Parameters

» widget (QDockWidget) — the dock widget that contains the log
* log (CustomQTextBrowser) — the log
e icon (str) —icon for the button
* visible (bool) — whether or not the widget is visible at the moment of creating this button
e color_name (str) — color for the button
* parent (QObject) — passed to QToolButton constructor

_handle_widget_visibility_changed(self, visible)
Hides the button when the widget becomes visible.

_handle_log_changed(self)
Shows the button when the log text changes and the widget is non-visible.

class spinetoolbox.widgets.statusbars._ItemLogButton(widget, log, icon, visible=False, color_name=",
parent=None)
Bases: _LogButton

Reimplemented to store the document currently in the log and the character count, for monitoring that document
only.

_handle_clicked(self, checked)
Reimplemented to select the item before showing the widget.

_handle_widget_visibility_changed(self, visible)
Hides the button when the widget becomes visible while showing the monitored document.

_handle_log_changed (self)
Shows the button when the log text changes and the widget is non-visible, but only if the log’s document is
the one being monitored.

hideEvent (self, ev)
Reimplemented to update the current character count.
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spinetoolbox.widgets.time_pattern_editor

An editor widget for editing a time pattern type (relationship) parameter values.
author
A. Soininen (VTT)
date 28.6.2019

Module Contents

Classes

TimePatternEditor A widget for editing time patterns.

class spinetoolbox.widgets.time_pattern_editor.TimePatternEditor (parent=None)
Bases: PySide2.QtWidgets.QWidget

A widget for editing time patterns.
Parameters parent (QWidget) — parent widget

_show_table_context_menu(self, position)
Opens the table’s context menu.

Parameters position (QPoint)— menu’s position on the table

set_value(self, value)
Sets the parameter_value to be edited.

value (self)
Returns the parameter_value currently being edited.

_open_header_editor (self, column)

spinetoolbox.widgets.time_series_fixed_resolution_editor

Contains logic for the fixed step time series editor widget.
author
A. Soininen (VTT)
date 14.6.2019

Module Contents

Classes

TimeSeriesFixedResolutionEditor A widget for editing time series data with a fixed time
step.
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Functions
_resolution_to_text(resolution) Converts a list of durations into a string of comma-
separated durations.
_text_to_resolution(text) Converts a comma-separated string of durations into a

resolution array.

spinetoolbox.widgets.time_series_fixed_resolution_editor._resolution_to_text (resolution)
Converts a list of durations into a string of comma-separated durations.

spinetoolbox.widgets.time_series_fixed_resolution_editor._text_to_resolution(text)
Converts a comma-separated string of durations into a resolution array.

class spinetoolbox.widgets.time_series_fixed_resolution_editor.TimeSeriesFixedResolutionEditor (parent=No
Bases: PySide2.QtWidgets.QWidget

A widget for editing time series data with a fixed time step.
Parameters parent (QWidget) — a parent widget

_resolution_changed(self)
Updates the models after resolution change.

_show_table_context_menu(self, position)
Shows the table’s context menu.

Parameters position (QPoint)— menu’s position in table view’s coordinates
_select_date(self, selected_date)

set_value(self, value)
Sets the parameter_value for editing in this widget.

_show_calendar (self)

_start_time_changed(self)
Updates the model due to start time change.

_update_plot (self, topLeft=None, bottomRight=None, roles=None)
Updated the plot.

value (self)
Returns the parameter_value currently being edited.

_open_header_editor (self, column)

spinetoolbox.widgets.time_series_variable_resolution_editor

Contains logic for the variable resolution time series editor widget.
author
A. Soininen (VTT)
date 31.5.2019
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Module Contents

Classes

TimeSeriesVariableResolutionEditor A widget for editing variable resolution time series data.

class spinetoolbox.widgets.time_series_variable_resolution_editor.TimeSeriesVariableResolutionEditor (pa
Bases: PySide2.QtWidgets.QWidget

A widget for editing variable resolution time series data.
Parameters parent (QWidget) — a parent widget

_show_table_context_menu(self, position)
Shows the table’s context menu.

Parameters position (QPoint)— menu’s position on the table

set_value(self, value)
Sets the time series being edited.

_update_plot (self, topLeft=None, bottomRight=None, roles=None)
Updates the plot widget.

value (self)
Return the time series currently being edited.

_open_header_editor (self, column)

spinetoolbox.widgets.toolbars

Functions to make and handle QToolBars.
author
P. Savolainen (VTT)
date 19.1.2018

Module Contents

Classes
ToolBar Base class for Toolbox toolbars.
PluginToolBar A plugin toolbar.
MainToolBar The main application toolbar: Items | Execute
PaddingLabel

class spinetoolbox.widgets.toolbars.ToolBar (name, toolbox)
Bases: PySide2.QtWidgets.QToolBar

Base class for Toolbox toolbars.

Parameters
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e name (str) — toolbar’s name
e toolbox (ToolboxUT) — Toolbox main window

abstract set_color(self, color)
Sets toolbar’s background color.

Parameters color (QColor) — background color

set_project_actions_enabled(self, enabled)
Enables or disables project related actions.

Parameters enabled (bool) — True to enable actions, False to disable

class spinetoolbox.widgets.toolbars.PluginToolBar (name, parent)
Bases: ToolBar

A plugin toolbar.
Parameters parent (ToolboxUI) - QMainWindow instance

setup (self, plugin_specs, disabled_names)
Sets up the toolbar.

Parameters
* plugin_specs (dict) — mapping from specification name to specification
¢ disabled_names (Iterable of str) - specifications that should be disabled

set_color (self, color)
Sets toolbar’s background color.

Parameters color (QColor) — background color

class spinetoolbox.widgets.toolbars.MainToolBar (execute_project_action, execute_selection_action,
stop_execution_action, parent)
Bases: ToolBar

The main application toolbar: Items | Execute
Parameters
* execute_project_action (QAction) — action to execute project
e execute_selection_action (QAction) — action to execute selected items
» stop_execution_action (QAction) — action to stop execution
e parent (ToolboxUI) — QMainWindow instance
_SEPARATOR = ;;

set_project_actions_enabled(self, enabled)
Enables or disables project related actions.

Parameters enabled (bool) — True to enable actions, False to disable

set_color (self, color)
Sets toolbar’s background color.

Parameters color (QColor) — background color
setup (self)
add_project_item_buttons (self)

_add_project_item_button(self, item_type, factory, colored)
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set_colored_icons(self, colored)

_make_tool_button(self, icon, tip, slot)
Makes a new tool button and adds it to the toolbar.

Parameters

¢ icon (QIcon) — button’s icon

¢ tip (str) - button’s tooltip

e slot (Callable) —slot where to connect button’s clicked signal
Returns created button
Return type QToolButton

_add_tool_button(self, button)
Adds a button to the toolbar.

Parameters button (QToolButton) — button to add

add_execute_buttons (self)
Adds project execution buttons to the toolbar.

dragLeaveEvent (self, event)
dragEnterEvent (self, event)
dragMoveEvent (self, event)
dropEvent (self, event)

_update_drop_actions(self, event)
Updates source and target actions for drop operation:

Parameters event (QDragMoveEvent) —

paintEvent (self, ev)
Draw a line as drop indicator.

_drop_line(self)
icon_ordering(self)

class spinetoolbox.widgets.toolbars.PaddingLabel (*args, **kwargs)
Bases: PySide2.QtWidgets.QLabel

20.1.2 Submodules

spinetoolbox.__main__

Spine Toolbox application main file.
author
P. Savolainen (VTT)
date 14.12.2017
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Module Contents

spinetoolbox.__main__.return_code

spinetoolbox.config

Application constants and style sheets

author
P. Savolainen (VTT)
date 2.1.2018

Module Contents

Functions

_make_text_browser_ss(color)

Attributes

LATEST_PROJECT_VERSION

REQUIRED_SPINE_OPT_VERSION

INVALID_CHARS

INVALID_FILENAME_CHARS

_frozen

_path_to_executable

APPLICATION_PATH

_program_root

DEFAULT_WORK_DIR

DOCUMENTATION_PATH

ONLINE_DOCUMENTATION_URL

PLUGINS_PATH

PLUGIN_REGISTRY_URL

continues on next page
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Table 142 — continued from previous page

JUPYTER_KERNEL_TIME_TO_DEAD

PROJECT_FILENAME

STATUSBAR_SS

SETTINGS_SS

ICON_BACKGROUND

ICON_TOOLBAR_SS

TEXTBROWSER_SS

TEXTBROWSER_OVERRIDE_SS

MAINWINDOW_SS

TREEVIEW_HEADER_SS

PIVOT_TABLE_HEADER_COLOR

spinetoolbox.config.LATEST_PROJECT_VERSION = 6
spinetoolbox.config.REQUIRED_SPINE_OPT_VERSION = 0.5.3

spinetoolbox.config.INVALID_CHARS = ['<', ">", ":', ""', /', "\\', 'I',
spinetoolbox.config.INVALID_FILENAME_CHARS = ['<', '>', ':', '"', '/',
I*l]

spinetoolbox.config._frozen
spinetoolbox.config._path_to_executable
spinetoolbox.config.APPLICATION_PATH
spinetoolbox.config._program_root
spinetoolbox.config.DEFAULT_WORK_DIR
spinetoolbox.config.DOCUMENTATION_PATH

spinetoolbox.config.ONLINE_DOCUMENTATION_URL =
https://spine-toolbox.readthedocs.io/en/master/

spinetoolbox.config.PLUGINS_PATH

spinetoolbox.config.PLUGIN_REGISTRY_URL =
https://spine-project.github.io/PluginRegistry/registry.json

spinetoolbox.config.JUPYTER_KERNEL_TIME_TO_DEAD = 8.0
spinetoolbox.config.PROJECT_FILENAME = project.json

'?l T%0 l.l]

l\\l’ III’ I?I’

spinetoolbox.config.STATUSBAR_SS = QStatusBar{background-color: #EBEBEQ; border-width:

1px; border-color: gray; border-style: groove;}
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spinetoolbox.config.SETTINGS_SS = #SettingsForm{background-color:
ghostwhite;}QLabel{color: black;}QLineEdit{font-size:...

spinetoolbox.config.ICON_BACKGROUND = glineargradient(x1: 1, yl: 1, x2: 0, y2: O,
stop: O #cceOff, stop: 1 #66alff);

spinetoolbox.config.ICON_TOOLBAR_SS
spinetoolbox.config._make_text_browser_ss(color)
spinetoolbox.config.TEXTBROWSER_SS
spinetoolbox.config.TEXTBROWSER_OVERRIDE_SS

spinetoolbox.config.MAINWINDOW_SS = QMainWindow::separator{width: 3px; background-color:
lightgray; border: 1px solid...

spinetoolbox.config.TREEVIEW_HEADER_SS = QHeaderView::section{background-color: #ecd8c6;
font-size: 12px;}

spinetoolbox.config.PIVOT_TABLE_HEADER_COLOR = #efefef
spinetoolbox.custom_file_system_watcher

Contains CustomFileSystemWatcher.
author
M. Marin (KTH)
date 12.11.2020

Module Contents

Classes

CustomFileSystemWatcher A file system watcher that keeps track of renamed files.

class spinetoolbox.custom_file_system_watcher.CustomFileSystemWatcher (parent=None)
Bases: PySide2.QtCore.QFileSystemWatcher

A file system watcher that keeps track of renamed files.
file_renamed

file_removed

file_added

_handle_dir_changed (self, dirname)
add_persistent_file_path(self, path)
add_persistent_file_paths(self, paths)
remove_persistent_file_path(self, path)
remove_persistent_file_paths(self, paths)
add_persistent_dir_path(self, path)

remove_persistent_dir_path(self, path)
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tear_down (self)
_take_snapshot (self, dirname)

static _absfilepaths(dirname)

spinetoolbox.dag_handler

Contains classes for handling DAGs.
author
P. Savolainen (VTT)
date 8.4.2019

Module Contents

Classes

DirectedGraphHandler Class for manipulating graphs according to user's ac-
tions.

class spinetoolbox.dag_handler.DirectedGraphHandler
Class for manipulating graphs according to user’s actions.

dags (self)
Returns a list of graphs (DiGraph) in the project.

add_dag(self, dag)
Add graph to list.

Parameters dag (DiGraph) — Graph to add

remove_dag(self, dag)
Remove graph from instance variable list.

Parameters dag (DiGraph) — Graph to remove

add_dag_node (self, node_name)
Create directed graph with one node and add it to list.

Parameters node_name (str) — Project item name to add as a node

add_graph_edge (self, src_node, dst_node)
Adds an edge between the src and dst nodes. If nodes are in different graphs, the reference to union graph
is saved and the references to the original graphs are removed. If src and dst nodes are already in the same
graph, the edge is added to the graph. If src and dst are the same node, a self-loop (feedback) edge is added.

Parameters
» src_node (str)— Source project item node name
* dst_node (str) — Destination project item node name
Returns True if edge established, False if not (e.g. any of the nodes doesn’t really exist)

Return type bool
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remove_graph_edge (self, src_node, dst_node)
Removes edge from a directed graph.

Parameters

* src_node (str) — Source project item node name

¢ dst_node (str) — Destination project item node name
Returns One or two DAGs containing source and destination nodes.
Return type list of DiGraph

remove_node_from_graph (self, node_name)
Removes node from a graph that contains it. Called when project item is removed from project.

Parameters node_name (str) — Project item name

rename_node (self, old_name, new_name)
Handles renaming the node and edges in a graph when a project item is renamed.

Parameters

¢ 0ld_name (str) — Old project item name

* new_name (str) — New project item name
Returns True if successful, False if renaming failed
Return type bool

dag_with_node (self, node_name)
Returns directed graph that contains given node.

Parameters node_name (str)— Node to look for
Returns Directed graph that contains node or None if not found.
Return type (DiGraph)

dag_with_edge (self, src_node, dst_node)
Returns dir